System i and System p
Partitioning for i5/OS with an HMC
System i and System p
Partitioning for i5/OS with an HMC
Eleventh Edition (September 2007)

This edition applies to version 5, release 4, modification 0 of IBM i5/OS (product number 5722-SS1) and to all subsequent releases and modifications until otherwise indicated in new editions. This version does not run on all reduced instruction set computer (RISC) models nor does it run on CISC models.


US Government Users Restricted Rights – Use, duplication or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
Contents

About this topic ................................ v

Partitioning for i5/OS with an HMC ........................................... 1
PDF file for Partitioning for i5/OS with an HMC ....................... 1

Partitioning with version 6 or earlier of the HMC ................. 194
Configuring i5/OS logical partitions using version 6 or earlier of the HMC .... 211
Partitioning a new or nonpartitioned server ........................... 211
Partitioning a new or nonpartitioned IBM System i5 or eServer i5 managed system using version 6 or earlier of the HMC .... 211
Partitioning a new or nonpartitioned IBM System p5, eServer p5, or IntelliStation POWER 285 managed system using version 6 or earlier of the HMC .... 217
Creating logical partitions using version 6 or earlier of the HMC .... 221
Creating additional partition profiles using version 6 or earlier of the HMC .... 223
Configuring a virtual Ethernet adapter using version 6 or earlier of the HMC .... 224
Designating the service partition for your managed system using version 6 or earlier of the HMC .... 225
Migrating existing i5/OS logical partitions to your new server ........ 226
Copying a partition profile using version 6 or earlier of the HMC .... 227
Creating a system profile using version 6 or earlier of the HMC .... 227
Copying a system profile using version 6 or earlier of the HMC .... 227
Creating an AIX logical partition using i5/OS virtual I/O resources .... 228
Creating a Linux logical partition using i5/OS virtual I/O resources .... 232
Deleting a logical partition using version 6 or earlier of the HMC .... 237
Reseting the managed system to a nonpartitioned configuration using version 6 or earlier of the HMC .... 238

Managing i5/OS logical partitions ............................................ 240
Managing partition profiles for logical partitions ....... 240
Activating a logical partition using the HMC ....... 240
Changing partition profile properties using version 6 or earlier of the HMC .... 240
Deleting a partition profile using version 6 or earlier of the HMC .... 242
Managing system profiles ............................................. 243
Activating a system profile using version 6 or earlier of the HMC .... 243
Deleting a system profile using version 6 or earlier of the HMC .... 243
Dynamically managing logical partition resources ....... 244
Dynamically managing 5250 CPW for i5/OS logical partitions using version 6 or earlier of the HMC .... 244
Managing physical I/O devices and slots dynamically using version 6 or earlier of the HMC .... 246
Managing memory dynamically using version 6 or earlier of the HMC .... 249
Managing processor resources dynamically using version 6 or earlier of the HMC .... 252
Scheduling the movement of resources to and from logical partitions using version 6 or earlier of the HMC .... 255
Saving the partition configuration to a partition profile ....... 256
Managing partitions remotely ............................................. 258
Installing new hardware for i5/OS logical partitions ....... 258
Managing AIX logical partitions using i5/OS virtual I/O resources .... 259
Adding virtual disk units to an AIX logical partition ....... 259
Managing network-server descriptions for an AIX logical partition that uses i5/OS resources .... 261
Using IPL types when running AIX ....... 263
Backing up and recovering AIX logical partitions that use i5/OS virtual I/O resources .... 263
Backing up the network server description and virtual disk drives associated with an AIX logical partition .... 266
Managing Linux logical partitions using i5/OS virtual I/O resources .... 269
Adding virtual disk units to a Linux logical partition ....... 269
Managing network-server descriptions for a Linux logical partition that uses i5/OS resources .... 273
Using IPL types when running Linux ....... 274
Backing up and recovering Linux logical partitions that use i5/OS virtual I/O resources .... 275
Backing up the network server description and virtual disk drives associated with a Linux partition .... 278
Getting fixes for logical partitions and server firmware ....... 283
About this topic

This topic describes how to use a Hardware Management Console (HMC) to create and maintain i5/OS® logical partitions on IBM® System i5®, System p5®, eServer™ i5, and eServer p5 hardware.

For information about the accessibility features of this product, for users who have a physical disability, see “Accessibility features,” on page 309.
Partitioning for i5/OS with an HMC

Partitioning for i5/OS includes information about using a Hardware Management Console (HMC) to configure and manage logical partitions that run i5/OS on IBM Systems and eServer hardware.

What’s new for Partitioning the server

Enhancements relating to partitioning in general have been made with this release.

Partitioning using version 7 or later of the HMC

New articles give instructions for using the latest, browser-based version of the Hardware Management Console (HMC).

Barrier-synchronization register

This new article gives a brief description of the barrier-synchronization register (BSR) that is located on certain POWER® technology-based processors, and how you can assign this resource to logical partitions using version 7 or later of the HMC.

Host Ethernet Adapter

This new article contains information on Host Ethernet Adapter (HEAs), which are physical Ethernet adapters that are integrated directly into the GX+ bus on a managed system. HEAs offer high throughput, low latency, and virtualization support for Ethernet connections.

Related concepts

Partitioning with version 7 or later of the HMC” on page 68

The Hardware Management Console (HMC) is a system that controls managed systems, including the management of logical partitions and use of Capacity Upgrade on Demand. Using service applications, the HMC communicates with managed systems to detect, consolidate, and forward information to IBM for analysis.

Barrier-synchronization register” on page 54

The barrier-synchronization register (BSR) is a memory register that is located on certain POWER technology-based processors. You can write a parallel-processing application running on AIX® so that the application uses a BSR to perform barrier synchronization, which is a method for synchronizing the threads in the parallel-processing application. If you use version 7 or later of the Hardware Management Console (HMC) to create logical partitions, you can divide BSRs into arrays and assign BSR arrays to partition profiles.

Host Ethernet Adapter” on page 54

A Host Ethernet Adapter (HEA) is a physical Ethernet adapter that is integrated directly into the GX+ bus on a managed system. HEAs offer high throughput, low latency, and virtualization support for Ethernet connections. HEAs are also known as Integrated Virtual Ethernet adapters (IVE adapters).

PDF file for Partitioning for i5/OS with an HMC

You can view and print a PDF file of this information.

To view or download the PDF version of this document, select Partitioning for i5/OS with an HMC (about 2194 KB).

You can view or download these related topics:
Saving PDF files

To save a PDF on your workstation for viewing or printing:
1. Right-click the PDF link in your browser.
2. Click the option that saves the PDF locally.
3. Navigate to the directory in which you want to save the PDF.
4. Click Save.

Downloading Adobe Reader

You need Adobe Reader installed on your system to view or print these PDFs. You can download a free copy from the Adobe Web site (www.adobe.com/products/acrobat/readstep2.html).

Concepts for partitioning the server

There are many different ways in which you can partition a server. You can assign some resources directly to logical partitions, and you can share other resources among your logical partitions to make your server more flexible and reduce the amount of maintenance that you must perform. A thorough understanding of the ways in which you can partition a server will allow you to take the fullest advantage of the capabilities of your server.
Logical partition overview

Logical partitioning is the ability to make a server run as if it were two or more independent servers. When you logically partition a server, you divide the resources on the server into subsets called logical partitions. You can install software on a logical partition, and the logical partition runs as an independent logical server with the resources that you have allocated to the logical partition.

Processors, memory, and input/output devices are examples of resources that you can assign to logical partitions. Examples of the kinds of software that you can install and run on logical partitions include the AIX, i5/OS, and Linux operating systems and Virtual I/O Server software.

Logical partitions share a few system attributes, such as the system serial number, system model, and processor feature code. All other system attributes can vary from one logical partition to another.

You must use tools to partition your servers. The tool that you use to partition each server depends upon the server model and the operating systems and features that you want to use on the server.

Benefits of partitioning

The following scenarios illustrate the benefits of partitioning your server:

Consolidating servers
A logically partitioned server can reduce the number of servers that are needed within an enterprise. You can consolidate several servers into a single logically partitioned system. This eliminates the need for, and expense of, additional equipment.

Sharing resources
You can quickly and easily move hardware resources from one logical partition to another as needs change. Features such as Micro-Partitioning™ allow for processor resources to be shared automatically among logical partitions that use the shared processor pool. Other features, such as dynamic logical partitioning, allow for resources to be moved to, from, and between running logical partitions manually without shutting down or restarting the logical partitions.

Maintaining independent servers
Dedicating a portion of the resources (disk storage unit, processors, memory, and I/O devices) to a partition achieves logical isolation of software. If configured correctly, logical partitions also have some hardware fault tolerance. Batch and 5250 on-line transaction processing (OLTP) workloads, which might not run well together on a single machine, can be isolated and run efficiently in separate partitions.

Creating a mixed production and test environment
You can create a combined production and test environment on the same server. The production partition can run your main business applications, and the test partition is used to test software. A failure in a test partition, while not necessarily planned, will not disrupt normal business operations.

Merging production and test environments
Partitioning enables separate partitions to be allocated for production and test servers, eliminating the need to purchase additional hardware and software. When testing has been completed, the resources allocated to the test partition can be returned to the production partition or elsewhere as required. As new projects are developed, they can be built and tested on the same hardware on which they will eventually be deployed.

Running integrated clusters
Using high-availability application software, your partitioned server can run as an integrated cluster. You can use an integrated cluster to protect your server from most unscheduled failures within a partition.
Although there are many benefits to using logical partitioning, consider the following points before choosing to partition.

- Processor and memory failures might result in the failure of the entire server with all of its logical partitions. (The failure of a single I/O device affects only the logical partition to which the I/O device belongs.) To reduce the possibility of system failure, you can use the Advanced System Management Interface (ASMI) to set the server so that the server can deconfigure failing processors or memory modules automatically. After the server deconfigures the failing processor or memory module, the server continues running without using the deconfigured processor or memory module.

- There are many concepts that you must understand to implement logical partitions successfully on your server.

- Administering a consolidated system might be more difficult in some ways than administering multiple smaller systems, particularly if the resources in the consolidated system are used at a level close to their capacity. If you anticipate that you will use your server at a level close to its capacity, consider ordering a server model that is capable of Capacity on Demand (CoD).

### Sharing resources

Although each logical partition acts as an independent server, the logical partitions on a server can share some kinds of resources with each other. The ability to share resources among many logical partitions allows you to increase resource utilization on the server and to move the server resources to where they are needed. The following list illustrates some of the ways in which logical partitions can share resources. For some server models, the features mentioned in this list are options for which you must obtain and enter an activation code.

- **Micro-Partitioning (or shared processing)** allows logical partitions to share the processors in the shared processor pool. The shared processor pool includes all processors on the server that are not dedicated to specific logical partitions. Each logical partition that uses the shared processor pool is assigned a specific amount of processor power from the shared processor pool. If the logical partition needs more processor power than its assigned amount, the logical partition is set by default to use the unused processor power in the shared processor pool. The amount of processor power that the logical partition can use is limited only by the virtual processor settings of the logical partition and the amount of unused processor power available in the shared processor pool. For more information about Micro-Partitioning, see Shared Processors.

- **Dynamic logical partitioning** allows you to move resources to, from, and between running logical partitions manually without shutting down or restarting the logical partitions. This allows you to share devices that logical partitions use occasionally. For example, if the logical partitions on your server use an optical drive occasionally, you can assign a single optical drive to multiple logical partitions as a desired device. The optical drive would belong to only one logical partition at a time, but you can use dynamic logical partitioning to move the optical drive between logical partitions as needed. On servers that are managed using the Integrated Virtualization Manager, dynamic logical partitioning is supported only for the management partition. Dynamic logical partitioning is not supported on servers that are managed using the Virtual Partition Manager.

- **Virtual I/O** allows logical partitions to access and use I/O resources on other logical partitions. For example, virtual Ethernet allows you to create a virtual LAN that connects the logical partitions on your server to each other. If one of the logical partitions on the server has a physical Ethernet adapter that is connected to an external network, you can configure the operating system of that logical partition to connect the virtual LAN with the physical Ethernet adapter. This allows the logical partitions on the server to share a physical Ethernet connection to an external network.

- **A Host Ethernet Adapter (HEA)** allows multiple logical partitions to share a single physical Ethernet adapter. Unlike most other types of I/O devices, you can never assign the HEA itself to a logical partition. Instead, multiple logical partitions can connect directly to the HEA and use the HEA resources. This allows these logical partitions to access external networks through the HEA without having to go through an Ethernet bridge on another logical partition.
Supported operating systems and software

The operating systems and software that are supported on IBM eServer hardware varies by server line.

The following table details the operating systems and software that is supported on each server line.

*Table 1. Supported operating systems and software for logical partitions on IBM Systems and eServer environments*

<table>
<thead>
<tr>
<th></th>
<th>IBM eServer i5</th>
<th>IBM System p5 and eServer p5</th>
<th>IBM eServer OpenPower®</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIX</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>i5/OS</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Linux</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Virtual I/O Server</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Windows® environment integrated on iSeries®</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Linux environment integrated on iSeries</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

Managed Systems

A managed system is a single physical server and the resources that are connected to the physical server and managed by the physical server as a single unit. Connected resources can include expansion units, towers, and drawers, and storage area network (SAN) resources that are assigned to the server.

You can install a single operating system on a managed system and use the managed system as a single server. Alternately, you can use a partitioning tool, such as the Hardware Management Console (HMC), to create multiple logical partitions on the managed system. The partitioning tool manages the logical partitions on the managed system.
In this figure, you can see the logical partitions on each managed system, with the operating systems installed on the disk drives of the physical server and the connected expansion units. The HMC is connected to both managed systems simultaneously and allows you to manage both managed systems from a single location.

**Related concepts**

“Shared processors” on page 32

*Shared processors* are physical processors whose processing capacity is shared among multiple logical partitions. The ability to divide physical processors and share them among multiple logical partitions is known as *Micro-Partitioning*.

**Partitioning tools**

You must use tools to partition your servers. The tool that you use to partition each server depends upon the server model and the operating systems and features that you want to use on the server.
Related concepts

“Dedicated processors” on page 31

Dedicated processors are whole processors that are assigned to a single partition.

“Memory” on page 37

Processors use memory to temporarily hold information. Memory requirements for partitions depend on partition configuration, I/O resources assigned, and applications used.

“Shared processors” on page 32

Shared processors are physical processors whose processing capacity is shared among multiple logical partitions. The ability to divide physical processors and share them among multiple logical partitions is known as Micro-Partitioning.

“Virtual processors in the shared processor pool” on page 33

A virtual processor is a representation of a physical processor to the operating system of a logical partition that uses the shared processor pool.

“Virtual SCSI adapters” on page 27

Virtual SCSI (Small Computer Systems Interface) adapters provide one partition with the ability to use storage I/O (disk, CD, and tape) that is owned by another partition.

“Virtual serial adapters” on page 26

Virtual serial adapters provide a point-to-point connection from one logical partition to another, or from the Hardware Management Console (HMC) to each logical partition on the managed system. Virtual serial adapters are used primarily to establish terminal or console connections to logical partitions.

Hardware Management Console

The Hardware Management Console (HMC) is a hardware appliance that you can use to configure and control one or more managed systems. You can use the HMC to create and manage logical partitions and activate Capacity Upgrade on Demand. Using service applications, the HMC communicates with managed systems to detect, consolidate, and send information to service and support for analysis.

The HMC also provides terminal and 5250 console emulation for the logical partitions on your managed system. You can connect to logical partitions from the HMC itself, or you can set up the HMC so that you can connect to logical partitions remotely through the HMC. HMC terminal and 5250 console emulation provides a dependable connection that you can use if no other terminal or console device is connected or operational. HMC terminal and 5250 console emulation is particularly useful during initial system setup, before you have configured your terminal or console of choice.

This figure illustrates the logical partitions and the server firmware on the IBM Systems and eServer hardware. The server firmware is code that is stored in system flash memory on the server. The server firmware directly controls the resource allocations on the server and the communications between logical partitions on the server. The HMC connects with the server firmware and specifies how the server firmware allocates resources on the server.
If you use a single HMC to manage a server, and the HMC malfunctions or becomes disconnected from
the server firmware, then the server continues to run, but you will not be able to change the logical
partition configuration of the server or manage the server. If desired, you can attach an additional HMC
to act as a backup and to provide a redundant path between the server and IBM service and support.

Partitioning using the HMC is supported on all IBM System i5 and eServer i5, IBM System p5 and
eServer p5, and IBM eServer OpenPower server models, although some models require you to enter an
Advanced POWER Virtualization activation code before you can partition the server.

There are two different HMC user interfaces.

- Version 7 and later of the HMC uses a web-based user interface. You can configure the HMC to allow
remote connections using a supported web browser.
- Version 6 and earlier of the HMC uses a window-based user interface. You can configure the HMC to
allow remote connections using the Web-based System Manager.

**Partition profile:**

A partition profile is a record on the Hardware Management Console (HMC) that specifies a possible
configuration for a logical partition. When you activate a logical partition using a partition profile, the
managed system attempts to start the logical partition using the configuration information in the partition
profile.

A partition profile specifies the desired system resources for the logical partition and the minimum and
maximum amounts of system resources that the logical partition can have. The system resources specified
within a partition profile includes processors, memory, and I/O resources. The partition profile can also
specify certain operating settings for the logical partition. For example, you can set a partition profile so
that, when the partition profile is activated, the logical partition is set to start automatically the next time
that you power on the managed system.

Each logical partition on a managed system that is managed by an HMC has at least one partition profile.
If desired, you can create additional partition profiles with different resource specifications for your
logical partition. If you create multiple partition profiles, you can designate any partition profile on the
logical partition to be the default partition profile. The HMC activates the default profile if you do not
select a specific partition profile to be activated. Only one partition profile can be active at one time. To
activate another partition profile for a logical partition, you must shut down the logical partition before
you activate the other partition profile.

A partition profile is identified by partition ID and profile name. Partition IDs are whole numbers used to
identify each logical partition that you create on a managed system, and profile names identify the
partition profiles that you create for each logical partition. Each partition profile on a logical partition
must have a unique profile name, but you can use a profile name for different logical partitions on a
single managed system. For example, logical partition 1 cannot have more than one partition profile with
a profile name of normal, but you can create a normal partition profile for each logical partition on the
managed system.

When you create a partition profile, the HMC shows you all of the resources available on your system.
The HMC does not verify if another partition profile is currently using a portion of these resources.
Therefore, it is possible for you to overcommit resources. When you activate a logical partition using a
partition profile, the system attempts to start the logical partition using the resources that are specified in
the partition profile. If the minimum resources specified in the partition profile are not available on the
managed system, the logical partition cannot be started using the partition profile.

For example, you have four processors on your managed system. Partition 1 profile A has three
processors, and partition 2 profile B has two processors. If you attempt to activate both of these partition
profiles at the same time, partition 2 profile B will fail to activate because you have overcommitted
processor resources.
When you shut down a logical partition and reactivate the logical partition using a partition profile, the partition profile overlays the resource specifications of the logical partition with the resource specifications in the partition profile. Any resource changes that you made to the logical partition using dynamic logical partitioning are lost when you reactivate the logical partition using a partition profile. This is desirable when you want to undo dynamic logical partitioning changes to the logical partition. However, this is not desirable if you want to reactivate the logical partition using the resource specifications that the logical partition had when you shut down the managed system. It is therefore best to keep your partition profiles up to date with the latest resource specifications. You can save the current configuration of the logical partition as a partition profile. This allows you to avoid having to change partition profiles manually. For more information about this procedure, see Saving the partition configuration to a partition profile.

If you shut down a logical partition whose partition profiles are not up to date, and the logical partition is set to start automatically when the managed system starts, you can preserve the resource specifications on that logical partition by restarting the entire managed system using the partition autostart power-on mode. When the logical partitions start automatically, the logical partitions have the resource specifications that the logical partitions had when you shut down the managed system.

Memory and processor resource assignment

When you create a partition profile for a logical partition, you set up the desired, minimum, and maximum amounts of memory and processor resources that you want for the logical partition. (Where applicable, this also applies to 5250 CPW.) The desired value is the resource amount that the logical partition gets if you do not overcommit the resource on the managed system. If the desired amount of resources is available when you activate the partition profile, then the logical partition starts with the desired amount of resources. However, if the desired amount of resources is not available when you activate the partition profile, then the resources on your managed system are overcommitted. In that case, if the amount of resources that are available on the managed system is equal to or greater than the minimum amount of resources in the partition profile, then the logical partition starts with the available amount of resources. If the minimum amount of resources is not met, then the logical partition does not start.

Virtual processor assignment

If you create a partition profile that is set to use shared processors, the HMC calculates a minimum, maximum, and desired number of virtual processors for the partition profile. The calculation is based upon the minimum, maximum, and desired number of processing units that you specify for the partition profile. By default, the virtual processor settings are calculated as follows:

- The default minimum number of virtual processors is the minimum number of processing units (rounded up to the next whole number). For example, if the minimum number of processing units is 0.8, the default minimum number of virtual processors is 1.
- The default desired number of virtual processors is the desired number of processing units (rounded up to the next whole number). For example, if the desired number of processing units is 2.8, the default desired number of virtual processors is 3.
- The default maximum number of virtual processors is the maximum number of processing units rounded up to the next whole number and multiplied by two. For example, if the maximum number of processing units is 3.2, the default maximum number of virtual processors is 8 (4 times 2).

When you activate the logical partition using the partition profile on the HMC, the logical partition is assigned the desired number of virtual processors. You can then use dynamic logical partitioning to change the number of virtual processors to any number between the minimum and maximum values, so long as the number of virtual processors is greater than the number of processing units that are assigned to the logical partition. Before changing the default settings, performance modeling should be performed.

For example, you create a partition profile on the HMC with the following processor unit settings.
Minimum processing units 1.25
Desired processing units 3.80
Maximum processing units 5.00

The default virtual processor settings for this partition profile on the HMC are as follows.
Minimum virtual processors 2
Desired virtual processors 4
Maximum virtual processors 10

When you activate the logical partition using this partition profile on the HMC, the operating system sees four processors, because the logical partition is activated with the desired value of four virtual processors. Each of these virtual processors has 0.95 processing units supporting the work assigned to the processor. After the logical partition is activated, you can use dynamic logical partitioning to change the number of virtual processors on the logical partition to any number between 2 and 10, so long as the number of virtual processors is greater than the number of processing units that are assigned to the logical partition. If you increase the number of virtual processors, bear in mind that you will have less processing power supporting the work assigned to each processor.

I/O device assignment

I/O devices are assigned to partition profiles on a slot-by-slot basis. Most I/O devices can be assigned to a partition profile on the HMC as required or as desired.

- If an I/O device is assigned to a partition profile as required, then the partition profile cannot be successfully activated if the I/O device is unavailable or is in use by another logical partition. Also, after the logical partition starts, you cannot use dynamic logical partitioning to remove the required I/O device from the running logical partition or move the required I/O device to another logical partition. This setting is suitable for devices that are required for the continuous operation of the logical partition (such as disk drives).

- If an I/O device is assigned to a partition profile as desired, then the partition profile can be successfully activated if the I/O device is unavailable or is in use by another logical partition. The desired I/O device can also be deconfigured in the operating system or system software and removed from the running logical partition or moved to another logical partition using dynamic logical partitioning. This setting is suitable for devices that you want to share among multiple logical partitions (such as optical drives or tape drives).

The exception to this rule is host channel adapters (HCAs), which are added to partition profiles on the HMC as required. Each physical HCA contains a set of 64 globally unique IDs (GUIDs) that can be assigned to partition profiles. You can assign multiple GUIDs to each partition profile, but you can assign only one GUID from each physical HCA to each partition profile. Also, each GUID can be used by only one logical partition at a time. You can create multiple partition profiles with the same GUID, but only one of those partition profiles can be activated at a time.

You can change the required or desired setting within any partition profile for any I/O device at any time. Changes to the required or desired setting for an I/O device take effect immediately, even if the logical partition is running. For example, you want to move a tape device from one running logical partition to another, and the I/O device is required in the active partition profile for the source logical partition. You can access the active partition profile for the source logical partition, set the tape device to be desired, and then deconfigure and move the tape device to the other logical partition without having to restart either logical partition.

If you create an i5/OS logical partition using the HMC, you must tag I/O devices to perform certain functions for that i5/OS logical partition. For more information on these types of devices, see Tagged resources for i5/OS logical partitions.
Related concepts

“i5/OS logical partition functional differences between IBM Systems and eServer hardware and previous hardware models” on page 12

i5/OS logical partition functions have new and changed technical enhancements for IBM Systems and eServer hardware.

Partition profiles that use all of the system resources:

You can create partition profiles on your Hardware Management Console (HMC) that specify all of the resources on the managed system. If you activate a logical partition using such a partition profile, then the managed system assigns all of its resources to the logical partition.

If you add additional resources to the managed system, the managed system automatically assigns the added resources to the logical partition when the profile is activated. The profile must be activated while the server is in ‘partition standby’ state, because automatic restart of the partition will not assign newly added processor and memory resources. You do not need to change the partition profile for the managed system to assign the additional resources to the logical partition.

You cannot activate a logical partition using a partition profile that specifies all of the system resources if any other logical partition is running. However, after the logical partition is activated with all of the system resources, you can remove most processor and memory resources and all I/O resources from the logical partition using dynamic logical partitioning. This allows you to start other logical partitions using the resources that you remove from the logical partition. There is an implicit minimum amount of processor and memory resources that is reserved for the logical partition that uses all of the system resources, so you cannot remove all processor and memory resources from such a logical partition.

System profile:

A system profile is an ordered list of partition profiles that is used by the Hardware Management Console (HMC) to start the logical partitions on a managed system in a specific configuration.

When you activate the system profile, the managed system attempts to activate each partition profile in the system profile in the order specified. A system profile helps you activate or change the managed system from one complete set of logical partition configurations to another.

It is possible for you to create a system profile whose partition profiles specify more resources than are available on the managed system. You can use the HMC to validate the system profile against the currently available system resources and against the total system resources. Validating your system profile ensures that your I/O devices and processing resources are not overcommitted, and it increases the likelihood that the system profile can be activated. The validation process estimates the amount of memory needed to activate all of the partition profiles in the system profile. It is possible that a system profile can pass validation and yet not have enough memory to be activated.

Related concepts

“i5/OS logical partition functional differences between IBM Systems and eServer hardware and previous hardware models” on page 12

i5/OS logical partition functions have new and changed technical enhancements for IBM Systems and eServer hardware.

Virtual Partition Manager

The Virtual Partition Manager is a feature of i5/OS that allows you to create and manage one i5/OS logical partition and up to four Linux logical partitions on a single IBM System i5 or eServer i5 server. You can use the Virtual Partition Manager to partition any IBM System i5 or eServer i5 model that does not require a Hardware Management Console (HMC), such as a model 595.
To use the Virtual Partition Manager, you must first install i5/OS on a nonpartitioned server. After you install i5/OS, you can initiate a console session on i5/OS and use System Service Tools (SST) to create and configure Linux logical partitions. i5/OS controls the resource allocations of the logical partitions on the server.

This figure illustrates the i5/OS logical partition and the Linux logical partitions that are managed by the i5/OS logical partition. The user creates and configures the Linux logical partitions on the server by accessing SST over the twinaxial console.

When you use the Virtual Partition Manager to partition an IBM System i5 or eServer i5 server, SST is the only tool that you can use to create and manage the logical partitions. You cannot use iSeries Navigator to create or manage logical partitions on an IBM System i5 or eServer i5 server. However, the console session that you use to access SST can be initiated using either iSeries Operations Console (LAN or direct attach) or a twinaxial console.

**i5/OS logical partition functional differences between IBM Systems and eServer hardware and previous hardware models**

i5/OS logical partition functions have new and changed technical enhancements for IBM Systems and eServer hardware.

To identify i5/OS V5R3 and V5R4 logical partition technical enhancements running on IBM Systems and eServer hardware compared to previous hardware models, see the following table:

<table>
<thead>
<tr>
<th>Logical partition (LPAR) function</th>
<th>OS/400® V5R2 on iSeries 8xx and previous models</th>
<th>i5/OS V5R3 and V5R4 on IBM Systems and eServer hardware models using a Hardware Management Console (HMC)</th>
<th>i5/OS V5R3 and V5R4 on IBM Systems and eServer hardware models using the Virtual Partition Manager</th>
</tr>
</thead>
<tbody>
<tr>
<td>LPAR documentation</td>
<td>IBM iSeries Information Center</td>
<td>IBM Systems Hardware Information Center</td>
<td>Virtual Partition Manager: A Guide to Planning and Implementation</td>
</tr>
</tbody>
</table>

12 System i and System p: Partitioning for i5/OS with an HMC
<table>
<thead>
<tr>
<th>Logical partition (LPAR) function</th>
<th>OS/400® V5R2 on iSeries 8xx and previous models</th>
<th>i5/OS V5R3 and V5R4 on IBM Systems and eServer hardware models using a Hardware Management Console (HMC)</th>
<th>i5/OS V5R3 and V5R4 on IBM Systems and eServer hardware models using the Virtual Partition Manager</th>
</tr>
</thead>
<tbody>
<tr>
<td>LPAR user interface</td>
<td>• iSeries Navigator</td>
<td>• Hardware Management Console (HMC)</td>
<td>The Virtual Partition Manager (in SST)</td>
</tr>
<tr>
<td></td>
<td>• Dedicated service tools (DST) or system service tools (SST)</td>
<td>• LPAR DST/SST function not available.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• LPAR API</td>
<td>• HMC remote command line</td>
<td></td>
</tr>
<tr>
<td>Supported models</td>
<td>All iSeries 8xx and 270 models</td>
<td>All IBM System i5 and eServer i5 server models, and the following IBM System p5 and eServer p5 server models: model 9117-570 with 1.65 GHz and 2.2 GHz processors, and models 9119-590 and 9119-595 with 1.65 GHz processors.</td>
<td>All IBM System i5 and eServer i5 server models except for models that require an HMC.</td>
</tr>
<tr>
<td>LPAR authority</td>
<td>Service Tools User IDs created using DST or SST:</td>
<td>HMC user IDs created with the following standard user roles:</td>
<td>Service Tools User IDs created using DST or SST:</td>
</tr>
<tr>
<td></td>
<td>• System partitions administration authority</td>
<td>• Super administrator</td>
<td>• System partitions administration authority</td>
</tr>
<tr>
<td></td>
<td>• System partitions operations authority</td>
<td>• Operator</td>
<td>• System partitions operations authority</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Viewer</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Product engineer</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Service representative</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can also create custom user roles based upon the standard user roles.</td>
<td></td>
</tr>
<tr>
<td>Maximum number of logical partitions</td>
<td>The maximum number of logical partitions supported depends on the number of processors in the server model. IBM System 270, 8xx, and 890 models: Up to 10 times the number of processors in the server, with a maximum of 32 logical partitions.</td>
<td>Up to 10 times the number of processors in the server, with a maximum of 254 total logical partitions. The maximum number of i5/OS logical partitions supported depends on the server model. IBM System i5 and eServer i5: Up to 64 i5/OS logical partitions per server. IBM System p5 and eServer p5 models that support i5/OS: Up to 10 i5/OS logical partitions on 9117-570 servers and up to 20 i5/OS logical partitions on 9119-590, and 9119-595 servers.</td>
<td>One i5/OS logical partition and up to four Linux logical partitions.</td>
</tr>
<tr>
<td>Types of logical partition configurations</td>
<td>• Primary partition</td>
<td>• No primary partition</td>
<td>One i5/OS logical partition and up to four Linux logical partitions</td>
</tr>
<tr>
<td></td>
<td>• Secondary partitions</td>
<td>• Partition profiles</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Shell partition</td>
<td>• System profiles</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Service partition</td>
<td></td>
</tr>
<tr>
<td>Creating logical partitions</td>
<td>New logical partition available after an IPL of the entire system.</td>
<td>New logical partition and partition profile immediately available.</td>
<td>Initial logical partition setup requires a server IPL. The creation of additional logical partitions might also require a server IPL.</td>
</tr>
<tr>
<td>Logical partition (LPAR) function</td>
<td>OS/400® V5R2 on iSeries 8xx and previous models</td>
<td>i5/OS V5R3 and V5R4 on IBM Systems and eServer hardware models using a Hardware Management Console (HMC)</td>
<td>i5/OS V5R3 and V5R4 on IBM Systems and eServer hardware models using the Virtual Partition Manager</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Additional operating system support | Linux | • AIX  
    • Linux  
      – SUSE Linux Enterprise Server 9  
      – Red Hat Enterprise Linux version 4 | Linux  
    • SUSE Linux Enterprise Server 9  
    • Red Hat Enterprise Linux version 4 |
| Sharing I/O resources with other operating system (formerly known as hosting) | Linux | • AIX  
    • Linux | Linux |
| Minimum and maximum values | Can be changed after an IPL of the system. | Can be changed after a shutdown and reactivation of the logical partition using a changed partition profile.  
    Note: If there is not a sufficient amount of contiguous memory available, a server IPL might be required to reorganize memory and make a sufficiently large amount of contiguous memory available. | Can be changed after a shutdown and reactivation of the logical partition.  
    Minimum and maximum values are used only for workload management applications and for managed system restart after a processor or memory failure. |
| Processors | • Dynamic: can be changed without restarting the logical partition.  
    • Can be shared among multiple logical partitions. | • Dynamic: can be changed without restarting the logical partition.  
    • Can be shared among multiple logical partitions.  
    • Shared mode of capped and uncapped.  
    • Powered-off logical partitions using dedicated processors will have their processors available to shared processor pool.  
    • Limited number of processors or processing units available for i5/OS logical partitions on IBM System p5 and eServer p5 servers. | • Static: must restart the logical partition before changes are applied.  
    • Can be shared among multiple logical partitions.  
    • Shared mode of capped and uncapped.  
    • Powered-off logical partitions using dedicated processors will have their processors available to shared processor pool. |
| Memory | • Dynamic: can be changed without restarting the logical partition.  
    • Memory assigned in increments of 1 MB. | • Dynamic: can be changed without restarting the logical partition.  
    • Memory can be assigned in increments of 16 MB, 32 MB, 64 MB, 128 MB, and 256 MB. | • Static: must restart the logical partition before changes are applied.  
    • Memory can be assigned in increments of 16 MB, 32 MB, 64 MB, 128 MB, and 256 MB. |
<p>| 5250 commercial processing workload (CPW) | Dynamic: can be changed without restarting the logical partition. | Dynamic: can be changed without restarting the logical partition. | All configurable 5250 CPW is assigned automatically to the i5/OS logical partition. |</p>
<table>
<thead>
<tr>
<th>Logical partition (LPAR) function</th>
<th>OS/400® V5R2 on iSeries 8xx and previous models</th>
<th>i5/OS V5R3 and V5R4 on IBM Systems and eServer hardware models using a Hardware Management Console (HMC)</th>
<th>i5/OS V5R3 and V5R4 on IBM Systems and eServer hardware models using the Virtual Partition Manager</th>
</tr>
</thead>
</table>
| I/O                              | • I/O resources allocated at bus-level or IOP-level.  
  • IOPs can be switched among logical partitions dynamically.  
  • Bus ownership or bus usage (shared or dedicated) changes occur dynamically. | • I/O resources allocated at slot level.  
  • IOPs, IOAs, and empty slots can be switched among logical partitions dynamically.  
  • Bus ownership cannot be configured. | All I/O is assigned automatically to the i5/OS logical partition. |
| Virtual I/O                      | Virtual I/O resources are devices owned by the hosting partition that provides I/O function to the guest partition.  
  Virtual console, virtual disk unit, virtual CD, virtual tape, and virtual Ethernet are supported virtual I/O resources.  
  A hosting partition (OS/400 partition) shares resources with a guest partition.  
  A hosted partition (guest partition) receives resources from OS/400. | Virtual I/O adapters can be defined in a partition profile so that they are added to the logical partition when you activate the logical partition using the partition profile.  
  Virtual I/O adapters can also be added and removed dynamically. (However, virtual I/O adapters cannot be moved dynamically between logical partitions.)  
  You can change the properties of a virtual I/O adapter without requiring a restart of the logical partition.  
  i5/OS logical partitions support up to 32 767 virtual I/O adapters.  
  IBM System i5 and eServer i5 models:  
  • Virtual SCSI adapters, virtual serial adapters, and virtual Ethernet adapters are supported for i5/OS logical partitions.  
  • An i5/OS logical partition can be a virtual server partition. (A virtual server partition is a logical partition that provides a virtual resource to other logical partitions on the system. The logical partitions that use these virtual resources are known as virtual client partitions.)  
  IBM System p5 and eServer p5 models:  
  • Virtual Ethernet adapters are supported for i5/OS logical partitions.  
  • Virtual SCSI adapters and virtual serial adapters are not supported for i5/OS logical partitions.  
  • An i5/OS logical partition cannot be a virtual server partition or a virtual client partition. | Eight virtual I/O slots exist initially, and five of these slots are free. If you create more than five virtual I/O devices on the managed system, you must IPL the managed system to enable all available virtual I/O slots. Otherwise, virtual adapters are created dynamically (without requiring an IPL).  
  Virtual SCSI adapters, virtual serial adapters, and virtual Ethernet adapters are supported for i5/OS logical partitions.  
  An i5/OS logical partition can be a virtual server partition. (A virtual server partition is a logical partition that provides a virtual resource to other logical partitions on the system. The logical partitions that use these virtual resources are known as virtual client partitions.) |
<table>
<thead>
<tr>
<th>Logical partition (LPAR) function</th>
<th>OS/400® V5R2 on iSeries 8xx and previous models</th>
<th>i5/OS V5R3 and V5R4 on IBM Systems and eServer hardware models using a Hardware Management Console (HMC)</th>
<th>i5/OS V5R3 and V5R4 on IBM Systems and eServer hardware models using the Virtual Partition Manager</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Configuration data</strong></td>
<td>Load source contains LPAR configuration data.</td>
<td>Service processor and HMC contain LPAR configuration data.</td>
<td>Service processor contains LPAR configuration data.</td>
</tr>
</tbody>
</table>
| **Console support**              | • iSeries Operations Console (LAN and Directly attached)  
  • Twinaxial console | • HMC 5250  
  • iSeries Operations Console (LAN and Directly attached)  
  • Twinaxial console | • iSeries Operations Console (LAN and Directly attached)  
  • Twinaxial console |
| **Virtual Ethernet**             | • Dynamic: can be changed without restarting the logical partition.  
  • Up to 16 networks | • Dynamic: can be changed without restarting the logical partition.  
  • Up to 4094 networks | • Dynamic: can be changed without restarting the logical partition.  
  • Up to four networks |
| **Virtual OptiConnect**          | • Dynamic: can be changed without restarting the logical partition.  
  • Single network. | • Dynamic: can be changed without restarting the logical partition.  
  • Single network. | Not available. |
| **HSL OptiConnect**              | • Dynamic: can be changed without restarting the logical partition.  
  • Can be shared among multiple logical partitions.  
  • Single network. | • Dynamic: can be changed without restarting the logical partition.  
  • Can be shared among multiple logical partitions.  
  • Single network. | • Dynamic: can be changed without restarting the logical partition.  
  • Can be shared among multiple logical partitions.  
  • Single network. |
| **Main storage dumps**           | • System level dump  
  • Partition dumps | • Service processor dumps  
  • Platform system dumps  
  • Partition dumps | • Service processor dumps  
  • Platform system dumps  
  • Partition dumps |
| **Hypervisor fixes**             | Primary partition | • HMC  
  • Service partition | The i5/OS logical partition automatically has service authority. |
| **Logical partition configuration backup** | Each secondary partition load source | HMC | No configuration backup available. |
Types of logical partition configurations

There are many different types of logical partition configurations on IBM Systems and eServer hardware.

Manufacturing default configuration

The manufacturing default configuration is the initial partition setup of the managed system as received from your service provider.

When your system is in the manufacturing default configuration, you can install an operating system on the managed system and use the managed system as a nonpartitioned server. In this state, you do not need to manage the system using a Hardware Management Console (HMC).

If you choose to attach an HMC to the managed system for reasons other than partitioning (such as to activate Capacity on Demand), then the HMC displays the managed system as having one logical partition with one partition profile. All of the physical hardware resources on the system are automatically assigned to this logical partition, and any new physical hardware resources that are added to the managed system are added automatically to this logical partition. The name of the logical partition is the serial number of the managed system, and the name of the partition profile is default. If the server is an IBM System i5 and eServer i5 server, then the i5/OS logical partition automatically has service authority. You do not need to make any partitioning changes on the server if you do not want to do so.

However, if you use the HMC to create, delete, change, copy, or activate any logical partitions or partition profiles on the managed system, the system will then be in partition mode. You must then use the HMC to manage the managed system. If the server is an IBM System i5 and eServer i5 server, then you must also change the managed system properties on the HMC so that one of the i5/OS logical partitions on the managed system is the service partition for the managed system. If a managed system is managed using an HMC, and you want to return the managed system to a nonpartitioned state or if you want to
partition the managed system with the Integrated Virtualization Manager or the Virtual Partition Manager, then you must follow a special procedure to reset the server.

Managed systems that are partitioned using the Integrated Virtualization Manager are not managed with an HMC. If a managed system is managed using the Integrated Virtualization Manager, then you do not need to reset the server to return the managed system to a nonpartitioned state. Also, you do not need to reset the server if you want to switch from using the Integrated Virtualization Manager to using an HMC. To switch to using an HMC, back up the data on each logical partition, attach the HMC to the server, create the logical partitions, and restore the data to the storage assigned to each logical partition.

Managed systems that are partitioned using the Virtual Partition Manager are not managed with an HMC. If a managed system is managed using the Virtual Partition Manager, then you do not need to reset the server to return the managed system to a nonpartitioned state. Also, you do not need to reset the server if you want to switch from using the Virtual Partition Manager to using an HMC. To switch to using an HMC, back up the data on each logical partition, attach the HMC to the server, create the logical partitions, and restore the data to the storage assigned to each logical partition.

Related tasks

“Resetting the managed system to a nonpartitioned configuration using version 6 or earlier of the HMC” on page 238

You can erase all of your logical partitions and reset the managed system to a nonpartitioned configuration. When you reset the managed system, all of the physical hardware resources are assigned to a single logical partition. This allows you to use the managed system as if it were a single, nonpartitioned server.

Service partition

If you are using the Hardware Management Console (HMC) to manage systems and the HMC becomes unavailable, then you can use the service partition to perform service-related tasks on systems.

The service partition is the i5/OS logical partition on an IBM eServer i5 server that you can configure to apply server firmware updates to the service processor or to the POWER Hypervisor™ and to communicate server common hardware errors to IBM. These abilities are useful if the HMC is undergoing maintenance or is otherwise unable to perform these functions. The preferred method for applying server firmware updates and communicating server common hardware errors to IBM is by using the HMC.

Server common hardware errors include errors in processors, memory, power subsystems, the service processor, the system unit vital product data (VPD), non-volatile random access memory (NVRAM), I/O unit bus transport (RIO and PCI), clustering hardware, and switch hardware. Server common hardware errors do not include errors in I/O processors (IOPs), I/O adapters (IOAs), or I/O device hardware. These I/O hardware errors are handled by i5/OS on the logical partition to which the I/O hardware belongs.

IBM System p5, eServer p5, and IBM eServer OpenPower servers do not have a service partition. If an IBM System p5, eServer p5, and IBM eServer OpenPower server is managed by an HMC, then you must use the HMC to update the server firmware, and the server can contact service and support only through the HMC. If you use an HMC to manage IBM System p5, eServer p5, and IBM eServer OpenPower servers, then use a backup HMC to ensure that the servers have redundant methods for contacting service and support and for applying fixes.

Servers that are managed using the Integrated Virtualization Manager do not have a service partition designation. The Virtual I/O Server logical partition automatically has service authority on servers that are managed using the Integrated Virtualization Manager.

Servers that are managed using the Virtual Partition Manager do not have a service partition designation. The i5/OS logical partition automatically has service authority on servers that are managed using the Virtual Partition Manager.
You can designate only one logical partition at a time as the service partition for your managed system. The service partition for your IBM eServer i5 server must be an i5/OS logical partition.

You must designate a service partition on a server only after you use the HMC to create, change, delete, copy, or activate any logical partitions on the managed system. You can set up the operating system on an unpartitioned server to contact service and support, and you can use the operating system on an unpartitioned server to apply server firmware updates.

If you want to configure your service partition to communicate errors to IBM, then the service partition should have a physical network connection that can reach IBM if the HMC is unavailable. Otherwise, there are no special hardware requirements for your service partition (apart from the hardware requirements for the operating system and for the normal workload of the service partition). The performance of the service partition is not affected when the service partition reports errors or performs service-related functions on the managed system.

The best candidate for a service partition is a logical partition that is running a set of applications that are not likely to cause the logical partition to fail. This increases the chances that the service partition will be available if there is a problem.

For more information about how to designate a logical partition as the service partition, see Designating the service partition for your managed system.

For more information about how your server helps you and service and support to quickly and accurately manage problems, see Overview of service and support.

Related concepts

“i5/OS logical partition functional differences between IBM Systems and eServer hardware and previous hardware models” on page 12

i5/OS logical partition functions have new and changed technical enhancements for IBM Systems and eServer hardware.

Related tasks

“Designating the service partition for your managed system using version 6 or earlier of the HMC” on page 225

The service partition is the i5/OS logical partition on an IBM System i5 or eServer i5 server that you can configure to apply server firmware updates to the service processor or to the hypervisor and to communicate server common hardware errors to IBM. These abilities are useful if the Hardware Management Console (HMC) is undergoing maintenance or is otherwise unable to perform these functions.

Related information

Overview of service and support

Virtual I/O Server partition

The Virtual I/O Server provides virtual SCSI and shared Ethernet capability to client logical partitions on IBM eServer p5, IBM System p5, and IBM eServer OpenPower systems.

The Virtual I/O Server is installed in its own partition. It allows a physical adapter with attached disks on the Virtual I/O Server partition to be shared by one or more partitions, enabling client logical partitions to consolidate, and potentially minimize, the number of physical adapters required. It also facilitates the sharing of physical Ethernet adapters, allowing multiple client logical partitions to share a single Ethernet adapter.

For more information about the Virtual I/O Server, see Using the Virtual I/O Server.
Partition workload groups
Partition workload groups identify sets of logical partitions that workload management tools can manage. For example, Enterprise Workload Manager (EWLM) can automatically distribute processing capacity within a partition workload group in response to workload performance goals.

A partition workload group identifies a set of logical partitions that reside on the same physical system. Workload management tools use partition workload groups to identify which logical partitions they can manage. For example, Enterprise Workload Manager (EWLM) can dynamically and automatically distribute processing capacity within a partition workload group to satisfy workload performance goals. EWLM adjusts processing capacity based on calculations that compare the actual performance of work processed by the partition workload group to the business goals that are defined for the work.

Systems managed by the Hardware Management Console (HMC) or the Integrated Virtualization Manager can assign logical partitions to partition workload groups. For HMC-managed systems, the maximum number of partition workload groups allowed per physical server is equal to the maximum number of logical partitions allowed on the physical server. You cannot assign a logical partition to more than one partition workload group at a time. Systems managed by the Integrated Virtualization Manager can have only one partition workload group per physical server.

It is not required that all logical partitions on a system participate in a partition workload group. Workload management tools manage the resources of only those logical partitions assigned to a partition workload group. Workload management tools can monitor the work of a logical partition that is not assigned to a partition workload group, but they cannot manage the logical partition’s resources.

Some workload management tools require that additional software be installed on the logical partitions to monitor its workload, manage its resources, or both. For example, EWLM requires that an EWLM managed server be installed on each logical partition that EWLM is to monitor and manage, and that partition management be enabled within EWLM.

i5/OS on IBM System p5 and eServer p5 servers
You can install and run i5/OS logical partitions on an IBM System p5 and eServer p5 server.

The ability to create i5/OS on an IBM System p5 and eServer p5 server is useful if all of the following conditions apply:

- You have a limited amount of i5/OS workload.
- You anticipate limited growth for your i5/OS workload.
- You want to consolidate your i5/OS workload onto a single server where the processing capability on the server will be almost entirely used by either AIX or Linux logical partitions.

There are limitations to how you can configure your i5/OS logical partitions on an IBM System p5 and eServer p5 server, and you cannot upgrade the IBM System p5 and eServer p5 server to overcome these limitations. IBM System i5 and eServer i5 servers are more suitable for users who want to upgrade their current System i® servers and who anticipate continued i5/OS application workload growth. You might also consider IBM System i5 and eServer i5 servers if you want to use your System i skills to manage the consolidated environment.

Requirements for i5/OS on IBM System p5 and eServer p5 servers:

All of the hardware requirements for running i5/OS on IBM System i5 and eServer i5 servers also apply to running i5/OS on IBM System p5 and eServer p5 servers. In addition, you must also adhere to the hardware requirements specific to running i5/OS on an IBM System p5 and eServer p5 server.

For more information about the general hardware requirements for running i5/OS on IBM System i5 and eServer i5 servers, see Minimum hardware configuration requirements for an i5/OS logical partition.
The following requirements must be met to run i5/OS on an IBM System p5 and eServer p5 server:

**Operating system version**
Only V5R3 and later releases of i5/OS can be installed on IBM System p5 and eServer p5 servers.

**Hardware Management Console (HMC)**
You must use a Hardware Management Console (HMC) to create i5/OS partitions on the IBM System p5 and eServer p5 server. The HMC must have machine code V4R3.1 or later installed.

**I/O**
All of your i5/OS logical partitions must use I/O hardware with System i feature codes. Install the System i hardware in System i expansion units, and then attach the System i expansion units to your IBM System p5 and eServer p5 server. The System i expansion units are seen by the IBM System p5 and eServer p5 server as an I/O subsystem with the feature code 9411-100. You can then create i5/OS logical partitions that use the I/O hardware in those System i expansion units. The i5/OS logical partitions cannot use I/O hardware outside of this I/O subsystem, and AIX and Linux logical partitions cannot use the I/O hardware in this I/O subsystem. You cannot have more than six iSeries units within the I/O subsystem, and this limit can be lower with some unit models.

**Licenses**
The i5/OS operating system is ordered with the IBM eServer p5 9117-570, 9119-590, and 9119-595 servers as product number 5722-SS1 with one of the following feature codes:
- 1527 - i5/OS 570 per Processor License
- 1528 - i5/OS 590 and 595 per Processor License

You cannot transfer i5/OS licenses from existing System i hardware. The i5/OS licenses apply to the IBM System p5 and eServer p5 server itself and not to the underlying I/O subsystem. Moving the subsystem to a new server at a later time will require that you obtain another license.

**Feature codes**
To install i5/OS on the IBM System p5 and eServer p5 server, you must order the following feature codes:
- 0530 - i5/OS Version V5R3 Specify. This feature code indicates that i5/OS Version V5R3 will be ordered for use in a logical partition on the server.
- 0267 - i5/OS Partition Specify. This feature number indicates the number of logical partitions that are to run i5/OS on the managed system.

The following feature codes provide enhanced commercial processing workload (CPW) availability when running i5/OS on an IBM System p5 and eServer p5 server:
- 7965 - Enterprise Enablement on 570. This feature code provides unlimited CPW on the available processor (up to approximately 3000 CPW).
- 7978 - 59x Enterprise Enablement on 590 and 595. This feature code provides unlimited CPW on one processor (up to approximately 3000 CPW) and can be used twice (for up to approximately 6000 CPW total).

Use the System Planning Tool (SPT) to validate the logical partition configuration on your IBM System p5 and eServer p5 server. For more information on the SPT, see System Planning Tool.
Related concepts

“System Planning Tool” on page 62

The System Planning Tool (SPT) helps you design a managed system that can support a specified set of workloads. You can design a managed system based upon workload data from your current systems, based upon new workloads that you want the managed system to support, based upon sample systems that are provided with the utility, or based upon your own custom specifications.

“Minimum hardware configuration requirements for an i5/OS logical partition” on page 24

Ensure that your hardware meets the minimum processor, memory, and I/O requirements for an i5/OS logical partition.

Limitations for running i5/OS on IBM System p5 and eServer p5 servers:

There are several limitations for running i5/OS on IBM System p5 and eServer p5 servers. They include limitations to server models, processors, and using resources of other logical partitions.

The following limitations apply to running i5/OS on IBM System p5 and eServer p5 servers:

Server models

The only IBM System p5 and eServer p5 server models that support i5/OS are the p5 570, p5 590, and p5 595 servers with 1.65 GHz processors and the p5 570 with 2.2 GHz processors.

Processors

You can run i5/OS on only one processor on a p5 570 server, and on only two processors on a p5 590 server or a p5 595 server. This limits the number of i5/OS logical partitions that you can create on these IBM System p5 and eServer p5 servers and the possible configurations of those i5/OS logical partitions. The following table lists the possible configurations of i5/OS on IBM System p5 and eServer p5 servers.

<table>
<thead>
<tr>
<th>Server model</th>
<th>Possible i5/OS logical partition configurations</th>
</tr>
</thead>
</table>
| p5 570 servers | • One logical partition that uses one dedicated processor.  
|               | • One logical partition that uses uncapped shared processing units, with a maximum of one virtual processor for the logical partition.  
|               | • Up to ten logical partitions that use capped shared processing units, with a minimum of 0.10 shared processing units for each logical partition, and the total number of shared processing units not to exceed 1.00 shared processing units. |
Server model | Possible i5/OS logical partition configurations
--- | ---
p5 590 servers or p5 595 servers | • One logical partition that uses one or two dedicated processors.
• Two logical partitions that use one dedicated processor each.
• One logical partition that uses uncapped shared processing units, with a maximum of two virtual processors for the logical partition.
• Two logical partitions that use uncapped shared processing units, with a maximum of one virtual processor for each logical partition.
• One logical partition that uses one dedicated processor and one logical partition that uses uncapped shared processing units, with a maximum of one virtual processor for the logical partition that uses uncapped shared processing units.
• One logical partition that uses one dedicated processor and from one to ten logical partitions that use capped shared processing units, with a minimum of 0.10 processing units for each logical partition that uses capped shared processing units, and the total number of capped shared processing units not to exceed 1.00 shared processing units.
• One logical partition that uses uncapped shared processors, with a maximum of one virtual processor for the logical partition that uses uncapped shared processing units, and from one to ten logical partitions that use capped shared processing units, with a minimum of 0.10 processing units for each logical partition that uses capped shared processing units, and the total number of capped shared processing units not to exceed 1.00 shared processing units.
• From one to twenty logical partitions that use capped shared processors, with a minimum of 0.10 shared processing units for each logical partition, and the total number of shared processing units not to exceed 2.00 shared processing units.

Using resources of other logical partitions

i5/OS logical partitions on an IBM System p5 and eServer p5 server cannot use the I/O resources of a virtual I/O server logical partition, and other logical partitions cannot use the I/O resources of an i5/OS logical partition on an IBM System p5 and eServer p5 server.

Supported functions:

Although there are limitations to how you can implement i5/OS on IBM System p5 and eServer p5 servers, many functions are still available.

Supported functions when running i5/OS on IBM System p5 and eServer p5 servers including the following:
• Micro-Partitioning (only after you enter the Advanced POWER Virtualization activation code for the IBM System p5 and eServer p5 server)
• Dynamic logical partitioning
• Virtual Ethernet
• Integrated xSeries® adapters (when they are installed within the 9411-100 I/O subsystem)

Migration process:

Before you migrate i5/OS to IBM System p5 and eServer p5 servers, ensure that you have met all the requirements required to run i5/OS on IBM System p5 and eServer p5 servers. Otherwise, the hardware and software installation processes are identical to those used to install i5/OS on IBM System i5 and eServer i5 servers.
Minimum hardware configuration requirements for an i5/OS logical partition

Ensure that your hardware meets the minimum processor, memory, and I/O requirements for an i5/OS logical partition.

Every i5/OS logical partition requires the following hardware resources. Furthermore, if you plan to run i5/OS on an IBM System p5 or eServer p5 model, you must adhere to additional configuration requirements. For more information on requirements for i5/OS logical partitions on an IBM System p5 or eServer p5 model, see Requirements for i5/OS on IBM System p5 and eServer p5 servers.

Minimum processor requirements

1 dedicated processor or 0.1 shared processing unit

Minimum memory requirements

128 MB

I/O requirements

- Load source
  - Disk I/O processor (IOP) and I/O adapter (IOA) or disk IOA that does not require an IOP
  - Disk unit that is at least 8 GB in size if you install i5/OS V5R3M0, or 17 GB in size if you install i5/OS V5R3M5 or later
- Console: your choice of one of the following console types:
  - Hardware Management Console (HMC) 5250 emulation
    HMC 5250 emulation requires an HMC.
  - Operations Console
    Operations Console requires either a LAN connection or an asynchronous IOA that supports Operations Console connections. The Operations Console LAN connection can be either an embedded port, a LAN IOA with an associated IOP, or, if you install i5/OS V5R3M5 or later, a LAN IOA that does not require an IOP.
  - Twinaxial console
    Twinaxial console requires a twinaxial workstation IOA with an associated IOP.
- Alternate restart device: your choice of tape, CD, or DVD. These devices connect either to an embedded SCSI or IDE controller, a SCSI or IDE controller with an associated IOP, or, if you install i5/OS V5R3M5 or later, a SCSI or IDE controller that does not require an IOP.
- Physical or virtual LAN adapter that can be used for serviceable event reporting and connection monitoring
  On IBM System i5 and eServer i5 models, at least one i5/OS logical partition in the managed system must have a physical LAN adapter that the i5/OS logical partition can use for serviceable event reporting and connection monitoring. You can then create a virtual LAN that connects the i5/OS logical partition with the physical LAN adapter with the other logical partitions on the managed system and bridge the physical LAN adapter to the virtual LAN. If the system is managed using an HMC, the physical LAN adapter must be able to communicate with the HMC so that serviceable event reporting can be routed through the HMC.
  On IBM System p5 and eServer p5 models, the i5/OS logical partitions can use either a physical LAN adapter or a virtual LAN adapter whose virtual LAN is bridged to a physical LAN adapter. In either case, the physical LAN must be able to communicate with the HMC so that serviceable event reporting can be routed through the HMC.
Related concepts

“Requirements for i5/OS on IBM System p5 and eServer p5 servers” on page 20

All of the hardware requirements for running i5/OS on IBM System i5 and eServer i5 servers also apply to running i5/OS on IBM System p5 and eServer p5 servers. In addition, you must also adhere to the hardware requirements specific to running i5/OS on an IBM System p5 and eServer p5 server.

Physical and virtual hardware resources

When you partition a managed system, you can assign the physical resources on the managed system directly to logical partitions. You can also share hardware resources among logical partitions by virtualizing those hardware resources. The methods used to virtualize and share hardware resources depend on the type of resource that you are sharing.

Virtual adapters

Virtual adapters allow you to connect logical partitions with each other without using physical hardware. Operating systems can display, configure, and use virtual adapters just like they can display, configure, and use physical adapters. Depending on the operating environment used by the logical partition, you can create virtual Ethernet adapters, virtual Small Computer Serial Interface (SCSI) adapters, and virtual serial adapters for a logical partition.

The system administrator uses the following tools to create virtual adapters:

- Hardware Management Console (HMC)
- Integrated Virtualization Manager
- Virtual Partition Manager

Adapters can be added while the system is running using dynamic logical partitioning. The virtual adapters are recorded in system inventory and management utilities. Converged location codes can be used to correlate operating-system level or partition-level software entities to adapters, such as eth0, CMN21, and en0. Similarly, the Ethernet adapters are visible in the same way as physical Ethernet adapters.

By default, Virtual Ethernet Media Access Control (MAC) addresses are created from the locally administered range. Using the default MAC addresses, it is possible that different servers will have virtual Ethernet adapters with the same addresses. This situation can present a problem if multiple, virtual networks are bridged to the same physical network.

If a server partition providing I/O for a client partition fails, the client partition might continue to function, depending on the significance of the hardware it is using. For example, if one partition is providing the paging volume for another partition, a failure of the partition providing that particular resource will be significant to the other partition. However, if the shared resource is a tape drive, a failure of the server partition providing the resource will have only minimal effects on the client partition.

Virtual I/O client support

The following table summarizes operating system support for using virtual I/O devices.

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Virtual console</th>
<th>Virtual Ethernet</th>
<th>Virtual disk</th>
<th>Virtual CD</th>
<th>Virtual tape</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIX</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes when Integrated Virtualization Manager managed</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>No when HMC managed</td>
<td></td>
</tr>
</tbody>
</table>
Table 2. Virtual I/O client support by operating system (continued)

<table>
<thead>
<tr>
<th></th>
<th>Virtual console</th>
<th>Virtual Ethernet</th>
<th>Virtual disk</th>
<th>Virtual CD</th>
<th>Virtual tape</th>
</tr>
</thead>
<tbody>
<tr>
<td>i5/OS</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Linux</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

AIX partitions support booting from virtual devices, including disk boot from virtual disk or network boot from virtual Ethernet.

The firmware running in AIX and Linux logical partitions recognizes virtual I/O and can start the partition from virtual I/O. IPL can be either from the network over virtual Ethernet, or from a device such as virtual disk or virtual CD.

Virtual I/O server support

The following table summarizes operating system support for providing virtual I/O to partitions.

Table 3. Virtual I/O server support by operating system

<table>
<thead>
<tr>
<th></th>
<th>Virtual CD</th>
<th>Virtual console</th>
<th>Virtual disk</th>
<th>Virtual tape</th>
</tr>
</thead>
<tbody>
<tr>
<td>i5/OS</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Linux</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Virtual I/O Server</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

Version 1.1 of the Virtual I/O Server (08/2004) provides SCSI disk and shared Ethernet adapter functions to logical partitions that use Virtual I/O Server resources.

i5/OS provides disk, CD, tape, and console functions to logical partitions that use i5/OS resources. i5/OS uses standard i5/OS network server storage and network server descriptions to provide disk, CD, and tape resources to other logical partitions.

To configure virtual I/O for the logical partitions on your managed system, you must create virtual I/O adapters on the HMC or Integrated Virtualization Manager. Virtual I/O adapters are usually created when you create your logical partitions. Alternately, you can add virtual I/O adapters to running logical partitions using dynamic logical partitioning. After you create a virtual I/O adapter, you can then access the operating system used by the logical partition and complete the configuration of the virtual I/O adapter in the operating system software. For Linux partitions, virtual adapters are listed in the device tree. The device tree contains Virtual SCSI adapters, not the devices under the adapter.

Logical Host Ethernet Adapter

A Logical Host Ethernet Adapter (LHEA) is a special type of virtual adapter. Even though an LHEA is a virtual resource, an LHEA can exist only if a physical Host Ethernet Adapter (HEA) provides its resources to the LHEA. For more information about how LHEAs work, see Host Ethernet Adapter.

How i5/OS implements virtual resources

i5/OS can share virtual I/O resources to provide I/O functions for an AIX or a Linux logical partition.

AIX or Linux running on IBM eServer i5 supports several kinds of virtual adapters, such as virtual SCSI and virtual serial adapters. By eliminating the need to have physical hardware adapters, you are able to use I/O resources without having a device driver for hardware devices, and you can use i5/OS support for backup and recovery.

Virtual serial adapters:
Virtual serial adapters provide a point-to-point connection from one logical partition to another, or from the Hardware Management Console (HMC) to each logical partition on the managed system. Virtual serial adapters are used primarily to establish terminal or console connections to logical partitions.

When you create a logical partition, the HMC automatically creates two virtual server serial adapters on the logical partition. These virtual server serial adapters allow you to establish a terminal or console connection to the logical partition through the HMC.

You can also create pairs of virtual serial adapters on logical partitions so that you can access and control one logical partition directly from another logical partition. For example, one logical partition uses the disk resources of another logical partition using virtual SCSI adapters. You can create a server serial adapter on the logical partition that uses the disk resources and a client serial adapter on the logical partition that owns the disk resources. This connection allows the logical partition that owns the disk resources to shut down the logical partition that uses the disk resources before you back up data on the logical partition that owns the disk resources.

Different partitioning tools assign virtual serial adapters to logical partitions in different ways. For more information about virtual serial adapter assignment by a specific partitioning tool, see Partitioning tools.

Related concepts

“Partitioning tools” on page 6

You must use tools to partition your servers. The tool that you use to partition each server depends upon the server model and the operating systems and features that you want to use on the server.

Virtual SCSI adapters:

Virtual SCSI (Small Computer Systems Interface) adapters provide one partition with the ability to use storage I/O (disk, CD, and tape) that is owned by another partition.

A Virtual SCSI client adapter in one logical partition can communicate with a Virtual SCSI server adapter in another partition. The Virtual SCSI client adapter allows a logical partition to access a storage device being made available by the other logical partition. The partition owning the hardware is the server partition, and the partition that uses the virtualized hardware is the client partition. With this arrangement, the system can have many server partitions.

For example, partition A provides disk space to partitions B, C, and D. A partition can simultaneously use virtual I/O from more than one partition. Therefore, using the example, while partition A provides disk space to partitions B, C, and D, partitions A and B can use a tape drive connected to partition D. In this case, A is serving D for disk space, while D is serving A for the tape device.

Virtual SCSI allows you to simplify the backup and maintenance operations on your managed system. When you back up the data on the server partition, you also back up the data on each client partition.

Virtual SCSI server adapters can be created only in partitions of type i5/OS and Virtual I/O Server.

Disk unit, CD/DVD, and tape on an IBM System i model are based on the SCSI protocol using the ANSI SCSI Remote DMA (Direct Memory Access) protocol. Therefore, Linux partitions can access data among each other or by an adapter that is directly attached to the memory of other partitions.

The virtual SCSI client device driver is not capable of storage protection using Redundant Arrays of Independent Disks (RAID). While the Linux operating system allows software RAID protection of virtual disks, the recommended technique for protecting disk storage is to configure the virtual I/O storage server to perform the disk protection.

Different partitioning tools assign virtual SCSI adapters to logical partitions in different ways. For more information about virtual SCSI adapter assignment by a specific partitioning tool, see Partitioning tools.
You must use tools to partition your servers. The tool that you use to partition each server depends upon the server model and the operating systems and features that you want to use on the server.

**Processors**

This information describes how you can set the managed system to distribute its processing capacity among the logical partitions on the managed system.

A *processor* is a device that processes programmed instructions. The more processors that you assign to a logical partition, the greater the number of concurrent operations that the logical partition can run at any given time.

You can set up a logical partition to use either shared processors from a shared processor pool or processors that are dedicated to that logical partition. If a logical partition uses dedicated processors, then you must assign processors (in increments of whole numbers) to the logical partition. A logical partition that uses dedicated processors cannot use any processing capacity beyond the processors that are assigned to the logical partition, and no other logical partition can use the dedicated processors that are assigned to that logical partition.

All processors that are not dedicated to specific logical partitions are placed in the shared processor pool. The shared processor pool can be used by logical partitions that are set to use shared processors. You can set a logical partition that uses shared processors to use as little as 0.10 processing units, which is approximately one tenth of the processing capacity of a single processor. You can specify the number of processing units to be used by a shared processor logical partition down to the hundredth of a processing unit. Also, you can set a shared processor logical partition so that, if the logical partition requires more processing capacity than its assigned number of processing units, the logical partition can use unused processing units from the shared processor pool. (Some IBM eServer p5, IBM System p5, and IBM eServer OpenPower server models might require you to enter an activation code before you can create logical partitions that use shared processors.)

You can assign up to the entire processing capacity on the managed system to a single logical partition, provided that the operating system and server model supports doing so. You can configure your managed system so that it does not comply with the software license agreement for your managed system, but you will receive out-of-compliance messages if you operate the managed system in such a configuration. For more information about calculating the number of software licenses that you need for any given configuration, see Software licensing for IBM licensed programs on logical partitions.

For example, an i5/OS logical partition can use a maximum of 32 processors at a time. However, IBM eServer p5 servers limit the total number of processors that can be used by all i5/OS logical partitions on the managed system. The number of processors that can be used by i5/OS logical partitions on IBM eServer p5 servers varies by server model. In turn, this limits the number of i5/OS logical partitions that you can create on these IBM eServer p5 servers and the possible configurations of those i5/OS logical partitions.

On IBM eServer p5 servers that support one processor for i5/OS logical partitions, you can create the following i5/OS logical partitions:

- One logical partition that uses one dedicated processor.
- One logical partition that uses uncapped shared processing units, with a maximum of one virtual processor for the logical partition.
- Up to ten logical partitions that use capped shared processing units, with a minimum of 0.10 processing units for each logical partition.

On IBM eServer p5 servers that support two processors for i5/OS logical partitions, you can create the following i5/OS logical partitions:
- One logical partition that uses one or two dedicated processors.
- Two logical partitions that use one dedicated processor each.
- One logical partition that uses uncapped shared processing units, with a maximum of two virtual processors for the logical partition.
- Two logical partitions that use uncapped shared processing units, with a maximum of one virtual processor for each logical partition.
- One logical partition that uses one dedicated processor and one logical partition that uses uncapped shared processing units, with a maximum of one virtual processor for the logical partition that uses uncapped shared processing units.
- One logical partition that uses one dedicated processor and from one to ten logical partitions that use capped shared processing units, with a minimum of 0.10 processing units for each logical partition that uses capped shared processing units.
- One logical partition that uses uncapped shared processors, with a maximum of one virtual processor for each logical partition that uses capped shared processing units, and from one to ten logical partitions that use capped shared processing units, with a minimum of 0.10 processing units for each logical partition that uses capped shared processing units.
- From one to twenty logical partitions that use capped shared processors, with a minimum of 0.10 processing units for each logical partition.

**Automatic redistribution of work when a processor fails**

If the server firmware detects that a processor is about to fail, or if a processor fails when the processor is not in use, then the server firmware creates a serviceable event. The server firmware can also deconfigure the failing processor automatically, depending upon the type of failure and the deconfiguration policies that you set up using the Advanced System Management Interface (ASMI). You can also deconfigure a failing processor manually using the ASMI. For more information, see Setting deconfiguration policies and Deconfiguring hardware.

When the server firmware deconfigures a failing processor, and there are no unassigned processors available on the managed system, the processor deconfiguration can cause the logical partition to which the processor is assigned to shut down. To avoid shutting down mission-critical workloads when your server firmware deconfigures a failing processor, you can use the Hardware Management Console (HMC) to set partition-availability priorities for the logical partitions on your managed system. A logical partition with a failing processor can acquire a replacement processor from logical partitions with a lower partition-availability priority. The acquisition of a replacement processor allows the logical partition with the higher partition-availability priority to continue running after a processor failure.

When a processor fails on a high-priority logical partition, the managed system follows these steps to acquire a replacement processor for the high-priority logical partition.

1. If there are unassigned processors on the managed system, the managed system replaces the failed processor with an unassigned processor.
2. If there are no unassigned processors on the managed system, the managed system checks the logical partitions with lower partition-availability priorities, starting with the lowest partition-availability priority.
   - If a lower-priority logical partition uses dedicated processors, the managed system shuts down the logical partition and replaces the failed processor with one of the processors from the dedicated-processor partition.
   - If a lower-priority logical partition uses shared processors, and removing a whole processor from the logical partition would not cause the logical partition to go below its minimum value, the managed system removes a whole processor from the shared-processor partition using dynamic logical partitioning and replaces the failed processor with the processor that the managed system removed from the shared-processor partition.
If a lower-priority logical partition uses shared processors, but removing a whole processor from the logical partition would cause the logical partition to go below its minimum value, the managed system skips that logical partition and continues to the logical partition with the next higher partition availability.

3. If the managed system still cannot find a replacement processor, the managed system shuts down as many of the shared-processor partitions as it needs to acquire the replacement processor. The managed system shuts down the shared-processor partitions in partition-availability priority order, starting with the lowest partition-availability priority.

A logical partition can take processors only from logical partitions with lower partition-availability priorities. If all of the logical partitions on your managed system have the same partition-availability priority, then a logical partition can replace a failed processor only if the managed system has unassigned processors.

By default, the partition-availability priority of Virtual I/O Server logical partitions with virtual SCSI adapters is set to 191. The partition-availability priority of all other logical partitions is set to 127 by default.

Do not set the priority of Virtual I/O Server logical partitions to be lower than the priority of the logical partitions that use the resources on the Virtual I/O Server logical partition. Do not set the priority of i5/OS logical partitions with virtual SCSI adapters to be lower than the priority of the logical partitions that use the resources on the i5/OS logical partition. If the managed system shuts down a logical partition because of its partition-availability priority, all logical partitions that use the resources on that logical partition are also shut down.

If a processor fails when the processor is in use, then the entire managed system shuts down. When a processor failure causes the entire managed system to shut down, the system deconfigures the processor and restarts. The managed system attempts to start the logical partitions that were running at the time of the processor failure with their minimum processor values. If the managed system does not have enough processor resources to start all of the logical partitions with their minimum processor values, then the managed system starts as many logical partitions as it can with their minimum processor values. If there are any processor resources remaining after the managed system has started the logical partitions, then the managed system distributes any remaining processor resources to the running logical partitions in proportion to their desired processor values.

**POWER6® processor compatibility modes**

POWER6 processors can be set to any of the following processor compatibility modes.

- The POWER6 architected mode allows supported operating-system versions to use all of the standard features of the POWER6 processor.
- The POWER6 enhanced mode provides additional floating-point instructions to applications using the processor.
- The POWER5™ compatibility mode allows you to use operating-system versions that support only POWER5 processors.

The processor compatibility mode used by a logical partition depends upon the following:

- The partition compatibility mode setting on the partition profile that you use to activate the logical partition
- The partition compatibility modes that are supported by the operating system or system software that is installed on the logical partition

Each partition profile has a partition compatibility mode setting. By default, partition profiles for POWER6 systems are set to the POWER6 architected processor mode. You can set the processor compatibility mode of a partition profile to the POWER6 enhanced mode by using the HMC command.
chsyscfg -r prof to set the \texttt{lpar\_proc\_compat\_mode} attribute to enhanced. If you want to set the processor compatibility mode of a partition profile back to the POWER6 architected mode, use the HMC command \texttt{chsyscfg -r prof} to set the \texttt{lpar\_proc\_compat\_mode} attribute back to \texttt{default}. (You cannot set a partition profile to the POWER5 compatibility mode.)

When you activate a logical partition, the managed system checks the partition compatibility mode setting on the partition profile, and determines whether the installed operating system or system software supports the specified mode. If so, the logical partition uses the partition compatibility mode from the partition profile. If not, the logical partition uses the most fully featured mode that is supported by the installed operating system or system software. (The logical partition therefore cannot use a more fully featured mode than the mode specified on the partition profile, but the operating system or system software can negotiate a lesser mode if it does not support the mode specified on the partition profile.)

You cannot dynamically change the partition compatibility mode used on a logical partition. To change the partition compatibility mode, you must shut down the logical partition and restart the logical partition with a partition profile that is set to the desired partition compatibility mode.

A POWER6 processor cannot emulate all features of a POWER5 processor. For example, certain types of performance monitoring might not be available for a logical partition if the logical partition is set to the POWER5 compatibility mode.

\textbf{Related concepts}

“Software licensing for IBM licensed programs on logical partitions” on page 34

If you use IBM licensed programs such as AIX and i5/OS on a partitioned server, consider carefully how many software licenses are required for your logical partition configuration. Careful consideration of your software needs will allow you to minimize the number of software licenses that you must purchase.

\textbf{Related information}

Setting deconfiguration policies
Deconfiguring hardware

\textbf{Dedicated processors:}

\textit{Dedicated processors} are whole processors that are assigned to a single partition.

If you choose to assign dedicated processors to a logical partition, you must assign at least one processor to that partition. Likewise, if you choose to remove processor resources from a dedicated partition, you must remove at least one processor from the partition.

Different partitioning tools assign dedicated processors to logical partitions in different ways. For more information about dedicated processor assignment by a specific partitioning tool, see Partitioning tools.

By default, a powered-off logical partition using dedicated processors will have its processors available to the shared processor pool. When the processors are in the shared processor pool, an uncapped partition that needs more processing power can use the idle processing resources. However, when you power on the dedicated partition while the uncapped partition is using the processors, the activated partition will regain all of its processing resources. If you use the Hardware Management Console, you can prevent dedicated processors from being used in the shared processor pool by disabling this function in the partition properties panels.

You can also set the properties of a logical partition using dedicated processors so that unused processing cycles on those dedicated processors can be made available to the shared processor pool while the dedicated processor logical partition is running. This effectively allows the dedicated processor partition to act as if it were a capped processor partition. You can change the processor sharing mode of the dedicated processor partition at any time, without having to shut down and restart the logical partition.
You must use tools to partition your servers. The tool that you use to partition each server depends upon the server model and the operating systems and features that you want to use on the server.

Shared processors:

*Shared processors* are physical processors whose processing capacity is shared among multiple logical partitions. The ability to divide physical processors and share them among multiple logical partitions is known as *Micro-Partitioning*.

**Note:** For some models, Micro-Partitioning is an option for which you must obtain and enter an Advanced POWER Virtualization activation code. If you have not yet entered this activation code for these server models, see Entering the activation code for Virtualization Engine technologies.

All physical processors that are not dedicated to specific logical partitions are grouped together in the *shared processor pool*. You can assign a specific amount of the processing capacity in the shared processor pool to each logical partition using the shared processor pool.

The shared processor pool allows you to assign partial processors to a logical partition. A minimum of 0.10 processing units can be configured for any partition using shared processors. Processing units are a unit of measure for shared processing power across one or more virtual processors. One shared processing unit on one virtual processor accomplishes approximately the same work as one dedicated processor.

Some server models allow only a portion of the shared processor pool for use by logical partitions, so you are not always able to assign the full capacity of the shared processor pool to logical partitions. The System Planning Tool (SPT) shows how much of the shared processor pool is available for partitioning use on each server model, so use the SPT to validate your partition plan. For more information about the SPT, see System Planning Tool.

Different partitioning tools assign shared processors to logical partitions in different ways. For more information about shared processor assignment by a specific partitioning tool, see Partitioning tools.

Partitions in the shared processor pool can have a sharing mode of capped or uncapped. An *uncapped logical partition* is a logical partition that can use more processor power than its assigned processing capacity. The amount of processing capacity that an uncapped logical partition can use is limited only by the number of virtual processors assigned to the logical partition and the amount of unused processing capacity that is available in the shared processor pool. In contrast, a *capped logical partition* is a logical partition that cannot use more processor power than its assigned processing capacity.

For example, logical partitions 2 and 3 are uncapped logical partitions, and logical partition 4 is a capped logical partition. Logical partitions 2 and 3 are each assigned 3.00 processing units and four virtual processors. Logical partition 2 currently uses only 1.00 of its 3.00 processing units, but logical partition 3 currently has a workload demand that requires 4.00 processing units. Because logical partition 3 is uncapped and has four virtual processors, the server firmware automatically allows logical partition 3 to use 1.00 processing units from logical partition 2. This increases the processing power for logical partition 3 to 4.00 processing units. Soon afterwards, logical partition 2 increases its workload demand to 3.00 processing units. The server firmware therefore automatically returns 1.00 processing units to logical partition 2 so that logical partition 2 can use its full, assigned processing capacity once more. Logical partition 4 is assigned 2.00 processing units and three virtual processors, but currently has a workload demand that requires 3.00 processing units. Because logical partition 4 is capped, logical partition 4...
cannot use any unused processing units from logical partitions 2 or 3. However, if the workload demand of logical partition 4 decreases below 2.00 processing units, logical partitions 2 and 3 could use any unused processing units from logical partition 4.

By default, logical partitions that use the shared processor pool are capped logical partitions. You can set a logical partition to be an uncapped logical partition if you want the logical partition to use more processing power than its assigned amount.

Although an uncapped logical partition can use more processor power than its assigned processing capacity, the uncapped logical partition can never use more processing units than its assigned number of virtual processors.

If multiple uncapped logical partitions need additional processor capacity at the same time, the server can distribute the unused processing capacity to all uncapped logical partitions. This distribution process is determined by the uncapped weight of each of the logical partitions.

Uncapped weight is a number in the range of 0 through 255 that you set for each uncapped partition in the shared processor pool. On the HMC, you can choose from any of the 256 possible uncapped weight values. The Integrated Virtualization Manager and the Virtual Partition Manager limit you to only one of several different uncapped weight values. By setting the uncapped weight (255 being the highest weight), any available unused capacity is distributed to contending logical partitions in proportion to the established value of the uncapped weight. The default uncapped weight value is 128.

For example, logical partition 2 has an uncapped weight of 100, and logical partition 3 has an uncapped weight of 200. If logical partitions 2 and 3 both require additional processing capacity, logical partition 3 would receive two additional processing units for every additional processing unit that logical partition 2 receives.

Related concepts

"Logical partition overview” on page 3

Logical partitioning is the ability to make a server run as if it were two or more independent servers. When you logically partition a server, you divide the resources on the server into subsets called logical partitions. You can install software on a logical partition, and the logical partition runs as an independent logical server with the resources that you have allocated to the logical partition.

“System Planning Tool” on page 62

The System Planning Tool (SPT) helps you design a managed system that can support a specified set of workloads. You can design a managed system based upon workload data from your current systems, based upon new workloads that you want the managed system to support, based upon sample systems that are provided with the utility, or based upon your own custom specifications.

“Partitioning tools” on page 6

You must use tools to partition your servers. The tool that you use to partition each server depends upon the server model and the operating systems and features that you want to use on the server.

“i5/OS logical partition functional differences between IBM Systems and eServer hardware and previous hardware models” on page 12

i5/OS logical partition functions have new and changed technical enhancements for IBM Systems and eServer hardware.

Related information

Entering the activation code for Virtualization Engine technologies

Virtual processors in the shared processor pool:

A virtual processor is a representation of a physical processor to the operating system of a logical partition that uses the shared processor pool.
When you install and run an operating system on a server that is not partitioned, the operating system calculates the number of operations that it can perform concurrently by counting the number of processors on the server. For example, if you install an operating system on a server that has eight processors, and each processor can perform two operations at a time, the operating system can perform 16 operations at a time. In the same way, when you install and run an operating system on a logical partition that uses dedicated processors, the operating system calculates the number of operations that it can perform concurrently by counting the number of dedicated processors that are assigned to the logical partition. In both cases, the operating system can easily calculate how many operations it can perform at a time by counting the whole number of processors that are available to it.

However, when you install and run an operating system on a logical partition that uses the shared processor pool, the operating system cannot calculate a whole number of operations from the fractional number of processing units that are assigned to the logical partition. The server firmware must therefore represent the processing power available to the operating system as a whole number of processors. This allows the operating system to calculate the number of concurrent operations that it can perform. A virtual processor is a representation of a physical processor to the operating system of a logical partition that uses the shared processor pool.

The server firmware distributes processing units evenly among the virtual processors assigned to a logical partition. For example, if a logical partition has 1.80 processing units and two virtual processors, each virtual processor has 0.90 processing units supporting its workload.

There are limits to the number of processing units that you can have for each virtual processor. The minimum number of processing units that you can have for each virtual processor depends on the server model. The maximum number of processing units that you can have for each virtual processor is always 1.00. This means that a logical partition cannot use more processing units than the number of virtual processors that it is assigned, even if the logical partition is uncapped.

A logical partition generally performs best if the number of virtual processors is close to the number of processing units available to the logical partition. This lets the operating system manage the workload on the logical partition effectively. In certain situations, you might be able to increase system performance slightly by increasing the number of virtual processors. If you increase the number of virtual processors, you increase the number of operations that can run concurrently. However, if you increase the number of virtual processors without increasing the number of processing units, the speed at which each operation runs will decrease. The operating system also cannot shift processing power between processes if the processing power is split between many virtual processors.

Different partitioning tools assign virtual processors to logical partitions in different ways. For more information on virtual processor assignment by a specific partitioning tool, see Partitioning tools.

Operating systems display virtual processors in system utilities and performance-monitoring programs in the same way that the operating systems would display physical processors. However, operating systems may differ in how they display processor information. For example, each physical POWER5 processor has two processor cores, and each processor core can run two threads simultaneously, so a physical POWER5 processor can run four threads simultaneously. When a logical partition uses the shared processor pool on a server that uses the POWER5 processor, each virtual processor can also run four threads simultaneously. System utilities in AIX take processor cores and threads into account, so if an AIX system utility says that you have four processors, then you have four threads on one virtual processor. In contrast, system utilities in i5/OS do not take processor cores or threads into account, so if an i5/OS system utility says that you have four processors, you have four virtual processors.

Related concepts

You must use tools to partition your servers. The tool that you use to partition each server depends upon the server model and the operating systems and features that you want to use on the server.

Software licensing for IBM licensed programs on logical partitions:
If you use IBM licensed programs such as AIX and i5/OS on a partitioned server, consider carefully how many software licenses are required for your logical partition configuration. Careful consideration of your software needs will allow you to minimize the number of software licenses that you must purchase.

Software license behavior varies by software product. Each solution provider has its own licensing strategy. If you use licensed programs from solution providers other than IBM, consult the documentation from those solution providers to determine the licensing requirements for those licensed programs.

Some System i models allow you to purchase i5/OS licenses on a per-user basis. For more information about which System i models are covered by user-based licensing and how to calculate the number of licenses needed for such systems, see Install, upgrade, or delete i5/OS and related software.

Many IBM licensed programs allow you to purchase licenses based upon the number of processors that the licensed program uses on a managed system as a whole. An advantage of this processor-based licensing method is that it allows you to create multiple logical partitions without having to purchase separate licenses for each logical partition. Also, this method caps the number of licenses that you need for a managed system. You need never obtain more licenses for a single licensed program than the number of processors on the managed system.

The main complicating factor in calculating the number of licenses that are required on a partitioned managed system using processor-based licensing is the fact that a logical partition that uses uncapped shared processors can use up to its assigned number of virtual processors. When you use processor-based licensing, ensure that the number of virtual processors on uncapped logical partitions are set so that each IBM licensed program does not use more processors than the number of processor-based licenses that you have purchased for that IBM licensed program.

The formula that is used to determine how many licenses are required for a single IBM licensed program on a managed system using processor-based licensing is as follows:

<table>
<thead>
<tr>
<th>The total number of dedicated processors on logical partitions that run the IBM licensed program and use dedicated processors.</th>
</tr>
</thead>
<tbody>
<tr>
<td>PLUS</td>
</tr>
<tr>
<td>The maximum number of shared processors that can be used on logical partitions that run the IBM licensed program and use shared processors. This number is the lesser of the following two values:</td>
</tr>
<tr>
<td>• The total number of virtual processors on logical partitions that run the IBM licensed program and use uncapped shared processors, plus the total number of capped shared processors on logical partitions that run the IBM licensed program and use capped shared processors, rounded up to the next integer.</td>
</tr>
<tr>
<td>• The total number of physical processors in the shared processor pool.</td>
</tr>
<tr>
<td>EQUALS</td>
</tr>
<tr>
<td>The total number of licenses required for the IBM licensed program on the managed system.</td>
</tr>
</tbody>
</table>

When you use processor-based licensing, ensure that the managed system is in compliance with the license agreement for each IBM licensed program that is installed on the managed system.

For example, Company Y has obtained three processor-based i5/OS licenses for a managed system with four processors and four logical partitions. All four logical partitions use the shared processing pool, so all four of the processors on the managed system are in the shared processing pool. The configuration of the logical partitions is as follows.

Table 4. Logical partition configuration in compliance with license agreement

<table>
<thead>
<tr>
<th>Partition name</th>
<th>Operating system</th>
<th>Processing mode</th>
<th>Sharing mode</th>
<th>Processing units</th>
<th>Virtual processors</th>
<th>Maximum number of processors that can be used by the logical partition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partition A</td>
<td>i5/OS</td>
<td>Shared</td>
<td>Uncapped</td>
<td>1.75</td>
<td>2</td>
<td>2.00 (the number of virtual processors for the uncapped shared logical partition)</td>
</tr>
<tr>
<td>Partition B</td>
<td>i5/OS</td>
<td>Shared</td>
<td>Capped</td>
<td>0.60</td>
<td>1</td>
<td>0.60 (the number of processing units for the capped shared logical partition)</td>
</tr>
</tbody>
</table>
In this configuration, there are three i5/OS logical partitions and one Linux logical partition on the managed system. The three i5/OS logical partitions can use a maximum of 3.00 processors (2.00 for Partition A, 0.60 for Partition B, and 0.40 for Partition C). The managed system has three i5/OS licenses, so the managed system is in compliance with the i5/OS license agreement.

For an example of a logical partition configuration that is out of compliance with a licensing agreement, the system administrator at Company Y changes the sharing mode of Partition B and Partition C from capped to uncapped. The following table shows the new partition configuration.

<table>
<thead>
<tr>
<th>Partition name</th>
<th>Operating system</th>
<th>Processing mode</th>
<th>Sharing mode</th>
<th>Processing units</th>
<th>Virtual processors</th>
<th>Maximum number of processors that can be used by the logical partition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partition A</td>
<td>i5/OS</td>
<td>Shared</td>
<td>Uncapped</td>
<td>1.75</td>
<td>2</td>
<td>2.00 (the number of virtual processors for the uncapped shared logical partition)</td>
</tr>
<tr>
<td>Partition B</td>
<td>i5/OS</td>
<td>Shared</td>
<td>Uncapped</td>
<td>0.60</td>
<td>1</td>
<td>1.00 (the number of virtual processors for the uncapped shared logical partition)</td>
</tr>
<tr>
<td>Partition C</td>
<td>i5/OS</td>
<td>Shared</td>
<td>Uncapped</td>
<td>0.40</td>
<td>1</td>
<td>1.00 (the number of virtual processors for the uncapped shared logical partition)</td>
</tr>
<tr>
<td>Partition D</td>
<td>Linux</td>
<td>Shared</td>
<td>Uncapped</td>
<td>1.25</td>
<td>2</td>
<td>2.00 (the number of virtual processors for the uncapped shared logical partition)</td>
</tr>
</tbody>
</table>

In this configuration, the three i5/OS logical partitions can use a maximum of 4.00 processors (2.00 for Partition A, 1.00 for Partition B, and 1.00 for Partition C). The managed system has only three i5/OS licenses, but requires a total of four i5/OS licenses, so the managed system is out of compliance with the i5/OS license agreement.

For another example of a logical partition configuration that is out of compliance with a licensing agreement, the system administrator at Company Y changes the sharing mode of Partition B and Partition C back to capped. However, the system administrator then moves 0.50 processing units from Partition D to Partition A. Before the system administrator is allowed to do this, the system administrator must increase the number of virtual processors on Partition A from 2 to 3. The following table shows the new partition configuration.

<table>
<thead>
<tr>
<th>Partition name</th>
<th>Operating system</th>
<th>Processing mode</th>
<th>Sharing mode</th>
<th>Processing units</th>
<th>Virtual processors</th>
<th>Maximum number of processors that can be used by the logical partition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partition A</td>
<td>i5/OS</td>
<td>Shared</td>
<td>Uncapped</td>
<td>2.25</td>
<td>3</td>
<td>3.00 (the number of virtual processors for the uncapped shared logical partition)</td>
</tr>
<tr>
<td>Partition B</td>
<td>i5/OS</td>
<td>Shared</td>
<td>Capped</td>
<td>0.60</td>
<td>1</td>
<td>0.60 (the number of processing units for the capped shared logical partition)</td>
</tr>
<tr>
<td>Partition C</td>
<td>i5/OS</td>
<td>Shared</td>
<td>Capped</td>
<td>0.40</td>
<td>1</td>
<td>0.40 (the number of processing units for the capped shared logical partition)</td>
</tr>
<tr>
<td>Partition D</td>
<td>Linux</td>
<td>Shared</td>
<td>Uncapped</td>
<td>0.75</td>
<td>2</td>
<td>2.00 (the number of virtual processors for the uncapped shared logical partition)</td>
</tr>
</tbody>
</table>
In this configuration, the three i5/OS logical partitions can use a maximum of 4.00 processors (3.00 for Partition A, 0.60 for Partition B, and 0.40 for Partition C). The managed system has only three i5/OS licenses, but requires a total of four i5/OS licenses, so the managed system is out of compliance with the i5/OS license agreement.

There might be considerations other than licensed program agreements that constrain your ability to run IBM licensed programs on certain server models. For example, if you want to create i5/OS logical partitions on IBM System p5 and eServer p5 models, you must obtain special licenses and feature codes. For more information about what you must obtain to use i5/OS on IBM System p5 and eServer p5 models, see Requirements for i5/OS on IBM System p5 and eServer p5 servers.

**Related concepts**

“Processors” on page 28

This information describes how you can set the managed system to distribute its processing capacity among the logical partitions on the managed system.

**Related information**

Requirements for i5/OS on IBM System p5 and eServer p5 servers

Install, upgrade, or delete i5/OS and related software

**Memory**

Processors use memory to temporarily hold information. Memory requirements for partitions depend on partition configuration, I/O resources assigned, and applications used.

Different partitioning tools assign memory to logical partitions in different ways. For more information about memory assignment by a specific partitioning tool, see Partitioning tools.

Memory can be assigned in increments of 16 MB, 32 MB, 64 MB, 128 MB, and 256 MB. The default memory block size varies according to the amount of configurable memory in the system.

<table>
<thead>
<tr>
<th>Amount of configurable memory</th>
<th>Default memory block size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Less than 4 GB</td>
<td>16 MB</td>
</tr>
<tr>
<td>Greater than 4 GB up to 8 GB</td>
<td>32 MB</td>
</tr>
<tr>
<td>Greater than 8 GB up to 16 GB</td>
<td>64 MB</td>
</tr>
<tr>
<td>Greater than 16 GB up to 32 GB</td>
<td>128 MB</td>
</tr>
<tr>
<td>Greater than 32 GB</td>
<td>256 MB</td>
</tr>
</tbody>
</table>

The memory block size can be changed by using the Logical Memory Block Size option in the Advanced System Management Interface (ASMI). The machine default value should only be changed under direction from your service provider. To change the memory block size, you must be a user with administrator authority, and you must shut down and restart the managed system for the change to take effect. If the minimum memory amount in any partition profile on the managed system is less than the new memory block size, you must also change the minimum memory amount in the partition profile.

Depending on the overall memory in your system and the maximum memory values you choose for each partition, the server firmware must have enough memory to perform logical partition tasks. Each partition has a Hardware Page Table (HPT). The size of the HPT is based on an HPT ratio of 1/64 and is determined by the maximum memory values you establish for each partition.

Server firmware requires memory to support the logical partitions on the server. The amount of memory required by the server firmware varies according to several factors. Factors influencing server firmware memory requirements include the following:

• Number of logical partitions
- Partition environments of the logical partitions
- Number of physical and virtual I/O devices used by the logical partitions
- Maximum memory values given to the logical partitions

**Note:** Firmware level updates can also change the server firmware memory requirements. Larger memory block sizes can exaggerate the memory requirement change.

Generally, you can estimate the amount of memory required by server firmware to be approximately 8% of the system installed memory. The actual amount required will generally be less than 8%. However, there are some server models that require an absolute minimum amount of memory for server firmware, regardless of the previously mentioned considerations.

When selecting the maximum memory values for each partition, consider the following:
- Maximum values affect the HPT size for each partition
- The logical memory map size for each partition

If the server firmware detects that a memory module has failed or is about to fail, then the server firmware creates a serviceable event. The server firmware can also deconfigure the failing memory module automatically, depending upon the type of failure and the deconfiguration policies that you set up using the ASMI. You can also deconfigure a failing memory module manually using the ASMI. If a memory module failure causes the entire managed system to shut down, the managed system restarts automatically if the managed system is in normal IPL mode. When the managed system restarts itself, or when you restart the managed system manually, the managed system attempts to start the logical partitions that were running at the time of the memory module failure with their minimum memory values. If the managed system does not have enough memory to start all of the logical partitions with their minimum memory values, then the managed system starts as many logical partitions as it can with their minimum memory values. If there is any memory left over after the managed system has started as many logical partitions as it can, then the managed system distributes any remaining memory resources to the running logical partitions in proportion to their desired memory values.

**Related concepts**

“Partitioning tools” on page 6
You must use tools to partition your servers. The tool that you use to partition each server depends upon the server model and the operating systems and features that you want to use on the server.

“Memory requirements for i5/OS logical partitions”
Before you create an i5/OS logical partition, you should become familiar with how i5/OS uses memory resources. In particular, you should know how dynamic memory changes affect the amount of memory that is available to the i5/OS logical partition.

**Memory requirements for i5/OS logical partitions:**

Before you create an i5/OS logical partition, you should become familiar with how i5/OS uses memory resources. In particular, you should know how dynamic memory changes affect the amount of memory that is available to the i5/OS logical partition.

You should also become familiar with how memory is generally used in a logical partitioning environment. For more information on how memory is generally used in a logical partitioning environment, see Memory.

Dynamic memory changes on i5/OS logical partitions affect the base memory pool of the logical partitions ("BASE pool"). Private memory pools or shared memory pools are not affected. Dynamic memory changes cannot cause the amount of memory in the base pool to fall below the minimum amount of memory required in the base pool (as determined by the base storage minimum size.
(QBASPOOL) system value). If a dynamic memory change would cause the base pool to fall below this amount, the system releases excess memory pages only after keeping the minimum amount of memory required in the base pool.

To prevent any data loss during dynamic memory movement, the system first writes any data from memory pages to the disks before making the memory pages available to another partition. Depending on the amount of memory you have requested to move, this might take some time.

The full amount of memory that you assign to a logical partition might not be available for the logical partition to use. Static memory overhead required to support the assigned maximum memory will affect the reserved or hidden memory amount. This static memory overhead will also influence the minimum memory size of a partition.

If you change the minimum memory amount of a logical partition, then you must restart the logical partition for the change to take effect. If you change the maximum memory amount of a logical partition, then you must restart the logical partition for the change to take effect, and you might also need to restart the managed system or change the minimum memory amount.

Related concepts
“Memory” on page 37

Processors use memory to temporarily hold information. Memory requirements for partitions depend on partition configuration, I/O resources assigned, and applications used.

Expansion unit
You can add expansion units to many of the models to support additional features and devices. If you want to create logical partitions on your server, you might need to add an expansion unit that contains the additional hardware that you need for each logical partition.

Some expansion units can support only disk units (storage expansion unit), while others can support a variety of hardware (system expansion unit). Expansion units generally contain one or more system I/O buses with various I/O devices.

Terminal and console options for logical partitions
You can initiate a terminal or console session to the logical partitions on your managed system using a variety of methods. Your choice of terminal or console depends on your operating system and business needs.

The following choices of terminal or console are available for each operating system.

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Terminal or console options</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIX</td>
<td>• Hardware Management Console (HMC)</td>
</tr>
<tr>
<td></td>
<td>• Telnet</td>
</tr>
<tr>
<td></td>
<td>• OpenSSH with OpenSSL (included in the AIX expansion pack)</td>
</tr>
<tr>
<td></td>
<td>• Direct serial connection (ASCII terminal or PC connected with null modem cable)</td>
</tr>
<tr>
<td></td>
<td>• i5/OS virtual console (for AIX logical partitions that use i5/OS resources)</td>
</tr>
<tr>
<td></td>
<td>• When on a system with a Virtual I/O Server (VIOS) partition, the console can be provided by the VIOS partition when using VIOS 1.2.0 or later.</td>
</tr>
<tr>
<td>i5/OS</td>
<td>• HMC</td>
</tr>
<tr>
<td></td>
<td>• Operations Console</td>
</tr>
<tr>
<td></td>
<td>• Operations Console LAN</td>
</tr>
<tr>
<td></td>
<td>• Operations Console Directly attached</td>
</tr>
<tr>
<td></td>
<td>• Twinaxial console</td>
</tr>
</tbody>
</table>
Table 8. Terminal and console options for logical partitions (continued)

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Terminal or console options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linux</td>
<td>• HMC</td>
</tr>
<tr>
<td></td>
<td>• Telnet</td>
</tr>
<tr>
<td></td>
<td>• OpenSSH with OpenSSL (included in the Linux distribution)</td>
</tr>
<tr>
<td></td>
<td>• Direct serial connection (ASCII terminal or PC connected with null modem cable)</td>
</tr>
<tr>
<td></td>
<td>• i5/OS virtual console (for Linux logical partitions that use i5/OS resources)</td>
</tr>
<tr>
<td></td>
<td>• When on a system with a Virtual I/O Server (VIOS) partition, the console can be provided by the VIOS partition when using VIOS 1.2.0 or later.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Virtual I/O Server</th>
<th>Terminal or console options</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Hardware Management Console (HMC)</td>
</tr>
<tr>
<td></td>
<td>• Telnet</td>
</tr>
<tr>
<td></td>
<td>• OpenSSH with OpenSSL (included in the AIX expansion pack)</td>
</tr>
<tr>
<td></td>
<td>• Direct serial connection (ASCII terminal or PC connected with null modem cable)</td>
</tr>
<tr>
<td></td>
<td>• i5/OS virtual console (for AIX logical partitions that use i5/OS resources)</td>
</tr>
<tr>
<td></td>
<td>• When on a system with a Virtual I/O Server (VIOS) partition, the console can be provided by the VIOS partition when using VIOS 1.2.0 or later.</td>
</tr>
</tbody>
</table>

**Hardware Management Console terminal and console options:**

The HMC provides virtual terminal emulation for AIX and Linux logical partitions and virtual 5250 console emulation for i5/OS logical partitions.

The HMC connects to the server firmware. You use the HMC to specify to the server firmware how you want resources to be allocated among the logical partitions on the managed system. You also use the HMC to start and stop the logical partitions, update the server firmware code, manage Capacity on Demand, and transmit service information to service and support if there are any hardware problems with your managed system.

You can create virtual terminal and virtual 5250 console sessions locally on the HMC by using the Server Management commands on the HMC. If you configure the HMC to allow remote access, you can also create virtual terminal and virtual 5250 console sessions remotely through the HMC. You can create remote virtual terminal sessions on AIX and Linux logical partitions by using the Server Management commands on Web-based System Manager. You can also create virtual 5250 console sessions on i5/OS logical partitions. You must configure the HMC to allow remote access, and you must configure encryption on the logical partitions for the session to be secure.

The HMC communicates with servers using service applications to detect, consolidate, and send information to IBM for analysis.

The following figure shows a partitioned server being managed by an HMC.
Operations Console for i5/OS logical partitions:

Operations Console allows you to use a local or remote PC to access i5/OS on logical partitions. Operations Console is an installable component of iSeries Access for Windows.

The management tasks that you can perform using Operations Console depend upon whether you are managing your logical partitions using a Hardware Management Console (HMC) or using the Virtual Partition Manager on i5/OS:

- If you are using an HMC to manage your logical partitions, you can use Operations Console to access i5/OS on your i5/OS logical partitions.
- If you are using the Virtual Partition Manager on i5/OS to manage your logical partitions, you can use Operations Console to access i5/OS on your i5/OS logical partitions. In turn, you can use Operations Console to access the Virtual Partition Manager on your i5/OS logical partitions. This allows you to create up to four Linux logical partitions on the managed system and manage the resources for all logical partitions on the managed system.

The following figure shows a partitioned IBM System i model with an HMC and local console on a network.
The following figure shows a partitioned IBM System i model with an HMC and local consoles directly attached to the server.

![Diagram of IBM System i model with HMC and consoles]

Note: Directly attached Operations Console does not support the remote control panel. For remote control panel support, you will need either LAN or the virtual control panel that uses the serial cable from the existing console.

For more information about adding and using Operations Console as your i5/OS console, refer to Managing Operations Console.

Related information
- Managing Operations Console

**Twinaxial console for i5/OS logical partitions:**

The *twinaxial console* uses a basic command-line interface to access i5/OS on logical partitions. It does not require the use of a PC to act as a console.

The management tasks that you can perform using a twinaxial console depend upon whether you are managing your logical partitions using a Hardware Management Console (HMC) or using the Virtual Partition Manager on i5/OS:

- If you are using an HMC to manage your logical partitions, you can use the twinaxial console to access i5/OS on your i5/OS logical partitions.
- If you are using the Virtual Partition Manager on i5/OS to manage your logical partitions, you can use a twinaxial console to access i5/OS on your i5/OS logical partition. In turn, you can use the twinaxial console to access the Virtual Partition Manager on the i5/OS logical partition. This allows you to create up to four Linux logical partitions on the managed system and manage the resources for all logical partitions on the managed system.

**Twinaxial console and an HMC**

The following figure shows a partitioned IBM System i5 model with an HMC connected to the server firmware and twinaxial consoles connected to each i5/OS logical partition. Use the HMC to create and manage logical partitions. Use the twinaxial console to access i5/OS on your i5/OS logical partitions.
Twinaxial console and the Virtual Partition Manager

The following figure shows a partitioned IBM System i5 model with a twinaxial console connected to i5/OS on your i5/OS logical partition. Use the twinaxial console to access the Virtual Partition Manager and create and manage the logical partitions on your managed system.

For more information about adding and using twinaxial console to your computing environment, refer to Managing the twinaxial console.

For more information about partitioning using the Virtual Partition Manager, refer to Partitioning with the Virtual Partition Manager.
Related information

Managing the twinaxial console

I/O devices
I/O devices allow your managed system to gather, store, and transmit data. I/O devices are found in the server unit itself and in expansion units and towers that are attached to the server. I/O devices can be embedded into the unit, or they can be installed into physical slots.

Not all types of I/O devices are supported for all operating systems or on all server models. For example, Switch Network Interface (SNI) adapters are supported only on certain server models, and are not supported for i5/OS logical partitions. Also, I/O processors (IOPs) are supported only on i5/OS logical partitions.

I/O pools for i5/OS logical partitions:

An I/O pool is a group of I/O adapters that form an IASP. Other names for IASPs include I/O failover pool and switchable independent disk pool.

The IASP can be switched from a failed server to a backup server within the same cluster without the active intervention of the Hardware Management Console (HMC). The I/O adapters within the IASP can be used by only one logical partition at a time, but any of the other logical partitions in the group can take over and use the I/O adapters within the IASP. The current owning partition must power off the adapters before another partition can take ownership.

IASPs are not suitable for sharing I/O devices between different logical partitions. If you want to share an I/O device between different logical partitions, use the HMC to move the I/O device dynamically between the logical partitions.

IOPs for i5/OS logical partitions:

I/O processors (IOPs) are cards that control communication links between I/O adapters (IOAs) and the managed system for i5/OS logical partitions. The IOP processes instructions from the managed system and works with the IOAs to control the I/O devices. Many types of IOA require the use of an IOP.

The combined-function IOP (CFIOP) can connect to a variety of different IOAs. For instance, a CFIOP could support disk units, a console, and communications hardware.

Note: A managed system with i5/OS logical partitions must have the correct IOP feature codes for the load-source disk unit and alternate restart devices. Without the correct hardware, the logical partitions will not function correctly.

A logical partition controls all devices connected to an IOP. You cannot switch one I/O device to another logical partition without moving the ownership of the IOP. Any resources (IOAs and devices) that are attached to the IOP cannot be in use when you move an IOP from one logical partition to another.

Tagged resources for i5/OS logical partitions:

When you create an i5/OS logical partition using the Hardware Management Console (HMC), you must tag I/O processors (IOPs) or I/O adapters (IOAs) to perform specific functions for the i5/OS logical partition.

A tagged resource is an IOP or IOA that is selected because it controls a device that performs a specific function for a logical partition. The HMC and the i5/OS operating system use this tagging to locate and use the correct I/O device for each I/O function. For example, when you create an i5/OS partition
profile, you must tag the I/O device that you want the i5/OS logical partition to use as its load source. The tag allows the HMC to locate the load source when you activate the logical partition using the partition profile.

You can tag either the IOP or the IOA that controls the I/O device that you want to use. Tagging the IOA allows you to specify the exact I/O device that you want to use. Tagging the IOP allows you to switch between devices on the IOP using control panel functions.

Some I/O device types are required to create an i5/OS logical partition, and other I/O device types are optional. For example, i5/OS always requires a load source from which you load the operating system. However, the alternate console device is used only if you use a twinaxial console as your primary console, so if you use another type of console as the primary console for i5/OS, you do not need to tag the alternate console device.

The following table lists and describes the device types that are tagged and indicates whether you must tag the device type for i5/OS logical partitions.

**Table 9. Devices associated with tagged IOPs or IOAs**

<table>
<thead>
<tr>
<th>Device</th>
<th>Description</th>
<th>Tagging required for i5/OS logical partitions?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alternate restart device</td>
<td>Can be a tape drive or an optical device. The media in the alternate restart device is what the system uses to start from when you perform a D-mode initial program load (IPL). The alternate restart device loads the Licensed Internal Code contained on the removable media instead of the code on the load source disk unit.</td>
<td>Yes</td>
</tr>
<tr>
<td>Partition console</td>
<td>The first workstation that the system activates in the partition and the only device it activates on a manual IPL. The partition assumes that a console will always be available for use.</td>
<td>Yes (if you are using a console device other than the HMC)</td>
</tr>
<tr>
<td>Alternate console device</td>
<td>The twinaxial console device that the partition will look for if the primary console fails during a manual IPL. The alternate console device is used only when the primary console is twinaxial.</td>
<td>No</td>
</tr>
<tr>
<td>Operations Console direct connect device</td>
<td>An adapter used to support either a directly attached Operations Console or to support an asynchronous modem. This adapter does not apply to LAN-attached Operations Console. You can connect the Operations Console device to an external line so that your managed system can send information to your support provider if the managed system encounters problems.</td>
<td>No</td>
</tr>
<tr>
<td>Load source disk unit</td>
<td>Each i5/OS logical partition must have one disk unit designated as the load source. The system uses the load source to start the logical partition. The system always identifies this disk unit as unit number 1.</td>
<td>Yes</td>
</tr>
</tbody>
</table>
If you use the Virtual Partition Manager to partition your managed system, you do not need to tag I/O devices for these I/O functions. The i5/OS logical partition automatically owns all physical I/O resources on the managed system, and the Virtual Partition Manager automatically tags the I/O device to use for each I/O function. The Virtual Partition Manager tags I/O devices for I/O functions based upon server model and location within the server. If you are partitioning a new server using the Virtual Partition Manager and have ordered the server with preloaded i5/OS, then you do not need to verify the placement of I/O devices within your new server. Otherwise, use the System Planning Tool (SPT) to verify the placement of I/O devices within your server before using the Virtual Partition Manager to partition the server.

**Switchable devices for i5/OS logical partitions:**

You can set up an I/O processor (IOP) so that it can be switched from one logical partition to another. This allows you to share the devices that are associated with that IOP among many i5/OS logical partitions.

When you switch an IOP or an I/O adapter (IOA), you take the control of the devices away from one partition and give it to another without restarting the server or the partition. Before switching the IOP or the IOA to another partition, you must ensure that the device is not in use.

IOPs or IOAs that are good candidates for switching between logical partitions include IOPs or IOAs that are attached to high-cost devices or low-use or low-demand devices.

**Attention:** When switching IOPs that control disk units, ensure that all disk units that belong to that specific IOP are first removed from the auxiliary storage pool and are in a nonconfigured status.

**IOAs for i5/OS logical partitions:**

I/O adapters (IOAs) are used to control devices in i5/OS logical partitions. Some types of IOAs have placement rules that you must follow when installing these devices in your system units and expansion units.

**Load source for i5/OS logical partitions:**

The load-source disk unit is the disk unit that contains the Licensed Internal Code for the i5/OS logical partition. Each i5/OS logical partition must have one disk unit designated as the load source. The managed system uses the load-source disk unit to start the i5/OS logical partition.

The i5/OS operating system always identifies the load-source disk unit as unit number 1.

You must follow placement rules when placing a load-source disk unit in your managed system. Before adding a load source to your managed system or moving a load source within your managed system, validate the revised system hardware configuration with the System Planning Tool (SPT), back up the data on the disks attached to the IOA, and move the hardware according to the SPT output.

For more information about the placement rules for load sources, see Load source placement rules for i5/OS logical partitions. For more information about the SPT, see System Planning Tool.
Related concepts

“Load source placement rules for i5/OS logical partitions”
You must properly place a disk unit within a system unit or expansion unit before you use the disk unit as the load source for an i5/OS logical partition. The placement rules depend upon the server unit or expansion unit in which the load source is located and the I/O adapter (IOA) that controls the load source.

“System Planning Tool” on page 62
The System Planning Tool (SPT) helps you design a managed system that can support a specified set of workloads. You can design a managed system based upon workload data from your current systems, based upon new workloads that you want the managed system to support, based upon sample systems that are provided with the utility, or based upon your own custom specifications.

Load source placement rules for i5/OS logical partitions:

You must properly place a disk unit within a system unit or expansion unit before you use the disk unit as the load source for an i5/OS logical partition. The placement rules depend upon the server unit or expansion unit in which the load source is located and the I/O adapter (IOA) that controls the load source.

Note: The information provided does not replace the System Planning Tool (SPT). Use this information as a resource with the SPT output. Its purpose is to assist you in the load source placement for your i5/OS logical partitions. For more information on the SPT, see System Planning Tool.

The load source disk for an i5/OS logical partition must be placed as follows.

Table 10. Load source placement rules

<table>
<thead>
<tr>
<th>Server or expansion unit</th>
<th>IOA</th>
<th>Disk slot</th>
</tr>
</thead>
<tbody>
<tr>
<td>515</td>
<td>Imbedded controller</td>
<td>P3-D2, P3-D3, P3-D4</td>
</tr>
<tr>
<td></td>
<td>SCSI bus port 0 of Optional PCI storage IOA controlling P2 disk slots</td>
<td>P2-D2, P2-D3, P2-D4</td>
</tr>
<tr>
<td>520</td>
<td>Imbedded controller</td>
<td>P3-D2, P3-D3, P3-D4</td>
</tr>
<tr>
<td></td>
<td>SCSI bus port 0 of Optional PCI storage IOA controlling P2 disk slots</td>
<td>P2-D2, P2-D3, P2-D4</td>
</tr>
<tr>
<td>525</td>
<td>Imbedded controller</td>
<td>P3-D2, P3-D3, P3-D4</td>
</tr>
<tr>
<td></td>
<td>SCSI bus port 0 of Optional PCI storage IOA controlling P2 disk slots</td>
<td>P2-D2, P2-D3, P2-D4</td>
</tr>
<tr>
<td>550</td>
<td>Imbedded controller</td>
<td>P3-D2, P3-D3, P3-D4</td>
</tr>
<tr>
<td></td>
<td>SCSI bus port 0 of Optional PCI storage IOA controlling P3 disk slots</td>
<td>P3-D2, P3-D3, P3-D4</td>
</tr>
<tr>
<td>570</td>
<td>Imbedded controller</td>
<td>P3-D4, P3-D5, P3-D6</td>
</tr>
<tr>
<td>595</td>
<td>SCSI bus port 0 of any storage IOA to which a load source disk unit is connected in the base PCI-X expansion tower (9194)</td>
<td>D01, D02, D11, D12, D21, D22, D06, D07, D16, D17, D26, D27, D31, D32, D33, D34 of base PCI-X expansion tower (9194)</td>
</tr>
<tr>
<td>5074 or 5079</td>
<td>IOA controlling device board slot 3</td>
<td>D31, D32, D33, D34</td>
</tr>
<tr>
<td></td>
<td>IOA controlling device board slot 1</td>
<td>D01, D02</td>
</tr>
<tr>
<td></td>
<td>IOA controlling device board slot 2</td>
<td>D06, D07</td>
</tr>
<tr>
<td>5094 or 5294</td>
<td>SCSI bus port 0 of any storage IOA to which a load source disk unit is connected.</td>
<td>D01, D02, D11, D12, D21, D22, D06, D07, D16, D17, D26, D27, D31, D32, D33, D34</td>
</tr>
</tbody>
</table>
Table 10. Load source placement rules (continued)

<table>
<thead>
<tr>
<th>Server or expansion unit</th>
<th>IOA</th>
<th>Disk slot</th>
</tr>
</thead>
<tbody>
<tr>
<td>5095</td>
<td>IOA controlling device board slot 1</td>
<td>D01, D02, D03, D04</td>
</tr>
<tr>
<td></td>
<td>IOA controlling device board slot 2</td>
<td>D07, D08, D09, D10</td>
</tr>
<tr>
<td>5786 or 5787</td>
<td>SCSI bus port 0 of any storage IOA to which a load source disk unit is connected</td>
<td>P1-D1, P1-D2, P1-D3 can contain the load source only if slot C3 contains a single SCSI (506E) repeater card that is connected to port 0 on a SCSI I/O Adapter (IOA) in the system unit but is not connected to slot C2. P1-D7, P1-D8, P1-D9 can contain the load source only if the SCSI repeater card in slot C2 is connected to port 0 on a SCSI IOA in the system unit. P2-D1, P2-D2, P2-D3 can contain the load source only if slot C4 contains a single SCSI (506E) repeater card that is connected to port 0 on a SCSI IOA in the system unit but is not connected to slot C5. P2-D7, P2-D8, P2-D9 can contain the load source only if the SCSI repeater card in slot C4 is connected to port 0 on a SCSI IOA in the system unit.</td>
</tr>
<tr>
<td>5790 or 5796</td>
<td>SCSI bus port 0 of any storage IOA to which a load source disk unit in a 5786 or 5787 expansion unit is connected</td>
<td>P1-D1, P1-D2, P1-D3 can contain the load source only if slot C3 contains a single SCSI (506E) repeater card that is connected to port 0 on a SCSI I/O Adapter (IOA) in the 5790 expansion unit but is not connected to slot C2. P1-D7, P1-D8, P1-D9 can contain the load source only if the SCSI repeater card in slot C2 is connected to port 0 on a SCSI IOA in the 5790 expansion unit. P2-D1, P2-D2, P2-D3 can contain the load source only if slot C4 contains a single SCSI (506E) repeater card that is connected to port 0 on a SCSI IOA in the 5790 expansion unit but is not connected to slot C5. P2-D7, P2-D8, P2-D9 can contain the load source only if the SCSI repeater card in slot C4 is connected to port 0 on a SCSI IOA in the 5790 expansion unit.</td>
</tr>
</tbody>
</table>

Read the following rules about load source placement for i5/OS logical partitions:

- The load-source IOP or IOA must be specified when you create your logical partition.
- Disk compression must be disabled for the load source disk.
• Disk units must have at least 8 GB of usable capacity for i5/OS V5R3M0 or 17 GB of usable capacity for i5/OS V5R3M5 or later.
• Disk mirroring requires two load source disk devices in valid load-source positions.
• External disk units cannot be used (except for those located in a SAN or in an expansion unit).
• Any disk IOP or IOAs that can attach to a system capable of having logical partitions can be used for additional storage capacity after the special requirements for the load-source disk are met.

• Each logical partition has its own single-level storage and hence its own ASP configuration. The ASP configuration rules that apply to systems without logical partitions also apply to logical partitions.
• Disk protection can be defined for a partition in the same way as for a nonpartitioned system: parity protection (RAID), mirroring, or mixed. Bus-level mirroring requires two buses in the partition. IOP-level partitioning requires two disk IOPs in the partition.
• Disk units that are already in use by a logical partition cannot be easily added to a different logical partition. You must first remove them from the configuration of the partition that is using the disk units before you add them to a different partition. In doing this, the system automatically moves any user or system data to other disk units in the same ASP.
• For a 5094 or 5294, you can attach load source disk units to a maximum of six storage IOAs. Also, a 5094 or 5294 can have load source disk units for up to six i5/OS logical partitions.

Related concepts
“Load source for i5/OS logical partitions” on page 46
The load-source disk unit is the disk unit that contains the Licensed Internal Code for the i5/OS logical partition. Each i5/OS logical partition must have one disk unit designated as the load source. The managed system uses the load-source disk unit to start the i5/OS logical partition.

“System Planning Tool” on page 62
The System Planning Tool (SPT) helps you design a managed system that can support a specified set of workloads. You can design a managed system based upon workload data from your current systems, based upon new workloads that you want the managed system to support, based upon sample systems that are provided with the utility, or based upon your own custom specifications.

Alternate restart device and removable media devices for i5/OS logical partitions:

An alternate restart device is a tape device or optical device (CD-ROM or DVD) that is used to load the Licensed Internal Code and i5/OS in the place of a load-source device. Alternate restart devices are typically used for the initial installation of i5/OS on a logical partition and for repairing an existing installation of i5/OS.

You must designate an alternate restart device for every i5/OS logical partition. The media in the alternate restart device is what the system uses to start from when you perform a D-mode initial program load (IPL). The alternate restart device loads the Licensed Internal Code contained on the removable media instead of the code on the load-source disk unit. It can also be used to install the system.

Depending on your hardware setup, you might decide that your logical partitions will share these devices. If you decide to share these devices, remember that only one logical partition can use the device at any time. To switch devices between logical partitions, you must move the IOP controlling the shared device to the desired logical partition.

For more information about the placement rules for alternate restart devices, see Alternate restart device placement rules for i5/OS logical partitions.
Related concepts

"Alternate restart device placement rules for i5/OS logical partitions"

You must properly place an optical or tape media device within a system unit or expansion unit before you use the device to load the Licensed Internal Code and i5/OS to the load source disk unit of an i5/OS logical partition. Also, you can use an optical or tape media device to load the Licensed Internal Code and i5/OS to a logical partition only if the feature code of the optical or tape media device supports logical partitions.

Alternate restart device placement rules for i5/OS logical partitions:

You must properly place an optical or tape media device within a system unit or expansion unit before you use the device to load the Licensed Internal Code and i5/OS to the load source disk unit of an i5/OS logical partition. Also, you can use an optical or tape media device to load the Licensed Internal Code and i5/OS to a logical partition only if the feature code of the optical or tape media device supports logical partitions.

Note: The information provided does not replace the System Planning Tool (SPT). Use this information as a resource with the SPT output. Its purpose is to assist you in the alternate restart device placement for your i5/OS logical partitions. For more information on the SPT, see System Planning Tool (SPT).

SCSI-to-unit-address conversion

Note: When attaching an external SCSI device as an alternate restart device, it must be at hardware unit address 5, 6, or 7. The following table shows the translation from SCSI to hardware unit addresses.

Table 11. SCSI-to-unit-address conversion

<table>
<thead>
<tr>
<th>SCSI address</th>
<th>Unit address</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>5</td>
</tr>
<tr>
<td>1</td>
<td>6</td>
</tr>
<tr>
<td>0</td>
<td>7</td>
</tr>
</tbody>
</table>

Supported internal CD-ROM and DVD-ROM devices

The following table shows the internal CD-ROM and DVD-ROM alternate restart devices that are supported by logical partitions.

Table 12. Supported internal CD-ROM and DVD-ROM devices

<table>
<thead>
<tr>
<th>Internal optical device feature code</th>
<th>515, 520, 525, and 570</th>
<th>550</th>
<th>595</th>
<th>5074, 5079, 5094, 5294, 5790, and 9194</th>
</tr>
</thead>
<tbody>
<tr>
<td>2640</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>4625</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4630</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4631</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4633</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5751</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>

i5/OS hardware requirements allow only certain IOPs to be used as the alternate restart IOP. Some of these IOPs must be in specific card slots in the expansions units. The IOP, specified during partition setup, must be in one of the following card slots.
Table 13. Supported IOPs and IOAs

<table>
<thead>
<tr>
<th>PCI IOP</th>
<th>PCI IOA</th>
<th>IOA Slot</th>
</tr>
</thead>
<tbody>
<tr>
<td>2843 and 2844</td>
<td>2749</td>
<td>Any IOA slot</td>
</tr>
<tr>
<td></td>
<td>2757</td>
<td>Any IOA slot</td>
</tr>
<tr>
<td></td>
<td>2768</td>
<td>Any IOA slot</td>
</tr>
<tr>
<td></td>
<td>2780</td>
<td>Any IOA slot</td>
</tr>
<tr>
<td></td>
<td>4748</td>
<td>Any IOA slot</td>
</tr>
<tr>
<td></td>
<td>4778</td>
<td>Any IOA slot</td>
</tr>
<tr>
<td></td>
<td>5702</td>
<td>Any IOA slot</td>
</tr>
<tr>
<td></td>
<td>5703</td>
<td>Any IOA slot</td>
</tr>
<tr>
<td></td>
<td>571A</td>
<td>Any IOA slot</td>
</tr>
<tr>
<td></td>
<td>571B</td>
<td>Any IOA slot</td>
</tr>
<tr>
<td></td>
<td>571E</td>
<td>Any IOA slot</td>
</tr>
<tr>
<td>IOPless</td>
<td>571A</td>
<td>Any IOA slot</td>
</tr>
<tr>
<td></td>
<td>571B</td>
<td>Any IOA slot</td>
</tr>
<tr>
<td></td>
<td>571E</td>
<td>Any IOA slot</td>
</tr>
</tbody>
</table>

Placement for an internal alternate restart device

The alternate restart device is in the same expansion unit as its controlling IOP or IOA. It must be placed as follows.

Table 14. Placement for an alternate restart device in an expansion unit

<table>
<thead>
<tr>
<th>Expansion unit</th>
<th>Removable media slot</th>
</tr>
</thead>
<tbody>
<tr>
<td>5074, 5079, 5094, 5294, 5790, and 9194</td>
<td>D41 or D42</td>
</tr>
</tbody>
</table>

The alternate restart device for an i5/OS logical partition in the system unit must be placed as follows:

Table 15. Placement for an alternate restart device in a system unit

<table>
<thead>
<tr>
<th>Server</th>
<th>IOA</th>
<th>Removable media slot</th>
</tr>
</thead>
<tbody>
<tr>
<td>515</td>
<td>Imbedded controller</td>
<td>P4-D1 or P4-D2</td>
</tr>
<tr>
<td>520</td>
<td>Imbedded controller</td>
<td>P4-D1 or P4-D2</td>
</tr>
<tr>
<td>525</td>
<td>Imbedded controller</td>
<td>P4-D1 or P4-D2</td>
</tr>
<tr>
<td>550</td>
<td>Imbedded controller</td>
<td>P4-D1 or P4-D2</td>
</tr>
<tr>
<td>570</td>
<td>Imbedded controller</td>
<td>P4-D1</td>
</tr>
<tr>
<td>595</td>
<td>Any valid IOA in the connected base PCI-X expansion unit (9194)</td>
<td>Any valid removable media slot in the connected base PCI-X expansion unit (9194)</td>
</tr>
</tbody>
</table>

Internal removable media devices are:
- Quarter-inch cartridge (QIC) 1/4-inch tape
- 8 mm tape
- LTO tape
- VXA tape
- 4mm tape
• CD-ROM or DVD

i5/OS logical partitions have a few more rules for alternate restart devices:
• The alternate restart device must be connected to SCSI bus 0.
• The alternate restart IOP or IOA is specified during partition setup.
• IOAs 2757, 2780, 2782, 5702, and 5703 also support disk devices. These IOAs should not be used to attach removable media that will be switched between partitions if disk devices are also attached.

Related concepts

“Alternate restart device and removable media devices for i5/OS logical partitions” on page 49

An alternate restart device is a tape device or optical device (CD-ROM or DVD) that is used to load the Licensed Internal Code and i5/OS in the place of a load-source device. Alternate restart devices are typically used for the initial installation of i5/OS on a logical partition and for repairing an existing installation of i5/OS.

“System Planning Tool” on page 62

The System Planning Tool (SPT) helps you design a managed system that can support a specified set of workloads. You can design a managed system based upon workload data from your current systems, based upon new workloads that you want the managed system to support, based upon sample systems that are provided with the utility, or based upon your own custom specifications.

Disk units for i5/OS logical partitions:

Disk units store data for i5/OS logical partitions. Disk units store data more permanently than memory (RAM). However, you can still erase data on a disk unit.

Disk units can be configured into auxiliary storage pools (ASPs) on any logical partition. All of the disk units you assign to an ASP must be from the same logical partition. You cannot create a cross-partition ASP.

You can also create an independent ASP. An independent ASP is a collection of disk units that can be taken offline, or made unavailable, independently of other disk pools because the data in the independent ASP is self-contained. The independent ASP can also be brought online, or made available, while the system is active, without having to restart the system. For more information about ASPs, see the i5/OS Disk pools topic collection.

Related information

Disk pools

5250 CPW for i5/OS logical partitions

5250 commercial processing workload (5250 CPW) is the capacity to perform 5250 online transaction processing (5250 OLTP) tasks on i5/OS logical partitions.

A 5250 OLTP task is a task that uses the 5250 data stream. Examples of 5250 OLTP tasks include the following:
• Any form of 5250 emulation, including Hardware Management Console (HMC) 5250, RUMBA/400, PC Support/400 workstation function, and Binary Synchronous Communication (BSC) 3270 emulation
• 5250 Telnet or 5250 Display Station Pass-Through (DSPT) workstations
• 5250/HTML workstation gateway
• Screen scrapers
• Interactive system monitors
• Printer jobs that pass through twinaxial media, regardless of whether the printer is working in dedicated mode or is printing spool files from an output queue
On IBM System i5 and eServer i5 models, the method used to determine the processing capability that is available for 5250 OLTP tasks depends on the edition type of the managed system. The following table shows how much processing capability is available for 5250 OLTP tasks.

<table>
<thead>
<tr>
<th>Edition type</th>
<th>Processing capability available for 5250 OLTP tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Enterprise Editions</strong></td>
<td>100% of the processing capability of the managed system is available for 5250 OLTP tasks. However, the amount of processing capability that you are entitled to use for 5250 OLTP tasks is limited by the number of Enterprise Enablement features on the managed system. You cannot assign specific amounts of 5250 CPW to logical partitions. Each i5/OS logical partition can use up to its entire processing capability for 5250 OLTP tasks automatically, provided that the managed system does not exceed its entitlement. The number of Enterprise Enablement features on the system determines the number of processors that are available for 5250 OLTP tasks. A number of Enterprise Enablement features are included with each system. The number of Enterprise Enablement features included with the system depends on the server model and processor feature. If needed, you can purchase additional Enterprise Enablement features for the server. Alternately, you can purchase a Full Enterprise Enablement feature for some server models. This feature enables the entire processing capacity of all permanently activated processors for 5250 OLTP tasks.</td>
</tr>
<tr>
<td><strong>High Availability Editions</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Express Configurations</strong></td>
<td>A fixed amount of the processing capability on the managed system is available for 5250 OLTP tasks. Percentages of this 5250 CPW can be assigned to i5/OS logical partitions. If you manage the system using an HMC, each i5/OS logical partition can use a fixed percentage of the total system 5250 CPW. When you use the HMC to activate an i5/OS logical partition, the HMC assigns this fixed percentage of system 5250 CPW to the i5/OS logical partition based on the 5250 CPW settings in the partition profile. After you activate the i5/OS logical partition, you can manually increase or decrease the percentage used by the i5/OS logical partition using dynamic logical partitioning. If you manage the system using the Virtual Partition Manager, all of the system 5250 CPW is assigned automatically to the single i5/OS logical partition.</td>
</tr>
<tr>
<td><strong>Value Editions</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Standard Editions</strong></td>
<td>No processing capability of the managed system is available for 5250 OLTP tasks. However, you can use a single 5250 console session on each i5/OS logical partition. You cannot assign specific amounts of 5250 CPW to i5/OS logical partitions.</td>
</tr>
<tr>
<td><strong>Solution Editions</strong></td>
<td>Consult the technical specifications for more information.</td>
</tr>
</tbody>
</table>

On IBM System p5 and eServer p5 models, 5250 CPW must be enabled using Enterprise Enablement features. You can enable up to the entire processing capacity available to the i5/OS logical partitions for 5250 OLTP tasks.

You can use the following tools to reduce the number of 5250 OLTP tasks that your managed system must perform:
- Use iSeries Navigator to manage your i5/OS logical partitions.
- Use the IBM WebFacing Tool to convert your 5250 OLTP applications into web-based applications that no longer need to use the 5250 data stream.
Barrier-synchronization register
The barrier-synchronization register (BSR) is a memory register that is located on certain POWER technology-based processors. You can write a parallel-processing application running on AIX so that the application uses a BSR to perform barrier synchronization, which is a method for synchronizing the threads in the parallel-processing application. If you use version 7 or later of the Hardware Management Console (HMC) to create logical partitions, you can divide BSRs into arrays and assign BSR arrays to partition profiles.

Each BSR array is 8 bytes long. The number of BSR arrays that are available on a managed system depends on the type of processors used on the server model. You can see the number of BSR arrays that are available on a managed system by viewing managed system properties on the HMC.

Using an HMC, you can assign a whole number of BSR arrays to one or more partition profiles. When you activate a logical partition using a partition profile that specifies a number of BSR arrays, the managed system assigns the BSR arrays to the logical partition if the specified number of BSR arrays are available. If the number of BSR arrays specified in the partition profile are not available, you cannot activate the logical partition using that partition profile.

The Integrated Virtualization Manager does not allow you to assign BSR arrays to logical partitions.

The HMC allows you to assign BSR arrays to any logical partition. However, AIX is the only operating system that currently supports the use of BSRs and BSR arrays. Also, you might not realize a performance advantage if you use barrier synchronization on a logical partition that uses shared processors.

You cannot add BSR arrays to or remove BSR arrays from logical partitions using dynamic logical partitioning. To add or remove BSR arrays, you must change the partition profile or create a new partition profile with the revised number of BSR arrays, shut down the logical partition, and restart the logical partition using the partition profile with the new number of BSR arrays.

To take advantage of barrier synchronization, a parallel-processing application must be written specifically to access and write to the BSR or a BSR array. For more information on how to do this, see the information about the bsr_alloc, bsr_free, and bsr_query kernel services under “Technical Reference: Kernel and Subsystems, Volume 1” in the IBM System p® and AIX Information Center.

Communications options for logical partitions
The types of communications options that you use depend on your business needs and the operating system you are running. You can establish interpartition communication using virtual Ethernet. For IBM System i5 and eServer i5 server models, you can also use the HSL OptiConnect for high-speed system-to-system communication or the virtual OptiConnect to emulate external OptiConnect hardware providing a virtual bus between logical partitions.

Host Ethernet Adapter
A Host Ethernet Adapter (HEA) is a physical Ethernet adapter that is integrated directly into the GX+ bus on a managed system. HEAs offer high throughput, low latency, and virtualization support for Ethernet connections. HEAs are also known as Integrated Virtual Ethernet adapters (IVE adapters).

Unlike most other types of I/O devices, you can never assign the HEA itself to a logical partition. Instead, multiple logical partitions can connect directly to the HEA and use the HEA resources. This allows these logical partitions to access external networks through the HEA without having to go through an Ethernet bridge on another logical partition.

To connect a logical partition to an HEA, you must create a Logical Host Ethernet Adapter (LHEA) for the logical partition. A Logical Host Ethernet Adapter (LHEA) is a representation of a physical HEA on a logical partition. An LHEA appears to the operating system as if it were a physical Ethernet adapter, just
as a virtual Ethernet adapter appears as if it were a physical Ethernet adapter. When you create an LHEA for a logical partition, you specify the resources that the logical partition can use on the actual physical HEA. Each logical partition can have one LHEA for each physical HEA on the managed system. Each LHEA can have one or more logical ports, and each logical port can connect to a physical port on the HEA.

You can create an LHEA for a logical partition using either of the following methods:

- You can add the LHEA to a partition profile, shut down the logical partition, and reactivate the logical partition using the partition profile with the LHEA.
- You can add the LHEA to a running logical partition using dynamic logical partitioning. (This method can be used for Linux logical partitions only if you install Red Hat Enterprise Linux version 5.1, Red Hat Enterprise Linux version 4.6, or a later version of Red Hat Enterprise Linux on the logical partition.)

When you activate a logical partition, the LHEAs in the partition profile are considered to be required resources. If the physical HEA resources required by the LHEAs are not available, then the logical partition cannot be activated. However, when the logical partition is active, you can remove any LHEAs you want from the logical partition.

After you create an LHEA for a logical partition, a network device is created in the logical partition. This network device is named `entX` on AIX logical partitions, `CMNXX` on i5/OS logical partitions, and `ethX` on Linux logical partitions, where `X` represents sequentially assigned numbers. The user can then set up TCP/IP configuration similar to a physical Ethernet device to communicate with other logical partitions.

A logical port can communicate with all other logical ports that are connected to the same physical port on the HEA. The physical port and its associated logical ports form a logical Ethernet network. Broadcast and multicast packets are distributed on this logical network as though it was a physical Ethernet network. You can connect up to 16 logical ports to a physical port using this logical network. By extension, you can connect up to 16 logical partitions to each other and to an external network through this logical network. The actual number of logical ports that you can connect to a physical port depends upon the Multi-Core Scaling value of the physical port group and the number of logical ports that have been created for other physical ports within the physical port group. By default, the Multi-Core Scaling value of each physical port group is set to 4, which allows 4 logical ports to be connected to the physical ports in the physical port group. To allow up to 16 logical ports to be connected to the physical ports in the physical port group, you must change the Multi-Core Scaling value of the physical port group to 1 and restart the managed system.

If you want to connect more than 16 logical partitions to each other and to an external network through a physical port on an HEA, you can create a logical port on a Virtual I/O Server logical partition and configure an Ethernet bridge between the logical port and a virtual Ethernet adapter on a virtual LAN. This allows all logical partitions with virtual Ethernet adapters on the virtual LAN to communicate with the physical port through the Ethernet bridge. Because you are bridging the Ethernet connection through the Virtual I/O Server, the connection might not perform as well as a logical network. If you configure an Ethernet bridge between a logical port and a virtual Ethernet adapter, the physical port that is connected to the logical port must have the following properties:

- The physical port must be configured so that the Virtual I/O Server logical partition is the promiscuous mode partition for the physical port. For more information on how to configure a physical port, see Configuring physical ports on a Host Ethernet Adapter using version 7 or later of the HMC.
- The physical port can have only one logical port.

You can set each logical port to restrict or allow packets that are tagged for specific VLANs. You can set a logical port to accept packets with any VLAN ID, or you can set a logical port to accept only the VLAN IDs that you specify. You can specify up to 20 individual VLAN IDs for each logical port.
The physical ports on an HEA are always configured on the managed system level. If you use an HMC to manage a system, you must use the HMC to configure the physical ports on any HEAs belonging to the managed system. Also, the physical port configuration applies to all logical partitions that use the physical port. (Some properties might require setup in the operating system as well. For example, the maximum packet size for a physical port on the HEA must be set on the managed system level using the HMC. However, you must also set the maximum packet size for each logical port within the operating system.) By contrast, if a system is unpartitioned and is not managed by an HMC, you can configure the physical ports on an HEA within the operating system just as if the physical ports were ports on a regular physical Ethernet adapter.

HEA hardware does not support Half Duplex mode.

You can change the properties of a logical port on an LHEA by using dynamic logical partitioning to remove the logical port from the logical partition and add the logical port back to the logical partition using the changed properties. If the operating system of the logical partition does not support dynamic logical partitioning for LHEAs, and you want to change any logical port property other than the VLANs on which the logical port participates, you must set a partition profile for the logical partition so that the partition profile contains the desired logical port properties, shut down the logical partition, and activate the logical partition using the new or changed partition profile. If the operating system of the logical partition does not support dynamic logical partitioning for LHEAs, and you want to change the VLANs on which the logical port participates, you must remove the logical port from a partition profile belonging to the logical partition, shut down and activate the logical partition using the changed partition profile, add the logical port back to the partition profile using the changed VLAN configuration, and shut down and activate the logical partition again using the changed partition profile.

**Virtual Ethernet for i5/OS logical partitions**

Virtual Ethernet provides similar function as a 1 Gigabit (Gb) Ethernet adapter. A logical partition can use virtual Ethernet to establish multiple high-speed interpartition connections within a single managed system. AIX, i5/OS, and Linux logical partitions, as well as Windows environments integrated on iSeries, can communicate with each other using TCP/IP over the virtual Ethernet communications ports.

You can create virtual Ethernet adapters on an i5/OS logical partition either by using a Hardware Management Console (HMC) or by using Virtual Partition Manager. When you create a virtual Ethernet adapter on an i5/OS logical partition, a communications device called CMNxx displays in the operating system, where xx indicates digits that uniquely identify the device within the operating system. You can then configure TCP/IP for that communications device in the operating system, just as if it were a physical Ethernet adapter. After TCP/IP is configured for the communications device, the virtual Ethernet adapter can communicate with other virtual Ethernet adapters with the same virtual LAN ID. To learn how to create a virtual Ethernet adapter using an HMC, see Configuring a virtual Ethernet adapter for i5/OS.

IBM Systems and eServer hardware contain an interpartition virtual switch that automatically connects virtual Ethernet adapters with the same virtual LAN ID. No special hardware or software is required for virtual Ethernet adapters to communicate over the virtual LAN.

If a logical partition on the virtual LAN is also connected to a physical LAN, then you can configure the operating system of that logical partition so that the logical partitions on the virtual LAN can communicate over the physical LAN. This allows the logical partitions on a managed system to share a physical connection to an external network. If desired, you can configure connections between the virtual LAN and multiple physical LANs, or you can configure redundant connections between a virtual LAN and a physical LAN (to enhance the reliability of the connection). The logical partition having the physical Ethernet adapter does not have to be the serving partition for virtual SCSI.

The logical partitions on a virtual LAN communicate with each other as peers. If you shut down any of the logical partitions on the virtual LAN, the other logical partitions on the virtual LAN are still able to communicate with each other over the virtual LAN. If you shut down a logical partition that owns an
external network connection, the other logical partitions on the virtual LAN are no longer able to use that external network connection, but the logical partitions can still communicate with each other. The only exception to this rule for i5/OS is the i5/OS logical partition on managed systems that are partitioned using the Virtual Partition Manager. If the i5/OS logical partition is shut down, then all of the other logical partitions on the managed system are also shut down.

You can connect Windows environments integrated on iSeries to a virtual LAN. To do this, you must first create a virtual Ethernet adapter on the i5/OS logical partition whose I/O resources are used by the integrated environment. You must then configure an Ethernet line description that associates a network server description (NWSD) with the CMNxx device for the virtual Ethernet adapter that you have just created. The virtual Ethernet adapter then belongs to the integrated environment and cannot be used by the i5/OS logical partition. If you want to connect the integrated environment and the i5/OS logical partition whose resources are used by the integrated environment to the same virtual LAN, then you must create two virtual Ethernet adapters on the i5/OS logical partition with the same virtual LAN ID.

In this figure, you can see three logical partitions on an IBM eServer i5 server. An Integrated xSeries Server (IXS) with Windows installed uses the I/O resources on the i5/OS logical partition. The i5/OS logical partition has two virtual Ethernet adapters that are connected to the same virtual LAN. One virtual Ethernet adapter is used by the i5/OS logical partition itself, and the other virtual Ethernet adapter is used by the IXS. Each of the other logical partitions has a virtual Ethernet adapter that is connected to the same virtual LAN as the virtual Ethernet adapters on the i5/OS logical partition. The virtual Ethernet adapter on the Linux logical partition is bridged to a physical Ethernet adapter that belongs to the Linux logical partition. This allows the AIX and i5/OS logical partitions and the IXS to connect to an external, physical LAN through the virtual LAN.

Observe the following limitations when you create virtual LANs on your managed system.

- You can define up to 4094 separate virtual LANs on each managed system using an HMC, or up to four separate virtual LANs on each managed system using the Virtual Partition Manager.
- You can define up to 32 767 virtual Ethernet adapters on each i5/OS logical partition using an HMC, or up to four virtual Ethernet adapters on each i5/OS logical partition using the Virtual Partition Manager.
• Virtual Ethernet adapters can use any virtual slot number from slot 2 through slot 65 535 using an HMC. Virtual Ethernet adapters created using the Virtual Partition Manager are assigned virtual slot numbers automatically, and you cannot choose which virtual slot number you use. (The slot number used for a virtual Ethernet adapter displays in i5/OS as the adapter number in the resource details for the CMNxx device.)

• i5/OS does not support the IEEE 802.1Q standard. This means that a virtual Ethernet adapter on an i5/OS logical partition can connect to only one virtual LAN. However, the i5/OS virtual Ethernet adapter can connect to virtual Ethernet adapters on logical partitions whose operating systems support the IEEE 802.1Q standard.

Also, when you create virtual Ethernet adapters on your managed system using the Virtual Partition Manager, you might inadvertently exceed the number of virtual slots allowed on the managed system. If you exceed this limit, then the managed system requires you to IPL the managed system before it creates the virtual Ethernet adapters. During the IPL, the managed system enables all the available slots on the managed system so that you never need to IPL the managed system again due to insufficient virtual slots.

For more information on how to create Ethernet line descriptions and how you connect a virtual Ethernet network to an external LAN, refer to the i5/OS topic TCP/IP techniques to connect virtual Ethernet to external LANs. Additional information about virtual Ethernet, along with scenarios that demonstrate this communication solution, can be found in the IBM Redbook LPAR Configuration and Management Working with System i Logical Partitions.

For more information about converting your pre-existing System i virtual Ethernet configuration, see Converting your pre-existing virtual Ethernet configuration.

Related concepts

“Converting your pre-existing virtual Ethernet configuration”
IBM System i5 and eServer i5 models do not use primary partitions and do not support a virtual LAN ID of 0. When you migrate logical partitions from an iSeries 8xx model to an IBM System i5 and eServer i5 model, the logical partitions can continue to use virtual Ethernet only if you make the appropriate changes to the virtual Ethernet settings of these logical partitions.

Related tasks

“Configuring a virtual Ethernet adapter using version 6 or earlier of the HMC” on page 224
You can configure a virtual Ethernet adapter dynamically for a running logical partition. Doing so will connect the logical partition to a virtual LAN.

Related information

TCP/IP techniques to connect virtual Ethernet to external LANs
LPAR Configuration and Management: Working with IBM eServer iSeries Logical Partitions

Converting your pre-existing virtual Ethernet configuration:

IBM System i5 and eServer i5 models do not use primary partitions and do not support a virtual LAN ID of 0. When you migrate logical partitions from an iSeries 8xx model to an IBM System i5 and eServer i5 model, the logical partitions can continue to use virtual Ethernet only if you make the appropriate changes to the virtual Ethernet settings of these logical partitions.

For example, your existing iSeries 8xx server has three logical partitions. The primary partition and partition LPAR 372 are able to communicate with each other because they share a virtual LAN ID of 0. The primary partition and partition LPAR 370 are able to communicate with each other because they share a virtual LAN ID of 2. The primary partition, partition LPAR 370, and partition LPAR 372 are able to communicate with each other because they share a virtual LAN ID of 5.
You will notice that the virtual LAN IDs on your existing logical partitions increased by one because the server automatically adds 1 to each of the virtual LAN IDs. The virtual LAN ID of 0 is no longer supported on IBM System i5 and eServer i5 servers. All IBM System i5 and eServer i5 servers support virtual LAN IDs 1 to 4096. The primary partition was renamed LPAR 180 because IBM System i5 and eServer i5 servers do not support a primary partition.

Partition LPAR 370 and partition LPAR 180 are able to communicate because they now share the same virtual LAN ID of 3. Partition LPAR 372 and partition LPAR 180 are able to communicate because they now share the same virtual LAN ID of 1. And partition LPAR 370, partition LPAR 372, and partition LPAR 180 are still able to communicate because they share the same virtual LAN ID of 6.
After successfully converting your existing virtual Ethernet configuration, you are now ready to create your Ethernet line descriptions and decide how you want to connect to an external LAN using different TCP/IP techniques. For more information about how to create Ethernet line descriptions and how you connect a virtual Ethernet network to an external LAN, refer to TCP/IP techniques to connect virtual Ethernet to external LANs.

Related concepts
“Virtual Ethernet for i5/OS logical partitions” on page 56

Related information
TCP/IP techniques to connect virtual Ethernet to external LANs

High-Speed link (HSL) OptiConnect for i5/OS logical partitions
The High-Speed link (HSL) OptiConnect feature provides high-speed system-to-system communication between managed systems.

The HSL OptiConnect feature can be used only for communications between i5/OS logical partitions on IBM System i models. If you must enable communications with an System p model, use an Ethernet connection instead of the HSL OptiConnect feature.

To use the HSL OptiConnect feature on a logical partition, you must install OptiConnect for OS/400 (a priced optional feature) on each i5/OS logical partition that is to use HSL OptiConnect. If you use the Hardware Management Console (HMC) to partition your managed system, you must also check the partition profile properties for each i5/OS logical partition that is to use HSL OptiConnect and ensure
that the Use High Speed Link (HSL) OptiConnect option is selected on the OptiConnect tab. For more information on changing partition profile properties, see Changing partition profile properties using the HMC.

You can use both the HSL OptiConnect feature and the virtual OptiConnect feature on the same i5/OS logical partition. If multiple paths are available between i5/OS logical partitions, the OptiConnect software automatically selects the virtual OptiConnect path instead of the HSL OptiConnect external path.

The HSL OptiConnect feature requires only standard HSL cables to connect the systems to one another. No additional hardware is required.

For more information about OptiConnect, refer to OptiConnect.

Related tasks
“Changing partition profile properties using version 6 or earlier of the HMC” on page 240
You can change the properties of a partition profile using the Hardware Management Console (HMC). Changing the properties of a partition profile will change the resource amounts that are assigned to a logical partition when you shut down and restart the logical partition using the changed partition profile.

Related information
Virtual OptiConnect for i5/OS logical partitions
The virtual OptiConnect feature provides high-speed interpartition communication within a managed system. The Virtual OptiConnect feature emulates external OptiConnect hardware by providing a virtual bus between logical partitions.

The virtual OptiConnect feature can be used only for communications between i5/OS logical partitions on IBM System i models. If you must enable communications with AIX or Linux logical partitions, or if you are using i5/OS on an IBM System p5 or eServer p5 model, use virtual Ethernet instead of the virtual OptiConnect feature.

To use the virtual OptiConnect feature on a logical partition, you must install OptiConnect for OS/400 (a priced optional feature) on each i5/OS logical partition that is to use virtual OptiConnect. If you use the Hardware Management Console (HMC) to partition your managed system, you must also check the partition profile properties for each i5/OS logical partition that is to use virtual OptiConnect and ensure that the Use virtual OptiConnect option is selected on the OptiConnect tab. For more information on changing partition profile properties, see Changing partition profile properties using the HMC.

You can use both the virtual OptiConnect feature and the High-Speed Link (HSL) OptiConnect feature on the same i5/OS logical partition. If multiple paths are available between i5/OS logical partitions, the OptiConnect software automatically selects the virtual OptiConnect path instead of the HSL OptiConnect external path.

You can use the virtual OptiConnect feature without any additional hardware requirements.

For more information about OptiConnect, refer to OptiConnect.
Related tasks

"Changing partition profile properties using version 6 or earlier of the HMC" on page 240

You can change the properties of a partition profile using the Hardware Management Console (HMC). Changing the properties of a partition profile will change the resource amounts that are assigned to a logical partition when you shut down and restart the logical partition using the changed partition profile.

Related information

Opticonnect

Logical partition utilities

There are utilities in addition to the main partition management tools that you can use to manage your system. These utilities allow you to monitor and manage resources more closely than you could if you use the partition management tools alone. These utilities are installed on logical partitions on your managed system.

System Planning Tool

The System Planning Tool (SPT) helps you design a managed system that can support a specified set of workloads. You can design a managed system based upon workload data from your current systems, based upon new workloads that you want the managed system to support, based upon sample systems that are provided with the utility, or based upon your own custom specifications.

If you make any changes to the hardware assignments or placement in the system, the SPT validates the changes to ensure that the resulting system fulfills the minimum hardware requirements and hardware placement requirements for the logical partitions.

When you are done making changes to the system, you can save your work as a system plan. You can import this file into your Hardware Management Console (HMC) or the management partition for the Integrated Virtualization Manager and deploy the system plan to a managed system that is managed by the HMC or the Integrated Virtualization Manager. When you deploy the system plan, the HMC or the Integrated Virtualization Manager creates the logical partitions from the system plan on the managed system. For more information on system plans, see Creating partitions from a system plan.

To download the SPT, see the IBM System Planning Tool Web site.
Related concepts

“Requirements for i5/OS on IBM System p5 and eServer p5 servers” on page 20
All of the hardware requirements for running i5/OS on IBM System i5 and eServer i5 servers also apply to running i5/OS on IBM System p5 and eServer p5 servers. In addition, you must also adhere to the hardware requirements specific to running i5/OS on an IBM System p5 and eServer p5 server.

“Shared processors” on page 32
Shared processors are physical processors whose processing capacity is shared among multiple logical partitions. The ability to divide physical processors and share them among multiple logical partitions is known as Micro-Partitioning.

“Alternate restart device placement rules for i5/OS logical partitions” on page 50
You must properly place an optical or tape media device within a system unit or expansion unit before you use the device to load the Licensed Internal Code and i5/OS to the load source disk unit of an i5/OS logical partition. Also, you can use an optical or tape media device to load the Licensed Internal Code and i5/OS to a logical partition only if the feature code of the optical or tape media device supports logical partitions.

“Load source for i5/OS logical partitions” on page 46
The load-source disk unit is the disk unit that contains the Licensed Internal Code for the i5/OS logical partition. Each i5/OS logical partition must have one disk unit designated as the load source. The managed system uses the load-source disk unit to start the i5/OS logical partition.

“Load source placement rules for i5/OS logical partitions” on page 47
You must properly place a disk unit within a system unit or expansion unit before you use the disk unit as the load source for an i5/OS logical partition. The placement rules depend upon the server unit or expansion unit in which the load source is located and the I/O adapter (IOA) that controls the load source.

Related tasks

“Creating additional partition profiles using version 6 or earlier of the HMC” on page 223
You can create more than one partition profile for a logical partition using the Hardware Management Console (HMC). Each partition profile can specify a different amount of system resources and different partition startup attributes. You can change the attributes used by a logical partition by shutting down the logical partition and restarting the logical partition using a different partition profile.

“Creating additional partition profiles using version 7 or later of the HMC” on page 92
You can create more than one partition profile for a logical partition using the Hardware Management Console (HMC). Each partition profile can specify a different amount of system resources and different partition startup attributes. You can change the attributes used by a logical partition by shutting down the logical partition and restarting the logical partition using a different partition profile.

Related information

Enterprise Workload Manager
Enterprise Workload Manager (EWLM) is a performance-management tool that monitors workloads on your managed system. With EWLM, you can establish performance goals for workloads. If your workloads require more system resources to meet the performance goals that you have established, EWLM automatically adjusts the resources on your managed system so that those performance goals can be met.

EWLM uses dynamic logical partitioning to adjust the resources on your managed system. To use this feature of EWLM, you must have a model that supports Advanced POWER Virtualization, or you must obtain and enter an Advanced POWER Virtualization enablement code for your managed system.

If you want EWLM to manage workloads on a logical partition, you must set up the logical partition so that it can be managed by a workload-management application. The workload-management setting is located in logical partition properties on the Hardware Management Console (HMC) and in the Integrated Virtualization Manager.
EWLM manages logical partitions in partition-workload groups. EWLM allows you to define the amount of resources that the workloads in each partition-workload group can use.

The HMC allows you to define from 0 to 4095 partition-workload groups on a single managed system. You can set the partition-workload group for each logical partition by changing the properties of the logical partition. Each logical partition can belong to one partition-workload group at a time, or to no partition-workload groups at all.

The Integrated Virtualization Manager allows only for a single partition-workload group on each managed system. Each logical partition can belong to the single partition-workload group, or to no partition-workload groups at all.

**Examples of logically partitioned systems**

You can use the logical partitioning examples in this section to consolidate servers, use computing resources more efficiently, and increase the flexibility of your enterprise.

**Creating multiple client environments**

You provide high-availability e-commerce services to a number of clients. You provide computing resources, applications, and technical support to each client, and each client can independently configure and use the applications running on the computing resources that you provide. In such an environment, it is essential to isolate the clients so that the clients have access only to their resources. However, dedicating a physical server to each client is cost prohibitive, and does not allow you to easily increase or decrease the amount of computing resources used by each client.

You therefore decide to create a logical partition for each client. You install an operating system and applications on each logical partition. You can then use dynamic logical partitioning to add resources to logical partitions or remove resources from logical partitions as needed. If a client stops using your service, you can delete the logical partition for that client and reassign the resources to other logical partitions.

**Testing new applications**

You are a furniture manufacturer that uses an application to track inventory at your plant. A new version of the application is now available. You want to test this new version before using it on your production server, but you do not have any money to buy separate test hardware.

You therefore decide to create a separate test environment on your managed system. You remove resources from the existing production environment, and you create a new logical partition that contains the resources that you removed from the production environment. You install an operating system and the new version of the inventory application on the logical partition. You can then use dynamic logical partitioning to move resources from the test logical partition to the production logical partition during peak production demand, and then return the resources to the test logical partition during testing. When you have finished testing, you can delete the test logical partition, add the resources back to the production logical partition, and install the new version of the inventory application on the production system.

**Integrating new acquisitions**

You have just acquired a new company. Your new acquisition does not use the same applications for payroll, inventory, and billing that you do. You plan to consolidate your two companies onto a single set of applications, but it will take time to implement this consolidation. In the meantime, you are under pressure to reduce data center costs quickly.
You therefore decide to create logical partitions for the applications used by your new acquisition. You install an operating system and the applications used by the new company on the logical partition. If the combined workloads require more resources, you can use Capacity Upgrade on Demand (CUoD) to add processors and memory to the managed system, and then use dynamic logical partitioning to add these resources to the logical partitions. This solution allows you to save hardware costs immediately while you determine the best way to consolidate onto a single set of applications.

**Planning for logical partitions**

IBM hardware architectures allow you to create logical partitions to distribute resources within a single server and make it function as if it were two or more independent servers. Before creating logical partitions (LPARs), you need to plan for several variables that are specific to your solution. You need to understand how you can reconfigure partitions to respond to future needs.

You can create logical partitions on your server to integrate multiple operating systems and consolidate several servers into one. Consolidation helps you reduce maintenance and administration costs while improving performance. Planning for logical partitions is a multistep process. Here are the recommended tasks for LPAR planning for AIX, i5/OS, and Linux logical partitions.

Before you begin your planning tasks, complete these items:

**Before you begin**

_ **Determine what you want to do**_

For example, you can:
- Plan a new system
- Reconfigure an existing system
- Upgrade an existing system
- Physically set up a new system
- Partition a new system
- Virtualize systems resources
- Install operating systems on new partitions
- Migrate a partition between physical systems

To help you determine what you want to do, see [Logical partition overview](#) and [Concepts for partitioning the server](#) in the IBM Systems Hardware Information Center.

This information familiarizes you with the hardware and software that is required for logical partitions and prepares you to plan for and create logical partitions on your server.
Before you begin

— Learn about available tools

The available tools include:

**IBM Prerequisite site**

The IBM Prerequisite site provides you with compatibility information for hardware features. This site helps you plan a successful system upgrade by providing you with the prerequisite information for features that you currently have or plan to add to your system.

**Workload Estimator**

The Workload Estimator estimates the computer resources that are required for Domino®, WebSphere® Commerce, WebSphere, Web Serving and traditional workloads. The Workload Estimator projects the most current System i and System p models that meet the capacity requirements that are within the CPU percent utilization objectives.

**System Planning Tool**

The System Planning Tool (SPT) emulates an LPAR configuration and validates that the planned partitions are valid. In addition, the SPT allows you to test the placement of AIX, i5/OS and Linux hardware within the system to ensure that the placement is valid.

**Hardware Management Console**

Managing your server using the Hardware Management Console

The Hardware Management Console (HMC) is a system that controls managed systems, including server hardware, logical partitions, and Capacity on Demand (CoD).

**Performance toolbox**

The AIX Performance Toolbox (PTX) for POWER Version 3.0 is a licensed program product that provides a comprehensive tool for monitoring and tuning system performance in distributed environments.

**Integrated Virtualization Manager**

Integrated Virtualization Manager is a browser-based system management interface that you can use to manage a single managed system that uses Virtual I/O Server on a managed partition.

— Check prerequisites

Use these resources to check prerequisites:

- Hardware resources

**Logical partition planning tasks**

— Take inventory of your current environment, and what is available through CoD

See [Working with Capacity on Demand](#)
Logical partition planning tasks

- **Perform capacity planning**
  
  Use the Workload Estimator (WLE) for each logical system, new or consolidated, to determine the number of partitions that are needed and the size of each. Use your existing Performance Monitor (PM) information as input for the WLE. See the IBM Systems Workload Estimator Web site at http://www.ibm.com/systems/support/tools/estimator/index.html.

- **Design and validate your partition configuration**
  
  Use the SPT to help you design a partitioned system and develop a system plan. See the System Planning Tool for more information about this tool. If you are using an HMC to partition, you can use the system plan file to automate the task of creating partitions on your system. See System plan overview to learn how to deploy a system plan.

- **Use the WLE and SPT output to identify the console that interacts with the server and its operating systems**
  
  See Console options for logical partitions to help you determine which console helps you to connect and communicate with the server and your operating systems.

- **Use the WLE and SPT output to determine how the partitions communicate with other partitions, servers, or workstations**
  
  See Communications options for logical partitions to help you select the communication option for your logical partition. Determine which communication option allows you to communicate with other partitions, servers, and workstations.

- **Use the WLE and SPT output to identify how the partitions communicate with the HMC**
  
  See Hardware Management Console (HMC) to help you determine how to implement a network connection on the HMC.

- **Determine a service and support strategy**
  
  See Service, support, and troubleshooting to understand how your server communicates to your service provider if you have hardware or software errors. Determine how to apply fixes to your server and how you identify problems that need to be reported to your service provider.

- **Decide if you want your operating systems to share I/O resources with each other**
  
  See Using the Virtual I/O Server to understand how your OS can provide I/O resources to other logical partitions.

- **Plan for software licensing in a partitioned environment**
  
  You need to decide how many software licenses you might need depending on your logical partition configuration.
  
  Software licensing for IBM licensed programs on logical partitions
  
  Software licensing considerations for Capacity BackUp
Related concepts

“Scenario: Creating an i5/OS logical partition and partition profile using version 6 or earlier of the HMC” on page 295
You can create an i5/OS logical partition that acts as a virtual server on your managed system. When you create the i5/OS logical partition, you specify the resources that the logical partition uses in a partition profile.

“Scenario: Using the HMC and Operations Console with i5/OS logical partitions using version 6 or earlier of the HMC” on page 305
Even if you use a Hardware Management Console (HMC) as your platform management tool, you can still use Operations Console as the operating system console for your i5/OS logical partitions.

“Scenario: Dynamically moving processors and memory resources using version 6 or earlier of the HMC” on page 300
You can use dynamic logical partition to move processor and memory resources between logical partitions using version 6 or earlier of the HMC. This allows you to maximize resource utilization on your managed system by moving resources to wherever the resources are needed.

“Scenario: Dynamically moving desired I/O devices using version 6 or earlier of the HMC” on page 303
You can move infrequently used I/O devices such as optical disc drives dynamically from one logical partition to another using version 6 or earlier of the HMC. This allows you to share the single I/O device among many logical partitions.

Partitioning with version 7 or later of the HMC

The Hardware Management Console (HMC) is a system that controls managed systems, including the management of logical partitions and use of Capacity Upgrade on Demand. Using service applications, the HMC communicates with managed systems to detect, consolidate, and forward information to IBM for analysis.

Version 7 or later of the HMC features a browser-based user interface. You can use the HMC locally by connecting a keyboard and mouse to the HMC. You can also configure the HMC so that you can connect to the HMC remotely using a supported browser.

In this figure, you can see the logical partitions and the server firmware on the managed system. The server firmware is code that is stored in flash memory on the managed system. The server firmware directly controls the resource allocations on the managed system and the communications between logical partitions on the managed system. The HMC connects with the server firmware and specifies how the server firmware allocates resources on the managed system.

If you use a single HMC to manage a managed system, and the HMC malfunctions or becomes disconnected from the server firmware, then the managed system continues to run, but you will not be
able to change the logical partition configuration of the managed system. If desired, you can attach an additional HMC to act as a backup and to provide a redundant path between the managed system and service and support.

When you configure logical partitions using the HMC, you must create at least one partition profile for each logical partition. A partition profile is a record on the HMC that specifies a resource configuration and activation state for the logical partition. Each logical partition has a default partition profile. If desired, you can create additional partition profiles with different resource configurations. When you activate a logical partition using the HMC, you choose a partition profile, and the server firmware starts the logical partition according to the specifications contained in the selected partition profile. For more information on partition profiles, see Partition profile.

To simplify the process of starting an entire system configuration, you can create system profiles. A system profile is a record on the HMC that contains an ordered list of partition profiles. When you activate a system profile from the HMC, the server firmware activates the partition profiles in the system profile in the order in which the partition profiles are listed. For more information on system profiles, see System profile.

The HMC also provides terminal and 5250 console emulation for the logical partitions on your managed system. You can connect to logical partitions from the HMC itself, or you can set up the HMC so that you can connect to logical partitions remotely through the HMC. HMC terminal and 5250 console emulation provides a dependable connection that you can use if no other terminal or console device is connected or operational. HMC terminal and 5250 console emulation is particularly useful during initial system setup, before you have configured your terminal or console of choice.

Partitioning using the HMC is supported on all IBM System i5 and eServer i5 and IBM System p5 and eServer p5 models, although some models require you to enter an Advanced POWER Virtualization Technologies enablement code before partitioning the managed system.

**Partitioning a new or nonpartitioned server**

Use these procedures to partition your new or nonpartitioned server using the Hardware Management Console (HMC).

When you receive your server, the server is in what is known as the manufacturing default configuration. You can install an operating system on the server and use the server in a nonpartitioned configuration. However, if you want to create logical partitions on the managed system, you must develop a partition plan for the server, add hardware to the server or move the hardware within the server according to your partition plan, and validate the hardware on the server. When the server is ready, you can then create the logical partitions using the HMC.

The procedure used to partition a new or nonpartitioned server varies by server type.

**Partitioning a new or nonpartitioned IBM System i5 or eServer i5 managed system using version 7 or later of the HMC**

Use this procedure to partition a new or nonpartitioned IBM System i5 or eServer i5 managed system using version 7 or later of the Hardware Management Console (HMC). In this procedure, you will validate the hardware on the managed system, create the logical partitions on the managed system, and designate the service partition for the managed system.

Use this procedure in the following cases:

- You have just received your managed system and want to partition the managed system immediately.
- You have used the managed system as a nonpartitioned server, and now want to partition the managed system.
If you want to create a new logical partition on a managed system that has already been partitioned, then you do not need to perform all of the steps in this procedure. For more information on creating a new logical partition on a managed system that has already been partitioned, see Creating logical partitions using version 7 or later of the HMC.

Before you begin, complete the following tasks:

- Use the System Planning Tool (SPT) to ensure that your hardware configuration supports your desired logical partition configuration.
- If necessary, install additional hardware resources on your managed system to support the partition plan specified by the SPT.
- Set up the HMC to manage your logical partition and the managed system. For information on how to set up the HMC, see Setting up the HMC.
- If you have used the managed system prior to partitioning, back up all data on the managed system.

To partition a new or nonpartitioned IBM System i5 or eServer i5 managed system using version 7 or later of the HMC, you must be a super administrator or operator on the HMC. For more information about user roles, refer to Tasks and roles.

To partition a new or nonpartitioned IBM System i5 or eServer i5 managed system using version 7 or later of the HMC, complete the following steps:

1. Ensure that the managed system is in a state of Standby or Operating. Complete the following:
   a. In the navigation pane, open Systems Management and click Servers.
   b. In the contents pane, find the state of the managed system as displayed in the contents pane under the Status heading.
   c. If the managed system is in a Power off state, select the managed system in the contents pane, click the Tasks button, choose Operations → Power On, select the power-on mode of Partition Standby, click OK, and wait until the contents area displays a Standby state for the managed system.

   If the managed system does not display in the contents pane, or if the managed system is in any state other than Standby or Operating, you must fix the problem before continuing. For more information about correcting the operating state of the managed system, see Correcting the managed system operating state.

2. Verify that a single logical partition exists on the managed system. When you connect a new or nonpartitioned managed system to an HMC, a single logical partition displays in the HMC user interface. All system resources belong to this logical partition. In this procedure, you will use this logical partition to validate the hardware on the managed system. After you validate the hardware on the managed system, you will delete this logical partition and create the logical partitions according to your logical partition plan.
   a. In the navigation pane of the HMC, open Servers and click on the managed system.
   b. In the contents pane, verify that there is only one logical partition in the list of partitions. The name of this logical partition will be the serial number of the managed system, and the logical partition will have one partition profile called default_profile.

   If the logical partition that is described in this step exists, continue to step 4 on page 71. Otherwise, continue to step 3 to reset the managed system.

3. Reset the managed system so that a single logical partition exists on the managed system. Complete the following at your HMC (not remotely) to create this logical partition:
   a. Ensure that the hardware placement in the managed system supports the manufacturing default configuration. If the hardware placement in the managed system does not support the manufacturing default configuration, you must move the hardware so that the hardware placement supports the manufacturing default configuration. For more information on placing the hardware in your managed system to support the manufacturing default configuration, contact your marketing representative or business partner.
b. In the navigation pane, click **Servers**.

c. In the contents pane, select the managed system in the contents area, click the **Tasks** button, choose **Configuration → Manage Partition Data → Initialize** and click **Yes**.

d. In the navigation pane, click **HMC Management**.

e. In the contents pane, click **Open Restricted Shell Terminal**. The Restricted shell command-line interface displays.

f. Type: `lpcfgop -m <managed_system_name> -o clear`. `<managed_system_name>` is the name of managed system as it displays in the content area.

g. Enter 1 to confirm. This step will take several seconds to complete.

4. Ensure that the logical partition is in a Not Activated state. In the navigation pane of the HMC, select the managed system if it is not already selected, and review the state of the logical partition on the managed system. If the logical partition is in a Running state, shut down the logical partition by completing the following steps:

   a. In the contents pane, select the logical partition, click the **Tasks** button, and choose **Properties**.

   b. Ensure that **Power off the system after all the logical partitions are powered off** is cleared, and click **OK**.

   c. Shut down the logical partition using operating system procedures. For more information on shutting down logical partitions using operating system procedures, see Shutting down i5/OS logical partitions.

If the logical partition is in an Error state, complete the following:

   a. In the contents pane, select the logical partition, click the **Tasks** button, and choose **Serviceability → Reference Code History**.

   b. Click the **Reference Code** tab and use the reference codes displayed on the **Reference Code** tab to diagnose and fix the problem. For more information about using reference codes to diagnose and fix problems, see Reference codes list for customers.

5. Identify (or tag) the load source device, alternate restart device, and console device to use for system setup. Identify the HMC as the console device for system setup, regardless of the types of console device that you ultimately plan to use for the logical partitions on your system. The HMC provides the easiest, most reliable method to access a console session during system setup. When you create your logical partitions, you can specify the console of your choice for each logical partition. Also, when you select the load source device and alternate restart device, select the devices that will be used by the first i5/OS logical partition in your SPT plan. To identify the devices to use for system setup, complete the following:

   a. In the contents pane, select the logical partition, click the **Tasks** button, and choose **Configuration → Manage Profiles**.

   b. Select the partition profile, click **Actions**, and choose **Edit**.

   c. Click the **Tagged I/O** tab.

   d. Under **Load source**, click **Select**.

   e. Select the slot in which the load source I/O Adapter (IOA) or the load source I/O Processor (IOP) is installed and click **OK**.

   f. Under **Alternate restart device**, click **Select**.

   g. Select the slot in which the alternate restart device IOA or IOP is installed and click **OK**.

   h. Select **Use HMC console** and click **OK**.

   i. Click **Close**.

6. If Licensed Internal Code was not preinstalled on the server, or if you want to install Licensed Internal Code yourself, then install Licensed Internal Code at this time. For more information on installing Licensed Internal code, see Installing Licensed Internal Code on the new logical partition. When the Licensed Internal Code installation is complete, continue to step 8 on page 72.

7. Activate the logical partition:
a. In the contents pane, select the logical partition, click the Tasks button, and choose Operations → Activate.

b. Click Advanced.

c. Select Manual in the Keylock position field, select B: IPL from the second side of the load source in the IPL type field, and click OK.

d. If you are performing this procedure from the HMC, select Open a terminal window or console session and click OK. If you are performing this procedure remotely, click OK and then open an HMC 5250 console session remotely on the logical partition. For more information about opening an HMC 5250 console session remotely, see Connecting to a 5250 console remotely.

e. Type 1 and press Enter to start a dedicated HMC 5250 console session.

8. Verify that the physical adapters are connected and reporting to the managed system using the Failed and non-reporting hardware resources option in the Hardware Service Manager. Use the Failed and non-reporting hardware resource option to display a list of the logical hardware resources that either failed or did not report to the system at the last IPL.

   Attention: Incorrect use of the Failed and non-reporting hardware resource option can cause damage to data in your system.

   a. In the HMC 5250 console session, type 3 and press Enter to select option 3 [Use Dedicated Service Tools (DST)].

   b. Sign onto DST with a valid user ID and password.

   c. Type 7 and press Enter to select option 7 [Start a service tool].

   d. Type 4 and press Enter to select option 4 [Hardware service manager].

   e. Type 4 and press Enter to select option 4 [Failed and non-reporting hardware resources].

   f. Verify that there are no failed or non-reporting resources. If no failed resources or non-reporting resources exist, the informational message No failed or non-reporting logical hardware resources were found will appear. If there are failed resources, contact your service provider.

         Note: You can verify only the adapters that are supported by i5/OS. Any adapter that is not supported by i5/OS might have an error of unknown or failed hardware.

   g. Press F3 until the Use Dedicated Service Tools (DST) display appears.

   h. Type 7 and press Enter to select option 7 [Start a service tool].

   i. Type 7 and press Enter to select option 7 [Operator panel functions].

   j. Press F10 to power off, press Enter to confirm, close the 5250 console session window, and wait until the logical partition shuts down.

9. If the hardware in the managed system is already in the configuration specified in your SPT configuration plan, then continue to step 15 on page 73.

10. Power off the managed system using your HMC.

    a. In the navigation pane, open Systems Management and click Servers.

    b. In the contents pane, select the managed system in the contents area, click the Tasks button, and choose Operations → Power Off.

    c. Select the Normal power off option and click OK.

11. Move the hardware in the managed system according to your SPT configuration plan.

12. Power on the managed system to the Standby state using your HMC.

    a. In the navigation pane, open Systems Management and click Servers.

    b. In the contents pane, select the managed system in the contents area, click the Tasks button, and choose Operations → Power On.

    c. Select Partition standby as the power-on mode and click OK.

13. Activate the logical partition:

    a. In the navigation pane, open Systems Management, open Servers, and click the managed system.
b. In the contents pane, select the logical partition, click the Tasks button, and choose Operations → Activate.

c. Click Advanced.

d. Select Manual in the Keylock position field, select B: IPL from the second side of the load source in the IPL type field, and click OK.

e. If you are performing this procedure from the HMC, select Open a terminal window or console session and click OK. If you are performing this procedure remotely, click OK and then open an HMC 5250 console session remotely on the logical partition. For more information on opening an HMC 5250 console session remotely, see Connecting to a 5250 console remotely.

f. Type 1 and press Enter to start a dedicated HMC 5250 console session.

14. Verify that the physical adapters are connected and reporting to the managed system using the Failed and non-reporting hardware resources option in the Hardware Service Manager.

Attention: Incorrect use of the Failed and non-reporting hardware resource option can cause damage to data in your system.

a. Type 3 and press Enter to select option 3 [Use Dedicated Service Tools (DST)].

b. Sign onto DST with a valid user ID and password.

c. Type 7 and press Enter to select option 7 [Start a service tool].

d. Type 4 and press Enter to select option 4 [Hardware service manager].

e. Type 4 and press Enter to select option 4 [Failed and non-reporting hardware resources].

f. Verify that there are no failed or non-reporting hardware resources. If no failed or non-reporting hardware resources exist, the informational message No failed or non-reporting logical hardware resources were found will appear. If there are failed resources, contact your service provider.

Note: You can verify only the adapters that are supported by i5/OS. Any adapter that is not supported by i5/OS might have an error of unknown or failed hardware.

g. Press F3 until the Use Dedicated Service Tools (DST) display appears.

h. Type 7 and press Enter to select option 7 [Start a service tool].

i. Type 7 and press Enter to select option 7 [Operator panel functions].

j. Press F10 to power off, press Enter to confirm, close the 5250 console session window, and wait until the logical partition shuts down.

15. Delete the logical partition that owns all of the system resources.

Attention: This procedure erases the logical partition and the logical partition configuration data stored on the partition profiles. This procedure does not affect any of the data stored on the managed system.

a. In the navigation pane, open Systems Management, open Servers, and click the managed system.

b. In the contents pane, ensure that the logical partition is powered off.

c. Select the logical partition, click the Tasks button, and choose Operations → Delete.

d. Click Yes to confirm.

16. Create each logical partition on your managed system according to your logical partition plan. You can do this by importing a system plan file into your HMC and deploying the system plan to the managed system. For more information on creating logical partitions using a system plan, see Managing system plans using version 7 or later of the HMC. You can alternately create the logical partitions by performing the following procedure for each logical partition that you want to create.

a. In the navigation pane, open Systems Management and click Servers.

b. In the contents pane, select the managed system, click the Tasks button, and choose Configuration → Create Logical Partition.
c. Follow the steps in the Create Logical Partition wizard to create a logical partition and a partition profile.

17. Designate one of the i5/OS logical partitions on your managed system as the service partition for the managed system.
   a. In the navigation pane, open **Systems Management** and click **Servers**.
   b. In the contents pane, select the managed system, click the **Tasks** button, and choose **Configuration → Properties**.
   c. In the **Service partition** field, select the logical partition that you want to designate as the service partition.
   d. Click **OK**.

18. Ensure that there is at least one LAN adapter on the HMC that is configured to connect with the logical partitions on your managed system.
   a. In the navigation pane, open **HMC Management**.
   b. Select **HMC Configuration**.
   c. In the contents pane, click **Change Network Settings**.
   d. Click the **LAN Adapters** tab.
   e. Select any LAN adapter other than the eth0 adapter that connects the HMC with the service processor and click **Details**.
   f. On the **LAN Adapter** tab, under **Local area network information**, select **Open**, and select **Partition communication**.
   g. Click the **Firewall Settings** tab.
   h. Ensure that the RMC application is one of the applications displayed in **Allowed Hosts**. If it is not displayed in **Allowed Hosts**, select the RMC application under **Available Applications** and click **Allow Incoming**. The RMC application displays in **Allowed Hosts** to signify that it has been selected.
   i. Click **OK**.

After you have created the logical partitions on your managed system, you must then complete the following tasks:

1. Install operating systems on the logical partitions. For installation procedures for the AIX, i5/OS, and Linux operating systems, refer to Installing operating systems.

2. Change the console device on each i5/OS logical partition to the console device of your choice. For procedures to change the console i5/OS logical partitions, see Changing the i5/OS console from the HMC to Operations Console or twinaxial console.

3. Connect the logical partitions on your managed system to the LAN adapter that you have just configured on the HMC. You can create a virtual LAN to connect the logical partitions on your managed system with each other, bridge the virtual LAN to a physical Ethernet adapter on an external network, and connect the LAN adapter on the HMC to the same external network. Alternately, you can configure a physical Ethernet adapter on each logical partition, connect the physical Ethernet adapters on the logical partitions to an external network, and connect the LAN adapter on the HMC to the same external network. For information on how to create and configure virtual Ethernet adapters for your logical partitions, see Configuring a virtual Ethernet adapter using version 7 or later of the HMC.
Related concepts

“Shutting down i5/OS logical partitions” on page 163
The correct way to shut down an i5/OS logical partition safely is from an i5/OS command line.

“System plan overview for the HMC” on page 195
Learn about system plan concepts and operations, as well as understand the high-level tasks that you can perform with system plans when using the Hardware Management Console (HMC).

Related tasks

“Creating logical partitions using version 7 or later of the HMC” on page 91
You can use the Create Logical Partition wizard on the Hardware Management Console (HMC) to create a new logical partition. When you create a logical partition, you also create a partition profile that contains the resource allocations and settings for the logical partition.

“Configuring a virtual Ethernet adapter using version 7 or later of the HMC” on page 95
You can configure a virtual Ethernet adapter dynamically for a running logical partition. Doing so will connect the logical partition to a virtual LAN.

Related information

Tasks and roles
Setting up the HMC
Correcting the managed system operating state
Connecting to a 5250 console remotely
Installing Licensed Internal Code on the new logical partition
Reference codes list for customers
Installing operating systems
Changing consoles, interfaces, and terminals

Partitioning a new or nonpartitioned IBM System p5, eServer p5 or IntelliStation POWER 285 managed system using version 7 or later of the HMC

Use this procedure to partition a new or nonpartitioned IBM System p5, eServer p5 or IntelliStation POWER 285 managed system using version 7 or later of the Hardware Management Console (HMC). In this procedure, you will validate the hardware on the managed system and create the logical partitions on the managed system.

Use this procedure in the following cases:
- You have just received your managed system and want to partition the managed system immediately.
- You have used the managed system as a nonpartitioned server, and now want to partition the managed system.

If you want to create a new logical partition on a managed system that has already been partitioned, then you do not need to perform all of the steps in this procedure. For more information about creating a new logical partition on a managed system that has already been partitioned, see Creating logical partitions using version 7 or later of the HMC.

Before you begin, complete the following:
- Use the System Planning Tool (SPT) to ensure that your hardware configuration supports your desired logical partition configuration.
- If necessary, install additional hardware resources on your managed system to support the partition plan specified by the SPT.
- Set up the HMC to manage your logical partition and the managed system. For information on how to set up the HMC, see Setting up the HMC.
- If you have used the managed system prior to partitioning, back up all data on the managed system.
To partition a new or nonpartitioned IBM System p5, eServer p5 or IntelliStation POWER 285 managed system using version 7 or later of the HMC, you must be a super administrator or operator on the HMC. For more information about user roles, refer to Tasks and roles.

To partition a new or nonpartitioned IBM System p5, eServer p5 or IntelliStation POWER 285 managed system using version 7 or later of the HMC, complete the following steps:

1. Ensure that the managed system is in a state of Standby or Operating. Complete the following:
   a. In the navigation pane, open Systems Management and click Servers.
   b. In the contents pane, find the state of the managed system as displayed in the contents pane under the Status heading.
   c. If the managed system is in a Power off state, select the managed system in the contents pane, click the Tasks button, choose Operations → Power on, select the power-on mode of Partition Standby, click OK, and wait until the contents area displays a Standby state for the managed system.

   If the managed system does not display in the contents pane, or if the managed system is in any state other than Standby or Operating, you must fix the problem before continuing. For more information about correcting the operating state of the managed system, see Correcting the managed system operating state.

2. Verify that a single logical partition exists on the managed system. When you connect a new or nonpartitioned managed system to an HMC, a single logical partition displays in the HMC user interface. All system resources belong to this logical partition. In this procedure, you will use this logical partition to validate the hardware on the managed system. After you validate the hardware on the managed system, you will delete this logical partition and create the logical partitions according to your logical partition plan.
   a. In the navigation pane of the HMC, open Servers and click on the managed system.
   b. In the contents pane, verify that there is only one logical partition in the list of partitions. The name of this logical partition will be the serial number of the managed system, and the logical partition will have one partition profile named default_profile.

   If the logical partition that is described in this step exists, continue to step 4. Otherwise, continue to step 3 to reset the managed system.

3. Reset the managed system so that a single logical partition exists on the managed system. Complete the following at your HMC (not remotely) to create this logical partition:
   a. Ensure that the hardware placement in the managed system supports the manufacturing default configuration. If the hardware placement in the managed system does not support the manufacturing default configuration, you must move the hardware so that the hardware placement supports the manufacturing default configuration. For more information about placing the hardware in your managed system to support the manufacturing default configuration, contact your marketing representative or business partner.
   b. In the navigation pane, click Servers.
   c. In the contents pane, select the managed system in the contents area, click the Tasks button, choose Configuration → Manage Partition Data → Initialize and click Yes.
   d. In the navigation pane, click HMC Management.
   e. In the contents pane, click Open Restricted Shell Terminal. The Restricted shell command-line interface displays.
   f. Type: lpcfgop -m managed_system_name -o clear. managed_system_name is the name of managed system as it displays in the content area.
   g. Enter 1 to confirm. This step will take several seconds to complete.

4. Ensure that the logical partition is in a Not Activated state. In the navigation pane of the HMC, select the managed system if it is not already selected, and review the state of the logical partition on the managed system. If the logical partition is in a Running state, shut down the logical partition by completing the following steps:
a. In the contents pane, select the logical partition, click the **Tasks** button, and choose **Properties**.
b. Ensure that **Power off the system after all the logical partitions are powered off** is cleared, and click **OK**.
c. Shut down the logical partition using operating system procedures. For more information about shutting down logical partitions using operating system procedures, see the following information:
   - For managed systems running AIX, see Shutting down AIX logical partitions using version 7 or later of the HMC.
   - For managed systems running Linux, see Shutting down Linux logical partitions using version 7 or later of the HMC.

If the logical partition is in an **Error** state, complete the following:

a. In the contents pane, select the logical partition, click the **Tasks** button, and choose **Serviceability** → **Reference Code History**.
b. Click the **Reference Code** tab and use the reference codes displayed on the **Reference Code** tab to diagnose and fix the problem. For more information about using reference codes to diagnose and fix problems, see Reference codes list for customers.

5. Activate the logical partition and verify that the physical adapters on the managed system are connected and reporting to the managed system using the configuration manager. If AIX is not installed on your managed system, continue with step [6] You can use the configuration manager in AIX to view all of the available devices. When AIX boots and the configuration manager runs, the configuration manager displays all the working adapters. The recognized adapters will be in the **Available** state if they are configured correctly.

a. In the contents pane, select the logical partition, click the **Tasks** button, and choose **Operations** → **Activate**.
b. Click **Advanced**.
c. In the **Boot mode** field, select **Normal** and click **OK**.
d. Select **Open a terminal window or console session** and click **OK**. A virtual terminal (vterm) window opens for the logical partition.
e. Ensure that all the resources are attached and powered on.
f. Log in to AIX using a valid user name and password.
g. Enter the following command at the command prompt to list all of the adapters on AIX:
   
   ```bash
   # lsdev -Cc adapter
   ```
   If there are any adapters that do not display as **Available**, contact service and support.
   
   **Note:** You can verify only the adapters that are recognized by AIX. Any adapter that is not recognized by AIX might have an error of unknown or failed hardware.

h. Shut down the logical partition using operating system procedures and close the terminal session window. For information on how to shut down AIX, see Shutting down AIX logical partitions using version 7 or later of the HMC.

6. Activate the logical partition and verify that the physical adapters on the managed system are connected and reporting to the managed system using the **System Management Services** (**SMS**) interface. If Linux is installed on the managed system, or if there is no operating system on the managed system, you can use the SMS interface to view the available devices. When the logical partition is activated, the bus is scanned to determine what device adapters are attached. The recognized adapters are listed.

a. In the contents pane, select the logical partition, click the **Tasks** button, and choose **Operations** → **Activate**.
b. Click **Advanced**.
c. In the **Boot mode** field, select **SMS** and click **OK**.
d. Select **Open a terminal window or console session** and click **OK**. A virtual terminal (vterm) window opens for the logical partition.

e. When the SMS interface is displayed, type 5 and press Enter to select option 5 [Select Boot Options].

f. Type 1 and press Enter to select option 1 [Select Install or Boot a Device]

g. Type 7 and press Enter to select option 7 [List all Devices]. All of the recognized devices in the partition are listed. If there are any devices that do not display, contact service and support.

   **Note:** You can verify only the adapters that are recognized by SMS. Any adapter that is not recognized by SMS might have an error of unknown or failed hardware.

h. Close the terminal session window, click the **Tasks** button, and choose **Operations → Shut down**, and click **OK**.

7. If the hardware in the managed system is already in the configuration specified in your SPT configuration plan, then continue to step 13 on page 79.

8. Power off the managed system using your HMC.
   a. In the navigation pane, open **Systems Management** and click **Servers**.
   b. In the contents pane, select the managed system in the contents area, click the **Tasks** button, and choose **Operations → Power Off**.
   c. Select the Normal power off option and click **OK**.

9. Move the hardware in the managed system according to your SPT configuration plan.

10. Power on the managed system to the Standby state using your HMC.
   a. In the navigation pane, open **Systems Management** and click **Servers**.
   b. In the contents pane, select the managed system in the contents area, click the **Tasks** button, and choose **Operations → Power On**.
   c. Select Partition standby as the power-on mode and click **OK**.

11. Activate the logical partition and verify that the physical adapters on the managed system are connected and reporting to the managed system using the configuration manager. If AIX is not installed on the managed system, continue with step [12 on page 79] You can use the configuration manager in AIX to view all of the available devices. When AIX boots and the configuration manager runs, the configuration manager displays all the working adapters. The recognized adapters will be in the Available state if they are configured correctly.
   a. In the navigation pane, open **Systems Management**, open **Servers**, and click the managed system.
   b. In the contents pane, select the logical partition, click the **Tasks** button, and choose **Operations → Activate**.
   c. Click Advanced.
   d. In the **Boot mode** field, select Normal and click **OK**.
   e. Select **Open a terminal window or console session** and click **OK**. A virtual terminal (vterm) window opens for the logical partition.
   f. Ensure that all the resources are attached and powered on.
   g. Log in to AIX using a valid user name and password.
   h. Enter the following command at the command prompt to list all of the adapters on AIX: `# lscdev -Cc adapter`. If there are any adapters that do not display as Available, contact service and support.

   **Note:** You can verify only the adapters that are recognized by AIX. Any adapter that is not recognized by AIX might have an error of unknown or failed hardware.

i. Shut down the logical partition using operating system procedures and close the terminal session window. For information on how to shut down AIX, see Shutting down AIX logical partitions using version 7 or later of the HMC.
12. Activate the logical partition and verify that the physical adapters on the managed system are
cconnected and reporting to the managed system using the System Management Services (SMS)
interface. If Linux is installed on the managed system, or if there is no operating system on the
managed system, you can use the SMS interface to view the available devices. When the logical
partition is activated, the bus is scanned to determine what device adapters are attached. The
recognized adapters are listed.
   a. In the navigation pane, open Systems Management, open Servers, and click the managed
      system.
   b. In the contents pane, select the logical partition, click the Tasks button, and choose Operations →
      Activate.
   c. Click Advanced.
   d. In the Boot mode field, select SMS and click OK.
   e. Select Open a terminal window or console session and click OK. A virtual terminal (vterm)
      window opens for the logical partition.
   f. When the SMS interface is displayed, type 5 and press Enter to select option 5 [Select Boot
      Options].
   g. Type 1 and press Enter to select option 1 [Select Install or Boot a Device]
   h. Type 7 and press Enter to select option 7 [List all Devices]. All of the recognized devices in the
      partition are listed. If there are any devices that do not display, contact service and support.

      Note: You can verify only the adapters that are recognized by SMS. Any adapter that is not
      recognized by SMS might have an error of unknown or failed hardware.
   i. Close the terminal session window, click the Tasks button, and choose Operations → Shut down,
      and click OK.

13. Delete the logical partition that owns all of the system resources.
   Attention: This procedure erases the logical partition and the logical partition configuration data
   stored on the partition profiles. This procedure does not affect any of the data stored on the
   managed system.
   a. In the navigation pane, open Systems Management, open Servers, and click the managed
      system.
   b. In the contents pane, ensure that the logical partition is powered off.
   c. Select the logical partition, click the Tasks button, and choose Operations → Delete.
   d. Click Yes to confirm.

14. Create each logical partition on your managed system according to your logical partition plan. You
can do this by importing a system plan file into your HMC and deploying the system plan to the
managed system. For more information about creating logical partitions using a system plan, see
Working with system plans using version 7 or later of the HMC. Alternately, you can create the
logical partitions by performing the following procedure for each logical partition that you want to
create.
   a. In the navigation pane, open Systems Management and click Servers.
   b. In the contents pane, select the managed system, click the Tasks button, and choose
      Configuration → Create Logical Partition.
   c. Follow the steps in the Create Logical Partition wizard to create a logical partition and a partition
      profile.

15. Ensure that there is at least one LAN adapter on the HMC that is configured to connect with the
logical partitions on your managed system.
   a. In the navigation pane, open HMC Management.
   b. Select HMC Configuration.
   c. In the contents pane, click Change Network Settings.
   d. Click the LAN Adapters tab.
e. Select any LAN adapter other than the eth0 adapter that connects the HMC with the service processor and click Details.
f. On the LAN Adapter tab, under Local area network information, select Open, and select Partition communication.
g. Click the Firewall Settings tab.
h. Ensure that the RMC application is one of the applications displayed in Allowed Hosts. If it is not displayed in Allowed Hosts, select the RMC application under Available Applications and click Allow Incoming. The RMC application displays in Allowed Hosts to signify that it has been selected.
i. Click OK.

After you have created the logical partitions on your managed system, you must then complete the following tasks:

1. Install operating systems on the logical partitions. For installation procedures for the AIX, i5/OS, and Linux operating systems, refer to Installing operating systems.

2. Connect the logical partitions on your managed system to the LAN adapter that you have just configured on the HMC. You can create a virtual LAN to connect the logical partitions on your managed system with each other, bridge the virtual LAN to a physical Ethernet adapter on an external network, and connect the LAN adapter on the HMC to the same external network. Alternately, you can configure a physical Ethernet adapter on each logical partition, connect the physical Ethernet adapters on the logical partitions to an external network, and connect the LAN adapter on the HMC to the same external network. For information on how to create and configure virtual Ethernet adapters, see Configuring a virtual Ethernet adapter using version 7 or later of the HMC.

Related concepts
“System plan overview for the HMC” on page 195
Learn about system plan concepts and operations, as well as understand the high-level tasks that you can perform with system plans when using the Hardware Management Console (HMC).

Related tasks
“Creating logical partitions using version 7 or later of the HMC” on page 91
You can use the Create Logical Partition wizard on the Hardware Management Console (HMC) to create a new logical partition. When you create a logical partition, you also create a partition profile that contains the resource allocations and settings for the logical partition.

“Configuring a virtual Ethernet adapter using version 7 or later of the HMC” on page 95
You can configure a virtual Ethernet adapter dynamically for a running logical partition. Doing so will connect the logical partition to a virtual LAN.

Related information
Tasks and roles
Setting up the HMC
Correcting the managed system operating state
Shutting down AIX using the HMC
Shutting down Linux using the HMC
Reference codes list for customers
Installing operating systems

Working with system plans using version 7 or later of the HMC
A system plan is a specification of the hardware and the logical partitions contained in one or more systems.

You can create a logical partition configuration on a managed system by using your Hardware Management Console (HMC) to deploy a system plan. You can also use your HMC to create a system
plan based upon an existing logical partition configuration. This allows you to keep a permanent record of the logical partition configuration at a specific time.

**Importing a system plan by using HMC Version 7**
You can import a system-plan file into a Hardware Management Console (HMC) from various types of media, a remote FTP site, or the computer from which you remotely access the HMC. You can then deploy the imported system plan to a system that the HMC manages.

You can import a system-plan file into the HMC from any of the following locations:
- From the computer on which you remotely access the HMC.
- From various media, such as optical discs or USB drivers, that is mounted on the HMC.
- From a remote site by using FTP. To use this option, you must fulfill the following requirements:
  - The HMC must have a network connection to the remote site.
  - An FTP server must be active on the remote site.
  - Port 21 must be open on the remote site.

*Note:* You cannot import a system plan that has an identical name to any system plan that is available on the HMC.

To import a system-plan file, you must be a super administrator. For more information about user roles, refer to Tasks and roles.

To import a system-plan file into Version 7 of the HMC, complete the following steps:
1. In the navigation area of the HMC, select **System Plans**.
2. In the tasks area, select **Import System Plan**. The Import System Plan window opens.
3. Select the source of the system-plan file that you want to import. Use the following table to complete the appropriate steps for importing the system plan from the selected source location of the file:

<table>
<thead>
<tr>
<th>Source of the system plan to import</th>
<th>Complete the following steps:</th>
</tr>
</thead>
</table>
| This computer                      | 1. Select **Import from this computer to the HMC**  
2. Click **Import** to display the Upload File window  
3. Click **Browse**.  
4. Select the system-plan file that you want to import and click **Open**.  
5. Click **OK** to upload the file. |
| Media                              | 1. Select **Import from media**.  
2. In the **System plan file name** field, enter the name of the system-plan file.  
   *Note:* The name of the system-plan file must end with the .sysplan file name suffix and can use alphanumeric characters only.  
3. In the **Sub-directory on media** field, enter the path in which the system-plan file is located on the media.  
   *Note:* Specify the subdirectory location only, rather than the fully qualified path and file name.  
4. Click **Import** to display the Select Media Device window.  
5. Select the media that contains the system-plan file you want to import.  
6. Click **OK**. |
Source of the system plan to import | Complete the following steps:
---|---
Remote FTP site | 1. Select *Import from a remote FTP site*.
2. In the *System plan file name* field, enter the name of the system-plan file.
   *Note:* The name of the system-plan file must end with the .sysplan file name suffix and can use alphanumeric characters only.
3. In the *Remote site hostname* field, enter the host name or IP address of the remote FTP site.
4. In the *User ID* field, enter the user ID to use to access the remote FTP site.
5. In the *Password* field, enter the password to use to access the remote FTP site.
6. In the *Remote directory* field, enter the path in which the system-plan file is located on the remote FTP site. If you do not enter a path, the HMC uses the default path specified on the remote FTP site.

4. Click *Import*. If the HMC returns an error, return to the *Import System Plan* window and verify that the information you entered is correct. If necessary, click *Cancel*, return to step 2 and redo the procedure, ensuring that the information you specify at each step is correct.

When you complete the process of importing the system-plan file, you can deploy the system plan in the system-plan file to a system that the HMC manages. For instructions, see Deploying a system plan using HMC version 7. If you imported the system-plan file from media, you can unmount the media by using the umount command in the HMC command line interface.

*Note:* As an alternative to the HMC Web user interface, you can use the *cpysysplan* command from the HMC command line interface to import a system plan.

**Related tasks**

- "Creating a system plan by using HMC Version 7" on page 85
- "Deleting a system plan by using HMC version 7" on page 90
- "Deploying a system plan by using HMC Version 7"
- "Exporting a system plan by using HMC Version 7" on page 87
- "Viewing a system plan by using HMC version 7" on page 89

**Related information**

**Tasks and roles**

**Deploying a system plan by using HMC Version 7**

You can use the Hardware Management Console (HMC) to deploy all or part of a system plan to a managed system.

When you deploy a system plan, the HMC creates logical partitions on the managed system according to the specifications in the system plan. Depending on the contents of the system plan, you can also install
operating environments on the partitions in the plan and, if the plan contains Virtual I/O Server provisioning information for a partition, such as storage assignments, the HMC can make these resource assignments for the partition.

Before you deploy a system plan, complete the following tasks:

- Ensure that the system-plan file exists on the HMC. If the system-plan file does not exist on the HMC, you must import the system-plan file into the HMC. For instructions, see Importing a system plan using HMC version 7.

- Verify that the physical hardware and any expansion units are connected and reporting to the server. Each server comes with one logical partition and one partition profile. All of the physical hardware resources on the system are assigned automatically to this logical partition so that you can power on the server and verify that the physical hardware is connected and reporting to the server.

- Delete the logical partition that was provided with your server, and delete any other logical partition that is not in the system plan. For instructions, see Deleting a logical partition. The name of the logical partition that was provided with the server is the serial number of the managed system, and the name of the partition profile is default_profile.

- If the system plan includes a Storage Area Network (SAN) or Fibre Channel adapters, ensure that the adapters are cabled and the SAN is configured.

- If you plan to deploy the Virtual I/O Server, then ensure that its installation image is on the HMC. To see the installation images on the HMC, enter this command 0S_install -l on the HMC command line. If the Virtual I/O Server installation image is not listed, then complete the following steps to copy an installation image to the HMC:
  1. Obtain a copy of the Virtual I/O Server on DVD. You can use the original installation media or you can contact your sales representative to obtain another copy. If you cannot obtain a copy of the Virtual I/O Server, you can deploy the remainder of the system plan and install the Virtual I/O Server at a later time.
  2. Insert the DVD into the DVD drive on the HMC.
  3. From the HMC command line, use the OS_install command to copy the Virtual I/O Server installation image from the DVD to the HMC. For example, you can enter the following command:

```
0S_install -o define_resource -a type=AIX -a version=1.4.0.0 -a location=/export/resources/vios -a source=/dev/cdrom vios1_install_res.
```

- Excluding the Virtual I/O Server logical partitions, shut down any logical partitions that you have already deployed to the managed system from the system plan. For Virtual I/O Server partitions previously deployed, ensure that they are active, and that there is an Resource Monitoring and Control (RMC) connection between the HMC and each Virtual I/O Server partition.

- Ensure that you are not using this HMC or any other HMC that is attached to the managed system to perform any other operations on the managed system.

- Ensure that you are a super administrator. For information about user roles, refer to Tasks and roles.

To use the HMC to deploy a system plan on a managed system, complete the following steps:

1. In the navigation area of the HMC, select System Plans.
2. In the contents area, select the system plan that you want to deploy.
3. Click Tasks and select Deploy system plan. The Deploy System Plan wizard starts.
4. On the Welcome page, complete the following steps:
   a. Select the system-plan file that contains the system plan that you want to deploy.
   b. Choose the managed system to which you want to deploy the system plan and click Next. If the system plan does not match the managed system to which you want to deploy the plan, the wizard displays a window that informs you of this. Click OK to continue or Cancel to select a different system plan.
Note: If the system-plan file contains multiple system plans, the wizard provides a step so that you can select a specific system plan from the file. This step does not occur unless there is more than one system plan in the specified file.

5. On the Validation page, complete the following steps:
   a. Wait for the wizard to validate the managed system and its hardware against the system plan. The validation process can take several minutes.
   b. If the validation process completes successfully, click Next.
   c. If the validation process does not complete successfully, correct the issues that the error messages describe, click Cancel to exit the wizard, and restart this procedure from the beginning.
   d. If the validation process fails, you might want to create a system plan that is based on the current configuration of the managed system. Such a system plan would allow you to compare the system plan that you want to deploy with the current configuration of the managed system. You can do this by using the Create System Plan task in the HMC, or you can run the following command from the HMC command line: mksysplan -m name_of_managed_system -f name_of_new_system_plan.sysplan. This action creates a new system plan that you can view and compare to the old system plan to help diagnose any problems.

6. Optional: On the Partition Deployment page, if you do not want to create all of the logical partitions, partition profiles, virtual adapter types, or virtual adapters in the system plan, clear the boxes in the Deploy column beside the logical partitions, partition profiles, virtual adapter types, or virtual adapters that you do not want to create. Virtual serial adapters are required in virtual slots 0 and 1 for each logical partition. You cannot create the logical partition unless you create these virtual serial adapters.

7. Optional: On the Operating Environment Install page, if there are operating environments specified in the system plan, complete the following steps:
   a. Select the operating environments that you want to deploy to the managed system for each partition. At this time, you can select to deploy the Virtual I/O Server operating environment only.
   b. Enter the location of the Virtual I/O Server installation image.
   c. Enter or change late-binding installation settings for the Virtual I/O Server. Late-binding installation settings are settings that are specific to the installation instance and must be supplied during the installation step to ensure that the settings are accurate for the installation instance. For example, you can enter the IP address of the target partition on which you are installing the operating environment.
   d. Save any changes that you make to late-binding installation settings. You can save them to the current system-plan file or to a new system-plan file.

8. On the Summary page, review the system deployment step order and click Finish. The HMC uses the system plan to create the specified logical partitions and to install any specified operating environments. This process can take several minutes.

After you finish the deployment of the system plan, complete the following tasks:
1. Locate the physical disk I/O adapters that belong to each logical partition and verify that the disk drives that are attached to these physical I/O adapters will support your desired configuration for each logical partition. The Deploy System Plan wizard validates only that the physical disk I/O adapters match the system plan. It does not validate that the disk drives are configured for the physical disk I/O adapters.
2. Install operating systems and software on the logical partitions.
3. Configure the virtual I/O adapters that are assigned to each logical partition within the operating systems so that virtual storage resources can be shared among logical partitions.
Related tasks

“Creating a system plan by using HMC Version 7”
You can use the Hardware Management Console (HMC) Version 7 to create a new system plan based on an existing system configuration, and then deploy that system plan to other managed systems.

“Deleting a system plan by using HMC version 7” on page 90
You can remove a system plan from your Hardware Management Console (HMC) Version 7.

“Exporting a system plan by using HMC Version 7” on page 87
You can export a system-plan file from a Hardware Management Console (HMC) to various types of media, a remote FTP site, or the computer from which you remotely access the HMC.

“Importing a system plan by using HMC Version 7” on page 81
You can import a system-plan file into a Hardware Management Console (HMC) from various types of media, a remote FTP site, or the computer from which you remotely access the HMC. You can then deploy the imported system plan to a system that the HMC manages.

“Viewing a system plan by using HMC version 7” on page 89
You can use the System Plan Viewer on the Hardware Management Console (HMC) to view a system plan.

Related information

Deleting a logical partition
Installing operating systems
Installing the Virtual I/O Server
Tasks and roles

Creating a system plan by using HMC Version 7

You can use the Hardware Management Console (HMC) Version 7 to create a new system plan based on an existing system configuration, and then deploy that system plan to other managed systems.

You can use the newly-created system plan to create identical logical partition configurations on managed systems with identical hardware. The new system plan contains specifications for the logical partitions and partition profiles of the managed system that you used to create the plan. The new system plan also can contain hardware information that the HMC is able to obtain from the selected managed system. However, the amount of hardware information that the HMC can capture for the new system plan varies based on the method that the HMC uses to gather the hardware information. There are two methods that the HMC potentially can use: inventory gathering and hardware discovery. For example, using inventory gathering, the HMC can detect virtual device configuration information for the Virtual I/O Server. Additionally, the HMC can use one or both of these methods to detect disk and tape information for i5/OS.

Inventory gathering prerequisites

The HMC always performs inventory gathering to capture detailed information for hardware that has an assignment to an active partition. To maximize the amount of data that the inventory gathering process of the HMC is able to collect from the managed system, ensure that you complete the following tasks:

• Ensure that the managed system in the ‘Standby’ state or that the managed system is powered on.

Note: You cannot create a system plan if the managed server is in either the power off state or the recovery state.

• Ensure that all the logical partitions on the managed system from which you plan to base the new system plan are activated.

• To ensure that Linux systems and partitions can perform inventory gathering, you must load the IBM Installation Toolkit for Linux on POWER, which is available at the IBM Service and productivity tools Web site (http://www14.software.ibm.com/webapp/set2/sas/f/lopdiags/installtools/home.html).
Ensure that there is an Resource Monitoring and Control (RMC) connection between the HMC and each logical partition. An RMC connection is required for the inventory-gathering process. An RMC connection also is required to configure Virtual I/O Server and to collect data for Virtual I/O Server device mappings.

**Note:** It is possible for an i5/OS partition to have more than one HMC set up to manage it. In this situation, if you want to use RMC to create a new system plan, you must ensure that you create the system plan from the primary HMC for the partition because secondary HMCs cannot use RMC.

To ensure that the HMC can use RMC, complete the following steps:

1. In the HMC navigation pane, select **HMC Management**.
2. In the contents pane, select **Change Network Settings** to display the Customize Network Settings window.
3. Click **LAN Adapters**, select the appropriate adapter from the list, and click **Details**.
4. On the LAN Adapter page of the LAN Adapters Details window, ensure that **Partition communication** is selected.
5. On the Firewall page, in the Firewall Settings list, select all instances of RMC, and click **Allow Incoming**, if necessary.
6. Click **OK** to close the LAN Adapter Details window.
7. Click **OK** to close the Customize Network Settings window.
8. Restart the HMC if you made any changes to these configuration settings.

For some operating systems, you might need to perform additional steps to ensure that RMC is configured and running correctly. To learn more about configuring and using RMC, review the appropriate operating system documentation.

**Hardware discovery prerequisites**

If the managed system supports hardware discovery, the HMC can use it, in addition to the inventory-gathering process, to capture hardware information for a new system plan. The hardware discovery process allows you to capture hardware configuration information, regardless of the state of the hardware. Using hardware discovery, you can capture information about hardware that does not have a partition assignment, as well as hardware with assignments to inactive partitions.

To use the hardware discovery process, ensure that you complete the following tasks:

- Ensure that there is a minimum of .5 processor available.
- Ensure that there is a minimum of 256 MB of free memory available.
- Ensure that all partitions on the managed server for which you want to use the hardware discovery process are inactive. If a partition is active, the hardware discovery process cannot capture fresh information from the partition and retrieves information about the hardware assigned to the inactive partition from the hardware inventory cache on the managed system instead.

**Note:** Hardware discovery does not require the use of RMC.

To create a system plan from Version 7 of the Hardware Management Console, complete the following steps:

1. From the navigation area, select **System Plans**. The System Plans page opens.
2. From the Tasks area, select **Create System Plan**. The Create System Plan window opens.
3. Select the managed system that you want to use as the basis for the new system plan.
4. Enter a name and description for the new system plan.
5. Optional: Select whether you want to retrieve inactive and unallocated hardware resources. This option appears only if the managed system is capable of hardware discovery and the option is selected by default.

**Note:** If you do not select the **Retrieve inactive and unallocated hardware resources** option, the HMC does not perform hardware discovery. The HMC still performs inventory gathering and retrieves hardware information for any active partitions on the managed server. The resulting new system plan contains hardware information from the inventory-gathering process, as well as hardware information from the hardware inventory cache on the system.

6. Optional: Select whether you want to view the system plan immediately after the HMC creates it.

7. Click **Create**.

Now that you have a new system plan, you can export the system plan, import it onto another managed system, and deploy the system plan to the managed system.

**Note:** As an alternative to the HMC Web user interface, you can use the mksysplan command on the HMC to create a system plan based upon the configuration of an existing managed system.

**Related tasks**

- "Deleting a system plan by using HMC version 7" on page 90
- "Deploying a system plan by using HMC Version 7" on page 82
- "Exporting a system plan by using HMC Version 7" on page 81
- "Importing a system plan by using HMC Version 7" on page 81
- "Viewing a system plan by using HMC version 7" on page 89

**Related information**

- mksysplan Command

**Exporting a system plan by using HMC Version 7**

You can export a system-plan file from a Hardware Management Console (HMC) to various types of media, a remote FTP site, or the computer from which you remotely access the HMC.

You can export a system-plan file from the HMC to any of the following locations:

- To the computer on which you remotely access the HMC.
- To media that is mounted on the HMC (such as optical discs or USB drives).
- To a remote site by using FTP. This allows you to import the system-plan file into a different HMC and deploy the system plan to a managed system with identical hardware. To use this option, you must fulfill the following requirements:
  - The HMC must have a network connection to the remote site.
  - An FTP server must be active on the remote site.
  - Port 21 must be open on the remote site.

To export a system-plan file, you must be a super administrator. For more information about user roles, refer to Tasks and roles.
To export a system-plan file that is stored on Version 7 of the HMC, complete the following steps:

1. In the navigation area of your HMC, select System Plans.
2. In the contents area, select the system-plan file that you want to export.
3. Click Tasks and select Export System Plan. The Export System Plan window opens.
4. Select the export destination for the system plan. Use the following table to complete the appropriate steps for exporting the system plan to the selected destination location of the file:

<table>
<thead>
<tr>
<th>Export destination for the system plan</th>
<th>Complete the following steps:</th>
</tr>
</thead>
<tbody>
<tr>
<td>This computer</td>
<td>1. Select Export to this computer from the HMC.</td>
</tr>
<tr>
<td></td>
<td>2. Click Export to display the Save File window.</td>
</tr>
<tr>
<td></td>
<td>3. Click the file name link and use the save file function of your browser to save the file to a location on your local file system.</td>
</tr>
<tr>
<td></td>
<td>4. Click OK to close the window after you have saved the file.</td>
</tr>
<tr>
<td>Media</td>
<td>1. Select Export to media.</td>
</tr>
<tr>
<td></td>
<td>2. In the Sub-directory on media field, enter the path on the media to which to export the system-plan file.</td>
</tr>
<tr>
<td></td>
<td>Note: Specify the subdirectory location only, rather than the fully qualified path and file name.</td>
</tr>
<tr>
<td></td>
<td>3. Click Export to display the Select Media Device window.</td>
</tr>
<tr>
<td></td>
<td>4. Select the media to which you want to export the system plan file.</td>
</tr>
<tr>
<td></td>
<td>5. Click OK.</td>
</tr>
<tr>
<td>Remote FTP site</td>
<td>1. Select Export to a remote site.</td>
</tr>
<tr>
<td></td>
<td>2. Enter the host name or IP address of the remote FTP site into the Remote site hostname field.</td>
</tr>
<tr>
<td></td>
<td>3. Enter the user ID to use to access the remote FTP site into the User ID field.</td>
</tr>
<tr>
<td></td>
<td>4. Enter the password to use to access the remote FTP site into the Password field.</td>
</tr>
<tr>
<td></td>
<td>5. Enter the path to which you want to export the system-plan file into the Remote directory field. If you do not enter a path, the HMC exports the system-plan file to the default path specified on the remote FTP site.</td>
</tr>
</tbody>
</table>

5. Click Export. If the HMC returns an error, verify that the information you entered on this window is correct. If necessary, click Cancel, return to step 4 and redo the procedure, ensuring that the information you specify at each step is correct.

If you exported the system-plan file to media, you can unmount the media by using the umount command in the HMC command-line interface. You can then import the system-plan file into a different HMC so that you can deploy the system plan to systems that the other HMC manages. For more information about importing the system-plan file into a different HMC, see Importing a system plan.

Note: As an alternative to the HMC Web user interface, you can use the cpysysplan command from the HMC command line interface to export a system plan.
Related tasks
“Creating a system plan by using HMC Version 7” on page 85
You can use the Hardware Management Console (HMC) Version 7 to create a new system plan based on an existing system configuration, and then deploy that system plan to other managed systems.

“Deleting a system plan by using HMC version 7” on page 90
You can remove a system plan from your Hardware Management Console (HMC) Version 7.

“Deploying a system plan by using HMC Version 7” on page 82
You can use the Hardware Management Console (HMC) to deploy all or part of a system plan to a managed system.

“Importing a system plan by using HMC Version 7” on page 81
You can import a system-plan file into a Hardware Management Console (HMC) from various types of media, a remote FTP site, or the computer from which you remotely access the HMC. You can then deploy the imported system plan to a system that the HMC manages.

“Viewing a system plan by using HMC version 7”
You can use the System Plan Viewer on the Hardware Management Console (HMC) to view a system plan.

Related information
Tasks and roles

Viewing a system plan by using HMC version 7
You can use the System Plan Viewer on the Hardware Management Console (HMC) to view a system plan.

The System Plan Viewer uses a navigation tree and tables to display the information in the system-plan file. It includes features such as dynamic table-column sorting and the ability to display EADS boundary lines. The System Plan Viewer is included with the HMC so that it can be accessed from the HMC. However, you must re-enter your user ID and password before you can view the system plan.

To view a system plan from version 7 of the HMC, complete the following steps:
1. From the navigation area, select System Plans.
2. In the contents area, select the system plan that you want to view.
3. Click Tasks and select View System Plan. The System Plan Viewer opens in a separate browser window.

   Note: You can also open the system plan in the System Plan Viewer by clicking on the name of the system plan.
4. Enter your HMC Username and Password to log in to the System Plan Viewer.
Related tasks

“Creating a system plan by using HMC Version 7” on page 85
You can use the Hardware Management Console (HMC) Version 7 to create a new system plan based on an existing system configuration, and then deploy that system plan to other managed systems.

“Deleting a system plan by using HMC version 7”
You can remove a system plan from your Hardware Management Console (HMC) Version 7.

“Deploying a system plan by using HMC Version 7” on page 82
You can use the Hardware Management Console (HMC) to deploy all or part of a system plan to a managed system.

“Exporting a system plan by using HMC Version 7” on page 87
You can export a system-plan file from a Hardware Management Console (HMC) to various types of media, a remote FTP site, or the computer from which you remotely access the HMC.

“Importing a system plan by using HMC Version 7” on page 81
You can import a system-plan file into a Hardware Management Console (HMC) from various types of media, a remote FTP site, or the computer from which you remotely access the HMC. You can then deploy the imported system plan to a system that the HMC manages.

Related information

System Planning Tool Web site

Deleting a system plan by using HMC version 7
You can remove a system plan from your Hardware Management Console (HMC) Version 7.

Removing a system plan from the Hardware Management Console (HMC) does not undo any partition or hardware configuration changes that occurred if the specified system plan was deployed on a managed system.

To remove a system plan from Version 7 of the HMC, complete the following steps:

1. From the navigation area, select System Plans.
2. In the contents area, select the system plan that you want to delete.
3. Click Tasks and select Remove System Plan. The Remove System Plans window opens.
4. Confirm that the system plan is the one that you want to remove and click Remove System Plan to delete the system plan.
Related tasks

“Creating a system plan by using HMC Version 7” on page 85
You can use the Hardware Management Console (HMC) Version 7 to create a new system plan based on an existing system configuration, and then deploy that system plan to other managed systems.

“Deploying a system plan by using HMC Version 7” on page 82
You can use the Hardware Management Console (HMC) to deploy all or part of a system plan to a managed system.

“Exporting a system plan by using HMC Version 7” on page 87
You can export a system-plan file from a Hardware Management Console (HMC) to various types of media, a remote FTP site, or the computer from which you remotely access the HMC.

“Importing a system plan by using HMC Version 7” on page 81
You can import a system-plan file into a Hardware Management Console (HMC) from various types of media, a remote FTP site, or the computer from which you remotely access the HMC. You can then deploy the imported system plan to a system that the HMC manages.

“Viewing a system plan by using HMC version 7” on page 89
You can use the System Plan Viewer on the Hardware Management Console (HMC) to view a system plan.

Configuring logical partitions using version 7 or later of the HMC
The Create Logical Partition wizard on the Hardware Management Console (HMC) guides you through the procedure of creating logical partitions and partition profiles on your server.

Creating logical partitions using version 7 or later of the HMC
You can use the Create Logical Partition wizard on the Hardware Management Console (HMC) to create a new logical partition. When you create a logical partition, you also create a partition profile that contains the resource allocations and settings for the logical partition.

Use this procedure only if you are creating logical partitions on a managed system that has already been partitioned. If you are creating logical partitions on a new or nonpartitioned managed system, you must test the hardware on your managed system to ensure that the hardware is in working order. Testing the hardware helps you detect potential problems with your managed system and makes such problems easier to correct. After you test the hardware, you can create logical partitions on a new or nonpartitioned managed system by deploying a system plan to the managed system. For more information about how to create logical partitions on new and nonpartitioned managed systems, see Partitioning a new or nonpartitioned IBM System p5, eServer p5 or IntelliStation POWER 285 managed system using version 7 or later of the HMC or Partitioning a new or nonpartitioned IBM System i5 or eServer i5 managed system using version 7 or later of the HMC.

You can also create logical partitions on a managed system by deploying a system plan to the managed system. A system plan automates the process of creating logical partitions and ensures that each logical partition gets the resources that are specified within the system plan. For more information about system plans, see System plan overview.

Before you create a logical partition, have the System Planning Tool (SPT) output available. Use the output from this tool as a guide as you start to create partition profiles on your server.

To create a partition profile, you must be a super administrator or an operator. For more information about the role of a super administrator and operator, refer to Tasks and roles.

To create a logical partition and a partition profile on your server using the HMC, follow these steps:
1. In the navigation pane, open Systems Management and click Servers.
2. In the contents pane, select the managed system, click the Tasks button, and choose Configuration → Create Logical Partitions.
3. Follow the steps in the Create Logical Partition wizard to create a logical partition and a partition profile.

After creating your logical partition and partition profile, you must install an operating system. For installation procedures for the AIX, i5/OS, and Linux operating systems, refer to Installing operating systems.

Related concepts

“System plan overview for the HMC” on page 195
Learn about system plan concepts and operations, as well as understand the high-level tasks that you can perform with system plans when using the Hardware Management Console (HMC).

Related tasks

“Partitioning a new or nonpartitioned IBM System i5 or eServer i5 managed system using version 7 or later of the HMC” on page 69
Use this procedure to partition a new or nonpartitioned IBM System i5 or eServer i5 managed system using version 7 or later of the Hardware Management Console (HMC). In this procedure, you will validate the hardware on the managed system, create the logical partitions on the managed system, and designate the service partition for the managed system.

“Partitioning a new or nonpartitioned IBM System p5, eServer p5 or IntelliStation POWER 285 managed system using version 7 or later of the HMC” on page 75
Use this procedure to partition a new or nonpartitioned IBM System p5, eServer p5 or IntelliStation POWER 285 managed system using version 7 or later of the Hardware Management Console (HMC). In this procedure, you will validate the hardware on the managed system and create the logical partitions on the managed system.

“Partitioning a new or nonpartitioned IBM System i5 or eServer i5 managed system using version 7 or later of the HMC” on page 69
Use this procedure to partition a new or nonpartitioned IBM System i5 or eServer i5 managed system using version 7 or later of the Hardware Management Console (HMC). In this procedure, you will validate the hardware on the managed system, create the logical partitions on the managed system, and designate the service partition for the managed system.

Related information

Tasks and roles
Installing operating systems

Configuring partition profiles for logical partitions using version 7 or later of the HMC

You can configure the partition profiles for your logical partitions using the Hardware Management Console (HMC). This allows you to change the resource specifications stored in your partition profiles as your needs change.

Creating additional partition profiles using version 7 or later of the HMC:

You can create more than one partition profile for a logical partition using the Hardware Management Console (HMC). Each partition profile can specify a different amount of system resources and different partition startup attributes. You can change the attributes used by a logical partition by shutting down the logical partition and restarting the logical partition using a different partition profile.

Before you create a partition profile, ensure that you have the System Planning Tool (SPT) output available. Use the output from this tool as a guide as you start to create partition profiles on your server. For more information about the SPT, see System Planning Tool.

To create a partition profile using version 7 or later of the HMC, you must be a super administrator or an operator. For more information about the role of a super administrator and operator, refer to Tasks and roles.
To create a partition profile using version 7 or later of the HMC, follow these steps:

1. In the navigation pane, open **Systems Management**, open **Servers**, and click the name of the managed system.
2. In the contents pane, select the logical partition for which you want to create the partition profile, click the **Tasks** button, and select **Configuration → Manage Profiles**.
3. Click **Actions → New**.
4. Follow the steps in the Create Partition Profile wizard to create the partition profile.

**Related concepts**

“System Planning Tool” on page 62

The System Planning Tool (SPT) helps you design a managed system that can support a specified set of workloads. You can design a managed system based upon workload data from your current systems, based upon new workloads that you want the managed system to support, based upon sample systems that are provided with the utility, or based upon your own custom specifications.

**Related information**

Tasks and roles

**Copying a partition profile using version 7 or later of the HMC:**

You can create a copy of an existing partition profile using the Hardware Management Console (HMC). After you create a copy of the existing partition profile, you can change the resource allocations within the new partition profile. This allows you to create multiple, nearly identical partition profiles without having to re-enter all of the resource allocations repeatedly.

To copy a partition profile using version 7 or later of the HMC, you must be a super administrator, operator, or product engineer. For more information about user roles, refer to Tasks and roles.

To copy a partition profile using version 7 or later of the HMC, follow these steps:

1. In the navigation pane, open **Systems Management**, open **Servers**, and click the name of the managed system.
2. In the contents pane, select the logical partition whose partition profile you want to copy, click the **Tasks** button, and select **Configuration → Manage Profiles**.
3. Select the partition profile that you want to copy and click **Actions → Copy**.
4. Enter the name of the new partition profile into **New profile name** and click **OK**.

**Related information**

Tasks and roles

**Changing partition profile properties using version 7 or later of the HMC:**

You can change the properties of a partition profile using version 7 or later of the Hardware Management Console (HMC). Changing the properties of a partition profile will change the resource amounts that are assigned to a logical partition when you shut down and restart the logical partition using the changed partition profile.

To change partition profile properties using version 7 or later of the HMC, you must be a super administrator, service representative, operator, or product engineer. For more information about user roles, refer to Tasks and roles.

A partition profile stores the required number of processors, memory, and hardware resources assigned to that profile. Any partition profile property changes will not be applied to the logical partition until the partition profile has been activated.

To change partition profile properties using version 7 or later of the HMC, follow these steps:
1. In the navigation pane, open **Systems Management**, open **Servers**, and click the name of the managed system.

2. In the contents pane, select the logical partition whose partition profile you want to change, click the **Tasks** button, and select **Configuration** → **Manage Profiles**.

3. Select the partition profile that you want to change and click **Actions** → **Edit**.

4. Make the appropriate changes and click **OK**.

**Related concepts**

**“Managing 5250 CPW dynamically using version 7 or later of the HMC” on page 159**

You can add, remove, and move 5250 commercial processing workload (5250 CPW) dynamically to and from running logical partitions using the Hardware Management Console (HMC).

**“Managing physical I/O devices and slots dynamically using version 7 or later of the HMC” on page 156**

You can add, remove, and move physical I/O devices and slots dynamically to and from running logical partitions using the Hardware Management Console (HMC). This allows logical partitions to share infrequently used I/O devices (such as optical disc drives).

**“Managing memory dynamically using version 7 or later of the HMC” on page 150**

You can add, remove, and move memory dynamically to and from running logical partitions using the Hardware Management Console (HMC). This allows you to adjust the memory allocated to each logical partition without having to shut down the logical partitions.

**“Managing processor resources dynamically using version 7 or later of the HMC” on page 153**

You can add, remove, and move processor resources dynamically to and from running logical partitions using the Hardware Management Console (HMC). This allows you to adjust the processor resources allocated to each logical partition without having to shut down the logical partitions.

**Related tasks**

**“Configuring a virtual Ethernet adapter using version 7 or later of the HMC” on page 95**

You can configure a virtual Ethernet adapter dynamically for a running logical partition. Doing so will connect the logical partition to a virtual LAN.

**“Saving the partition configuration to a partition profile using version 7 or later of the HMC” on page 162**

Use this procedure to save the current configuration of a logical partition to a new partition profile using a Hardware Management Console (HMC). Use this procedure if you change the configuration of a logical partition using dynamic logical partitioning and you do not want to lose the changes when you reactivate the logical partition. This procedure allows you to save the changed configuration to a new partition profile instead of having to enter the changed resource allocations manually.

**Related information**

Tasks and roles

**Deleting a partition profile using version 7 or later of the HMC:**

You can delete a partition profile using version 7 or later of the HMC Hardware Management Console (HMC). This allows you to remove partition profiles that you no longer use.

To delete a partition profile using version 7 or later of the HMC, you must be a super administrator or an operator. For more information about the role of a super administrator and operator, refer to Tasks and roles.

**Note:** You cannot delete a partition profile that is the default partition profile for the logical partition. If the partition profile you want to delete is the default partition profile, you must first change the default profile to another partition profile.

To delete a partition profile using version 7 or later of the HMC, follow these steps:

1. In the navigation pane, open **Systems Management**, open **Servers**, and click the managed system on which the partition profile is located.
2. In the contents pane, select the logical partition on which the partition profile is located, click the Tasks button, and choose **Configuration → Manage Profiles**.

3. Select the partition profile that you want to delete and click **Actions → Delete**.

4. Click **OK** to confirm.

**Related information**

**Tasks and roles**

**Configuring a virtual Ethernet adapter using version 7 or later of the HMC**

You can configure a virtual Ethernet adapter dynamically for a running logical partition. Doing so will connect the logical partition to a virtual LAN.

You can dynamically configure a virtual Ethernet adapter for a Linux logical partition only if the following conditions are met:

- A Linux distribution that supports dynamic logical partitioning is installed on the Linux logical partition. Distributions that support dynamic logical partitioning include Red Hat Enterprise Linux version 4, SUSE Linux Enterprise Server 9, and later versions of these distributions.
- The DynamicRM tool package is installed on the Linux logical partition. For more information about the DynamicRM tool package, see the Service and productivity tools Web site.

To configure a virtual Ethernet adapter dynamically for a running logical partition using version 7 or later of the HMC, you must be a super administrator, service representative, product engineer, or operator. For more information about user roles, refer to **Tasks and roles**.

To configure a virtual Ethernet adapter dynamically for a running logical partition using version 7 or later of the HMC, follow these steps:

1. In the navigation pane, open **Systems Management**, open **Servers**, and click the system on which the logical partition is located.

2. In the contents pane, select the logical partition on which you want to configure the virtual Ethernet adapter, click the **Tasks** button, and choose **Dynamic Logical Partitioning → Virtual Adapters**.

3. Click **Actions** and choose **Create → Ethernet Adapter**.

4. Enter the slot number for the virtual Ethernet adapter into **Adapter ID**.

5. Enter the Port Virtual LAN ID (PVID) for the virtual Ethernet adapter into **VLAN ID**. The PVID allows the virtual Ethernet adapter to communicate with other virtual Ethernet adapters that have the same PVID.

6. If the logical partition is an AIX, Linux, or Virtual I/O Server logical partition, select **IEEE 802.1 compatible adapter** if you want to configure the virtual Ethernet adapter to communicate over multiple virtual LANs. If you leave this option unchecked and you want this partition to connect to multiple virtual networks, then you must create multiple virtual adapters by creating additional virtual LAN IDs.

7. Click **OK**.

After you have finished, access any existing partition profiles for the logical partition and add the virtual Ethernet adapters to those partition profiles. The virtual Ethernet adapter will be lost if you shut down the logical partition and activate that logical partition using a partition profile that does not have the virtual Ethernet adapter in it.
Creating a Logical Host Ethernet Adapter for a running logical partition using version 7 or later of the HMC

If your managed system has a Host Ethernet Adapter (HEA), you can set up a logical partition to use HEA resources by creating a Logical Host Ethernet Adapter (LHEA) for the logical partition. A Logical Host Ethernet Adapter (LHEA) is a representation of a physical HEA on a logical partition. An LHEA allows the logical partition to connect to external networks directly through the HEA. HEAs are also known as Integrated Virtual Ethernet adapters (IVE adapters).

You can add an LHEA dynamically to a running Linux logical partition only if you install Red Hat Enterprise Linux version 5.1, Red Hat Enterprise Linux version 4.6, or a later version of Red Hat Enterprise Linux on the logical partition. To add an LHEA to a Linux logical partition with a distribution other than these distributions, you must shut down the logical partition and reactivate the logical partition using a partition profile that specifies the LHEA.

If a logical partition is not currently running, you can create an LHEA for the logical partition by changing the partition profiles for the logical partition. For more information on how to change partition profiles, see Changing partition profile properties using version 7 or later of the HMC.

To create an LHEA for a running logical partition using version 7 or later of the HMC, you must be a super administrator, a service representative, a product engineer, or an operator. For more information about user roles, refer to Tasks and roles.

To create an LHEA for a running logical partition using version 7 or later of the HMC, follow these steps:

1. In the navigation pane, open **Systems Management**, open **Servers**, and click the managed system on which the logical partition is located.
2. In the contents pane, select the logical partition for which you want to create the LHEA, click the **Tasks** button, and select **Dynamic Logical Partitioning** → **Host Ethernet** → **Add**.
3. Select the HEA whose resources you want the logical partition to use in **Choose an HEA to select Logical Ports from**.
4. In the table that lists HEA physical ports, select a physical port whose resources you want the logical partition to use, and click **Configure**.
5. In the **Choose Logical Ports** table, select the logical port (LHEA port) that you want the logical partition to use.

6. Set the logical port to accept packets with any virtual LAN ID (VLAN ID) or to accept only packets with specific VLAN IDs.
   - If you want the logical port to accept packets with any VLAN ID, select **Allow all VLAN IDs**.
   - If you want the logical port to accept only packets with specific VLAN IDs, enter each VLAN ID into **VLAN to add** and click **Add**. You can repeat this step to allow up to 20 VLAN IDs to be accepted on the logical port.

7. Click **OK**.

8. Repeat steps 4 on page 96 through 7 for each additional physical port whose resources you want the logical partition to use.

9. Adjust the values in **Timeout (minutes)** and **Detail level** if necessary and click **OK**.

When you are done, one or more new Ethernet adapters will be visible to the operating system of the logical partition.

**Configuring physical ports on a Host Ethernet Adapter using version 7 or later of the HMC**

You can configure the properties of each physical port on a Host Ethernet Adapter (HEA). These properties include port speed, duplex mode, maximum packet size, flow control setting, and the promiscuous logical partition for unicast packets. The physical port properties are also used by the logical ports that are associated with each physical port. HEAs are also known as Integrated Virtual Ethernet adapters (IVE adapters).

To configure physical ports on an HEA using version 7 or later of the HMC, you must be a super administrator, a service representative, a product engineer, or an operator. For more information about the role of a super administrator, service representative, product engineer, and operator, refer to Tasks and roles.

To configure physical ports on an HEA using version 7 or later of the HMC, follow these steps:

1. In the navigation pane, open **Systems Management** and click **Servers**.

2. In the contents pane, select the managed system whose HEAs you want to configure, click the **Tasks** button, and select **Hardware (Information) → Adapters → Host Ethernet**.

3. Select the HEA in **Choose a Physical Location Code to view / modify that Host Ethernet Adapter’s information**.

4. In the **Current Status** table, select a physical port that you want to configure and click **Configure**.

5. Change the HEA physical port configuration settings as necessary and click **OK**.

6. Repeat steps 4 and 5 for any other physical ports that you want to configure.

7. When you are done configuring physical ports, click **OK**.

After this procedure is complete, you might need to reconfigure any logical ports that are associated with the changed physical ports. For example, if you change the maximum packet size on the physical port, you might also need to access the operating systems that use the resources on that physical port and change the maximum packet size for the corresponding logical ports.

**Configuring system profiles using version 7 or later of the HMC**

You can configure the system profiles on your managed system using the Hardware Management Console (HMC). This allows you to change the logical partitions and partition profiles specified within the system profiles as the logical partitions change on your managed system.

**Creating a system profile using version 7 or later of the HMC:**
You can create a system profile using version 7 or later of the Hardware Management Console (HMC). A system profile is an ordered list of partition profiles. When you activate a system profile, the managed system attempts to activate the partition profiles in the system profile in the order in which the partition profiles are listed.

System profiles are also useful for validating your partition profiles to ensure that you have not overcommitted the resources on your managed system.

To create a system profile using version 7 or later of the HMC, you must be a super administrator or an operator. For more information about the role of a super administrator and operator, refer to Tasks and roles.

To create a system profile using version 7 or later of the HMC, follow these steps:
1. In the navigation pane, open Systems Management and click Servers.
2. In the contents pane, select the managed system, click the Tasks button, and choose Configuration → Manage System Profiles.
3. Click Actions → New.
4. Enter the name of the new system profile into System profile name.
5. For each partition profile that you want to add to the system profile, open the logical partition to which the partition profile belongs, select the partition profile, and click Add.
6. When you are done adding partition profiles to the system profile, click OK.

Related information
- Tasks and roles

Copying a system profile using version 7 or later of the HMC:

You can use the Hardware Management Console (HMC) to create a copy of an existing system profile. After you create a copy of the existing system profile, you can change the partition profiles that are contained within the new system profile. This allows you to create multiple, nearly identical system profiles quickly and easily.

To copy a system profile using version 7 or later of the HMC, you must be a super administrator, operator, or product engineer. For more information about user roles, refer to Tasks and roles.

To copy a system profile using version 7 or later of the HMC, follow these steps:
1. In the navigation pane, open Systems Management and click Servers.
2. In the contents pane, select the managed system, click the Tasks button, and choose Configuration → Manage System Profiles.
3. Select the system profile and click Actions → Copy.
4. Enter the name that you want to use for the copy into New profile name and click OK.

Related information
- Tasks and roles

Changing a system profile using version 7 or later of the HMC:

You can change which partition profiles are included in a system profile using the Hardware Management Console (HMC).

To change a system profile using version 7 or later of the Hardware Management Console (HMC), you must be a super administrator, operator, or product engineer. For more information about user roles, refer to Tasks and roles.

To change a system profile using version 7 or later of the HMC, follow these steps:
1. In the navigation pane, open **Systems Management** and click **Servers**.

2. In the contents pane, select the managed system, click the **Tasks** button, and choose **Configuration** → **Manage System Profiles**.

3. Select the system profile that you want to change and click **Actions** → **Edit**.

4. In the **System Profile** area, select each partition profile that you want to remove from the system profile and click **Remove**.

5. For each partition profile that you want to add to the system profile, open the logical partition to which the partition profile belongs, select the partition profile, and click **Add**.

6. When you are done changing the system profile, click **OK**.

**Related information**

Tasks and roles

Validating a system profile using version 7 or later of the HMC:

When you validate a system profile, the Hardware Management Console (HMC) compares the resources defined in the system profile with the resources available on the managed system. If the system profile requires more resources than are available on the managed system, a message is displayed on the HMC.

To validate a system profile using version 7 or later of the Hardware Management Console (HMC), you must be a super administrator, operator, or product engineer. For more information about user roles, refer to Tasks and roles.

To validate a system profile using version 7 or later of the HMC, follow these steps:

1. In the navigation pane, open **Systems Management** and click **Servers**.

2. In the contents pane, select the managed system, click the **Tasks** button, and choose **Configuration** → **Manage System Profiles**.

3. Select the system profile and click **Validate**.

4. When validation is complete, click **OK**.

**Related information**

Tasks and roles

Deleting a system profile using version 7 or later of the HMC:

You can delete a system profile using the Hardware Management Console (HMC). This allows you to remove system profiles that you no longer use.

To delete a system profile using version 7 or later of the HMC, you must be a super administrator or an operator. For more information about the role of a super administrator and operator, refer to Tasks and roles.

A system profile helps you activate or change the managed system from one complete set of logical partition configurations to another.

To delete a system profile using version 7 or later of the HMC, follow these steps:

1. In the navigation pane, open **Systems Management** and click **Servers**.

2. In the contents pane, select the managed system, click the **Tasks** button, and choose **Configuration** → **Manage System Profiles**.

3. Select the system profile and click **Actions** → **Delete**.

4. Click **Yes** to confirm.
Creating an AIX logical partition that uses i5/OS virtual I/O resources using version 7 or later of the HMC

You can create an AIX logical partition that uses i5/OS virtual I/O resources on IBM System i models. This allows you to maximize utilization of the physical hardware and simplify the backup procedure for your managed system.

To set this up, you must create virtual SCSI adapters that connect the AIX logical partition with the i5/OS. You can then set up i5/OS to provide disk resources to the AIX logical partition through the virtual SCSI connection. You can also create a virtual serial connection between the i5/OS logical partition and the AIX logical partition. A virtual serial connection allows you to connect to the AIX logical partition from the i5/OS logical partition.

You cannot create a AIX logical partition that uses i5/OS virtual I/O resources on IBM System p or OpenPower servers. On IBM System p or OpenPower servers, you can create a Virtual I/O Server logical partition and configure the AIX logical partition to use the virtual SCSI and virtual Ethernet resources of the Virtual I/O Server logical partition. You might need to enter an Advanced POWER Virtualization activation code to create a Virtual I/O Server logical partition on your IBM System p or OpenPower server. For more information about the Virtual I/O Server, see Using the Virtual I/O Server.

To create a AIX logical partition that uses i5/OS virtual I/O resources using version 7 or later of the HMC, you must be a super administrator or operator. For more information about the role of a super administrator and an operator, refer to Tasks and roles.

To create an AIX logical partition that uses i5/OS virtual I/O resources using version 7 or later of the HMC, follow these steps on your HMC:

1. In the navigation pane, open Systems Management and click Servers.
2. In the contents pane, select the managed system, click the Tasks button, and choose Configuration → Create Logical Partition.
3. Follow the steps in the Create Logical Partition wizard to create a logical partition and a partition profile.
4. Create a network server description (NWSD) and network server storage space. For more information, see Creating a network-server description and a network-server storage space for an AIX logical partition.
5. Set up the console for your AIX partition. For more information, see Connecting to the virtual console for an AIX logical partition.
6. Start the NWSD. For more information, see Starting the network-server description for an AIX logical partition.
7. Install the AIX operating system on your new logical partition. For installation procedures, see Installing operating systems.

Creating a network-server description and a network-server storage space for an AIX logical partition:

A network-server description (NWSD) is an i5/OS object that describes the storage resources that are used by an integrated operating environment. An NWSD can be linked to one or more network-server storage spaces. Create an NWSD to assign storage to an AIX logical partition that uses i5/OS resources.

To create an NWSD and a network-server storage space for an AIX logical partition that uses i5/OS resources, follow these steps:

1. Determine the correct SCSI server resource name.
If there is only one SCSI server adapter corresponding to a given client partition, and that adapter has its remote partition and remote slot configured correctly, you can specify **AUTO** as the RSRCNAME in your NWSD.

Otherwise, you must determine the actual resource name. At an i5/OS command line, type WRKHDWRSC *CMN, and find a controller resource with type 290B and a converged location code that corresponds to the SCSI server adapter at the Hardware Management Console (HMC). This resource name will be used later to specify the SCSI server resource.

2. At an i5/OS command line on the partition that shares resources, type CRTNWSD and press F4 for prompts.

3. Specify the following information: The default or suggested parameter values are provided within the parentheses. These settings are relevant only to a logical partition. After the installation, if your root file system (/) is not installed on the first partition of the first disk, you must set a root parameter.
   - NWSD (Provide a name for the NWSD)
   - RSRCNAME (**AUTO or the resource name of the SCSI server resource**)
   - TYPE(*GUEST)
   - ONLINE (**NO or **YES**)
   - PARTITION (**Provide the name of your AIX logical partition**)

   As an alternative to the Partition parameter, you can also specify a partition number by typing PTNBR(integer) where integer is the number of the partition you are specifying.
   - CODEPAGE (437)
   - TCPPORTCFG (**NONE**)
   - RSTDDEVRSC (for virtual CD and tape devices) (**NONE**)
   - SYNCTIME (**TYPE**)
   - IPLSRC (**NWSSTG**)

   – You can store a kernel in a disk partition of a virtual disk (a network-server storage space (NWSSTG)). By specifying the IPLSRC (**NWSSTG**) parameter, you are specifying that the AIX logical partition will start from a disk partition on that virtual disk. The disk partition on the virtual disk must be formatted as type PreP Boot (type 0x41) and marked as a device that starts.

   – To start an NWSD with a kernel from a stream file, set the IPLSRC parameter to **STMF** and set the IPLSTMF parameter to point to the kernel. You must have read access to the file and the path leading to the file to use the vary on command. This value only loads the kernel. After the kernel is running, it must find a root file system. In an initial installation, the root file system might be a RAM disk that is physically attached to the kernel.

   - IPLSTMF (**NONE**)
   - IPLPARM (**NONE**)
   - PWRCTL (**NO**)

   – If you specify PWRCTL (**YES**), perform the following steps:
     - Ensure that the server adapter in the i5/OS partition specifies the remote partition and remote slot in its configuration.
     - Ensure that the client partition has the i5/OS partition as the power-controlling partition in the profile.
     - Ensure before you activate the NWSD that the client partition’s profile has been saved to the server by activating the partition from the HMC, even if the client operating system does not activate correctly because of the absence of virtual devices.

   – If you specify PWRCTL(**NO**), virtual devices will be available to the partition. You must shut down and restart the partition using the HMC.

4. If you use iSeries Navigator, create the network-server storage space using iSeries Navigator.
   - Expand **My Connections** → **your server** → **Network** → **Windows Administration**
   - Right-click the **Disk Drives** and select **New Disk**.
c. In the **Disk drive name** field, specify the name that you want to give to the disk drive.
d. In the **Description** field, specify a meaningful description for the disk drive.
e. In the **Capacity** field, specify the size of the new disk drive in megabytes.
f. Click **OK**.
g. Continue with step 6.

5. If you use a character-based interface, create the network-server storage space using a character-based interface:
   a. At an i5/OS command line, type the command CRTNWSSTG and press F4. The Create NWS Storage Space (CRTNWSSTG) display appears.
   b. In the Network-server storage space field, specify the name you want to give to the storage space.
   c. In the Size field, specify the size in megabytes for the new storage space.
   d. In the Text description field, specify a meaningful description for the storage space.
   e. Press Enter.
   f. Continue with step 7.

6. If you use iSeries Navigator, link the network-server storage space using iSeries Navigator.
   a. Expand **My Connections → your server → Network → Windows Administration**.
   b. Click **Disk Drives**, right-click an available network-server storage space, and select **Add Link**.
   c. Select the server to which you want to link the network-server storage space.
   d. Select the link sequence position you want to use.
   e. Select one of the available data access types.
   f. Click **OK**.

   The procedure is complete. Do not complete step 7.

7. If you use a character-based interface, link the network-server storage space using a character-based interface:
   a. At an i5/OS command line, type the command ADDNWSSTGL and press F4. The Add Network-Server Storage Link (ADDNWSSTGL) display appears.
   b. In the Network server description field, specify the name of the network server description (NWSD).
   c. In the Dynamic storage link field, specify *YES to make the network-server storage space dynamically available to the partition (that is, available without rebooting the AIX partition).
   d. In the Drive sequence number field, specify the link sequence position you want to use.
   e. Press Enter.

**Related tasks**

"Creating an AIX logical partition using i5/OS virtual I/O resources” on page 228
You can create an AIX logical partition that uses i5/OS virtual I/O resources on IBM System i5 or eServer i5 models. This allows you to maximize utilization of the physical hardware and simplify the backup procedure for your managed system.

**Connecting to the virtual console for an AIX logical partition:**

You can connect to the virtual console for an AIX logical partition so that you can install the operating system or access the command line interface for the AIX logical partition.

You must have one of the following privileges to use the AIX virtual console:

- Remote Panel
- System Partitions - Administration
The virtual console provides the console function for an AIX server. It is used primarily during the initial installation of the operating system. The virtual console can also be used to view server errors or to restore communication to the LAN. This console connection is used prior to configuring TCP/IP.

Any Telnet client can be used as the AIX console. Multiple Telnet clients can share access to the same virtual console. To connect to a console, use Telnet to connect to port 2301 of the partition that is sharing its resources. TCP/IP must be configured and running on at least one i5/OS logical partition. Perform one of the following procedures:

- If you use IBM Personal Communications, connect to a virtual console using IBM Personal Communications.
  1. Click Start → IBM Personal Communications → Start or Configure Session.
  2. From the Customize Communication window, select ASCII as your type of host and select Link Parameters.
  3. From the Telnet ASCII window, enter the host name or the IP address of the partition that is sharing its resources, and enter port number 2301 of the partition sharing its resources. Click OK.
  4. If you are not using an Integrated xSeries Server, go to the next step. If you are using both AIX partitions and Integrated xSeries Server consoles, select i5/OS Guest Partition Consoles from the i5/OS Virtual Consoles window.
  5. From the i5/OS Guest Partition Consoles window, select the logical partition to which you want to connect as the console.
  6. Enter the i5/OS service tools ID and password to connect to the AIX logical partition.

- If you use Telnet, connect to the virtual console using Telnet from an MS-DOS command prompt.
  1. From an MS-DOS command prompt, use the Telnet command to connect to your server and port 2301 (telnet xxxxxx 2301).
  2. If you are not using an Integrated xSeries Server, go to the next step. If you are using both AIX partitions and Integrated xSeries Server consoles, select i5/OS Guest Partition Consoles from the i5/OS Virtual Consoles window.
  3. From the i5/OS Guest Partition Consoles window, select the logical partition to which you want to connect as the console.
  4. Enter the i5/OS service tools ID and password to connect to the AIX logical partition.

Related tasks

“Creating an AIX logical partition using i5/OS virtual I/O resources” on page 228

You can create an AIX logical partition that uses i5/OS virtual I/O resources on IBM System i5 or eServer i5 models. This allows you to maximize utilization of the physical hardware and simplify the backup procedure for your managed system.

Starting the network-server description for an AIX logical partition:

You can start the network-server description (NWSD) for a AIX logical partition that uses i5/OS resources to make the resources defined in the NWSD available to the AIX logical partition.

To start (vary on) the NWSD for an AIX logical partition, complete the following tasks:

1. If you use iSeries Navigator, start the NWSD using iSeries Navigator.
   a. Click Network → Windows Administration → Integrated xSeries Servers
   b. Right-click the name of the NWSD that you want to start.
   c. Click Start.
2. If you use the character-based interface, start the NWSD using the character-based interface:
   a. Type WRKCF6STS *NWS and press Enter.
   b. Type 1 next to the NWSD that you want to start and press Enter.
Related tasks

“Creating an AIX logical partition using i5/OS virtual I/O resources” on page 228
You can create an AIX logical partition that uses i5/OS virtual I/O resources on IBM System i5 or eServer i5 models. This allows you to maximize utilization of the physical hardware and simplify the backup procedure for your managed system.

“Unlinking virtual disk drives from an AIX logical partition” on page 108
By unlinking virtual disk drives (network-server storage spaces) from an AIX logical partition that uses i5/OS resources, you disconnect the virtual disk drives from the logical partition, making the virtual disk drives inaccessible to users. If you delete a AIX logical partition that uses i5/OS resources, you must unlink all virtual disk drives from the logical partition before you delete the logical partition.

Adding virtual disk units to an AIX logical partition:

You can add virtual disk units dynamically to an AIX logical partition that uses i5/OS resources. This allows you to increase the storage capacity of your AIX logical partition when needed.

Virtual disks simplify hardware configuration on the server because they do not require you to add additional physical devices to the server in order to run AIX. You can allocate up to 64 virtual disks to an AIX logical partition. Each virtual disk supports up to 1000 GB of storage. Each virtual disk appears to AIX as one actual disk unit. However, the associated space in the i5/OS integrated file system is distributed across the disks that belong to the i5/OS logical partition. Distributing storage across the disks provides the benefits of device parity protection through i5/OS. Therefore, you do not have to use additional processing resources and memory resources by setting up device parity protection through AIX.

i5/OS provides the ability to dynamically add virtual disks to an AIX logical partition. You can allocate disk space in the integrated file system and make it available to AIX without restarting the server or logical partition. The AIX administrator can also configure the newly allocated disk space and make it available without restarting the server.

To add virtual disks dynamically to an AIX logical partition, do the following:

1. If you use iSeries Navigator, create a network-server storage space using iSeries Navigator.
   a. Expand My Connections → your server → Network → Windows Administration.
   b. Right-click the Disk Drives and select New Disk.
   c. In the Disk drive name field, specify the name that you want to give to the network-server storage space.
   d. In the Description field, specify a meaningful description for the network-server storage space.
   e. In the Capacity field, specify the size of the new network-server storage space in megabytes. Refer to the AIX installation documentation to determine the size you want to use.
   f. Click OK.
   g. Continue with step 3 on page 105
2. If you use a character-based interface, create a network-server storage space using the character-based interface:
   a. At an i5/OS command line, type the command CRTNWSSTG and press F4. The Create NWS Storage Space (CRTNWSSTG) display appears.
   b. In the Network-server storage space field, specify the name you want to give to the network-server storage space.
   c. In the Size field, specify the size in megabytes for the new network-server storage space. Refer to the AIX installation documentation to determine the size you want to use.
   d. In the Text description field, specify a meaningful description for the network-server storage space.
   e. Press Enter.
If you use iSeries Navigator, link the network-server storage space using iSeries Navigator.

a. Expand My Connections → your server → Network → Windows Administration.

b. Click Disk Drives, right-click an available network-server storage space, and select Add Link.

c. Select the server to which you want to link the network-server storage space.

d. Select one of the available data access types.

e. Click OK.

f. Continue with step 5.

If you use a character-based interface, link the network-server storage space using a character-based interface:

a. At an i5/OS command line, type the command ADDNWSSTGL and press F4. The Add Network-Server Storage Link (ADDNWSSTGL) display appears.

b. In the Network server description field, specify the name of the network server description (NWSD).

c. In the Dynamic storage link field, specify *YES to make the network-server storage space dynamically available to the partition (that is, available without rebooting the AIX partition).

d. In the Drive sequence number field, specify the link sequence position you want to use.

e. Press Enter.

5. Activate the AIX logical partition (if it is not already activated).

6. Log in to AIX using a user name with superuser (root) privileges.

7. Configure the new virtual disk on the AIX logical partition by running the AIX command cfgmgr.

8. Verify that your new disk has been added and can be configured by running the AIX command lspv. When you enter lspv at the command prompt, the system lists the disks that are currently available to AIX. An example of the output for this command is below:

```
# lspv
hdisk0  00cad6aceafe8fe4 rootvg active
hdisk1  none        None
```

Note the name of the new disk as it displays in the left-hand column.

9. Configure the new disk using one of the following two methods.

   • Add the new virtual disk to the root volume group by using the AIX command extendvg rootvg diskname, where diskname is the name of the new disk. If you use this method, you do not need to continue this procedure. You can use AIX methods to increase the file system size at a later time.

   • Create a new volume group for the new virtual disk by using the AIX command mkvg -y volgroup diskname, where volgroup is the name that you want to use for the new volume group and diskname is the name of the new disk.

10. Make a logical volume on the new virtual disk using the AIX mklv -y logicvol volgroup 1 diskname command. logicvol is the name that you want to use for the new logical volume, volgroup is the name of the new volume group, and diskname is the name of the new disk. (The numeral 1 indicates that the logical volume is to consist of one logical disk partition.)

11. Format the disk partition using the AIX crfs command. There are a number of optional parameters for the crfs command, but typically the defaults satisfy most disk uses. To format the disk partition created in the previous steps, type the following command at an AIX command prompt, where logicvol is the name of the logical volume and /mnt/data is the mount point directory at which you want to mount the new disk:

```
crfs -v jfs -d logicvol -m /mnt/data
```

The crfs command displays the following diagnostic messages:
crfs -v jfs -d logicvol -m /mnt/data
Based on the parameters chosen, the new /mnt/data JFS file system is limited to
a maximum size of 134217728 (512 byte blocks)
New File System size is 8192.

12. Verify that the mount point directory exists by using the cd /mnt/data command. /mnt/data is the
mount point. The crfs command creates this directory so that you can access your new file system.
If the mount point directory does not exist, then run the following command, where /mnt/data is the
name of the mount point directory:
mkdir /mnt/data

13. Verify that an entry for your new file system exists in the /etc/filesystems file. The crfs command
automatically generates the appropriate /etc/filesystems entry for your new file system. To verify
that the entry exists, use an AIX text editor, such as vi, to open the /etc/filesystems file, and look
for the entry in the /etc/filesystems file. If the entry does not exist, use the text editor to add the
entry to the /etc/filesystems file. An example of such an entry is below:
/mnt/data:
    dev = /dev/logicvol
    vfs = jfs
    log = /dev/loglv01
    mount = true
    account = false

This entry mounts the virtual disk every time you restart AIX.

14. Mount the virtual disk drive in the new directory by typing: mount /dev/logicvol /mnt/data.
    logicvol is the name of the logical volume and /mnt/data is the mount point directory.

Linking a network-server storage space to a network-server description:

You can link a network-server storage space (NWSSTG) to one or more network-server descriptions
(NWSDs). This allows the NWSDs and their associated logical partitions to use the data stored on the
NWSSTG.

You can link an NWSSTG to an unlimited number of NWSDs. This is beneficial when multiple logical
partitions need access to a single application.

When you link an NWSSTG to an NWSD, you can set up the NWSD to have read-only access to the
NWSSTG, or you can set up the NWSD to read or write to the NWSSTG.

Attention: If more than one NWSD can write to the NWSSTG, ensure that only one NWSD can update
the data at a time. Otherwise, changes made by one NWSD can be overwritten by another NWSD.

To link an NWSSTG to an NWSD, follow these steps:
1. At an i5/OS command line, type the command ADDNWSSTGL and press F4.
2. From the Add Server Storage Link display, provide the following information:
    NWSSTG (Name)
    NWSD (Name)
    DYNAMIC (+YES)
    DRVSEQNBR (+CALC)
3. Press F10 (Additional Parameters).
4. Enter the type of access the storage space will have.

Deleting network-server descriptions for an AIX logical partition:

You can delete the i5/OS network-server description (NWSD) for an AIX logical partition that uses i5/OS
resources. When you delete the NWSD, all the configuration information for the AIX logical partition is
deleted from i5/OS.
To delete the network-server description (NWSD) for an AIX logical partition, follow these steps:

1. On an i5/OS control language (CL) command line, type the command WRKNWSD and press Enter.
2. Type 8 in the Opt field to the left of the Network Server and press Enter.
3. In the Work with Configuration Status display, if the status of the NWSD is not varied off, type 2 in the Opt field to the left of the Network Server and press Enter. Otherwise, go to the next step.
4. Press F3 to return to the previous display.
5. Enter a 4 in the Opt field to the left of the Network Server and press Enter.

Deleting virtual disk drives for an AIX logical partition:

You can delete a virtual disk drive from an AIX logical partition that uses i5/OS resources to make the space available to the i5/OS logical partition once more. When you delete a virtual disk drive, all of the information on the virtual disk drive is erased.

Before you can delete a virtual disk drive, you must unlink the virtual disk drive from the network-server description (NWSD). For more information on how to unlink a virtual disk drive from an NWSD, see Unlinking virtual disk drives from an AIX logical partition.

To delete a virtual disk drive, follow these steps:

Delete the disk drive using the interface that you prefer.

<table>
<thead>
<tr>
<th>Interface</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>iSeries Navigator</td>
<td>1. Click Network → Windows Administration → Disk Drives.</td>
</tr>
<tr>
<td></td>
<td>2. Right-click the disk drive that you want to delete.</td>
</tr>
<tr>
<td></td>
<td>3. Click Delete in the confirmation window.</td>
</tr>
<tr>
<td>i5/OS character-based interface</td>
<td>1. At an i5/OS control language (CL) command line, type DLTNWSSSTG and press F4.</td>
</tr>
<tr>
<td></td>
<td>2. Type the name of the disk drive in the Network-server storage space field and press Enter.</td>
</tr>
</tbody>
</table>

Related tasks

"Unlinking virtual disk drives from an AIX logical partition” on page 108

By unlinking virtual disk drives (network-server storage spaces) from an AIX logical partition that uses i5/OS resources, you disconnect the virtual disk drives from the logical partition, making the virtual disk drives inaccessible to users. If you delete a AIX logical partition that uses i5/OS resources, you must unlink all virtual disk drives from the logical partition before you delete the logical partition.

Using IPL types when running AIX:

The IPL source (IPLSRC) parameter on the network-server description (NWSD) determines the initial program that is loaded when the NWSD is varied on. For an AIX logical partition that uses i5/OS resources, the initial program is the kernel. Ensure that the IPLSRC parameter specifies the kernel location of the kernel for the AIX logical partition that uses i5/OS resources.

You can set the IPLSRC parameter when you use the Create Network Server Description (CRTNWSD) command, and you can change the IPLSRC parameter when you use the Change Network Server Description (CHGNWSD) command.

Note: IPLSRC parameter also has the values A, B, and D, which are not valid for IBM System i hardware.
The IPLSRC parameter has the following valid values.

<table>
<thead>
<tr>
<th>IPLSRC values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>*Panel</td>
<td>The partition is started from the source indicated on the control panel.</td>
</tr>
<tr>
<td>*NWSSTG (network-server storage space)</td>
<td>This IPL type is used to start a partition from a virtual disk. The open firmware will find the kernel in the virtual disk. The open firmware searches the first virtual disk connected to the server for a partition marked bootable, and of type 0x41 (PReP start). If a partition of this type does not exist, the partition IPL will fail.</td>
</tr>
<tr>
<td>*STMF (stream file)</td>
<td>This IPL type is used to start a partition from a kernel i5/OS loaded in the i5/OS integrated file system. Note that the integrated file system includes files on the optical (CD) drive on i5/OS.</td>
</tr>
</tbody>
</table>

Unlinking virtual disk drives from an AIX logical partition:

By unlinking virtual disk drives (network-server storage spaces) from an AIX logical partition that uses i5/OS resources, you disconnect the virtual disk drives from the logical partition, making the virtual disk drives inaccessible to users. If you delete a AIX logical partition that uses i5/OS resources, you must unlink all virtual disk drives from the logical partition before you delete the logical partition.

To unlink a virtual disk drive from an AIX logical partition that uses i5/OS resources, follow these steps:

1. Unlink disk drives from a logical partition using iSeries Navigator. If you prefer to use a character-based interface, go to step 2.
   a. Vary off the NWSD for your logical partition. For more information, see Starting and stopping the network server description.
   b. Click Network ➔ Windows Administration ➔ Disk Drives.
   c. Right-click the name of the disk drive that you want to unlink.
   d. Click Remove Link.
   e. Select a server from the list of linked servers.
   f. If you are unlinking a disk drive that you plan to relink later, uncheck Compress link sequence.
      You must relink the disk drive as the same link sequence number before you vary on the server. By preventing compression of the link sequence values, you avoid having to unlink and relink all the disk drives to get them in the correct sequence.
   g. Click Remove.
   h. You have completed this procedure. Do not complete step 2.

2. Unlink disk drives from a logical partition using a character-based interface:
   a. Vary off the NWSD for your logical partition. For more information, see Starting and stopping the network server description.
   b. Type RMVNWSSTGL and press F4.
   c. In the Network-server storage space field, type the name of the storage space that you want to unlink and press Enter.
   d. In the Network server description field, type the name of the server from which you want to unlink the storage space and press Enter.
   e. If you are unlinking a linked disk drive that you plan to relink later, specify *NO in the Renumber field.
      Note: You must relink the disk drive as the same sequence number before you vary on the server. By preventing automatic renumbering, you avoid having to unlink and relink all the disk drives to get them in the correct sequence.
   f. Press Enter.
Note: If you are uninstalling a logical partition, your next step is to delete the disk drive. For more information on deleting disk drives, see Deleting virtual disk drives for an AIX logical partition. Otherwise, vary on the NWSD for your logical partition. For more information about starting the NWSD, see Starting and stopping the network server description.

For more information about saving i5/OS server objects, see Saving server objects in i5/OS.

Related tasks

“Deleting virtual disk drives for an AIX logical partition” on page 107
You can delete a virtual disk drive from an AIX logical partition that uses i5/OS resources to make the space available to the i5/OS logical partition once more. When you delete a virtual disk drive, all of the information on the virtual disk drive is erased.

“Starting the network-server description for an AIX logical partition” on page 103
You can start the network-server description (NWSD) for a AIX logical partition that uses i5/OS resources to make the resources defined in the NWSD available to the AIX logical partition.

Saving AIX server objects in i5/OS:

When an AIX logical partition uses i5/OS resources, i5/OS stores AIX information in i5/OS objects. i5/OS can restore the objects correctly only if you save all objects for an AIX logical partition.

You can save these objects by using options of the i5/OS GO SAVE command in the server.
- Option 21 saves the entire server.
- Option 22 saves server data, which includes objects in the QUSRSYS library.
- Option 23 saves all user data, which includes objects in the QFPNWSSTG library.

If you want to save a particular object, use the following table to see the location of that object on i5/OS and the command to use. For more information about using the save commands, see the i5/OS Backup and recovery topic collection.

<table>
<thead>
<tr>
<th>Table 16. Objects to save for logical partitions with virtual disk</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Object content</strong></td>
</tr>
<tr>
<td>Guest partition and virtual disk drive</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

Table 17. Objects to save for all logical partitions with a server

| **Object content** | **Object name** | **Object location** | **Object type** | **Save command** |
|---------------------------------------------------------------|
| Messages from the logical partition | Various | Various | Server message queue | GO SAVE, option 21 or 23 |
| | | | | SAVOBJ OBJ(msg) LIB(qlibrary) DEV(TAP01) OBJTYPE(*MSGQ) |
| i5/OS configuration objects for logical partitions | Various | QSYS | Device configuration objects | GO SAVE, option 21, 22, or 23 |
| | | | | SAVOBJ DEV (TAP01) |
Table 17. Objects to save for all logical partitions with a server (continued)

<table>
<thead>
<tr>
<th>Object content</th>
<th>Object name</th>
<th>Object location</th>
<th>Object type</th>
<th>Save command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Various</td>
<td>Various</td>
<td>QUSRSYS</td>
<td>Various</td>
<td>GO SAVE, option 21 or 23</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>SAVLIB LIB(*NONSYS) or</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>LIB(*ALLUSR)</td>
</tr>
</tbody>
</table>

Related information

Backup and recovery

Creating a Linux logical partition that uses i5/OS virtual I/O resources using version 7 or later of the HMC

You can create a Linux logical partition that uses i5/OS virtual I/O resources on IBM System i models. This allows you to maximize utilization of the physical hardware and simplify the backup procedure for your managed system.

To set this up, you must create virtual SCSI adapters that connect the Linux logical partition with the i5/OS. You can then set up i5/OS to provide disk resources to the Linux logical partition through the virtual SCSI connection. You can also create a virtual serial connection between the i5/OS logical partition and the Linux logical partition. A virtual serial connection allows you to connect to the Linux logical partition from the i5/OS logical partition.

You cannot create a Linux logical partition that uses i5/OS virtual I/O resources on IBM System p or OpenPower servers. On IBM System p or OpenPower servers, you can create a Virtual I/O Server logical partition and configure the Linux logical partition to use the virtual SCSI and virtual Ethernet resources of the Virtual I/O Server logical partition. You might need to enter an Advanced POWER Virtualization activation code to create a Virtual I/O Server logical partition on your IBM System p or OpenPower server. For more information about the Virtual I/O Server, see Using the Virtual I/O Server.

To create a Linux logical partition that uses i5/OS virtual I/O resources using version 7 or later of the HMC, you must be a super administrator or operator. For more information about the role of a super administrator and an operator, refer to Tasks and roles.

To create a Linux logical partition that uses i5/OS virtual I/O resources using version 7 or later of the HMC, follow these steps:

1. In the navigation pane, open Systems Management and click Servers.
2. In the contents pane, select the managed system, click the Tasks button, and choose Configuration → Create Logical Partition.
3. Follow the steps in the Create Logical Partition wizard to create a logical partition and a partition profile.
4. Create a network server description (NWSD) and network-server storage space. For more information, see Creating an NWSD and a network-server storage space for a Linux logical partition.
5. Set up the console for your Linux partition. For more information, see Connecting to the virtual console for a Linux logical partition.
6. Start the NWSD. For more information, see Starting the network-server description for a Linux logical partition.
7. Install the Linux operating system on your new logical partition. For installation procedures, see Installing operating systems.

Creating an NWSD and a network-server storage space for a Linux logical partition:

A network-server description (NWSD) is an i5/OS object that describes the storage resources that are used by an integrated operating environment. An NWSD can be linked to one or more network-server storage spaces. Create an NWSD to assign storage to a Linux logical partition that uses i5/OS resources.
To create an NWSD and a network-server storage space for a Linux logical partition that uses i5/OS resources, follow these steps:

1. Determine the correct SCSI server resource name.
   - If there is only one SCSI server adapter corresponding to a given client partition, and that adapter has its remote partition and remote slot configured correctly, you can specify *AUTO as the RSRCNAME in your NWSD.
   - Otherwise, you must determine the actual resource name. At an i5/OS command line, type `WRKHDWRSC *CMN`, and find a controller resource with type 290B and a converged location code that corresponds to the SCSI server adapter at the Hardware Management Console (HMC). This resource name will be used later to specify the SCSI server resource.

2. At an i5/OS command line on the partition that shares resources, type `CRTNWSD` and press F4 for prompts.

3. Specify the following information. The default or suggested parameter values are provided within the parentheses. These settings are relevant only to a logical partition. After the installation, if your root file system (/) is not installed on the first partition of the first disk, you must set a root parameter.
   - NWSD (Provide a name for the NWSD)
   - RSRCNAME (*AUTO or the resource name of the SCSI server resource)
   - TYPE(*GUEST)
   - ONLINE (*NO or *YES)
   - PARTITION ('Provide the name of your Linux logical partition')
     As an alternative to the Partition parameter, you can also specify a partition number by typing `PTNNBR(integer)` where integer is the number of the partition you are specifying.
   - CODEPAGE (437)
   - TCPPORTCFG (*NONE)
   - RSTDDEVRSC (for virtual CD and tape devices) (*NONE)
   - SYNCTIME (*TYPE)
   - IPLSRC (*NWSSTG)
     - You can store a kernel in a disk partition of a virtual disk (a network-server storage space (NWSSTG)). By specifying the IPLSRC (*NWSSTG) parameter, you are specifying that the Linux logical partition will start from a disk partition on that virtual disk. The disk partition on the virtual disk must be formatted as type PReP Boot (type 0x41) and marked as a device that starts. You can format a disk partition as type PReP Boot by using the Linux `f disk` command with the -t option. You can specify that the disk partition starts by using the `fdisk` command with the -a option.
     - To start an NWSD with a kernel from a stream file, set the IPLSRC parameter to *STMF and set the IPLSTMF parameter to point to the kernel. You must have read access to the file and the path leading to the file to use the vary on command. This value only loads the kernel. After the kernel is running, it must find a root file system. In an initial installation, the root file system might be a RAM disk that is physically attached to the kernel.
   - IPLSTMF (*NONE)
   - IPLPARM (*NONE)
   - PWRCTL (*YES)
     - If you specify PWRCTL (*YES), perform the following steps:
       a. Ensure that the server adapter in the i5/OS partition specifies the remote partition and remote slot in its configuration.
       b. Ensure that the client partition has the i5/OS partition as the power-controlling partition in the profile.
       c. Ensure before you activate the NWSD that the client partition’s profile has been saved to the server by activating the partition from the HMC, even if the client operating system does not activate correctly because of the absence of virtual devices.
If you specify PWRCTL(*NO), virtual devices will be available to the partition. You must shut down and restart the partition using the HMC.

4. If you use iSeries Navigator, create the network-server storage space using iSeries Navigator.
   a. Expand **My Connections** → **your server** → **Network** → **Windows Administration** .
   b. Right-click the **Disk Drives** and select **New Disk**.
   c. In the **Disk drive name** field, specify the name that you want to give to the disk drive.
   d. In the **Description** field, specify a meaningful description for the disk drive.
   e. In the **Capacity** field, specify the size of the new disk drive in megabytes. Refer to your preferred Linux distributor installation documentation to determine the size you want to use.
   f. Click **OK**.
   g. Continue with step 6.

5. If you use a character-based interface, create the network-server storage space using the character-based interface:
   a. At an i5/OS command line, type the command CRTNWSSTG and press F4. The Create NWS Storage Space (CRTNWSSTG) display appears.
   b. In the Network-server storage space field, specify the name you want to give to the storage space.
   c. In the **Size** field, specify the size in megabytes for the new storage space. Refer to your preferred Linux distributor installation documentation to determine the size you want to use.
   d. In the Text description field, specify a meaningful description for the storage space.
   e. Press Enter.
   f. Continue with step 7.

6. If you use iSeries Navigator, link the network-server storage space using iSeries Navigator:
   a. Expand **My Connections** → **your server** → **Network** → **Windows Administration** .
   b. Click **Disk Drives**, right-click an available network-server storage space, and select **Add Link**.
   c. Select the server to which you want to link the network-server storage space.
   d. Select the link sequence position you want to use.
   e. Select one of the available data access types.
   f. Click **OK**.

   The procedure is complete. Do not complete step 7.

7. If you use a character-based interface, link the network-server storage space using the character-based interface:
   a. At an i5/OS command line, type the command ADDNWSSTGL and press F4. The Add Network-Server Storage Link (ADDNWSSTGL) display appears.
   b. In the Network server description field, specify the name of the network server description (NWSD).
   c. In the Dynamic storage link field, specify *YES to make the network-server storage space dynamically available to the partition (that is, available without rebooting the Linux partition).
   d. In the Drive sequence number field, specify the link sequence position you want to use. If you want the system to find the next available position for you, specify *CALC.
   e. Press Enter.

**Related tasks**

"Creating a Linux logical partition using i5/OS virtual I/O resources" on page 232

IBM System i5 and eServer i5 models allow you to create a Linux logical partition that uses i5/OS virtual I/O resources. This allows you to maximize utilization of the physical hardware and simplify the backup procedure for your managed system.

**Connecting to the virtual console for a Linux logical partition:**
You can connect to the virtual console for a Linux logical partition so that you can install the operating system or access the command line interface for the Linux logical partition.

You must have one of the following privileges to use the Linux virtual console.
- Remote Panel
- System Partitions - Administration

The virtual console provides the console function for a Linux server. It is used primarily during the initial installation of the operating system. The virtual console can also be used to view server errors or to restore communication to the LAN. This console connection is used prior to configuring TCP/IP.

Any Telnet client can be used as the Linux console. Multiple Telnet clients can share access to the same virtual console. To connect to a console, use Telnet to connect to port 2301 of the partition that is sharing its resources. TCP/IP must be configured and running on at least one i5/OS logical partition. Perform one of the following procedures:
- If you use IBM Personal Communications, connect to a virtual console using IBM Personal Communications.
  1. Click Start → IBM Personal Communications → Start or Configure Session.
  2. From the Customize Communication window, select ASCII as your type of host and select Link Parameters.
  3. From the Telnet ASCII window, enter the host name or the IP address of the partition that is sharing its resources, and enter port number 2301 of the partition sharing its resources. Click OK.
  4. If you are not using an Integrated xSeries Server, go to the next step. If you are using both Linux partitions and Integrated xSeries Server consoles, select i5/OS Guest Partition Consoles from the i5/OS Virtual Consoles window.
  5. From the i5/OS Guest Partition Consoles window, select the logical partition to which you want to connect as the console.
  6. Enter the i5/OS service tools ID and password to connect to the Linux logical partition.
- If you use Telnet, connect to the virtual console using Telnet from an MS-DOS command prompt.
  1. From an MS-DOS command prompt, use the Telnet command to connect to your server and port 2301 (telnet xxxxxx 2301).
  2. If you are not using an Integrated xSeries Server, go to the next step. If you are using both Linux partitions and Integrated xSeries Server consoles, select i5/OS Guest Partition Consoles from the i5/OS Virtual Consoles window.
  3. From the i5/OS Guest Partition Consoles window, select the logical partition to which you want to connect as the console.
  4. Enter the i5/OS service tools ID and password to connect to the Linux logical partition.

**Related tasks**

"Creating a Linux logical partition using i5/OS virtual I/O resources" on page 232

IBM System i5 and iSeries i5 models allow you to create a Linux logical partition that uses i5/OS virtual I/O resources. This allows you to maximize utilization of the physical hardware and simplify the backup procedure for your managed system.

**Starting the network-server description for a Linux logical partition:**

You can start the network-server description (NWSD) for a Linux logical partition that uses i5/OS resources to make the resources defined in the NWSD available to the Linux logical partition.

To start (vary on) the NWSD for a Linux logical partition, complete the following tasks:
  1. If you use iSeries Navigator, start the NWSD using iSeries Navigator.
     a. Click Network → Windows Administration → Integrated xSeries Servers
b. Right-click the name of the NWSD that you want to start.

c. Click Start.

2. If you use the character-based interface, start the NWSD using a character-based interface:
   a. Type WRKCFGSTS *NWS and press Enter.
   b. Type 1 next to the NWSD that you want to start and press Enter.

**Related tasks**

“Creating a Linux logical partition using i5/OS virtual I/O resources” on page 232

IBM System i5 and eServer i5 models allow you to create a Linux logical partition that uses i5/OS virtual I/O resources. This allows you to maximize utilization of the physical hardware and simplify the backup procedure for your managed system.

“Unlinking virtual disk drives from a Linux logical partition” on page 119

By unlinking virtual disk drives (network-server storage spaces) from a Linux logical partition that uses i5/OS resources, you disconnect the virtual disk drives from the logical partition, making the virtual disk drives inaccessible to users. If you delete a Linux logical partition that uses i5/OS resources, you must unlink all virtual disk drives from the logical partition before you delete the logical partition.

**Adding virtual disk units to a Linux logical partition:**

You can add virtual disk units dynamically to a Linux logical partition that uses i5/OS resources. This allows you to increase the storage capacity of your AIX logical partition when needed.

Virtual disks simplify hardware configuration on the server because they do not require you to add additional physical devices to the server in order to run Linux. You can allocate up to 64 virtual disks to a Linux logical partition. Each virtual disk supports up to 1000 GB of storage. Each virtual disk appears to Linux as one actual disk unit. However, the associated space in the i5/OS integrated file system is distributed across the disks that belong to the i5/OS logical partition. Distributing storage across the disks provides the benefits of device parity protection through i5/OS. Therefore, you do not have to use additional processing resources and memory resources by setting up device parity protection through Linux.

i5/OS provides the ability to dynamically add virtual disks to a Linux logical partition. You can allocate disk space in the integrated file system and make it available to Linux without restarting the server or logical partition. The Linux administrator can also configure the newly allocated disk space and make it available without restarting the server.

To add virtual disks dynamically to a Linux logical partition, do the following:

1. If you use iSeries Navigator, create a network-server storage space using iSeries Navigator.
   a. Expand My Connections → your server → Network → Windows Administration.
   b. Right-click the Disk Drives and select New Disk.
   c. In the Disk drive name field, specify the name that you want to give to the network-server storage space.
   d. In the Description field, specify a meaningful description for the network-server storage space.
   e. In the Capacity field, specify the size of the new network-server storage space in megabytes. Refer to the installation documentation of your preferred Linux distributor to determine the size you want to use.
   f. Click OK.
   g. Continue with step 4 on page 115

2. If you use a character-based interface, create a network-server storage space using the character-based interface:
   a. At an i5/OS command line, type the command CRTNWSSTG and press F4. The Create NWS Storage Space (CRTNWSSTG) display appears.
b. In the Network-server storage space field, specify the name you want to give to the network-server storage space.

c. In the Size field, specify the size in megabytes for the new network-server storage space. Refer to the installation documentation of your preferred Linux distributor to determine the size you want to use.

d. In the Text description field, specify a meaningful description for the network-server storage space.

e. Press Enter.

3. If you use iSeries Navigator, link the network-server storage space using iSeries Navigator.
   a. Expand **My Connections** → your server → **Network** → **Windows Administration**.
   b. Click **Disk Drives**, right-click an available network-server storage space, and select **Add Link**.
   c. Select the server to which you want to link the network-server storage space.
   d. Select one of the available data access types.
   e. Click **OK**.
   f. Continue with step [5]

4. If you use a character-based interface, link the network-server storage space using a character-based interface:
   a. At an i5/OS command line, type the command `ADDNWSSTGL` and press F4. The Add Network-Server Storage Link (ADDNWSSTGL) display appears.
   b. In the Network server description field, specify the name of the network server description (NWSD).
   c. In the Dynamic storage link field, specify *YES to make the network-server storage space dynamically available to the partition (that is, available without rebooting the Linux partition).
   d. In the Drive sequence number field, specify the link sequence position you want to use.
   e. Press Enter.

5. If the Linux logical partition is not running, activate the Linux logical partition. Do not continue until the partition is running.

6. Log in to Linux using a user name with superuser (root) privileges.

7. Determine the host ID, SCSI bus, and logical unit number (LUN) for your new virtual disk drive.
   You can list the existing devices by typing the following command at the Linux command prompt:
   ```
cat /proc/scsi/scsi
```
   The following example shows sample output of the command:

   ```
   Attached devices:
   Host: scsi0 Channel: 00 Id: 00 Lun: 00
   Vendor: IBM   Model: VDAD NETSPACE   Rev: 0001
   Type: Direct-Access   ANSI SCSI revision: 04
   ```

   In this example, NETSPACE is the name of the network storage space for the displayed device. Look for the name of an existing network storage space on your Linux logical partition. Note the numeric part of the host: value (host ID) and the channel: (SCSI bus) and Lun: (logical unit number (LUN)) values for the existing network storage space. The new virtual disk drive will have the same host ID, SCSI bus, and LUN as the existing network storage space. For example, if the existing network storage space is as displayed in the preceding example output, then the new virtual disk drive will have a host ID of 0, a SCSI bus of 0, and a LUN of 0.

8. Determine the SCSI ID for your new virtual disk drive. You can list the existing devices in table form by typing the following commands at the Linux command prompt:

   ```
cd /proc/scsi/
   cat device_hdr; cat devices
   ```

   The following example shows sample output of the commands:
Note the host (host ID), chan (SCSI bus), id (SCSI ID), and lun (logical unit number (LUN)) values for the existing devices. Find the devices that have the same host ID, SCSI bus, and LUN as the new virtual disk drive (as you determined in the previous step). Of those devices, find the device with the greatest SCSI ID. The new virtual disk drive will have a SCSI ID that is one greater than the greatest existing SCSI ID. For example, if the new virtual disk drive has a host ID of 0, a SCSI bus of 0, and a LUN of 0, and the devices on your Linux logical partition are as listed in the example output above, then the new virtual disk drive will have a SCSI ID of 1.

9. Type the following command at the Linux command prompt to add the virtual disk drive manually:
   `echo "scsi add-single-device host chan id lun" > /proc/scsi/scsi`
   Use the following information to help you understand the arguments of the command:
   - host is the host ID.
   - chan is the SCSI bus.
   - id is the SCSI ID.
   - lun is the LUN.
   For example, if the new virtual disk drive is to have a host ID of 0, a SCSI bus of 0, a SCSI ID of 1, and a LUN of 0, you would type the command `echo "scsi add-single-device 0 0 1 0" > /proc/scsi/scsi` at the Linux command prompt.

10. At the Linux command prompt, type the following command to create a disk partition on the virtual disk drive: `fdisk /dev/sdb`. You must have superuser (root) privileges to run this command. The Command (m for help): prompt appears.

11. Type `p` at the prompt to see the current partition table for the virtual disk drive. By default, the new virtual disk drive shows a single disk partition on the virtual disk. For example,
   ```
   Disk /dev/sdb: 64 heads, 32 sectors, 200 cylinders
   Units = cylinders of 2048 * 512 bytes
   Device Boot Start    End    Blocks  Id  System
   /dev/sdb1 1    199  203760  6     FAT16
   ```

12. Type `d` at the command prompt to delete the current partition and then create a new one. The default format for the disk partition is FAT16. Do not use a disk partition that is formatted as FAT16 on your virtual disk drive. The Partition number (1-4): prompt appears.

13. Type the disk partition number you want to delete and press Enter. In this example, you type a 1. The fdisk command indicates that the deletion is successful by displaying the command prompt.

14. Type `n` to create a new disk partition. The Command action E extended P primary partition (1-4) prompt appears.

15. Type `p` to create a primary disk partition on the virtual disk and press Enter. The Partition number (1-4): prompt appears.

16. Type 1 because this is the first partition on the virtual disk, and press Enter. The First cylinder (1-200, default 1): prompt appears.

17. Press Enter to use the default of 1 for the first disk cylinder. This uses the entire disk for this disk partition. The Last cylinder or +size or +sizeM or +sizeK (1-200, default 200): prompt appears.

18. Press Enter to use the default of 200 for the last disk cylinder. This uses the entire virtual disk for this partition.

   **Note:** The type of the partition defaults to Linux. If you need a different disk type (like Logical Volume Manager (LVM), or Linux Extended), type `t` to change the type of the partition. The fdisk command indicates that the partition creation is successful by returning the command prompt.
19. Type w to commit the changes to the disk structure and press Enter. The fdisk command writes the changes to the virtual disk drive. The fdisk command displays the following diagnostic message:

   The partition table has been altered!

   Calling ioctl() to re-read partition table.
   Syncing disks.

After the operation is completed, the fdisk command returns the command prompt.

20. Format the disk partition using the Linux mkfs command. There are a number of optional parameters for the mkfs command, but typically the defaults satisfy most disk uses. To format the disk partition created in the previous steps, ensure that you are logged in with superuser (root) privileges and type the following command at a Linux command prompt:

   mkfs /dev/sdb1

Since a single disk partition exists on the second virtual disk, the name of the disk is /dev/sdb1 (the sdb indicates that it is the second disk, and the 1 indicates that it is partition 1). The mkfs command displays the following diagnostic messages:

   mke2fs 1.28 (31-Aug-2002)
   Filesystem label=
   OS type: Linux Block size=1024 (log=0)
   Fragment size=1024 (log=0)
   51200 inodes, 204784 blocks
   10239 blocks (5.00%) reserved for the super user
   First data block=1
   25 block groups
   8192 blocks per group, 8192 fragments per group
   2048 inodes per group
   Superblock backups stored on blocks:
      8193, 24577, 40961, 57345, 73729
   Writing inode tables: done
   Writing superblocks and filesystem accounting information: done
   This filesystem will be automatically checked every 29 mounts or
   180 days, whichever comes first. Use tune2fs -c or -i to override.

21. Type the following command to create a directory that you can use to access the new file: mkdir /mnt/data

22. Type the following command to mount the virtual disk drive in the new directory: mount /dev/sdb1 /mnt/data

23. Add an entry to the /etc/fstab file using a Linux text editor, such as vi. For example, /dev/sdb1 /mnt/data ext2 defaults 1 1. This entry mounts the virtual disk every time you restart Linux.

**Linking a network-server storage space to a network-server description:**

You can link a network-server storage space (NWSSTG) to one or more network-server descriptions (NWSDs). This allows the NWSDs and their associated logical partitions to use the data stored on the NWSSTG.

You can link an NWSSTG to an unlimited number of NWSDs. This is beneficial when multiple logical partitions need access to a single application.

When you link an NWSSTG to an NWSD, you can set up the NWSD to have read-only access to the NWSSTG, or you can set up the NWSD to read or write to the NWSSTG.

**Attention:** If more than one NWSD can write to the NWSSTG, ensure that only one NWSD can update the data at a time. Otherwise, changes made by one NWSD can be overwritten by another NWSD.

To link an NWSSTG to an NWSD, follow these steps:
1. At an i5/OS command line, type the command ADDNWSSTG and press F4.
2. From the Add Server Storage Link display, provide the following information:
   - NWSSTG (Name)
   - NWSD (Name)
   - DYNAMIC (*YES)
   - DRVSEQNBR (*CALC)
3. Press F10 (Additional Parameters).
4. Enter the type of access the storage space will have.

**Deleting network-server descriptions for a Linux logical partition:**

You can delete the i5/OS network-server description (NWSD) for a Linux logical partition that uses i5/OS resources. When you delete the NWSD, all the configuration information for the Linux logical partition is deleted from i5/OS.

To delete the network-server description (NWSD) for a Linux logical partition, follow these steps:
1. On an i5/OS control language (CL) command line, type the command WRKNWSD and press Enter.
2. Type 8 in the Opt field to the left of the Network Server and press Enter.
3. In the Work with Configuration Status display, if the status of the NWSD is not varied off, type 2 in the Opt field to the left of the Network Server and press Enter. Otherwise, go to the next step.
4. Press F3 to return to the previous display.
5. Enter a 4 in the Opt field to the left of the Network Server and press Enter.

**Deleting virtual disk drives for a Linux logical partition:**

You can delete a virtual disk drive from a Linux logical partition that uses i5/OS resources to make the space available to the i5/OS logical partition once more. When you delete a virtual disk drive, all of the information on the virtual disk drive is erased.

Before you can delete a disk drive, you must unlink it from the network-server description. For more information on how to unlink a virtual disk drive from an NWSD, see Unlinking virtual disk drives from a Linux logical partition.

To delete a virtual disk drive, follow these steps:

Delete the disk drive using the interface that you prefer.

<table>
<thead>
<tr>
<th>Interface</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>iSeries Navigator</td>
<td>Complete the following steps:</td>
</tr>
<tr>
<td></td>
<td>1. Click Network → Windows Administration → Disk Drives.</td>
</tr>
<tr>
<td></td>
<td>2. Right-click the disk drive that you want to delete.</td>
</tr>
<tr>
<td></td>
<td>3. Click Delete.</td>
</tr>
<tr>
<td></td>
<td>4. Click Delete in the confirmation window.</td>
</tr>
<tr>
<td>i5/OS character-based interface</td>
<td>Complete the following steps:</td>
</tr>
<tr>
<td></td>
<td>1. At an i5/OS control language (CL) command line, type DLTNWSSTG and press F4.</td>
</tr>
<tr>
<td></td>
<td>2. Type the name of the disk drive in the Network-server storage space field and press Enter.</td>
</tr>
</tbody>
</table>
Related tasks

“Unlinking virtual disk drives from a Linux logical partition”

By unlinking virtual disk drives (network-server storage spaces) from a Linux logical partition that uses i5/OS resources, you disconnect the virtual disk drives from the logical partition, making the virtual disk drives inaccessible to users. If you delete a Linux logical partition that uses i5/OS resources, you must unlink all virtual disk drives from the logical partition before you delete the logical partition.

Using IPL types when running Linux:

The IPL source (IPLSRC) parameter on the network-server description (NWSD) determines the initial program that is loaded when the NWSD is varied on. For a Linux logical partition that uses i5/OS resources, the initial program is the kernel. Ensure that the IPLSRC parameter specifies the kernel location of the kernel for the Linux logical partition that uses i5/OS resources.

You can set the IPLSRC parameter when you use the Create Network Server Description (CRTNWSD) command, and you can change the IPLSRC parameter when you use the Change Network Server Description (CHGNWSD) command.

Note: IPLSRC parameter also has the values A, B, and D, which are not valid for IBM System i hardware.

The IPLSRC parameter has the following valid values.

<table>
<thead>
<tr>
<th>IPLSRC values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>*Panel</td>
<td>The partition is started from the source indicated on the control panel.</td>
</tr>
<tr>
<td>*NWSSTG (network-server storage space)</td>
<td>This IPL type is used to start a partition from a virtual disk. The open firmware will find the kernel in the virtual disk. The open firmware searches the first virtual disk connected to the server for a partition marked bootable, and of type 0x41 (PReP start). If a partition of this type does not exist, the partition IPL will fail.</td>
</tr>
<tr>
<td>*STMF (stream file)</td>
<td>This IPL type is used to start a partition from a kernel loaded in the i5/OS integrated file system. Note that the integrated file system includes files on the optical (CD) drive on i5/OS.</td>
</tr>
</tbody>
</table>

Unlinking virtual disk drives from a Linux logical partition:

By unlinking virtual disk drives (network-server storage spaces) from a Linux logical partition that uses i5/OS resources, you disconnect the virtual disk drives from the logical partition, making the virtual disk drives inaccessible to users. If you delete a Linux logical partition that uses i5/OS resources, you must unlink all virtual disk drives from the logical partition before you delete the logical partition.

To unlink a virtual disk drive from a Linux logical partition that uses i5/OS resources, follow these steps:

1. Unlink disk drives from a logical partition using iSeries Navigator. If you prefer to use a character-based interface, go to step 2 on page 120
   a. Vary off the NWSD for your logical partition. For more information, see Starting and stopping the NWSD.
   b. Click Network → Windows Administration → Disk Drives.
   c. Right-click the name of the disk drive that you want to unlink.
   d. Click Remove Link.
   e. Select a server from the list of linked servers.
f. If you are unlinking a disk drive that you plan to relink later, uncheck Compress link sequence.
   You must relink the disk drive as the same link sequence number before you vary on the server. By
   preventing compression of the link sequence values, you avoid having to unlink and relink all the
   disk drives to get them in the correct sequence.

g. Click Remove.

h. You have completed this procedure. Do not complete step 2.

2. Unlink disk drives from a logical partition using a character-based interface:
   a. Vary off the NWSD for your logical partition. For more information, see Starting and stopping the
      NWSD.
   b. Type RMVNWSTG and press F4.
   c. In the Network-server storage space field, type the name of the storage space that you want to
      unlink and press Enter.
   d. In the Network server description field, type the name of the server from which you want to
      unlink the storage space and press Enter.
   e. If you are unlinking a linked disk drive that you plan to relink later, specify *NO in the Renumber
      field.

      Note: You must relink the disk drive as the same sequence number before you vary on the server.
      By preventing automatic renumbering, you avoid having to unlink and relink all the disk drives to
      get them in the correct sequence.

   f. Press Enter.

      Note: If you are uninstalling a logical partition, your next step is to delete the disk drive. For more
      information on deleting disk drives, see Deleting virtual disk drives for a logical partition.
      Otherwise, vary on the NWSD for your logical partition. For more information about starting the
      NWSD, see Starting and stopping the NWSD.

For more information about saving i5/OS server objects, see Saving server objects in i5/OS.

Related concepts

“Saving Linux server objects in i5/OS”
When a Linux logical partition uses i5/OS resources, i5/OS stores Linux information in i5/OS
objects. i5/OS can restore the objects correctly only if you save all objects for a Linux logical partition.

Related tasks

“Deleting virtual disk drives for a Linux logical partition” on page 118
You can delete a virtual disk drive from a Linux logical partition that uses i5/OS resources to make the
space available to the i5/OS logical partition once more. When you delete a virtual disk drive, all of the
information on the virtual disk drive is erased.

“Starting the network-server description for a Linux logical partition” on page 113
You can start the network-server description (NWSD) for a Linux logical partition that uses i5/OS
resources to make the resources defined in the NWSD available to the Linux logical partition.

Saving Linux server objects in i5/OS:

When a Linux logical partition uses i5/OS resources, i5/OS stores Linux information in i5/OS
objects. i5/OS can restore the objects correctly only if you save all objects for a Linux logical partition.

You can save these objects by using options of the i5/OS GO SAVE command in the server.
   • Option 21 saves the entire server.
   • Option 22 saves server data, which includes objects in the QUSRSYS library.
   • Option 23 saves all user data, which includes objects in the QFPNWSSTG library.
If you want to save a particular object, use the following table to see the location of that object on i5/OS and the command to use. For more information about using the save commands, see the i5/OS Backup and recovery topic collection.

**Table 18. Objects to save for logical partitions with virtual disk**

<table>
<thead>
<tr>
<th>Object content</th>
<th>Object name</th>
<th>Object location</th>
<th>Object type</th>
<th>Save command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Guest partition and virtual disk drive</td>
<td>stgspc</td>
<td>/QFPNWSSTG</td>
<td>User-defined network-server storage spaces in system auxiliary storage pool</td>
<td>GO SAV, option 21 or 23</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(ASP)</td>
<td>SAV OBJ('/QFPNWSSTG/stgspc')</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>DEV('/QSYS.LIB/TAP01.DEVD')</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Table 19. Objects to save for all logical partitions with a server**

<table>
<thead>
<tr>
<th>Object content</th>
<th>Object name</th>
<th>Object location</th>
<th>Object type</th>
<th>Save command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Messages from the logical partition</td>
<td>Various</td>
<td>Various</td>
<td>Server message queue</td>
<td>GO SAVE, option 21 or 23</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>SAVOBJ OBJ(msg) LIB(library)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>DEV(TAPO1) OBJTYPE(*MSGQ)</td>
</tr>
<tr>
<td>i5/OS configuration objects for logical partitions</td>
<td>Various</td>
<td>QSYS</td>
<td>Device configuration objects</td>
<td>GO SAVE, option 21, 22, or 23</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>SAVOBJ DEV (TAPO1)</td>
</tr>
<tr>
<td>Various</td>
<td>Various</td>
<td>QUSR SYS</td>
<td>Various</td>
<td>GO SAVE, option 21 or 23</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>SAVLIB LIB(*NONSYS) or LIB(*ALLUSR)</td>
</tr>
</tbody>
</table>

**Related tasks**

"Unlinking virtual disk drives from a Linux logical partition" on page 119

By unlinking virtual disk drives (network-server storage spaces) from a Linux logical partition that uses i5/OS resources, you disconnect the virtual disk drives from the logical partition, making the virtual disk drives inaccessible to users. If you delete a Linux logical partition that uses i5/OS resources, you must unlink all virtual disk drives from the logical partition before you delete the logical partition.

**Related information**

- [Backup and recovery](#)

**Setting partition-availability priorities for your managed system using version 7 or later of the HMC**

To avoid shutting down mission-critical workloads when your server firmware deconfigures a failing processor, you can set partition-availability priorities for the logical partitions on your managed system. A logical partition with a failing processor can acquire a replacement processor from logical partitions with a lower partition-availability priority. The acquisition of a replacement processor allows the logical partition with the higher partition-availability priority to continue running after a processor failure.

To set partition-availability priorities for your managed system using version 7 or later of the Hardware Management Console (HMC), you must be a super administrator, product engineer, or an operator. For more information about the role of a super administrator, product engineer, and operator, refer to Tasks and roles.
To set partition-availability priorities for your managed system using version 7 or later of the HMC, follow these steps:

1. In the navigation pane, open **Systems Management** and click **Servers**.
2. In the contents pane, select the managed system whose partition-availability priorities you want to set, click the **Tasks** button, and select **Configuration → Partition Availability Priority**.
3. Select the logical partitions whose partition-availability priority you want to set, set **Availability priority** to the partition-availability priority value that you want to use for all selected logical partitions, and click **OK**. You can enter any value from 0 to 255 into **Availability priority**, or you can select one of the preset choices. All selected logical partitions are set to the same partition-availability priority value.
4. Repeat this procedure for other logical partitions to set the partition-availability priority for those logical partitions.

**Designating the service partition for your managed system using version 7 or later of the HMC**

The **service partition** is the i5/OS logical partition on an IBM System i server that you can configure to apply server firmware updates to the service processor or to the hypervisor and to communicate server common hardware errors to IBM. These abilities are useful if the Hardware Management Console (HMC) is undergoing maintenance or is otherwise unable to perform these functions.

The preferred method for applying server firmware updates and communicating server common hardware errors to IBM is by using the HMC.

IBM System p and OpenPower servers do not have a service partition. If an IBM System p and OpenPower server is managed by an HMC, then you must use the HMC to update the server firmware, and the server can contact service and support only through the HMC. If you use an HMC to manage IBM System p and OpenPower servers, then use a backup HMC to ensure that the servers have redundant methods for contacting service and support and for applying fixes.

You can designate only one logical partition at a time as the service partition for your managed system. The service partition for your IBM System i server must be an i5/OS logical partition.

Before you can designate a logical partition as the service partition for your managed system, you must shut down the logical partition. You must also shut down the logical partition before you remove the service partition designation from the logical partition. If you want to change the service partition from one logical partition to another logical partition, you must shut down both logical partitions before using this procedure. Refer to the operating system shutdown procedures for information on shutting down your logical partitions normally.

**Note:** You must designate a service partition on a server only after you use the HMC to create, change, delete, copy, or activate any logical partitions on the managed system. You can set up the operating system on an unpartitioned server to contact service and support, and you can use the operating system on an unpartitioned server to apply server firmware updates.

To designate a service partition for your managed system using version 7 or later of the HMC, you must be a member of the super administrator role. For more information about user roles, refer to Tasks and roles.

To designate one of your logical partitions as the service partition for your managed system using version 7 or later of the HMC, follow these steps:

1. In the navigation pane, open **Systems Management** and click **Servers**.
2. In the contents pane, select the managed system whose service partition you want to designate, click the **Tasks** button, and select **Properties**.
3. In the **Service partition** field, select the logical partition that you want to designate as the service partition. If you do not want to designate another logical partition as the service partition, select **None**.

4. Click **OK**.

**Installing new hardware for i5/OS logical partitions**

You can install an I/O processor (IOP) or an I/O adapter (IOA) for an i5/OS logical partition.

When you install new hardware in an i5/OS partitioned environment, you should be aware of the following things:

- Verify that your logical partition configuration is current.
- Empty positions might not be owned by a logical partition. They should be assigned to the desired logical partition before installing new adapters in them. After you install the new adapter, you must also add the adapter to the partition profile so that, when you shut down and activate the logical partition using the partition profile, the logical partition reactivates with the adapter that you added.
- A new IOP or IOA is owned by the logical partition that owns the slot, and a new device is owned by the logical partition that owns the IOA to which the device is attached.
- New processors and memory are available (unassigned) to be assigned to any partition.
- New 5250 commercial processing workload (5250 CPW) is assigned across i5/OS logical partitions by the percentage specified in the Create Partition Profile wizard. After an upgrade, ensure partitions are not assigned more 5250 CPW than they can use.

To install an IOP or IOA for an i5/OS logical partition, perform the following steps:

1. Assign empty slots to the desired logical partition. For more information about assigning an empty slot to a logical partition, see Managing physical I/O devices and slots dynamically using the HMC. For more information about adding an adapter to a partition profile, see Changing partition profile properties using the HMC.

2. Install the new hardware into the empty slots using the Installing features and replacing parts information.

**Related concepts**

- "Managing physical I/O devices and slots dynamically using version 6 or earlier of the HMC" on page 246

You can add, remove, and move physical I/O devices and slots dynamically from one running logical partition to another using the Hardware Management Console (HMC). This allows logical partitions to share infrequently used I/O devices (such as optical disc drives).

**Related tasks**

- "Changing partition profile properties using version 6 or earlier of the HMC" on page 240

You can change the properties of a partition profile using the Hardware Management Console (HMC). Changing the properties of a partition profile will change the resource amounts that are assigned to a logical partition when you shut down and restart the logical partition using the changed partition profile.

**Related information**

- Installing features and replacing parts

**Configuring resource management for AIX partitions with the Partition Load Manager**

The Partition Load Manager for AIX 5L™ provides automated processor and memory resource management across logical partitions that are capable of dynamic logical partitioning on AIX 5L.

The Partition Load Manager allocates resources to partitions on demand within the constraints of a user-defined policy. Partitions with a high demand for resources are given resources from partitions with a lower demand, improving the overall resource utilization of the system. Resources that would otherwise be unused, if left allocated to a partition that was not using them, can now be used to meet resource demands of other partitions in the same system.
The Partition Load Manager uses a client/server model to report and manage resource utilization. The clients, or managed partitions, notify the Partition Load Manager server when resources are either not used enough or are overused. Upon notification of one of these events, the Partition Load Manager server makes resource allocation decisions based on a user-defined resource management policy. This policy determines how much of the available resources are to be allocated to each partition.

The Partition Load Manager works much like any other system management software in that you can use it to view the resources across your partitions, group those resources into manageable segments, and allocate and reallocate those resources within or across the groups. It also locally logs activity on the partitions. The underlying processes of the Partition Load Manager rely on Resource Monitoring and Control (RMC) for network communication with the managed partitions.

Requirements for using the Partition Load Manager server include the following:

- A Hardware Management Console (HMC) must be attached to the managed system.
- The Partition Load Manager system can be running AIX 5L Version 5.2 with the 5200-04 Technology Level or AIX 5L Version 5.3.
- The Partition Load Manager system can be a partition in the managed server, a partition in a different server, or a stand-alone AIX system.
- The Partition Load Manager server system requires network connectivity to the HMC and to every managed partition.
- Multiple Partition Load Manager servers might be run on one AIX system.
- One Partition Load Manager server can manage partitions within only one managed server.

Preparing to install the Partition Load Manager:

Use this procedure to prepare to install the Partition Load Manager.

Before you install the Partition Load Manager, complete the following steps:

Name resolution

Resolve the host name by completing the following steps:

1. Set the host name on each logical partition to the fully qualified host name, such as lpar1.domain.com.
2. If you are not using a name server, edit the /etc/hosts file on each logical partition to include the Partition Load Manager server host name, similar to the following:

   172.16.0.30 lpar1.domain.com lpar1
   172.16.0.100 plmserver1.domain.com plmserver1

3. If you are not using a name server, edit the /etc/hosts file on the Partition Load Manager server to include the logical partitions and HMC host names, similar to the following:

   172.16.0.100 plmserver1.domain.com plmserver1
   172.16.0.30 lpar1.domain.com lpar1
   172.16.0.33 lpar2.domain.com lpar2
   172.16.0.3 p5hmc1.domain.com p5hmc1

Dynamic logical partitioning capability on logical partitions

Determine the dynamic logical partitioning capability of logical partitions by completing the following steps:

1. To determine whether each logical partition is capable of dynamic logical partitioning, run the following command:

   lssrc -a | grep rsct

   If the IBM.DRM daemon is running, then the logical partition has an active Resource Monitoring and Control (RMC) session with the HMC and is capable of dynamic logical partitioning.
If the IBM.DRM daemon is not running, check the name resolution and the network connectivity between the HMC and the LPAR.

2. If you changed the host name without rebooting, recycle the RMC daemons on each logical partition by running the following commands:

   /usr/sbin/rcst/bin/rmcctrl -z
   /usr/sbin/rsct/bin/rmcctrl -s

**RSH and RCP access to managed logical partitions from the Partition Load Manager server**

Remote shell (rsh) and remote control panel (rcp) access is required to all logical partitions for setting up the Partition Load Manager. If rsh and rcp have been disabled for security reasons, use the following steps to enable these services:

1. Edit the `.rhosts` file on each logical partition to add the following lines:
   
   plmserver1 root
   plmserver1.domain.com root

2. Enable rsh and rcp on each logical partition by running the following commands:

   chmod 4554 /usr/sbin/rshd
   chmod 4554 /usr/bin/rcp

3. Edit the `/etc/inetd.conf` file, and uncomment the following line:

   shell stream tcp6 nowait root /usr/sbin/rshd rshd

4. Restart the inetd daemon by running the following command.

   refresh -s inetd

5. Test the rsh access from the Partition Load Manager server to each logical partition by running the following commands:

   rsh lpar1 -l root date
   rsh lpar2 -l root date

**Create an AIX user ID for the Partition Load Manager**

The Partition Load Manager server is a `setuid` program that runs under the configured user ID. This user must exchange ssh keys with the configured HMC user and be authorized with Resource Monitoring and Control (RMC) before running Partition Load Manager. Use any of the management interfaces to create the `plmuser` ID on the Partition Load Manager server.

**Installing OpenSSH software tools:**

Use this procedure to download and install OpenSSH software tools on an AIX logical partition. OpenSSH must be set up so that you can facilitate authentication and communication between the Partition Load Manager server and the controlling Hardware Management Console (HMC).

Whenever the Partition Load Manager satisfies a resource request, it uses remote HMC commands to gather partition information and initiate dynamic logical partitioning operations. The HMC must be enabled for OpenSSH by activating the Enable/Disable Remote Command Execution task on the HMC.

When you are setting up a user on the HMC for OpenSSH, specify one of the following roles:

- System administrator
- Service representative
- Advanced operator

Before you can use OpenSSH, there must be a user on the HMC that has remote command enabled. This user must exchange ssh keys with the configured HMC user, but does not have to be the same user as the `plmuser` ID.
OpenSSH software tools support the SSH1 and SSH2 protocols. The tools provide shell functions where network traffic is encrypted and authenticated. OpenSSH is based on client and server architecture. OpenSSH runs the sshd daemon process on the AIX host and waits for the connection from clients. It supports public-key and private-key pairs for authentication and encryption of channels to ensure secure network connections and host-based authentication. For more information about OpenSSH, including the man pages, see http://www.openssh.org.

The OpenSSH software is included on the AIX 5.3 Expansion Pack. This version of OpenSSH is compiled and packaged as **installp** packages using the **openssh-3.7.1p2** level of source code. The **installp** packages include the man pages and the translated message filesets. The OpenSSH program contained in the Expansion Pack CD-ROM media is licensed under the terms and conditions of the IBM International Program License Agreement (IPLA) for Non-Warranted Programs.

Before installing the OpenSSH **installp** format packages, you must install the Open Secure Sockets Layer (OpenSSL) software that contains the encrypted library. OpenSSL is available in RPM packages from the AIX Toolbox for Linux Applications Web site.

Because the OpenSSL package contains cryptographic content, you must register on the Web site to download the packages. You can download the packages by completing the following steps:

1. Access the AIX Toolbox for Linux Applications Web site.
2. Click the **AIX Toolbox Cryptographic Content** link on the right side of the page.
3. Click **Sign in** and sign in using your IBM ID, or click **register now** and register for a new IBM ID.
   The license agreement page is displayed when you are done.
4. Click **View license** to read the license.
5. If you agree to the license terms, select **I agree** and click **I confirm**.
6. Scroll to the **OpenSSL — SSL Cryptographic Libraries** section of the download page.
7. Click **Download Now!** under each rpm package that you want to download.

After you download the OpenSSL package, you can install OpenSSL and OpenSSH.

1. Install the OpenSSL RPM package using the geninstall command, as follows:

   ```
   # geninstall -d/directory R:openssl-0.9.6g
   ```

   where **directory** is the name of the directory to which you downloaded the OpenSSL package. Output similar to the following displays:

   ```
   SUCCESSES
   ---------
   openssl-0.9.6g-3
   ```

2. Install the OpenSSH **installp** packages using the geninstall command, as follows:

   ```
   # geninstall -Y -d/directory I:openssh.base
   ```

   Use the **-Y** flag to accept the OpenSSH license agreement after you have reviewed the license agreement.

   To view the license agreement, type the following command:

   ```
   # geninstall -IapE -d/directory openssh.base 2>&1 |pg
   ```

   After you accept the license agreement, output similar to the following displays:

   ```
   Installation Summary
   -------------------
   Name            Level     Part     Event    Result
   -------------------
   openssh.base.client 3.6.0.5200 USR APPLY SUCCESS
   openssh.base.server 3.6.0.5200 USR APPLY SUCCESS
   openssh.base.client 3.6.0.5200 ROOT APPLY SUCCESS
   openssh.base.server 3.6.0.5200 ROOT APPLY SUCCESS
   ```
You can also use the `smitty license_on_media` fast path to view the license, and the `smitty install_software` fast path to install OpenSSL and OpenSSH.

The following OpenSSH binary files are installed as a result of the preceding procedure:

- **scp**: A file copy program similar to `rcp`
- **sftp**: A program similar to FTP that works over the SSH1 and SSH2 protocol
- **sftp-server**: A SFTP server subsystem (started automatically by `sshd` daemon)
- **sshd**: A daemon that permits you to log in
- **ssh**: Similar to the `rlogin` and `rsh` client programs
- **ssh-agent**: A tool that adds keys to `ssh-agent`
- **ssh-keygen**: A key-generation tool
- **ssh-keyscan**: A utility for gathering public host keys from a number of hosts
- **ssh-keysign**: A utility for host-based authentication
- **sshd**: A daemon that permits you to log in

**SSH access to the HMC from the Partition Load Manager server**

After you have installed SSH, you can generate the SSH keys and communicate with the HMC.

If you are going to run the Partition Load Manager server under the `plmuser` ID, grant SSH access to the HMC from the Partition Load Manager server by using the following steps:

1. Log in under the `plmuser` ID.
2. Generate SSH keys on the Partition Load Manager server by using the following command:
   
   ```bash
   ssh-keygen -t rsa
   ```
3. Exchange SSH keys with the HMC by using the following commands:
   
   ```bash
   scp hscroot@p5hmc1:.ssh/authorized_keys2 ~/.ssh/tmp_authorized_keys2
cat ~/.ssh/id_rsa.pub >> ~/.ssh/tmp_authorized_keys2
   scp ~/.ssh/tmp_authorized_keys2 hscroot@p5hmc1:.ssh/authorized_keys2
   ```
4. Test the SSH access to the HMC as the `plmuser` ID without using a password by using the following command:
   
   ```bash
   ssh hscroot@p5hmc1 date
   ```
5. Obtain the name of the managed system from the HMC by using the following command:
   
   ```bash
   ssh hscroot@p5hmc1 lssyscfg -r sys
   ```

Unless the name of the managed system is changed on the HMC using the **Properties** tab on the managed system, the default managed system name is similar to the following:

```
eServer-9117-570-SNxxxxxxx
```

**Note**: The HMC hostname used in the setup and the managed system name are used in the Partition Load Manager policy. If there is more than one managed system, determine which system contains the partitions to be managed. For each managed system, use the following command:

```bash
ssh hmcuser@hmchost lssyscfg -r lpar -m machine
```
Installing the Partition Load Manager server:

Use this procedure to install the Partition Load Manager server on an AIX logical partition.

To install the Partition Load Manager server, complete the following steps:
1. Mount the Partition Load Manager CD to your system.
2. Using either the installp command or the smitty install_latest fastpath, install the following filesets:
   - plm.license
   - plm.server.rte
   - plm.sysmgt.websm
   - plm.msg.en_US.server
   - plm.msg.en_US.websm
3. Read and accept the license.

Now that the Partition Load Manager server is installed, you can create a policy file and configure Resource Monitoring and Control (RMC) for the Partition Load Manager. If you create the policy file first and Web-based System Manager is being used, you can use the policy file to input the list of partitions being managed.

Configuring the policy file:

Use this procedure to configure the policy file for the Partition Load Manager server.

Policy file concepts

The system uses the policy file to determine which processor and memory resources may be managed by the Partition Load Manager server. The policy also includes resource shares, group definitions, and tunable parameters. This file defines the partitions that are to be managed, their guaranteed entitlements, and their minimum and maximum entitlements.

The policy file is divided into stanzas. Each stanza has a type field. Every stanza follows the following format:

<stanza_label>:
  attribute=value
  attribute2=value
  type=value

The policy file has the following rules:
- The policy file consists of a number of stanzas containing attributes.
- Stanza names may not contain any blanks and must be followed immediately by a colon (:). Only white space or a comment can follow the stanza name. For improved readability, enter stanza names starting in column 1 on the line. The following are the supported stanza types:
  - globals:
  - tunables:
  - group_name:
  - partition_name:
- Attributes consist of a name and a value separated by an equal sign (=). Attribute names and values may not contain any blanks. Only white space or a comment may follow the value. For improved readability, enter attributes so that they are indented under the containing stanza name.
- Do not repeat attributes in a stanza. Only the first attribute in a stanza is used.
- Comments begin with a number sign (#). Comments can be started in any column on the line and continue until end of line.
Stanzas may be placed in the policy file in any order. The following is a suggested order:

1. globals stanza
2. tunables stanza
3. group stanza for first group
4. partition stanzas for partitions in first group
5. repeat group/partition stanza for subsequent groups

The available types of stanzas and their attributes are described as follows:

**globals stanza:**

This stanza specifies global environment attributes for the Partition Load Manager server. Only one globals stanza can be specified in a Partition Load Manager policy.

The following attributes are required in the globals stanza:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hmc_host_name</td>
<td>Host name of the Hardware Management Console (HMC) that manages the server that contains the managed partitions. This is the host name that was used for the HMC when exchanging ssh keys.</td>
</tr>
<tr>
<td>hmc_cec_name</td>
<td>The HMC managed system name for the server that contains the managed partitions.</td>
</tr>
<tr>
<td>hmc_user_name</td>
<td>The user name that the Partition Load Manager uses to send OpenSSH commands to the HMC.</td>
</tr>
</tbody>
</table>

The following attribute is optional in the globals stanza:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Minimum value</th>
<th>Maximum value</th>
<th>Default value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hmc_command_wait</td>
<td>1 minute</td>
<td>60 minutes</td>
<td>5 minutes</td>
<td>The number of minutes that the Partition Load Manager waits before timing out an HMC command. This is the DR Phase Timeout, one of three phases.</td>
</tr>
</tbody>
</table>

**tunables stanza:**

This optional stanza is used to specify tunable attributes for the managed partitions. There are no required attributes in the tunables stanza. The Partition Load Manager has selected default values for these attributes that are appropriate for most installations. However, installations with special requirements can customize their installation by specifying the attributes in this stanza. The attributes in the tunables stanza can also be specified in the group and partition stanzas. A tunable attribute for a partition is obtained in the following order:

1. From the partition stanza.
2. From the group stanza containing the partition if tunable attribute is not specified in the partition stanza.
3. From the tunables stanza if tunable attribute is not specified in the partition or group stanzas.
4. Default value is used if tunable attribute is not specified in the partition, group, or tunables stanzas.

Specify any of the following processor-related attributes:
<table>
<thead>
<tr>
<th>Attribute</th>
<th>Minimum value</th>
<th>Maximum value</th>
<th>Default value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cpu_intervals</td>
<td>1</td>
<td>100</td>
<td>6</td>
<td>The number of 10-second periods that a CPU-related sample must cross before the Partition Load Manager will activate. Setting this value higher causes the Partition Load Manager to react more slowly to system changes. Setting it lower causes the Partition Load Manager to activate more quickly.</td>
</tr>
<tr>
<td>cpu_load_low</td>
<td>0.10</td>
<td>1.00</td>
<td>0.5</td>
<td>The CPU load average low threshold value. A partition with a load average below this value is considered to have unneeded CPU capacity. Note: The minimum delta between cpu_load_low and cpu_load_high is 0.10.</td>
</tr>
<tr>
<td>cpu_load_high</td>
<td>0.2</td>
<td>10.0</td>
<td>1.0</td>
<td>The CPU load average high threshold value. A partition with a load average above this value is considered to need more CPU capacity. Note: The minimum delta between cpu_load_low and cpu_load_high is 0.10.</td>
</tr>
<tr>
<td>cpu_free_unused</td>
<td></td>
<td></td>
<td>No</td>
<td>Indicates whether CPU capacity not needed by a partition is removed from the partition. A value of no indicates unneeded CPU capacity remains in the partition until another partition has a need for it. A value of yes indicates unneeded CPU capacity is removed from the partition when the partition no longer has a need for it.</td>
</tr>
</tbody>
</table>

Specify any of the following shared processor-related attributes:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Minimum value</th>
<th>Maximum value</th>
<th>Default value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ec_delta</td>
<td>1</td>
<td>100</td>
<td>10</td>
<td>The amount of CPU entitled capacity to add or remove from a shared processor partition. The value specifies the percentage of the partition’s current entitled capacity to add or remove.</td>
</tr>
<tr>
<td>ec_per_vp_min</td>
<td>0.1</td>
<td>0.9</td>
<td>0.5</td>
<td>The minimum amount of entitled capacity per virtual processor. This attribute prevents a partition from having degraded performance by having too many virtual processors relative to its entitled capacity. When entitled capacity is removed from a partition, virtual processors will also be removed if the amount of entitled capacity for each virtual processor falls below this number. Note: The minimum delta between ec_per_vp_min and ec_per_vp_max is 0.10.</td>
</tr>
</tbody>
</table>
### ec_per_vp_max

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Minimum value</th>
<th>Maximum value</th>
<th>Default value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ec_per_vp_max</td>
<td>0.2</td>
<td>1.0</td>
<td>0.8</td>
<td>The maximum amount of entitled capacity per virtual processor. This attribute controls the amount of available capacity that may be used by an uncapped shared CPU partition. When entitled capacity is added to a partition, virtual processors will be added if the amount of the entitled capacity for each virtual processor exceeds this number. Increasing the number of virtual processors in an uncapped partition allows the partition to use more of the available CPU capacity. <strong>Note:</strong> The minimum delta between ec_per_vp_min and ec_per_vp_max is 0.10.</td>
</tr>
</tbody>
</table>

Specify any of the following memory-related attributes:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Minimum value</th>
<th>Maximum value</th>
<th>Default value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>mem_intervals</td>
<td>1</td>
<td>100</td>
<td>6</td>
<td>The number of 10-second periods that a memory-related sample must cross before the Partition Load Manager will activate. Setting this value higher causes the Partition Load Manager to react more slowly to system changes. Setting it lower causes the Partition Load Manager to activate more quickly.</td>
</tr>
<tr>
<td>mem_util_low</td>
<td>1</td>
<td>90</td>
<td>50</td>
<td>The memory utilization low threshold value. A partition with a memory utilization below this value is considered to have unneeded memory. Units are expressed as a percent. <strong>Note:</strong> The minimum delta between mem_util_low and mem_util_high is 10.</td>
</tr>
<tr>
<td>mem_util_high</td>
<td>1</td>
<td>100</td>
<td>90</td>
<td>The memory utilization high threshold value. A partition with a memory utilization above this value is considered to need more memory. Units are expressed as a percent. <strong>Note:</strong> The minimum delta between mem_util_low and mem_util_high is 10.</td>
</tr>
<tr>
<td>mem_pgstl_high</td>
<td>0</td>
<td>2147483647</td>
<td>0</td>
<td>The page steal threshold. A partition with a page steal rate, which is the number of page steals per second, greater than or equal to this value is considered to need more memory. Units are expressed as an integer value. The result of checking this threshold is logically ANDed with the result of the mem_util_high threshold check when determining if memory is needed.</td>
</tr>
<tr>
<td>Attribute</td>
<td>Minimum value</td>
<td>Maximum value</td>
<td>Default value</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>---------------</td>
<td>---------------</td>
<td>---------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>mem_free_unused</td>
<td></td>
<td></td>
<td>No</td>
<td>Indicates when memory not needed by a partition is removed from the partition. A value of no indicates unneeded memory remains in the partition until another partition has a need for it. A Yes value indicates unneeded memory is removed from a partition when the partition no longer has a need for it.</td>
</tr>
<tr>
<td>mem_delta</td>
<td>1</td>
<td>256</td>
<td></td>
<td>Specifies one LMB to be removed or added to a partition at a time. The amount of memory to be removed or added to a partition. The units are in megabytes. If the value is less than the system’s logical memory block (LMB) size, the value is rounded up to the system’s LMB size. If the value is greater than the system’s LMB size but not a multiple of LMB size, the value is rounded down to the nearest LMB multiple size.</td>
</tr>
</tbody>
</table>

**group_name stanza:**

This stanza specifies the name and global attributes for a group, and any or all of the tunables stanzas. The name on a group stanza specifies the name of the group. The group stanza allows you to create multiple groups of partitions that are managed independently. At least one group must be defined.

The following attributes are required in the group stanza:

- type = group
- cpu_maximum
- mem_maximum

The **cpu_maximum** attribute specifies if processor management is desired for the partitions in the group and if desired the amount of processor capacity to be allocated to the partitions. If processor management is specified, processor management is performed for all partitions in the group. Specifying a **cpu_maximum** value of 0 specifies processor management is not performed for the partitions in the group.

All partitions in a group must have the same processor type. The **cpu_type** attribute specifies the processor type for all the partitions in the group and is written as follows:

cpu_type = dedicated | shared

The **mem_maximum** attribute specifies memory management is desired for the partitions in the group and if desired the amount of memory to be allocated to the partitions. If memory management is specified, memory management is performed for all partitions in the group. Specifying a **mem_maximum** value of 0 specifies memory management is not performed for the partitions in the group.

You can specify **cpu_maximum** and **mem_maximum** values greater than the amount of physical resources in the server. In this situation, all available resources will be used to satisfy resource requests for the managed partitions.

The following attributes are required in this stanza:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>type=group</td>
<td>An attribute identifying this as a group stanza. The attribute must be specified as type = group.</td>
</tr>
<tr>
<td>Attribute</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cpu_maximum</td>
<td>The maximum amount of CPU capacity to be allocated to partitions in the group. The units are in physical CPU units. A value of 0 indicates CPUs are not managed for the partitions in the group.</td>
</tr>
<tr>
<td>mem_maximum</td>
<td>The maximum amount of memory to be allocated to partitions in the group. The units are in megabytes (MB). A value of 0 indicates memory is not be managed for the partitions in the group.</td>
</tr>
<tr>
<td>cpu_type</td>
<td>The processor type of the partitions in the group. All partitions in the group must be the same type. The attribute value must either be dedicated or shared.</td>
</tr>
</tbody>
</table>

**partition_name stanza:**

This stanza specifies the name and attributes for a partition. A partition stanza is required for every managed partition.

The name of the partition stanza is the host name of the managed partition.

The following attributes are required in a partition stanza:

- type = partition
- group = group_name

The following attributes are optional in the partition stanza:

- cpu_minimum
- cpu_guaranteed
- cpu_maximum
- cpu_shares
- mem_minimum
- mem_guaranteed
- mem_maximum
- mem_shares

If not specified, the `cpu_minimum`, `cpu_guaranteed`, and `cpu_maximum` attribute values are obtained from the CPU minimum, desired, and maximum HMC partition definition values respectively. Similarly, the `mem_minimum`, `mem_guaranteed`, and `mem_maximum` attribute values are obtained from the minimum, desired, and maximum HMC partition memory definition values. The shares values default to 1.

If minimum, guaranteed, and maximum values are specified in the policy, the values must satisfy the following relationship:

minimum <= guaranteed <= maximum

If management of CPU or memory resource is not wanted in a specific partition in a group, the values for the resource can all be specified as the same value. If management of CPU or memory resource is not wanted for all partitions in a group, the `cpu_maximum` or `mem_maximum` attributes in the group definition can be set to 0.

Any CPU or memory values specified in the policy must be compatible with the partition’s HMC partition definition. You cannot use the Partition Load Manager to decrease a partition’s minimum below the HMC minimum. Nor can you use the Partition Load Manager to increase a partition’s maximum over the HMC maximum. System administrators are responsible for ensuring that the Partition Load Manager policies and HMC partition definitions are compatible.
The `cpu_shares` and `mem_shares` attributes are optional in the partition stanza, with default values set to 1.

The default value for `cpu_shares` is to have equal shares for all partitions in the group. The default `cpu_shares` value for shared, uncapped processor partitions is not obtained from the variable weight attribute of the partition’s HMC definition. If the `cpu_shares` attribute is not specified, the Partition Load Manager does not set the variable weight HMC attribute for the partition. (The variable weight value set by the HMC continues to be used.) If the `cpu_shares` attribute is specified and the partition is shared or uncapped, the Partition Load Manager sets the partition’s variable weight HMC attribute to the `cpu_shares` value.

The following tunable attributes are used in the partition stanza:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Minimum value</th>
<th>Maximum value</th>
<th>Default value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>type</td>
<td></td>
<td></td>
<td></td>
<td>A required attribute identifying this as a partition stanza. The attribute must be specified as <code>type = partition</code>.</td>
</tr>
<tr>
<td>group</td>
<td></td>
<td></td>
<td></td>
<td>A required attribute specifying the group containing this partition.</td>
</tr>
<tr>
<td>cpu_minimum</td>
<td></td>
<td></td>
<td></td>
<td>The minimum amount of CPU capacity to be allocated to a partition. The units are in physical CPU units.</td>
</tr>
<tr>
<td>cpu_guaranteed</td>
<td></td>
<td></td>
<td></td>
<td>The guaranteed amount of CPU capacity to be allocated to a partition. The units are in physical CPU units.</td>
</tr>
<tr>
<td>cpu_maximum</td>
<td></td>
<td></td>
<td></td>
<td>The maximum amount of CPU capacity to be allocated to partition. The units are in physical CPU units.</td>
</tr>
</tbody>
</table>
| cpu_shares      | 0             | 255           | 1             | A factor without units that is used to specify how available CPU capacity in excess of the `cpu_guaranteed` is distributed to partitions in the group. The available excess CPU capacity is allocated to partitions using the following formula:

\[
\frac{\text{cpu_shares}}{\sum \text{cpu_shares from active partitions in the group}}
\]

**Note:** Specifying a minimum value of 0 limits a partition to receiving only its `cpu_guaranteed` amount of CPU capacity. |
| mem_minimum     |               |               |               | The minimum amount of memory to be allocated to the partition. The units are in megabytes (MB). |
| mem_guaranteed  |               |               |               | The guaranteed amount of memory to be allocated to the partition. The units are in megabytes (MB). |
| mem_maximum     |               |               |               | The maximum amount of memory to be allocated to the partition. The units are in megabytes (MB). |
### Attribute Table

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Minimum value</th>
<th>Maximum value</th>
<th>Default value</th>
<th>Description</th>
</tr>
</thead>
</table>
| mem_shares   | 0             | 255           | 1             | A factor with no units that is used to specify how available memory in excess of the `mem_guaranteed` is distributed to the partitions in the group. The available excess memory is allocated to partitions using the following formula: 

\[
\text{(mem_shares)} / \left( \text{sum of mem_shares from competing partitions} \right)
\]

**Note:** Specifying a minimum value of 0 limits a partition to receiving only its `mem_guaranteed` amount of memory. |

---

**Example of policy file creation and configuration**

Using the Web-based System Manager, create a policy file by using the following steps as an example.

**Note:** If you are using a remote X server, set the `DISPLAY` variable, and use the `wsm &` command to start the Web-based System Manager client.

1. Create a policy file.
2. Add the policy file name: `/etc/plm/policies/plm1`
3. Add the following global values for the following fields:
   - Hardware Management Console (HMC) name: `p5hmc1`
   - HMC user name: `hscroot`
   - Central Electronic Complex name: `eServer-9117-570-SNxxxxxxx`
4. Obtain the names of the LPARs and settings from the HMC by running the following commands:
   - `ssh hscroot@p5hmc1 lssyscfg -r lpar -m eServer-9117-570-SNxxxxxxx` (LPAR names and default profile names)
   - `ssh hscroot@p5hmc1 lshwres -r proc -m eServer-9117-570-SNxxxxxxx --level lpar` (settings)
   - `ssh hscroot@p5hmc1 lshwres -r proc -m eServer-9117-570-SNxxxxxxx --level sys` (system resources)
   
   The output includes the following information:
   - `name=lpal1, default_profile=default`
   - `curr_min_proc_units=0.5, curr_proc_units=0.75, curr_max_proc_units=1.25`
   - `name=lpal2, default_profile=default`
   - `curr_min_proc_units=0.5, curr_proc_units=0.75, curr_max_proc_units=1.25`
5. Add the following group information to the policy file:
   - **Group name:** `plm1`
     - Maximum CPU: 1.75
     - Maximum Memory: N/A
     - CPU type: shared
     - Select **CPU management**
     - Deselect **Memory management**
6. Add the following information for partitions for CPU resource management:
   - Partition name: `lpal1.domain.com` (this is the fully qualified host name for lpar1)
- Group name: plm1
- Resource Entitlements:
  - Minimum CPU: 0.5
  - Guaranteed CPU: 0.75
  - Maximum CPU: 1.25
  - CPU variable shares: 1 (default)
- Partition name: lpar2.domain.com
- Group name: plm1
- Resource Entitlements:
  - Minimum CPU: 0.5
  - Guaranteed CPU: 0.75
  - Maximum CPU: 1.25
  - CPU variable shares: 1 (default)
- Tunable attributes:
  - CPU load average high threshold: 0.8
  - CPU load average low threshold: 0.2

**Querying partition status:**

You can use Partition Load Manager to query the status of the logical partitions on your managed system.

Any user can run the `xlplm` command to obtain status information for running instances of Partition Load Manager.

**Query the status of Partition Load Manager**

To query the status of all running instances of Partition Load Manager, type the following command:

```
xlplm -Q
```

A list of the instances that are running is displayed. If there are no instances running, no output is displayed.

**Query the attributes of an instance**

To query the attributes of a single instance, type the following command, where `test1` is the name of the instance:

```
xlplm -Q test1
```

Output from this command will be similar to the following:

```
PLM Instance: test1
GROUP: group1
   CUR   MAX   AVAIL  RESVD  MNGD
CPU:  6.00  4.00  0.00  0.00  Yes
MEM:  8192  8192  0    0    Yes

thimblelp10.server.company.com

RESOURCES:
   CUR  MIN  GUAR  MAX  SHR
CPU:  3.00  1.00  3.00  3.00  1
MEM:  4096 1024  4096 4096  1
```
View additional information from a query

To view additional information from the query of a specific instance, type the following command, where *test1* is the name of the instance:

```
xlpm -v -Q test1
```

The verbose output from this command will be similar to the following:

```
PLM Instance: test1

CEC Name       Thimble
Mode           monitor
Policy         /etc/plm/policies/policy1
Log            /tmp/log.test
HMC Host       kbuphsc2.server.company.com
HMC User       hscroot

GROUP: group1

<table>
<thead>
<tr>
<th></th>
<th>CUR</th>
<th>MAX</th>
<th>AVAIL</th>
<th>RESVD</th>
<th>MNGD</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>6.00</td>
<td>4.00</td>
<td>0.00</td>
<td>0.00</td>
<td>Yes</td>
</tr>
<tr>
<td>MEM</td>
<td>8192</td>
<td>8192</td>
<td>0.00</td>
<td>0.00</td>
<td>Yes</td>
</tr>
</tbody>
</table>

CPU TYPE: dedicated
```

Allocate resources to partitions

You can allocate resources to specific partitions and even reserve resources for specific partitions regardless of when those partitions will use the resources. You can reserve and allocate resources from a group of managed partitions using the `xlplm -R` command. Those resources that are reserved can be used to create a new unmanaged partition, or to make room for a new partition to enter the managed group.
Reserved resources will not be allocated to any existing partition in a group unless they are first released. If a previously offline partition comes online and enters a managed group, any reserved resources within that group automatically are removed from the collection of reserved resources, called the free pool, and assigned to the new partition. If the reserved resources are used instead to create a new, unmanaged partition, they can be released to the group after the new partition has booted and can then be automatically reclaimed by the managed group if they later become available and are needed.

The requested reservation amount is absolute, so a reserve command can result in either a reserve or a release, depending on the current reservation amount. The minimum allowed changes in the reservation amounts are the following:
- 1 MB for memory
- 1 processor unit for a dedicated processor group
- 0.01 processor unit for a shared processor group

When you reserve resources, the free pool for the target group is first checked for available resources. If the free pool has enough resources to satisfy the request, the requested amount is removed from the free pool. If the free pool does not have enough resources to satisfy the request, resources will be taken from one or more partitions with the lowest workload, or least need for the resources. A reservation request will fail if the requested amount is more than the minimum allowed for the group.

Manage memory resource requests

The following is an example of how to use Partition Load Manager to manage memory resource requests. This example shows how Partition Load Manager responds to memory resource requests between two partitions:

The two partitions, LP0 and LP1, are configured as follows:

LP0:
- Minimum = 1024 MB
- Guaranteed = 1024 MB
- Maximum = 4096 MB
- Weight = 2
- Current Entitlement = 1024 MB

LP1:
- Minimum = 1024 MB
- Guaranteed = 1024 MB
- Maximum = 4096 MB
- Current Entitlement = 1024 MB
- Weight = 1

The total amount of memory managed by Partition Load Manager is 5120 MB. With each partition’s current memory allocation, shown as Current Entitlement = 1024 MB, Partition Load Manager assumes that the remaining 3072 MB is unallocated and available.

If both partitions become loaded in terms of memory use, then events demanding more memory resources are generated and sent to the Partition Load Manager server. For each event received, Partition Load Manager identifies the partition as a taker. At the same time, Partition Load Manager checks whether the partition is currently using more than its guaranteed amount. If so, the partition is identified as an excess user. Because there are available resources, Partition Load Manager satisfies the request immediately and allocates memory in the amount of mem_increment (defined either in the Partition Load Manager policy or by the internal default value) to the partition from the available memory. After the available memory is depleted, the new entitlement allocations are as follows:

LP0: Current Entitlement = 2560 MB
LP1: Current Entitlement = 2560 MB

Even with the current allocations, the partitions continue to generate events demanding more memory resources.
For each event, Partition Load Manager continues to identify the partition as a taker and excess user because the partition has more resources allocated than is shown as its guaranteed entitlement. However, because there are no available resources, the request is queued if there are no other resource donors or any other excess users. When the request from the second partition is received, it is also marked as a taker and an excess user. Because there is an excess user already queued, Partition Load Manager can satisfy the resource request.

Because both LP0 and LP1 are takers and excess users, Partition Load Manager uses the weight associated with each as the determining factor of how the extra entitlement (the sum of the current entitlement for each partition minus the sum of each partition’s guaranteed allotment) will be distributed between the two partitions.

In this example, of the extra 3072 MB, the LP0 partition is allocated 2048 MB and the LP1 partition is allocated 1024 MB. Partition Load Manager assigns the mem_increment MB of memory from the LP1 partition to the LP0 partition.

With constant memory requests from each partition, Partition Load Manager eventually distributes the memory so that current entitlements become the following:

LP0: Current Entitlement = 3072 MB  
LP1: Current Entitlement = 2048 MB  

Manage processor resources in a shared partition environment

The following example describes how Partition Load Manager manages processor resources in a shared partition environment. The two partitions are configured as follows:

LP0: Minimum = 0.1  
Guaranteed = 0.5  
Maximum = 2.0  
Max entitlement per virtual processor = 0.8  
Weight = 3  
Current entitlement = 0.1  
Current number of virtual processors = 1

LP1: Minimum = 0.1  
Guaranteed = 0.5  
Maximum = 2.0  
Max entitlement per virtual processor = 0.8  
Weight = 1  
Current entitlement = 0.1  
Current number of virtual processors = 1

The total amount of processor entitlement managed by Partition Load Manager is 2.0. The amount that is currently allocated to each partition, 0.1, leaves 1.8 of unallocated processor entitlement that Partition Load Manager can distribute.

If both partitions begin running processor-intensive jobs, they request more processor entitlement by sending requests to the Partition Load Manager. Partition Load Manager then identifies the demanding partitions as takers and as excess users if the current entitlement is above its guaranteed value.

In addition to managing processor entitlement, Partition Load Manager also manages the number of virtual processors. When either partition’s current entitlement exceeds 0.8, a virtual processor is also added.

In this example, Partition Load Manager assigns the available entitlement until the partitions reach the following state:
LP0:  Current entitlement = 1.0
       Current number of virtual processors = 2
LP1:  Current entitlement = 1.0
       Current number of virtual processors = 2

If the partitions continue to demand more resource, then Partition Load Manager redistributes the
assigned entitlement based on the weight and excess entitlement. Here, between the LP0 partition and the
LP1 partition, the total excess amount is 1.5. Because LP0 has a weight of 3 and LP1 has a weight of 1,
Partition Load Manager removes processor entitlement from the LP1 partition and reassigns it to the LP0
partition. If both partitions remain busy, then the resource allocation becomes the following:
LP0:  Current entitlement = 1.25
       Current number of VPs = 2
LP1:  Current entitlement = 0.75
       Current number of VPs = 2

Configuring Resource Monitoring and Control (RMC):

Use this procedure to configure Resource Monitoring and Control (RMC) and to verify that RMC is
installed correctly.

The Partition Load Manager server uses RMC to communicate with the managed logical partitions.

The RMC setup comprises host authentication and user authorization. The host authentication involves a
public key exchange between the Partition Load Manager server and the managed nodes (partitions).
This allows the Partition Load Manager server to connect, or create a session, to the managed system.
The user authorization involves adding an entry to the RMC ACL (Access Control) file and allows the
plmuser (the Partition Load Manager server) access to the required resource class. The plmsetup script
automates these tasks using remote shell commands. If the remote shell is unavailable or not configured,
the administrator can perform these tasks manually.

Run the following shell script as the root user on the managing machine that will run the Partition Load
Manager:
/etc/plm/setup/plmsetup

After the script runs successfully, the RMC ACL file on the remote machine will have an entry similar to
the following:
IBM.LPAR plmuser@plmserver1.domain.com * rw

The setup procedure takes the following as arguments:
• The user ID under which the Partition Load Manager is to run
• The host name of the partition

This user ID is used to set up the RMC ACL files on the logical partitions. ACL files are used to
authenticate authorized users for each resource class when they connect to the RMC subsystem. Only this
user will be permitted access to the Partition Load Manager. Only the authorized user can run Partition
Load Manager. Any user is able to run commands that only display data.

Resource Monitoring and Control (RMC) configuration for the Partition Load Manager

Configure RMC for the Partition Load Manager by doing the following steps.
1. Select Set up Management of Logical Partitions.
   Authenticated user name: plmuser
2. Select Automatically setup with each partition in the policy file.
   Policy file name: /etc/plm/policies/plm1
3. Click OK.

This configuration can also be done using the command line if you are the root user on the Partition Load Manager server:
/etc/plm/setup/plmsetup lpar_hostname plmuser

To run this command, you must have rsh and rcp access. After the setup has been run, you can delete the .rhosts file.

Verifying the Resource Monitoring and Control (RMC) setup:

Use this procedure to verify the Resource Monitoring and Control (RMC) setup.

To verify the RMC setup, run the following as the Partition Load Manager user for each of the logical partitions that were used with the plmsetup script. Replace PART_HOST with the name of the logical partitions in the following command:

CT_CONTACT=PART_HOST lsrc IBM.LPAR

If the persistent attributes of the resource class are displayed, then verification is successful.

If the persistent attributes of the resource class are not displayed, try the following steps:

• To troubleshoot host or connection errors, complete the following steps.
  1. Perform host-based authentication. Complete the following steps:
     a. Run the following command on both the Partition Load Manager server machine and the logical partition.
        /usr/sbin/rsct/bin/ctsvhbal
        A list of identities are displayed. These are identities as which the known partition host can be identified.
     b. Run the following command on both the Partition Load Manager server machine and the logical partition.
        /usr/sbin/rsct/bin/ctsth1 -l
        On the Partition Load Manager server machine, there is an entry for the logical partition. On the logical partition, there is an entry for the Partition Load Manager server machine. The HOST_IDENTITY value must match one of the identities listed in the respective ctsvhbal command output.
   2. If the HOST_IDENTITY value in the ctsth1 command output does not match the correct identity in the ctsvhbal command output on either the Partition Load Manager server machine or the logical partition, change the HOST_IDENTITY value by completing the following steps:
     a. Remove the incorrect HOST_IDENTITY value by running the following command:
        /usr/sbin/rsct/bin/ctsth1 -d -n HOST_IDENTITY
     b. Add the correct HOST_IDENTITY value by running the following command:
        /usr/sbin/rsct/bin/ctsth1 -a -n HOST_IDENTITY -m METHOD -p ID_VALUE
        The value for the METHOD parameter can be obtained from the ctsth1 command. Look for an entry for the machine itself. In that entry, use the value in the Identifier Generation Method field. One example is rsa512. For the ID_VALUE parameter value, use the Identifier Value field in the same entry.

• To troubleshoot user or authorization type errors, check the ACL file on the logical partition. In the /var/ct/cfg/ctrmc.acls file, there is a stanza for IBM.LPAR towards the end of the file that looks similar to the following:
IBM.LPAR plmuser@plmserver1.domain.com * rw

The user name in the stanza must match the actual user name to run the Partition Load Manager. Also, the host name in the stanza must match what was returned by the ctsvhbal command which was run
on the Partition Load Manager server machine. If the host name is incorrect, run the plmsetup script again, this time using the IDENTITY provided by the ctsvhbal command.

For additional information about cluster configuration and management, see the Cluster library Web site.

**Starting and stopping the Partition Load Manager server:**

Use this procedure to start and stop the Partition Load Manager server and to check the Partition Load Manager statistics.

**Starting the Partition Load Manager server**

- Assume the following environment:
  - Configuration name: default
  - Policy file name: `/etc/plm/policies/plm1`
  - Log file name: `/var/opt/plm/plm.log`
  - Operation mode: management or monitoring

- Start the Partition Load Manager server by doing one of the following:
  - For management operation mode, type the following command from the command line:
    ```
xlplm -S -p /etc/plm/policies/plm1 -l /var/opt/plm/plm.log -o M
    ```
  - For monitoring operation mode, type the following command from the command line:
    ```
xlplm -S -p /etc/plm/policies/plm1 -l /var/opt/plm/plm.log -o N
    ```

- Check the log for errors by typing the following command:
  ```
tail -f /var/opt/plm/plm.log
  ```

**Checking the Partition Load Manager statistics**

The `xlpstat` command is independent of the Partition Load Manager server and therefore can be run whether or not the Partition Load Manager server is running. The `xlpstat` command can be run any time after the RMC setup is complete.

- Check the Partition Load Manager statistics by typing the following command, which checks the statistics every five seconds until you cancel the command:
  ```
xlpstat -p /etc/plm/policies/plm1 5
  ```

**Stopping the Partition Load Manager server**

Stop the Partition Load Manager server by doing one of the following steps:
- Assume that the configuration name is `default`.
- From the command line, type the following:
  ```
xlplm -K default
  ```

**Commands for the Partition Load Manager:**

A description of each Partition Load Manager command is given here. This information is also available from the command line using the man command.

```xlplm command:```

The `xlplm` command starts, stops, modifies, reserves, and queries a Partition Load Manager server.
**Purpose**

Start, stop, modify, reserve, and query a Partition Load Manager server.

This command is for use with the Partition Load Manager on AIX only.

**Syntax**

```
xlplm -S -p policy_file -l log_file [-o operation_mode] [configuration]
xlplm -K [configuration]
xlplm -M [-p policy_file] [-l log_file] [-o operation_mode] [configuration]
xlplm -R [-g group_name] [-c cpu_resource_size] [-m memory_resource_size] [configuration]
xlplm -Q [-r] [-f] [configuration]
xlplm -C -p policy_file
```

**Description**

The Partition Load Manager server xlplmd daemon performs the specified resource management operations.

**Flags**

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-c cpu_resource_size</td>
<td>Specifies the amount of processor resources to reserve.</td>
</tr>
<tr>
<td>-C</td>
<td>Verifies the validity of the policy file.</td>
</tr>
<tr>
<td>-f</td>
<td>By default, the query operation displays the active configuration values that might have been adjusted at run time due to conflicts with the partition profile. This option changes the output to display the values that were specified in the policy file.</td>
</tr>
<tr>
<td>-g group_name</td>
<td>Specifies the name of a group in the policy file. Use this flag when you are reserving or releasing resources. The resources that you want to reserve are removed from the specified group in the policy file. When you are releasing resources, they are placed in the free pool of the specified group in the policy file.</td>
</tr>
<tr>
<td>-K</td>
<td>Stop the Partition Load Manager instance. To use this flag, you must either have root authority or be logged in as the authorized plmuser user ID.</td>
</tr>
<tr>
<td>-l log_file</td>
<td>Specifies the name of the file you want to contain the Partition Load Manager activity log.</td>
</tr>
<tr>
<td>-M</td>
<td>Modify a Partition Load Manager server. To use this flag, you must either have root authority or be logged in as the authorized plmuser user ID.</td>
</tr>
<tr>
<td>-m memory_resource_size</td>
<td>Specifies the amount of memory resource to reserve.</td>
</tr>
<tr>
<td>-o operation_mode</td>
<td>Specifies whether the Partition Load Manager server is to operate in management mode, with a value of M, or monitoring mode, with a value of N. When the xlplm daemon starts, the default value is management mode, or M.</td>
</tr>
<tr>
<td>-p policy_file</td>
<td>Specifies the name of the Partition Load Manager policy file.</td>
</tr>
<tr>
<td>-Q</td>
<td>Query the Partition Load Manager server status.</td>
</tr>
</tbody>
</table>
Flag | Description
--- | ---
-R | Reserve or release resources from a partition managed by a Partition Load Manager server. To use this flag, you must either have root authority or be logged in as the authorized `plmuser` user ID.
-r | Use the Partition Load Manager server in raw data mode.
-S | Start a Partition Load Manager instance. To use this flag, you must either have root authority or be logged in as the authorized `plmuser` user ID.

Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>configuration</td>
<td>Identifies an instance of the Partition Load Manager management. This parameter must be specified if there are multiple instances of the Partition Load Manager server on your system. If the parameter is not specified, a default value is used.</td>
</tr>
</tbody>
</table>

Exit status

This command returns the following exit values:

0 | Command completed successfully.
1 | The program encountered a nonrecoverable internal error, such as a memory allocation or system call failure.
2 | The specified log file could not be opened or created.
3 | The specified policy file could not be opened or created.
4 | A required temporary file could not be created in the `/tmp` directory.
5 | The specified policy is not valid.
6 | The daemon failed to start. This could be the result of an internal error or an inability to communicate with the Hardware Management Console (HMC).
7 | Command line usage error.
8 | The number specified for the reservation amount was not valid.
9 | The current user does not match the authorized user in the `/etc/plm/auth/plmuser` file, or the file could not be read.
10 | An instance with the requested name already exists.
11 | An instance with the requested name does not exist.
12 | The requested mode is the same as the current mode.
13 | A remote command to the HMC failed.
14 | A reservation request failed due to one of the following reasons:
   - unknown group
   - reservation amount is already set to requested amount
   - could not reserve the requested amount
   - the requested resource is not managed
Examples

1. Start the Partition Load Manager server in management mode with a configuration name of cec1 by typing one of the following commands on the Partition Load Manager server system:

   
   cd /etc/xlplm/cec1
   xlplm -S -p policy -l log cec1

   or

   xlplm -S -p /etc/xlplm/cec1 -l /etc/xlplm/cec1/log -o M cec1

2. Start the Partition Load Manager server in monitoring mode by typing the following:

   xlplm -S -p policy -l log -o N cec1

3. Stop the Partition Load Manager server by typing the following:

   xlplm -K cec1

4. Load a new policy into the Partition Load Manager server by typing the following:

   xlplm -M -p evening_policy cec1

5. Start using a new log file, called newlog, for the Partition Load Manager server by typing the following:

   xlplm -M -l newlog cec1

6. Display configuration names for the active Partition Load Manager server by typing the following:

   xlplm -Q

xlpstat command:

The xlpstat command displays logical partition load statistics for a list of host names.

Purpose

Displays logical partition load statistics for a list of host names.

This command is for use with the Partition Load Manager on AIX only.

Syntax

xlpstat [-r] [-p policy_file | -f host_list] [interval] [count]

Description

Display load statistics for one or more remote logical partitions. The command will contact the remote systems every number of seconds specified by the interval parameter for each number of intervals specified by the count parameter. If the interval parameter and the count parameter are omitted, the remote systems are queried once. If only the count parameter is omitted, the remote systems are queried every number of seconds specified by the interval parameter until the command is terminated by the user.

The caller of this command must be the root user or the Partition Load Manager authorized user.

For the formatted output, the output is displayed as follows, for each host listed in the input file:

<table>
<thead>
<tr>
<th>STAT</th>
<th>CPU</th>
<th>MEM</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>up</td>
<td>4.00</td>
<td>1024</td>
</tr>
<tr>
<td>up</td>
<td>2.00</td>
<td>2048</td>
</tr>
<tr>
<td>up</td>
<td>10.00</td>
<td>5120</td>
</tr>
</tbody>
</table>
STAT Partition status. May be "up" or "down".
TYP Partition type. May be "D" (dedicated) "S" (shared) or "U" (unknown).
   If the type is "U", the command was unable to query the partition type and
   there may be a connectivity or authentication problem.
CUR The current amount of resource allocated to the partition.
PCT Percent utilization for the resource
LOAD CPU load average
PGSTL Page steals per second
HOST Managed host name

The raw output is displayed as a header containing column descriptions followed by one line of data for
each host:

```

testlp1.mydomain.com:group1:up:dedicated:4.00:45.05:0.38:1024:75.00:0

testlp2.mydomain.com:group1:up:dedicated:2.00:87.23:0.92:2048:92.21:123

testlp3.mydomain.com:group1:up:dedicated:10.00:95.17:1.01:5120:70.30:0
```

Flags

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-r</td>
<td>Raw output mode. Data is printed in colon separated</td>
</tr>
<tr>
<td></td>
<td>format, with one line per host.</td>
</tr>
<tr>
<td>-p policy_file</td>
<td>Retrieves the host list from the given policy file.</td>
</tr>
<tr>
<td>-f host_list</td>
<td>Retrieves the host list from the given plain text file. This file has one host name per line.</td>
</tr>
</tbody>
</table>

Exit status

This command returns the following exit values:

1  Internal error.
3  Could not open input file.
5  Invalid policy file.
7  Usage error.
9  Not authorized.

Deleting a logical partition using version 7 or later of the HMC

You can use the Hardware Management Console (HMC) to delete a logical partition and all of the
partition profiles associated with the logical partition.

To delete a logical partition using version 7 or later of the HMC, you must be a super administrator or
operator. For more information about user roles, refer to Tasks and roles.

You cannot delete a logical partition if it is the service partition of your managed system. Before you can
delete such a logical partition, you must designate another logical partition as the service partition of
your managed system or remove the service partition designation from the logical partition. For more
information, see Designating the service partition for your managed system.

Attention: This procedure erases the logical partition and the logical partition configuration data stored
on the partition profiles.

To delete a logical partition using version 7 or later of the HMC, follow these steps:

1. In the navigation pane, open Systems Management, open Servers, and click the managed system on
   which the partition profile is located.
2. In the contents pane, select the logical partition on which the partition profile is located, click the Tasks button, and choose Operations → Delete.

3. Click OK to confirm.

Related tasks

“Designating the service partition for your managed system using version 6 or earlier of the HMC” on page 225

The service partition is the i5/OS logical partition on an IBM System i5 or eServer i5 server that you can configure to apply server firmware updates to the service processor or to the hypervisor and to communicate server common hardware errors to IBM. These abilities are useful if the Hardware Management Console (HMC) is undergoing maintenance or is otherwise unable to perform these functions.

Related information

Tasks and roles

Resetting the managed system to a nonpartitioned configuration using version 7 or later of the HMC and the ASMI

Use this procedure to erase all of your logical partitions and reset the managed system to a nonpartitioned configuration. When you reset the managed system, all of the physical hardware resources are assigned to a single logical partition. This allows you to use the managed system as if it were a single, nonpartitioned server.

Attention: By resetting a partitioned managed system to a nonpartitioned configuration, you will lose all of your logical partition configuration data. However, resetting the managed system does not erase the operating systems and data from disk units on that managed system.

Before you reset the managed system, ensure that the hardware placement in the managed system supports a nonpartitioned configuration. If the hardware placement in the managed system does not support a nonpartitioned configuration, you must move the hardware so that the hardware placement supports a nonpartitioned configuration. For more information about how to place the hardware in your managed system to support a nonpartitioned configuration, contact your marketing representative or business partner.

Also, if you plan to use an operating system that is already installed on one of the logical partitions on the managed system (instead of reinstalling the operating system after you reset the managed system), consider how the console used by that operating system will change when you reset the managed system.

- If the operating system that you want to use is AIX, log into AIX and enable the login prompt for the virtual serial port vty0 using either SMIT or the chdev command. You can then reset the managed system, use a physical serial console to log into AIX, and use SMIT or chcons to change the console device to the console device you want to use.
- If the operating system that you want to use is i5/OS, the device tagging that you set up on the HMC no longer applies after you disconnect the HMC. Before you reset the managed system, switch the console setting to the device that you want to use.

To reset a partitioned managed system to a nonpartitioned configuration using version 7 or later of the HMC, you must be a super administrator or operator. For more information about user roles, refer to Tasks and roles. You must also have an Advanced System Management Interface (ASMI) login profile with an administrator authority level.

Also, parts of this procedure must be performed at your HMC (not connected remotely). Ensure that you have physical access to the HMC before you begin.

To reset a partitioned managed system to a nonpartitioned configuration using version 7 or later of the HMC, follow these steps:
1. Shut down all logical partitions on your managed system using operating system procedures. For more information about shutting down logical partitions using operating system procedures, see the following information:
   • For logical partitions running AIX, see Shutting down AIX logical partitions using version 7 or later of the HMC.
   • For logical partitions running i5/OS, see Shutting down i5/OS logical partitions.
   • For logical partitions running Linux, see Shutting down Linux logical partitions using version 7 or later of the HMC.

2. If the managed system powered off automatically when you shut down the last logical partition, power on the managed system to the Standby state. Complete the following:
   a. In the navigation pane of your HMC, open Systems Management and click Servers.
   b. In the contents pane, select the managed system, click the Tasks button, and choose Operations → Power On.
   c. Select the power-on mode of Partition Standby and click OK.
   d. Wait until the contents pane displays a Standby state for the managed system.

3. Initialize the profile data on the HMC. Complete the following:
   a. In the contents pane, select the managed system, click the Tasks button, and choose Configuration → Manage Partition Data → Initialize.
   b. Click Yes to confirm.

4. Clear the partition configuration data on the managed system. Complete the following at your HMC (not connected remotely):
   a. In the navigation pane, click HMC Management.
   b. In the contents pane, click Open Restricted Shell Terminal.
   c. Type the command: lpcfgop -m managed_system_name -o clear. In this command, managed_system_name is the name of the managed system as it displays in the content area.
   d. Enter 1 to confirm. This step will take several seconds to complete.

5. Optional: If you no longer intend to manage the system using the HMC, remove the connection between the HMC and the managed system. To remove the connection between the HMC and the managed system, complete the following:
   a. In the contents pane, select the managed system, click the Tasks button, and choose Connections → Reset or Remove Connection.
   b. Select Remove connection and click OK.

6. Access the Advanced System Management Interface (ASMI) using a Web browser on a PC. If you do not already have a PC that is set up to access the ASMI on the managed system, you will need to set up the PC at this point. For more information about accessing ASMI, see Accessing the ASMI using a Web browser.

7. On the ASMI Welcome pane, log in using the admin user ID (enter admin into User ID, enter the admin password into Password, and click Log In).

8. In the navigation pane, expand Power/Restart Control and click Power On/Off System.

9. Set Boot to server firmware to Running.

10. Click Save settings and power off.

11. Click Power On/Off System periodically to refresh the window. Repeat this step until Current system power state: Off is displayed in the navigation pane.

12. Click Save settings and power on.

13. Wait for the managed system to restart. It can take several minutes for the managed system and operating system to restart completely.
Managing logical partitions using version 7 or later of the HMC

You can manage the configuration of your logical partitions using the Hardware Management Console (HMC). The HMC allows you to adjust the hardware resources that are used by each logical partition.

Activating a logical partition using version 7 or later of the HMC

You must activate a logical partition before you can use the logical partition. When you activate a logical partition, the system commits resources to the logical partition and starts the operating system or software that is installed on the logical partition.

To activate a logical partition using version 7 or later of the HMC, you must be a super administrator, operator, or product engineer. For more information about user roles, refer to Tasks and roles.

When you activate a logical partition, you must select a partition profile. A partition profile is a record on the Hardware Management Console (HMC) that specifies a possible configuration for a logical partition.

To activate a logical partition using version 7 or later of the HMC, follow these steps:
1. In the navigation pane, open Systems Management, open Servers, and click the system on which the logical partition is located.
2. In the contents pane, select the logical partition, click the Tasks button, and choose Operations → Activate.
3. Select the partition profile that you want to use to activate the logical partition.
4. If you want the HMC to open a terminal window or console session for the logical partition when the logical partition is activated, select Open a terminal window or console session.
5. If you want to use a keylock position or boot mode that is different from the keylock position or boot mode specified in the partition profile, click Advanced, select the desired keylock position and boot mode, and click OK.
6. Click OK.

Related information

Tasks and roles

Activating a system profile using version 7 or later of the HMC

You can activate many logical partitions at a time by activating a system profile. A system profile is an ordered list of partition profiles. When you activate a system profile, the managed system attempts to activate the partition profiles in the system profile in the order in which the partition profiles are listed.

To activate a system profile using version 7 or later of the Hardware Management Console (HMC), you must be a super administrator, operator, or product engineer. For more information about user roles, refer to Tasks and roles.

To activate a system profile using version 7 or later of the HMC, follow these steps:
1. In the navigation pane, open Systems Management and click Servers.
2. In the contents pane, select the managed system, click the Tasks button, and choose Configuration → Manage System Profiles.
3. Select the system profile and click Activate.
4. Select the desired activation settings for the system profile and click Continue.
Managing logical partition resources dynamically using version 7 or later of the HMC

You can add, remove, or move processor, memory, and I/O resources between running logical partitions without restarting the logical partitions or the managed system.

Dynamic resource management is used only for running logical partitions. If a logical partition is not running, you cannot add resources to that logical partition dynamically or remove resources from that logical partition dynamically. Also, if you shut down a logical partition, you cannot move resources dynamically to or from that logical partition. (However, the resources that were used by that logical partition can be added dynamically to running logical partitions.) You can change the resource allocations for an idle logical partition by changing the properties of the partition profiles used by that logical partition. When you start the logical partition using one of the changed partition profiles, the managed system applies the changes to the logical partition.

Managing memory dynamically using version 7 or later of the HMC:

You can add, remove, and move memory dynamically to and from running logical partitions using the Hardware Management Console (HMC). This allows you to adjust the memory allocated to each logical partition without having to shut down the logical partitions.

Dynamic memory changes on i5/OS logical partitions affect the base memory pool of the logical partitions (*BASE pool). Private memory pools or shared memory pools are not affected. Dynamic memory changes cannot cause the amount of memory in the base pool to fall below the minimum amount of memory required in the base pool (as determined by the base storage minimum size (QBASPOOL) system value). If a dynamic memory change would cause the base pool to fall below this amount, the system releases excess memory pages only after keeping the minimum amount of memory required in the base pool.

To prevent any data loss during dynamic memory movement, the system first writes any data from memory pages to the disks before making the memory pages available to another partition. Depending on the amount of memory you have requested to move, this might take some time.

Memory in each logical partition operates within its assigned minimum and maximum values. The full amount of memory that you assign to a logical partition might not be available for the logical partition to use. Static memory overhead that is required to support the assigned maximum memory affects the reserved or hidden memory amount. This static memory overhead also influences the minimum memory size of a partition.

Note: If resources are moved dynamically, the configuration change is temporary and is not reflected in the partition profile. This means that all configuration changes will be lost the next time the partition profile is activated. If you want to save your new partition configuration, either change the partition profile or save the partition configuration to a new partition profile.
Related tasks

“Changing partition profile properties using version 7 or later of the HMC” on page 93
You can change the properties of a partition profile using version 7 or later of the Hardware Management Console (HMC). Changing the properties of a partition profile will change the resource amounts that are assigned to a logical partition when you shut down and restart the logical partition using the changed partition profile.

“Saving the partition configuration to a partition profile using version 7 or later of the HMC” on page 162
Use this procedure to save the current configuration of a logical partition to a new partition profile using a Hardware Management Console (HMC). Use this procedure if you change the configuration of a logical partition using dynamic logical partitioning and you do not want to lose the changes when you reactivate the logical partition. This procedure allows you to save the changed configuration to a new partition profile instead of having to enter the changed resource allocations manually.

Adding memory dynamically using version 7 or later of the HMC:

You can add memory dynamically to a running logical partition using the Hardware Management Console (HMC). This allows you to increase the memory available to a logical partition without having to shut down the logical partition.

A Linux logical partition supports the dynamic addition of memory resources only if the following conditions are met:

• A Linux distribution that supports the dynamic addition of memory resources is installed on the Linux logical partition. Distributions that support the dynamic addition of memory resources include Novell SUSE Linux Enterprise Server 10, Red Hat Enterprise Linux version 5, and later versions of these distributions.
• The DynamicRM tool package is installed on the Linux logical partition. For more information on the DynamicRM tool package, see the Service and productivity tools Web site.

To add memory to a Linux logical partition that uses an earlier version of these distributions, you must shut down the Linux logical partition and reactivate the logical partition using a partition profile that specifies a greater amount of memory.

To add memory dynamically to a running logical partition using version 7 or later of the HMC, you must be a super administrator, service representative, product engineer, or operator. For more information about user roles, refer to Tasks and roles.

To add memory dynamically to a running logical partition using version 7 or later of the HMC, follow these steps:

1. In the navigation pane of your HMC, open Systems Management, open Servers, and click the managed system on which the logical partition is located.
2. In the contents pane, select the logical partition, click the Tasks button, and choose Dynamic Logical Partitioning → Memory → Add or Remove.
3. Enter the amount of memory that you want the logical partition to have into the fields in the Pending memory row.
4. Adjust the settings in the Options area if necessary. You might need to increase the value in the Timeout (minutes) field to allow enough time for the HMC to complete the operation. (These settings relate to how the managed system adds memory dynamically. These settings are not retained after the addition completes.)
5. Click OK.
Related information

Tasks and roles

Moving memory dynamically using version 7 or later of the HMC:

You can move memory dynamically from one running logical partition to another using version 7 or later of the Hardware Management Console (HMC). This allows you to reassign memory directly to a logical partition that needs additional memory.

You cannot move memory dynamically from a running Linux logical partition. To remove memory from a Linux logical partition, you must shut down the Linux logical partition and reactivate the logical partition using a partition profile that specifies a lesser amount of memory.

You can move memory to a running Linux dynamically only if the following conditions are met:

- A Linux distribution that supports the dynamic addition of memory resources is installed on the Linux logical partition. Distributions that support the dynamic movement of memory resources include Novell SUSE Linux Enterprise Server 10 and later versions. Distributions that support the dynamic movement of memory resources include Novell SUSE Linux Enterprise Server 10, Red Hat Enterprise Linux version 5, and later versions of these distributions.
- The DynamicRM tool package is installed on the Linux logical partition. For more information on the DynamicRM tool package, see the Service and productivity tools Web site.

To move memory to a Linux logical partition that uses an earlier version of these distributions, you must shut down the Linux logical partition and reactivate the logical partition using a partition profile that specifies a greater amount of memory.

To move memory dynamically from one running logical partition to another using version 7 or later of the HMC, you must be a super administrator, service representative, product engineer, or operator. For more information about user roles, refer to Tasks and roles.

To move memory dynamically from one running logical partition to another using version 7 or later of the HMC, follow these steps:

1. In the navigation pane of your HMC, open Systems Management, open Servers, and click the managed system on which the logical partitions are located.
2. In the contents pane, select the logical partition, click the Tasks button, and choose Dynamic Logical Partitioning → Memory → Move.
3. Select the logical partition to which you want to move the memory in Select Destination Partition.
4. Enter the amount of memory that you want to move into the fields in the Memory to move row.
5. Adjust the settings in the Options area if necessary. You might need to increase the value in the Timeout (minutes) field to allow enough time for the HMC to complete the operation. (These settings relate to how the managed system moves memory dynamically. These settings are not retained after the move completes.)
6. Click OK.

Related information

Tasks and roles

Removing memory dynamically using version 7 or later of the HMC:

You can remove memory dynamically from a running AIX, i5/OS, or Virtual I/O Server logical partition using the Hardware Management Console (HMC). This allows you to reassign the memory to other logical partitions.
You cannot remove memory dynamically from a running Linux logical partition. To remove memory from a Linux logical partition, you must shut down the logical partition and reactivate the logical partition using a partition profile that specifies a lesser amount of memory.

To remove memory dynamically from a running logical partition using version 7 or later of the HMC, you must be a super administrator, service representative, product engineer, or operator. For more information about user roles, refer to Tasks and roles.

To remove memory dynamically from a running logical partition using version 7 or later of the HMC, follow these steps:

1. In the navigation pane of your HMC, open Systems Management, open Servers, and click the managed system on which the logical partition is located.
2. In the contents pane, select the logical partition, click the Tasks button, and choose Dynamic Logical Partitioning → Memory → Add or Remove.
3. Enter the amount of memory that you want the logical partition to have into the fields in the Pending memory row.
4. Adjust the settings in the Options area if necessary. You might need to increase the value in the Timeout (minutes) field to allow enough time for the HMC to complete the operation. (These settings relate to how the managed system removes memory dynamically. These settings are not retained after the removal completes.)
5. Click OK.

Related information
Tasks and roles

Managing processor resources dynamically using version 7 or later of the HMC:

You can add, remove, and move processor resources dynamically to and from running logical partitions using the Hardware Management Console (HMC). This allows you to adjust the processor resources allocated to each logical partition without having to shut down the logical partitions.

The ability to move processor resources dynamically becomes important when you need to adjust to changing workloads. Processor resources can be moved based on the minimum and maximum values that you created for the partition profile. You can move processor resources as long as the processor resources for each logical partition remains within the range specified by the minimum and maximum values for the logical partition. If the managed system uses more than one shared processor pool, you must also ensure that the number of processors used in each shared processor pool is less than or equal to the maximum number of processing units specified for each shared processor pool.

Note: If resources are moved dynamically, the configuration change is temporary and is not reflected in the partition profile. This means that all configuration changes will be lost the next time the partition profile is activated. If you want to save your new partition configuration, either change the partition profile or save the partition configuration to a new partition profile.
Related tasks

"Changing partition profile properties using version 7 or later of the HMC" on page 93

You can change the properties of a partition profile using version 7 or later of the Hardware Management Console (HMC). Changing the properties of a partition profile will change the resource amounts that are assigned to a logical partition when you shut down and restart the logical partition using the changed partition profile.

"Saving the partition configuration to a partition profile using version 7 or later of the HMC" on page 162

Use this procedure to save the current configuration of a logical partition to a new partition profile using a Hardware Management Console (HMC). Use this procedure if you change the configuration of a logical partition using dynamic logical partitioning and you do not want to lose the changes when you reactivate the logical partition. This procedure allows you to save the changed configuration to a new partition profile instead of having to enter the changed resource allocations manually.

Adding processor resources dynamically using version 7 or later of the HMC:

You can add processor resources dynamically to a running logical partition using the Hardware Management Console (HMC). This allows you to increase the processing capacity of a running logical partition without having to shut down the logical partition.

A Linux logical partition supports the dynamic addition of processor resources only if the following conditions are met:

- A Linux distribution that supports dynamic logical partitioning is installed on the Linux logical partition. Distributions that support dynamic logical partitioning include Red Hat Enterprise Linux version 4, SUSE Linux Enterprise Server 9, and later versions of these distributions.
- The DynamicRM tool package is installed on the Linux logical partition. For more information on the DynamicRM tool package, see the Service and productivity tools Web site.

To add processor resources dynamically to a running logical partition using version 7 or later of the HMC, you must be a super administrator, service representative, product engineer, or operator. For more information about user roles, refer to Tasks and roles.

To add processor resources dynamically to a running logical partition using version 7 or later of the HMC, follow these steps:

1. In the navigation pane of your HMC, open Systems Management, open Servers, and click the managed system on which the logical partition is located.
2. In the contents pane, select the logical partition, click the Tasks button, and choose Dynamic Logical Partitioning → Processor → Add or Remove.
3. Enter the amounts of processor resources that you want the logical partition to have into the fields in the Current column. If the logical partition uses shared processors, you might need to adjust the number of virtual processors so that it is greater than the number of processing units.
4. Adjust the settings in the Options area if necessary. You might need to increase the value in the Timeout (minutes) field to allow enough time for the HMC to complete the operation. (These settings relate to how the managed system adds processor resources dynamically. These settings are not retained after the addition completes.)
5. Click OK.

Related information

Tasks and roles:

Service and productivity tools Web site

Moving processor resources dynamically using version 7 or later of the HMC:
You can move processor resources from one running logical partition to another using the Hardware Management Console (HMC). This allows you to reassign processor resources directly to a logical partition that needs additional processor resources.

A Linux logical partition supports the dynamic movement of processor resources only if the following conditions are met:

- A Linux distribution that supports dynamic logical partitioning is installed on the Linux logical partition. Distributions that support dynamic logical partitioning include Red Hat Enterprise Linux version 4, SUSE Linux Enterprise Server 9, and later versions of these distributions.
- The DynamicRM tool package is installed on the Linux logical partition. For more information on the DynamicRM tool package, see the Service and productivity tools Web site.

To move processor resources dynamically from one running logical partition to another using version 7 or later of the HMC, you must be a super administrator, service representative, product engineer, or operator. For more information about user roles, refer to Tasks and roles.

To move processor resources dynamically from one running logical partition to another using version 7 or later of the HMC, follow these steps:

1. In the navigation pane of your HMC, open Systems Management, open Servers, and click the managed system on which the logical partitions are located.
2. In the contents pane, select the logical partition, click the Tasks button, and choose Dynamic Logical Partitioning → Processor → Move.
3. Enter the amounts of processor resources that you want to move into the fields in the To move column.
4. Select the logical partition to which you want to move the processor resources in Select Destination Partition.
5. Adjust the settings in the Options area if necessary. You might need to increase the value in the Timeout (minutes) field to allow enough time for the HMC to complete the operation. (These settings relate to how the managed system moves processor resources dynamically. These settings are not retained after the move completes.)
6. Click OK.

**Related information**

- [Tasks and roles](#)
- Service and productivity tools Web site

**Removing processor resources dynamically using version 7 or later of the HMC:**

You can remove processor resources dynamically from a running logical partition using the Hardware Management Console (HMC). This allows you to reassign the processor resources to other logical partitions.

A Linux logical partition supports the dynamic removal of processor resources only if the following conditions are met:

- A Linux distribution that supports dynamic logical partitioning is installed on the Linux logical partition. Distributions that support dynamic logical partitioning include Red Hat Enterprise Linux version 4, SUSE Linux Enterprise Server 9, and later versions of these distributions.
- The DynamicRM tool package is installed on the Linux logical partition. For more information on the DynamicRM tool package, see the Service and productivity tools Web site.

To remove processor resources dynamically from a running logical partition using version 7 or later of the HMC, you must be a super administrator, service representative, product engineer, or operator. For more information about user roles, refer to Tasks and roles.
To remove processor resources dynamically from a running logical partition using version 7 or later of the HMC, follow these steps:

1. In the navigation pane of your HMC, open Systems Management, open Servers, and click the managed system on which the logical partition is located.
2. In the contents pane, select the logical partition, click the Tasks button, and choose Dynamic Logical Partitioning → Processor → Add or Remove.
3. Enter the amounts of processor resources that you want to the logical partition to have into the fields in the Current column. If the logical partition uses shared processors, you might need to adjust the number of virtual processors so that it is greater than the number of processing units.
4. Adjust the settings in the Options area if necessary. You might need to increase the value in the Timeout (minutes) field to allow enough time for the HMC to complete the operation. (These settings relate to how the managed system removes processor resources dynamically. These settings are not retained after the removal completes.)
5. Click OK.

Related information

Managing physical I/O devices and slots dynamically using version 7 or later of the HMC:

You can add, remove, and move physical I/O devices and slots dynamically to and from running logical partitions using the Hardware Management Console (HMC). This allows logical partitions to share infrequently used I/O devices (such as optical disc drives).

Logical partitions can have desired or required I/O devices or slots. When you specify that an I/O device or slot is desired (or shared), this means either that the I/O device or slot is meant to be shared with other logical partitions, or that the I/O device or slot is optional. When you specify that an I/O device or slot is required (or dedicated), then you cannot activate the logical partition if the I/O device or slot is unavailable or in use by another logical partition.

Note: If resources are moved dynamically, the configuration change is temporary and is not reflected in the partition profile. This means that all configuration changes will be lost the next time the partition profile is activated. If you want to save your new partition configuration, either change the partition profile or save the partition configuration to a new partition profile.

Related tasks

“Changing partition profile properties using version 7 or later of the HMC” on page 93
You can change the properties of a partition profile using version 7 or later of the Hardware Management Console (HMC). Changing the properties of a partition profile will change the resource amounts that are assigned to a logical partition when you shut down and restart the logical partition using the changed partition profile.

“Saving the partition configuration to a partition profile using version 7 or later of the HMC” on page 162
Use this procedure to save the current configuration of a logical partition to a new partition profile using a Hardware Management Console (HMC). Use this procedure if you change the configuration of a logical partition using dynamic logical partitioning and you do not want to lose the changes when you reactivate the logical partition. This procedure allows you to save the changed configuration to a new partition profile instead of having to enter the changed resource allocations manually.

Adding physical I/O devices and slots dynamically using version 7 or later of the HMC:

You can add a physical I/O slot (and the adapter and devices that are connected to that slot) to a running logical partition using the Hardware Management Console (HMC). This allows you to add I/O capabilities to a running logical partition without having to shut down the logical partition.
A Linux logical partition supports the dynamic addition of physical I/O slots only if the following conditions are met:
- A Linux distribution that supports dynamic logical partitioning is installed on the Linux logical partition. Distributions that support dynamic logical partitioning include Red Hat Enterprise Linux version 4, SUSE Linux Enterprise Server 9, and later versions of these distributions.
- The DynamicRM tool package is installed on the Linux logical partition. For more information on the DynamicRM tool package, see the Service and productivity tools Web site.

To add a physical I/O slot dynamically to a running logical partition using version 7 or later of the HMC, you must be a super administrator, service representative, product engineer, or operator. For more information about user roles, refer to Tasks and roles.

To add a physical I/O slot dynamically to a running logical partition using version 7 or later of the HMC, follow these steps:
1. In the navigation pane of your HMC, open Systems Management, open Servers, and click the managed system on which the logical partition is located.
2. In the contents pane, select the logical partition, click the Tasks button, and choose Dynamic Logical Partitioning ➤ Physical Adapters ➤ Add.
3. Select the physical I/O slot that you want to add to the logical partition.
4. If you want to assign the physical I/O slot to an I/O pool, select the I/O pool for the physical I/O slot in I/O Pool ID.
5. Click OK.

Related information
- Service and productivity tools Web site

Moving physical I/O devices and slots dynamically using version 7 or later of the HMC:

You can move a physical I/O slot (and the adapter and devices that are connected to that slot) from one running logical partition to another using the Hardware Management Console (HMC). This allows you to share a physical I/O device such as a DVD drive among many logical partitions.

Before you begin, vary off any devices that are attached to the managed system through the physical I/O slot that you want to move. You can vary off devices using operating system commands.

Attention: The dynamic movement of a physical I/O slot that controls disk drives can cause unpredictable results, such as partition failure or loss of data.

A Linux logical partition supports the dynamic movement of physical I/O slots only if the following conditions are met:
- A Linux distribution that supports dynamic logical partitioning is installed on the Linux logical partition. Distributions that support dynamic logical partitioning include Red Hat Enterprise Linux version 4, SUSE Linux Enterprise Server 9, and later versions of these distributions.
- The DynamicRM tool package is installed on the Linux logical partition. For more information on the DynamicRM tool package, see the Service and productivity tools Web site.

To move a physical I/O slot dynamically from one running logical partition to another using version 7 or later of the HMC, you must be a super administrator, service representative, product engineer, or operator. For more information about user roles, refer to Tasks and roles.

To move a physical I/O slot dynamically from one running logical partition to another using version 7 or later of the HMC, follow these steps:
1. In the navigation pane of your HMC, open System Management, open Servers, and click the managed system on which the logical partitions are located.
2. In the contents pane, select the logical partition that currently owns the physical I/O slot, click the Tasks button, and choose Dynamic Logical Partitioning -> Physical Adapters -> Move or Remove.
3. Select the physical I/O slot that you want to move from the list.
4. Select the running logical partition to which you want to move the selected physical I/O slot in Move to partition.
5. If you want to assign the physical I/O slot to an I/O pool on the logical partition to which the physical I/O slot will be moved, select the I/O pool for the physical I/O slot in I/O Pool ID.
6. Ensure that any devices that are attached to the managed system through the physical I/O slot are not busy. The devices should be varied off.
7. Click OK.

Related information

Tasks and roles

Service and productivity tools Web site

Removing physical I/O devices and slots dynamically using version 7 or later of the HMC:

You can remove a physical I/O slot and the adapter and devices that are connected to that slot dynamically from a running logical partition using the Hardware Management Console (HMC). This allows you to reassign the physical I/O slot to other logical partitions.

Before you begin, vary off any devices that are attached to the managed system through the physical I/O slot that you want to remove. You can vary off devices using operating system commands.

Attention: The dynamic removal of a physical I/O slot that controls disk drives can cause unpredictable results, such as partition failure or loss of data.

A Linux logical partition supports the dynamic removal of physical I/O slots only if the following conditions are met:

- A Linux distribution that supports dynamic logical partitioning is installed on the Linux logical partition. Distributions that support dynamic logical partitioning include Red Hat Enterprise Linux version 4, SUSE Linux Enterprise Server 9, and later versions of these distributions.
- The DynamicRM tool package is installed on the Linux logical partition. For more information on the DynamicRM tool package, see the Service and productivity tools Web site.

To remove a physical I/O slot dynamically from a running logical partition using version 7 or later of the HMC, you must be a super administrator, service representative, product engineer, or operator. For more information about user roles, refer to Tasks and roles.

To remove a physical I/O slot dynamically from a running logical partition using version 7 or later of the HMC, follow these steps:

1. In the navigation pane of your HMC, open System Management, open Servers, and click the managed system on which the logical partition is located.
2. In the contents pane, select the logical partition, click the Tasks button, and choose Dynamic Logical Partitioning -> Physical Adapters -> Move or Remove.
3. Select the physical I/O slot that you want to move from the list.
4. Ensure that any devices that are attached to the managed system through the physical I/O slot are not busy. The devices should be varied off.
5. Click OK.
Managing 5250 CPW dynamically using version 7 or later of the HMC:

You can add, remove, and move 5250 commercial processing workload (5250 CPW) dynamically to and from running logical partitions using the Hardware Management Console (HMC).

5250 CPW is the capacity to perform 5250 online transaction processing (5250 OLTP) tasks on i5/OS logical partitions. Certain IBM System i models allow you to assign a percentage of the total 5250 CPW available on the managed system to each i5/OS logical partition. The ability to assign 5250 CPW to i5/OS logical partitions is available only for Express Configurations and Value Editions.

5250 CPW can be moved based on the desired, minimum, and maximum percentages you created for the partition profile. The desired 5250 CPW percentage you establish is the amount of 5250 CPW that you get if you do not overcommit the available 5250 CPW. The minimum and maximum values enable you to establish a range within which you can dynamically move the 5250 CPW.

Attention: If resources are moved dynamically, the configuration change is temporary and is not reflected in the partition profile. This means that all configuration changes will be lost the next time the partition profile is activated. If you want to save your new partition configuration, you should change the partition profile or save the partition configuration to a new partition profile.

Related tasks

“Changing partition profile properties using version 7 or later of the HMC” on page 93
You can change the properties of a partition profile using version 7 or later of the Hardware Management Console (HMC). Changing the properties of a partition profile will change the resource amounts that are assigned to a logical partition when you shut down and restart the logical partition using the changed partition profile.

“Saving the partition configuration to a partition profile using version 7 or later of the HMC” on page 162
Use this procedure to save the current configuration of a logical partition to a new partition profile using a Hardware Management Console (HMC). Use this procedure if you change the configuration of a logical partition using dynamic logical partitioning and you do not want to lose the changes when you reactivate the logical partition. This procedure allows you to save the changed configuration to a new partition profile instead of having to enter the changed resource allocations manually.

Dynamically adding 5250 CPW for i5/OS logical partitions using version 7 or later of the HMC:

You can add 5250 commercial processing workload (5250 CPW) to a running i5/OS logical partition using the Hardware Management Console (HMC). This allows you to increase the ability of the i5/OS logical partition to run 5250 online transaction processing (5250 OLTP) tasks.

This procedure applies only to IBM System i Express Configurations and Value Editions, which provide a fixed amount of processing capability for 5250 OLTP tasks.

To add 5250 CPW dynamically to a running logical partition using version 7 or later of the HMC, you must be a super administrator, service representative, product engineer, or operator. For more information about user roles, refer to Tasks and roles.

To add 5250 CPW to a running i5/OS logical partition using version 7 or later of the HMC, follow these steps:

1. In the navigation pane of your HMC, open Systems Management, open Servers, and click the managed system on which the logical partition resides.
2. In the contents pane, select the logical partition, click the Tasks button, and choose Dynamic Logical Partitioning → Processor → Add or Remove.

3. Enter the amounts of 5250 CPW that you want the logical partition to have into the 5250 CPW (percent) field in the Current column.

4. Adjust the settings in the Options area if necessary. You might need to increase the value in the Timeout (minutes) field to allow enough time for the HMC to complete the operation. (These settings relate to how the managed system adds 5250 CPW dynamically. These settings are not retained after the addition completes.)

5. Click OK.

Related information

Tasks and roles

Dynamically moving 5250 CPW for i5/OS logical partitions using version 7 or later of the HMC:

You can move 5250 commercial processing workload (5250 CPW) from one running i5/OS logical partition to another using the Hardware Management Console (HMC). This allows you to use the limited amount of 5250 CPW that is available on your managed system efficiently.

This procedure applies only to IBM System i Express Configurations and Value Editions, which provide a fixed amount of processing capability for 5250 online transaction processing (5250 OLTP) tasks.

To move 5250 CPW dynamically from one running i5/OS logical partition to another using version 7 or later of the HMC, you must be a super administrator, service representative, product engineer, or operator. For more information about user roles, refer to Tasks and roles.

To move 5250 CPW from one running i5/OS logical partition to another using version 7 or later of the HMC, follow these steps:

1. In the navigation pane of your HMC, open Systems Management, open Servers, and click the managed system on which the logical partitions reside.
2. In the contents pane, select the logical partition from which you want to move 5250 CPW, click the Tasks button, and choose Dynamic Logical Partitioning → Processor → Move.
3. Enter the amounts of 5250 CPW that you want to move into the 5250 CPW (percent) field in the To move column.
4. Select the logical partition to which you want to move 5250 CPW in Select Destination Partition.
5. Adjust the settings in the Options area if necessary. You might need to increase the value in the Timeout (minutes) field to allow enough time for the HMC to complete the operation. (These settings relate to how the managed system moves 5250 CPW dynamically. These settings are not retained after the move completes.)
6. Click OK.

Related information

Tasks and roles

Dynamically removing 5250 CPW for i5/OS logical partitions using version 7 or later of the HMC:

You can remove 5250 commercial processing workload (5250 CPW) dynamically from a running i5/OS logical partition using the Hardware Management Console (HMC). This allows you to make 5250 CPW available for assignment to other i5/OS logical partitions on the managed system.

This procedure applies only to IBM System i Express Configurations and Value Editions, which provide a fixed amount of processing capability for 5250 online transaction processing (5250 OLTP) tasks.
To remove 5250 CPW dynamically from a running logical partition using version 7 or later of the HMC, you must be a super administrator, service representative, product engineer, or operator. For more information about user roles, refer to Tasks and roles.

To remove 5250 CPW from a running i5/OS logical partition using version 7 or later of the HMC, follow these steps:

1. In the navigation pane of your HMC, open Systems Management, open Servers, and click the managed system on which the logical partition resides.
2. In the contents pane, select the logical partition, click the Tasks button, and choose Dynamic Logical Partitioning → Processor → Add or Remove.
3. Enter the amounts of 5250 CPW that you want the logical partition to have into the 5250 CPW (percent) field in the Current column.
4. Adjust the settings in the Options area if necessary. You might need to increase the value in the Timeout (minutes) field to allow enough time for the HMC to complete the operation. (These settings relate to how the managed system removes 5250 CPW dynamically. These settings are not retained after the removal completes.)
5. Click OK.

Related information

Scheduling the movement of resources to and from logical partitions using version 7 or later of the HMC:

You can schedule the movement of memory, dedicated processors, shared processors, and I/O devices between running logical partitions on a managed system. This allows you to move resources between running logical partitions without user intervention.

To schedule the movement of resources to and from running logical partitions using version 7 or later of the HMC, you must be a member of the super administrator role or the operator role. For more information about user roles, refer to Tasks and roles.

To schedule the movement of resources to or from a running logical partition using version 7 or later of the HMC, follow these steps:

1. In the navigation pane, open Systems Management, open Servers, and click the system on which the logical partition is located.
2. In the contents pane, select the logical partition for which you want to schedule the movement of resources, click the Tasks button, and choose Operations → Schedule Operations. (If you want to schedule the movement of resources from one logical partition to another, select the logical partition from which you are moving resources.)
3. Click Options and choose New.
4. Select Dynamic Reconfiguration, and click OK.
5. Select the date and time on which you want the movement to occur.
6. Select the Options tab and select the resource type (I/O, memory, or processor), the type of movement (Add, Remove, or Move to), the destination logical partition (if you are moving resources to another logical partition), and the quantity (in processors or in megabytes) or the I/O slot that you want to move.
7. If you want the operation to be repeated, select the Repeat tab and specify how you want the operation to be repeated.
8. Click Save.
9. When the message dialog displays, click OK to continue.
When this procedure is completed, the managed system is set to perform the dynamic logical partitioning task at the date and time that you specify.

Related information

Tasks and roles

Saving the partition configuration to a partition profile using version 7 or later of the HMC:

Use this procedure to save the current configuration of a logical partition to a new partition profile using a Hardware Management Console (HMC). Use this procedure if you change the configuration of a logical partition using dynamic logical partitioning and you do not want to lose the changes when you reactivate the logical partition. This procedure allows you to save the changed configuration to a new partition profile instead of having to enter the changed resource allocations manually.

You can perform this procedure at any time after you initially activate a logical partition.

To save the current configuration of a logical partition to a new partition profile using version 7 or later of the HMC, you must be a super administrator, service representative, operator, or product engineer. For more information about user roles, refer to Tasks and roles.

You can perform this procedure on active logical partitions and on logical partitions that are shut down. In either of these cases, the HMC reads the partition configuration that is stored for the logical partition in the server firmware and saves this partition configuration to the specified partition profile. For active logical partitions, the partition configuration that is stored in the server firmware is the current partition configuration of the logical partition. For logical partitions that are shut down, the partition configuration that is stored in the server firmware is the partition configuration at the time that you shut down the logical partition. Regardless of the state of the logical partition at the time that you perform this procedure, the procedure allows you to save the dynamic logical partitioning changes to a partition profile and use the partition profile to reactivate the logical partition without losing those changes.

After you shut down a logical partition, other logical partitions can use the resources that were used by that logical partition when the logical partition was active. Therefore, the resources available on the managed system might not support the logical partition configuration that is stored in the server firmware for the inactive logical partition. After you save the partition configuration of a logical partition that is shut down, verify that the resources available on the managed system can support the logical partition configuration that you saved to a partition profile.

When you save the partition configuration to a new partition profile, the desired amounts of memory, processors, processing units, and virtual processors in the new partition profile are set to the current amounts from the partition configuration. The minimum and maximum amounts of memory, processors, processing units, and virtual processors in the new partition profile are set to the minimum and maximum amounts from the partition configuration. For example, you start a logical partition using a partition profile that specifies a minimum of 512 MB of memory, a maximum of 2 GB of memory, and 1 GB as the desired amount of memory. The managed system has over 1 GB of memory available, so the logical partition has 1 GB of memory when it starts. You then add 1 GB of memory to the logical partition for a total of 2 GB of memory. If you shut down the logical partition, and then save the partition configuration, the resulting partition profile specifies a minimum of 512 MB of memory, a maximum of 2 GB of memory, and 2 GB as the desired amount of memory. Likewise, if the model and edition feature of the managed system allow you to assign percentages of the 5250 CPW capability of the managed system to i5/OS logical partitions, the minimum, desired, and maximum percentage of 5250 CPW in the new partition profile are the minimum, current, and maximum percentages of 5250 CPW from the partition configuration.

The physical and virtual I/O devices that are set as required in the active partition profile are saved as required devices in the new partition profile. The physical and virtual I/O devices that are set as desired in the active partition profile or that were added to the logical partition through dynamic logical
partitioning are saved as desired devices in the new partition profile. The partition workload group on the logical partition (if any) is saved as the partition workload group on the new partition profile.

To save the current configuration of a logical partition to a new partition profile using version 7 or later of the HMC, complete the following:

1. In the navigation pane of the HMC, open Systems Management, open Servers, and click the managed system on which the logical partition is located.
2. In the contents pane, select the logical partition, click the Tasks button, and select Configuration → Save Current Configuration.
3. Enter the name of the new partition profile into New profile and click OK.

After you save the partition configuration to a new partition profile, verify that the new partition profile is set the way that you want. In particular, verify that the required and desired settings are set correctly for your I/O devices. By default, physical and virtual I/O devices that are added to the logical partition using dynamic logical partitioning are saved as desired devices in the new partition profile. If you want any of these I/O devices to be required, you must change the partition profile so that the I/O device is required. For more information on changing partition profiles, see Changing partition profile properties using version 7 or later of the HMC.

Related concepts

- “Managing 5250 CPW dynamically using version 7 or later of the HMC” on page 159
- “Managing physical I/O devices and slots dynamically using version 7 or later of the HMC” on page 156
- “Managing memory dynamically using version 7 or later of the HMC” on page 150
- “Managing processor resources dynamically using version 7 or later of the HMC” on page 153

Related tasks

- “Changing partition profile properties using version 7 or later of the HMC” on page 93

Related information

- Tasks and roles

Using i5/OS installed on a logical partition

There are some differences between using i5/OS on a logical partition and using i5/OS on a nonpartitioned server. In most cases, you will find these two environments to be similar, if not identical.

Shutting down i5/OS logical partitions

The correct way to shut down an i5/OS logical partition safely is from an i5/OS command line.
If you cannot shut down the i5/OS logical partition from an i5/OS command line, you can shut down the i5/OS logical partition from the Shut Down Partition window on your HMC or from the remote control panel on the Operations Console. Using these methods can cause an abnormal shutdown and can result in loss of data.

Before you shut down an i5/OS logical partition, you must perform all of the basic i5/OS shutdown tasks. For example, all other users must be signed off of the i5/OS logical partition before you can shut it down. If you shut down the i5/OS logical partition without completing all of the required tasks, you can cause damage to data or cause the system to behave in unpredictable ways. For more information on what you must do before shutting down the i5/OS logical partition, see the i5/OS Basic system operations topic collection.

Related tasks

“Partitioning a new or nonpartitioned IBM System i5 or eServer i5 managed system using version 6 or earlier of the HMC” on page 21

Use this procedure to partition a new or nonpartitioned IBM System i5 or eServer i5 managed system using version 6 or earlier of the Hardware Management Console (HMC). In this procedure, you will validate the hardware on the managed system, create the logical partitions on the managed system, and designate the service partition for the managed system.

“Partitioning a new or nonpartitioned IBM System i5 or eServer i5 managed system using version 7 or later of the HMC” on page 69

Use this procedure to partition a new or nonpartitioned IBM System i5 or eServer i5 managed system using version 7 or later of the Hardware Management Console (HMC). In this procedure, you will validate the hardware on the managed system, create the logical partitions on the managed system, and designate the service partition for the managed system.

Related information

Basic system operations

Shutting down i5/OS logical partitions using version 7 or later of the HMC:

You can shut down i5/OS logical partitions using the Hardware Management Console (HMC).

Before you shut down the i5/OS logical partition, complete the following:

1. If an Integrated xSeries Adapter (IXA) is present on the system, shut down the IXA using i5/OS options.
2. Ensure that all jobs are completed and all applications are ended.
3. Ensure that your partition profiles are updated with any dynamic logical partitioning resource changes that you want to keep when you restart the logical partition.

The correct way to shut down an i5/OS logical partition from the HMC is to open an HMC 5250 emulator session and run the Power Down System (PWRDWN) command.

To shut down an i5/OS logical partition version 7 or later of the HMC, follow these steps:

1. In the navigation pane of your HMC, open Systems Management, open Servers, and click the managed system on which the logical partition is located.
2. In the contents pane, select the logical partition, click the Tasks button, and choose Console Window → Open Dedicated 5250 Console.
3. From the i5/OS command line in the emulator session, type PWRDWN SYS OPTION (*CNTRL) DELAY (600) and press Enter. The system will only shut down the i5/OS logical partition you selected. The PWRDWN SYS command does not affect other i5/OS logical partitions on your system. If you enter the PWRDWN SYS command with the RESTART(*YES) option, the operating system restarts, and the resource specifications of the logical partition remain the same. If you do not use the RESTART(*YES) option, then the logical partition shuts down completely, and other logical partitions will be able to take and use the resources that were used by the logical partition. Also, when you
reactivate the logical partition using a partition profile, the partition profile overlays the resource specifications of the logical partition with the resource specifications in the partition profile. Any resource changes that you made to the logical partition using dynamic logical partitioning are lost when you reactivate the logical partition using a partition profile. If the logical partition is set to start automatically when the managed system starts, you can preserve the resource specifications on that logical partition by restarting the entire managed system using the Partition autostart power-on mode. When the logical partitions start automatically, the logical partitions have the resource specifications that the logical partitions had when you shut down the managed system.

4. If the PWRDWN SYS command does not work, you can use either of the following methods to shut down the i5/OS logical partition.

   **Attention:** Using these methods can cause an abnormal shutdown and can result in loss of data.
   - Delayed shutdown. See Performing a delayed shutdown of an i5/OS logical partition using version 7 or later of the HMC for instructions.
   - Immediate shutdown. See Performing an immediate shutdown of an i5/OS logical partition using version 7 or later of the HMC for instructions.

*Performing a delayed shutdown of an i5/OS logical partition using version 7 or later of the HMC:*

You can perform a delayed shutdown of a logical partition using the Hardware Management Console (HMC). Using delayed shutdown is equivalent to using the power button on the remote control panel. Use delayed shutdown only when you must shut down a logical partition, and the PWRDWN SYS command does not work.

When you use the delayed shutdown option, the logical partition waits a predetermined amount of time to shut down. This allows the logical partition time to end jobs and write data to disks. If the logical partition is unable to shut down within the predetermined amount of time, it will end abnormally and the next restart might take a long time.

To perform a delayed shutdown of an i5/OS logical partition using version 7 or later of the HMC, complete the following:

1. In the navigation pane of your HMC, open **Systems Management**, open **Servers**, and click the managed system on which the logical partition is located.
2. In the contents pane, select the logical partition, click the **Tasks** button, and choose **Operations** → **Shut Down**.
3. Select **Delayed** and click **OK**.

*Performing an immediate shutdown of an i5/OS logical partition using version 7 or later of the HMC:*

Use this procedure to perform an immediate shutdown of a logical partition using version 7 or later of the Hardware Management Console (HMC).

**Attention:** Using immediate shutdown can cause an abnormal IPL of the i5/OS logical partition and possibly cause loss of data. Use immediate shutdown only when an i5/OS logical partition cannot shut down using PWRDWN SYS or delayed shutdown.

When you use the immediate shutdown option, the system shuts down without any preset delay. Using immediate shutdown is equivalent to using function 8 on the remote control panel.

To perform an immediate shutdown of an i5/OS logical partition using version 7 or later of the HMC, complete the following:

1. In the navigation pane of your HMC, open **Systems Management**, open **Servers**, and click the managed system on which the logical partition is located.
2. In the contents pane, select the logical partition, click the **Tasks** button, and choose **Operations** → **Shut Down**.
3. Select Immediate and click OK.

**Shutting down i5/OS logical partitions using Operations Console:**

You can shut down i5/OS logical partitions using Operations Console.

Before you shut down the i5/OS logical partition, complete the following:

1. If an Integrated xSeries Adapter (IXA) is present on the system, shut down the IXA using i5/OS options.
2. Ensure that all jobs are completed and all applications are ended.
3. Ensure that your partition profiles are updated with any dynamic logical partitioning resource changes that you want to keep when you restart the logical partition.

The correct way to shut down a logical partition is by using the i5/OS power down system (PWRDWNSYS) command.

From an i5/OS command line, type PWRDWNSYS OPTION (*CNTRLD) DELAY (600) and press Enter. The system will only shut down the i5/OS logical partition you selected. The PWRDWNSYS command does not affect other i5/OS logical partitions on your system.

If you enter the PWRDWNSYS command with the RESTART(*YES) option, the operating system restarts, and the resource specifications of the logical partition remain the same. If you do not use the RESTART(*YES) option, then the logical partition shuts down completely, and other logical partitions will be able to take and use the resources that were used by the logical partition. Also, when you reactivate the logical partition using a partition profile, the partition profile overlays the resource specifications of the logical partition with the resource specifications in the partition profile. Any resource changes that you made to the logical partition using dynamic logical partitioning are lost when you reactivate the logical partition using a partition profile. If the logical partition is set to start automatically when the managed system starts, you can preserve the resource specifications on that logical partition by restarting the entire managed system using the Partition autostart power-on mode. When the logical partitions start automatically, the logical partitions have the resource specifications that the logical partitions had when you shut down the managed system.

If the PWRDWNSYS command does not work, you can use the remote control panel through Operations Console to use control panel functions through a PC. The graphical user interface of the remote control panel looks similar to the physical control panel. The remote control panel installs through Operations Console. For more information on the remote control panel, see the i5/OS Remote control panel topic collection. Using the remote control panel to shut down the i5/OS logical partition can result in an abnormal IPL and loss of data.

**Delayed shutdown**

Use delayed shutdown only when you must shut down a logical partition, and the PWRDWNSYS command does not work.

When you use the delayed shutdown option, the partition waits a predetermined amount of time to shut down. This allows the partition time to end jobs and write data to disks. If the partition is unable to shut down within the predetermined amount of time, it will end abnormally and the next restart might take a long time.

**Immediate shutdown**

Use immediate shutdown only when an i5/OS logical partition cannot shut down using PWRDWNSYS or delayed shutdown.
When you use the immediate shutdown option, the system powers down without any preset delay.

**Attention:** This might cause an abnormal IPL of the i5/OS logical partition and possibly cause loss of data.

Use the remote control panel to perform a delayed shutdown or an immediate shutdown. The power button will start a delayed shutdown and function 8 will start an immediate shutdown of a system.

**Related information**

- Remote control panel

---

**Restarting and shutting down i5/OS in a logical partition**

At times you will need to perform an initial program load (IPL) or shut down an i5/OS logical partition. For example, if you want to apply a delayed fix to i5/OS, you must perform an IPL before i5/OS can apply the fix.

The preferred method for restarting and shutting down i5/OS logical partitions is through the i5/OS command line. The Hardware Management Console (HMC) does not shut down the i5/OS operating system before it shuts down the logical partition. Using the HMC to restart or shut down an i5/OS logical partition can result in an abnormal IPL and the loss of data. However, you might need to use the HMC to change the operating mode or IPL type of the i5/OS logical partition before you restart or shut down the i5/OS logical partition using the i5/OS command line.

It is important to remember that, when you perform an IPL of an i5/OS logical partition, you are powering off only the logical partition and not the entire managed system. Other logical partitions on your managed system continue to run when you perform an IPL on the i5/OS logical partition. However, when you shut down the last logical partition that is running on a managed system, then the managed system is set to power off automatically by default. If you want, you can set the managed system properties on the HMC so that the managed system remains powered on when you shut down the last running logical partition.

For more information about abnormal IPLs, see the i5/OS Basic system operations topic collection.

**Related information**

- Basic system operations

---

**Changing the operating mode for an i5/OS logical partition using version 7 or later of the HMC:**

You can change the operating mode for an i5/OS logical partition using the Hardware Management Console (HMC). The operating mode for an i5/OS logical partition determines the number of options that are presented to the operator for consideration during and after the initial program load (IPL). It can also secure (lock) the control panel to prevent an unauthorized or inadvertent IPL from the control panel.

To change the i5/OS operating mode of a logical partition using version 7 or later of the HMC, follow these steps:

1. In the navigation pane of your HMC, open **Systems Management**, open **Servers**, and click the managed system on which the logical partition is located.
2. In the contents pane, select the logical partition, click the **Tasks** button, and choose **Properties**.
3. Click **Settings**, set i5/OS Keylock position to your preference, and click **OK**.

For more information about operating modes for an i5/OS logical partition, see the Operating mode of an IPL.

**Changing the IPL type for an i5/OS logical partition using version 7 or later of the HMC:**
You can change the initial program load (IPL) type for an i5/OS logical partition using the Hardware Management Console (HMC). When you change the IPL type, the managed system loads the Licensed Internal Code and i5/OS from the location specified by the IPL type. The IPL type is also known as the IPL source, because each IPL type is associated with a different IPL source.

You can choose a separate IPL type for each i5/OS logical partition.

Attention: Only use IPL type C under the direction of your service representative. Severe data loss can occur with incorrect use of this function.

To change the i5/OS IPL type of a logical partition using version 7 or later of the HMC, follow these steps:
1. In the navigation pane of your HMC, open Systems Management, open Servers, and click the managed system on which the logical partition is located.
2. In the contents pane, select the logical partition, click the Tasks button, and choose Properties.
3. Click Settings, set i5/OS IPL source to your preference, and click OK.

For information about how each IPL source works and why you might need to change IPL types, see the IPL type topic.

Managing logical-partition and operating-system security
When all logical partitions are managed by the Hardware Management Console, you can control who has access to the HMC and the system. You can also use the IBM eServer Security Planner to help you plan a basic security policy for each of the operating systems on your system.

When all logical partitions are managed by the Hardware Management Console (HMC), the system administrator for the HMC can control who has access to the HMC and the managed systems by creating HMC user roles. The user roles control who can access different parts of the HMC and what tasks they can perform on the managed system.

For more information about securing the HMC and protecting your server, refer to Working with users, roles, and passwords, System Manager Security, or Tasks and roles.

You can use the IBM eServer Security Planner to help you plan a basic security policy for each of the operating systems on your IBM Systems or eServer hardware. The planner provides you with a list of recommendations for setting password rules, resource-access rules, logging and auditing rules, and other security settings that are specific to the operating system.

For more information about protecting your operating system, refer to the IBM eServer Security Planner.

Related information
- Working with users, roles, and passwords
- System Manager Security
- Tasks and roles
- IBM eServer Security Planner

Backing up and recovering data
It is crucial that you back up your data because you never know when you might need to do a server recovery. Save everything in your system as often as possible. You might not be prepared to recover from a site loss or certain types of disk failures if you do not regularly save everything.

For more information about planning a backup and recovery strategy for the Hardware Management Console (HMC) and i5/OS data, refer to the following topics:
Table 20. Backup and recovery information for the HMC and i5/OS

<table>
<thead>
<tr>
<th>Topic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backing up critical HMC data</td>
<td>This procedure explains how to save critical HMC data (such as user information and platform-configuration files) to a backup file. This information is in the Managing the HMC topic.</td>
</tr>
<tr>
<td>Backing up partition profile data</td>
<td>This procedure explains how to back up the partitioning data on your HMC to a backup file on the HMC. This information is in the Managing the HMC topic.</td>
</tr>
<tr>
<td>Reinstalling the HMC machine code</td>
<td>This procedure explains how to reinstall the HMC interface from the recovery CD-ROM. This information is in the Managing the HMC topic.</td>
</tr>
<tr>
<td>Restoring profile data</td>
<td>This procedure explains how to restore the partitioning data from the backup file to the HMC. This information is in the Managing the HMC topic.</td>
</tr>
<tr>
<td>Back up your server</td>
<td>This information can help you develop the backup strategy for your i5/OS logical partition. This information is in the Backup and recovery topic in the iSeries Information Center.</td>
</tr>
<tr>
<td>Recover your server</td>
<td>This information can help you reload your operating system and data. This information is in the Backup and recovery topic in the iSeries Information Center.</td>
</tr>
</tbody>
</table>

Related information
- Backing up critical HMC data
- Backing up partition profile data
- Reinstalling the HMC machine code
- Restoring profile data
- Back up your server
- Recover your server

Backing up and recovering AIX logical partitions that use i5/OS virtual I/O resources:

When you create an AIX logical partition that uses resources from an i5/OS logical partition, you can manage backup and recovery using i5/OS control language (CL) commands, AIX commands, or a combination of the two.

For more information on planning your backup strategy, see the i5/OS Backup and recovery topic.

To save AIX data in a logical partition that uses i5/OS resources to a shared tape drive and restore the data from the tape drive, you can use either the AIX tar command or the i5/OS Save (SAV) and Restore (RST) commands. You can also use the tar command to save your data to a file. If you use the tar command to save data, the only way you can restore that data is by using the tar command again. Similarly, if you use the SAV command to save data, the only way you can restore that data is by using the RST command. The two methods of backing up and restoring data are not compatible.

The following restrictions apply:
- To use the i5/OS SAV or RST command to save or restore the NWSD, AIX must be inactive (that is, the NWSD must be varied off).
- Saving the storage space is typically faster than saving by using the tar command, but it does not provide file-level backup and recovery.
- You cannot save i5/OS data and tar data on the same tape volume.
Related information

Backup and recovery

Backing up and recovering AIX files using the tar command:

The most common data backup utility in AIX is the `tar` (tape archive) utility. Use the AIX `tar` command if you have AIX installed on a dedicated disk or if you cannot vary off an AIX partition while you are backing up data.

Backups using the AIX `tar` command are at the file level. They save only the files and directories that the `tar` command specifies. Therefore, you cannot use the `tar` command to save AIX data that is not in the file server. For example, you cannot save a kernel in the PowerPC Reference Platform (PReP) start partition by using the `tar` command.

Saving to and restoring from a tape device:

Use these procedures to save and restore AIX files between an AIX logical partition that uses i5/OS resources and a shared tape drive.

Ensure that your AIX data is in the file server.

To save and restore AIX files between a partition that uses i5/OS resources and a shared tape drive, follow these steps:

1. Type the following command:
   ```bash
tar -c -f /dev/rmt0 files
   ```
   Use the following descriptions to help you understand the arguments of this command:
   - `tar` is the command name (the contraction of “tape archive”).
   - `-c` is the command action to create. This argument specifies that the `tar` command creates a new archive or overwrites an old one (as opposed to restoring files from an archive or adding individual files to an existing archive).
   - `-f /dev/rmt0` is the tape device and number. This argument specifies that the command uses virtual tape 0 on the IBM System i server. After the `tar` command runs, the tape device is closed and the tape is rewound. To save more than one archive on the tape, you must keep the tape from rewinding after each use, and you must position the tape to the next file marker. To do this, specify the `rmt0.1` (nonrewinding virtual tape) device instead of `rmt0`.
   - `files` are the names of the files and directories that you plan to save.
   
   You have now saved AIX data from a partition that uses i5/OS resources to the shared tape drive.

2. Type the following command:
   ```bash
tar -x -f /dev/rmt0 files
   ```
   The `-x` (extract) argument replaces the `-c` (create) argument in the `tar` command used in step x. You have now restored AIX data from the shared tape drive to a partition that is sharing resources.

Saving to and restoring from a file:

You can save and restore AIX files between an AIX logical partition that uses i5/OS resources and a tar file.

Saving to a file

The following is an example of using the `tar` command to save to a file.

```bash
tar -cvf /tmp/etc.tar /etc
```

Use the following descriptions to help you understand the arguments of this command:

- `tar` The command name.
Create a tar file.

Verbose. This argument shows the files that are being added to the tar file.

The data immediately following f is the name of the tar file.

/tmp/etc.tar
   The name of the tar file.

/ etc
   An object to be added to the tar file. Because /etc is a directory, the utility adds all the contents
   of the directory and its subdirectories to the tar file.

After you create the tar file, you can save it to an offline medium in several ways. For example, you can
save the tar file to a virtual tape device or a directly attached tape device. You can also copy the tar file
to the integrated file system and save it at a later time.

You can save the data on an AIX partition to a tar file during normal server usage. You can automate and
start the tar utility by using the cron (chronology) daemon on the logical partition. The cron daemon is a
scheduling mechanism for AIX. You can also use the tar utility to schedule a single backup request. For
example, if you want to use the tar utility to back up the /etc directory at 10 p.m. on 19 September, you
can type the following command:at 10pm Sep 19 -f tar.command.

Restoring from a file

The following is an example of using the tar command to restore from file:
tar -xvf /tmp/etc.tar /etc.
   The -x (extract) argument replaces the -c (create) argument in the tar command used to save the files.

Backing up and recovering AIX logical partitions using i5/OS CL commands:

If you have an AIX logical partition that uses i5/OS resources, tools are available in i5/OS for backup
and recovery. You can use the Save (SAV) and Restore (RST) commands to save and restore entire virtual
disks in their current state.

The SAV command saves the directory that has the same name as the virtual disk under the
QFPNWSSTG directory in the integrated file system. This method of backup and recovery is most
effective if the AIX kernel is saved in a PowerPC Reference Platform (PReP) start partition on the virtual
disk. On AIX, this usually occurs as part of a default installation.

Backups using i5/OS control language (CL) command are at the drive level. This means that i5/OS backs
up the entire contents of a virtual disk, or network storage space, rather than individual files. Thus, the
correct SAV command backs up any information on the drive, including a kernel in the PReP start
partition.

If you save the AIX kernel in a PReP partition, you can restore and start the partition after a total system
reinstallation. You can also transport and restore saved virtual disks to other IBM System i servers using
File Transfer Protocol (FTP) and tape.

Save AIX data by using i5/OS SAV:

You can save data for an AIX logical partition that uses i5/OS resources by using the Save (SAV) i5/OS
CL command.

On i5/OS, your data is in a network-server storage space (NWSSTG).

To save data for an AIX logical partition that uses i5/OS resources by using the Save (SAV) i5/OS CL
command, follow these steps:
   1. At the i5/OS command line, enter the Save (SAV) command.
   2. On the Save display, enter the following parameter values:
a. In the **Device** field, enter the associated i5/OS device description. To save to a save file in a library like QGPL, enter `/qsys.lib/qgpl.lib/myfile.file`. For example, if your tape device is named TAP01, enter `/qsys.lib/tap01.devd`.

b. In the **Objects: Name** field, enter the integrated-file-system location of the network-server storage space. For example, if your network-server storage space is named TEST1, enter `/qfpnwsstg/test1`.

3. At the i5/OS command line, enter the Display Save File (DSPSAVF) command to verify that the changed save file exists.

4. In the Option field by the new save file name, enter 5 (Display) to display a list of the stream files in the save file.

**Restore AIX data by using i5/OS RST:**

You can restore data for an AIX logical partition that uses i5/OS resources by using the Restore (RST) i5/OS CL command.

Restore (RST) is the i5/OS CL command to restore AIX files from the shared tape drive of the partition that shares resources.

To restore data for an AIX logical partition that uses i5/OS resources by using the Restore (RST) i5/OS CL command, follow these steps:

1. At the i5/OS command line, enter the Restore (RST) command.

2. On the Restore Object display, enter the following parameter values:
   a. To restore from a tape device, enter the associated i5/OS device description in the **Device** field. To save to a save file in a library like QGPL, enter `/qsys.lib/qgpl.lib/myfile.file`. For example, if your tape device is named TAP01, enter `/qsys.lib/tap01.devd`. To restore from a save file in library QGPL, enter, enter `/qsys.lib/qgpl.lib/myfile.file`.
   b. In the **Objects: Name** field, enter the integrated-file-system location of the network-server storage space. For example, if your network-server storage space is named TEST1, enter `/qfpnwsstg/test1`.

**Backing up the network server description and virtual disk drives associated with an AIX logical partition:**

Learn about how to back up the data for an AIX logical partition that uses i5/OS resources.

When you install the logical partitions with virtual disk, the i5/OS logical partition that shares resources creates a network server description and creates disk drives for your AIX logical partition that you need to back up. Some of the disk drives are server-related (the installation and server drives), while others are user-related. Because your AIX logical partition might consider the disk drives to be a unified server, you must save all the disk drives and the network server description so they restore correctly.

The implementation of a logical partition for IBM System i servers allows you to save and restore virtual disks as i5/OS network-server storage space objects. These objects are saved as part of the full i5/OS server backup. You can also specifically save the network server description and storage spaces that are associated with a logical partition on an IBM System i server. Daily backup of the server drive is a good practice.

**Related information**

- [Backup and recovery](#)

**Backing up network server descriptions for an AIX logical partition:**

When you save the storage space objects that are associated with a logical partition that uses virtual disks, you must also save the network server description (NWSD). Otherwise, a logical partition might not be able to re-establish items such as the file-system permissions for the partition.
To save the network server description (NWSD), use the Save Configuration (SAVCFG) command as follows:

1. On an i5/OS command line, type $SAVCFG$.
2. Press Enter to save the NWSD configuration.

The Save Configuration command (SAVCFG) saves the objects associated with an NWSD and the current static network-server storage spaces. This command does not save the links associated with the dynamically added storage spaces. You must add these links manually after the configuration and the dynamically linked storage spaces have been restored.

Restoring network-server descriptions for an AIX partition:

In a disaster-recovery situation, you would restore all the configuration objects, which include the network-server description (NWSD) for your logical partition. In some situations, you must specifically restore the NWSD. For example, you must restore the NWSD when you migrate to new hardware.

To have i5/OS automatically relink disk drives within the integrated file system to the restored NWSD, restore those disk drives first.

To restore the NWSD, use the Restore Configuration (RSTCFG) command:

1. On an i5/OS command line, type $RSTCFG$ and press F4 (Prompt).
2. In the Objects field, specify the name of the NWSD.
3. In the Device field, specify which device you are using to restore the NWSD. If you are restoring from media, specify the device name. If you are restoring from a save file, specify *SAVF and identify the name and library for the save file in the appropriate fields.
4. Press Enter to restore the NWSD.
5. When you have restored the NWSD and all of its associated storage spaces, start (vary on) the logical partition.

Backing up and recovering Linux logical partitions that use i5/OS virtual I/O resources:

When you create a Linux logical partition that uses resources from an i5/OS logical partition, you can manage backup and recovery using i5/OS control language (CL) commands, Linux commands, or a combination of the two.

For more information on planning your backup strategy, see the i5/OS Backup and recovery topic.

To save Linux data in a logical partition that uses i5/OS resources to a shared tape drive and restore the data from the tape drive, you can use either the Linux tar command or the i5/OS Save (SAV) and Restore (RST) commands. You can also use the tar command to save your data to a file. If you use the tar command to save data, the only way you can restore that data is by using the tar command again. Similarly, if you use the SAV command to save data, the only way you can restore that data is by using the RST command. The two methods of backing up and restoring data are not compatible.

The following restrictions apply:

- To use the tape device from Linux, you must vary the tape off under i5/OS.
- To use the i5/OS SAV or RST command to save or restore the NWSD, Linux must be inactive (that is, the NWSD must be varied off).
- Saving the storage space is typically faster than saving by using the tar command, but it does not provide file-level backup and recovery.
- Linux does not support switching tapes in a library device. You can only use the tape that is currently in the device.
- You cannot save i5/OS data and tar data on the same tape volume.
Backing up and recovering Linux files using the tar command:

The most common data backup utility in Linux is the tar (tape archive) utility. Use the Linux tar command if you have Linux installed on a dedicated disk or if you cannot vary off a Linux partition while you are backing up data.

Backups using the Linux tar command are at the file level. They save only the files and directories that the tar command specifies. Therefore, you cannot use the tar command to save Linux data that is not in the file server. For example, you cannot save a kernel in the PowerPC Reference Platform (PReP) start partition by using the tar command.

One advantage of the tar command is that it supports incremental backups and backup of special devices, which is not common for tar implementations. Also, the tar command backs up files without regard to the underlying file system type.

Saving to and restoring from a tape device:

Use these procedures to save and restore Linux files between a Linux logical partition that uses i5/OS resources and a shared tape drive.

Ensure that your Linux data is in the file server.

Linux typically treats tape as a character device that it can quickly read from or write to in long streams of data, but cannot quickly access to find specific data. By contrast, Linux treats a disk or CD as a block device that it can read from or write to quickly at any point on the device, making it suitable for the mount command.

Complete the following steps to save and restore Linux files between a partition that uses i5/OS resources and a shared tape drive:

1. Type the following command: tar -b 40 -c -f /dev/st0 files Use the following descriptions to help you understand the arguments of this command:
   - tar is the command name (the contraction of “tape archive”).
   - -b 40 is the block size in sectors. This argument specifies that Linux is to write the archive stream in blocks of 40 sectors (20 KB). If you do not specify a value for this argument, the default value is 20 sectors (10 KB), which does not perform as well over virtual tape as does a value of 40.
   - -c is the command action to create. This argument specifies that the tar command creates a new archive or overwrites an old one (as opposed to restoring files from an archive or adding individual files to an existing archive).
   - -f /dev/st0 is the virtual tape device and number. This argument specifies that the command uses virtual tape 0 on the IBM System i server. After the tar command runs, the tape device is closed and the tape is rewound. To save more than one archive on the tape, you must keep the tape from rewinding after each use, and you must position the tape to the next file marker. To do this, specify the nst0 (nonrewinding virtual tape) device instead of st0.
   - files are the names of the files and directories that you plan to save.

   You have now saved Linux data from a partition that uses i5/OS resources to the shared tape drive.

2. Type the following command: tar -b 40 -x -f /dev/st0 files The -x (extract) argument replaces the -c (create) argument in the tar command used in step 1. You have now restored Linux data from the shared tape drive to a partition that is sharing resources.

Saving to and restoring from a file:
You can save and restore Linux files between a Linux logical partition that uses i5/OS resources and a tar file.

**Saving to a file**

The following is an example of using the `tar` command to save to a file.

```
tar -cvf /tmp/etc.tar /etc
```

Use the following descriptions to help you understand the arguments of this command:

- **tar**: The command name.
- **c**: Create a tar file.
- **v**: Verbose. This argument shows the files that are being added to the tar file.
- **f**: The data immediately following `f` is the name of the tar file.

```
/tmp/etc.tar
```

- The name of the tar file.

```
/etc
```

- An object to be added to the tar file. Because `/etc` is a directory, the utility adds all the contents of the directory and its subdirectories to the tar file.

After you create the tar file, you can save it to an offline medium in several ways. For example, you can save the tar file to a virtual tape device or a directly attached tape device. You can also copy the tar file to the integrated file system and save it at a later time.

You can save the data on a Linux partition to a tar file during normal server usage. You can automate and start the `tar` utility by using the `cron` (chronology) daemon on the logical partition. The `cron` daemon is a scheduling mechanism for Linux. You can also use the `tar` utility to schedule a single backup request. For example, if you want to use the `tar` utility to back up the `/etc` directory at 10 p.m. on 19 September, you can type the following command:

```
at 10pm Sep 19 -f tar.command
```

**Restoring from a file**

The following is an example of using the `tar` command to restore from file:

```
tar -xvf /tmp/etc.tar /etc
```

The `-x` (extract) argument replaces the `-c` (create) argument in the `tar` command used to save the files.

**Backing up and recovering Linux partitions using i5/OS commands:**

If you have a Linux logical partition that uses i5/OS resources, tools are available in i5/OS for backup and recovery. You can use the Save (SAV) and Restore (RST) control language (CL) commands to save and restore entire virtual disks in their current state.

The SAV command saves the directory that has the same name as the virtual disk under the QFPNWSSTG directory in the integrated file system. This method of backup and recovery is most effective if the Linux kernel is saved in a PowerPC Reference Platform (PReP) start partition on the virtual disk. On most Linux distributions, this usually occurs as part of a default installation.

Backups using i5/OS commands are at drive level. This means that i5/OS backs up the entire contents of a virtual disk, or network storage space, rather than individual files. Thus, the correct SAV command backs up any information on the drive, including a kernel in the PReP start partition.

If you save the Linux kernel in a PReP partition, you can restore and start the partition after a total system reinstallation. You can also transport and restore saved virtual disks to other IBM System i servers using File Transfer Protocol (FTP) and tape.
Save Linux data by using i5/OS SAV:

You can save data for a Linux logical partition that uses i5/OS resources by using the Save (SAV) i5/OS CL command.

On i5/OS, your data is in a network-server storage space.

To save data for a Linux logical partition that uses i5/OS resources by using the Save (SAV) i5/OS CL command, follow these steps:
1. At the i5/OS command line, enter the Save (SAV) command.
2. On the Save display, enter the following parameter values:
   a. In the **Device** field, enter the associated i5/OS device description. To save to a save file in a library like QGPL, enter `/qsys.lib/qgpl.lib/myfile.file`. For example, if your tape device is named TAP01, enter `/qsys.lib/tap01.devd`.
   b. In the **Objects: Name** field, enter the integrated-file-system location of the network-server storage space. For example, if your network-server storage space is named TEST1, enter `/qfpnwsstg/test1`.
3. At the i5/OS command line, enter the Display Save File (DSPSAVF) command to verify that the changed save file exists.
4. In the Option field by the new save file name, enter 5 (Display) to display a list of the stream files in the save file.

Restore Linux data using i5/OS RST:

You can restore data for a Linux logical partition that uses i5/OS resources by using the Restore (RST) i5/OS CL command.

Restore (RST) is the i5/OS command to restore Linux files from the shared tape drive of the partition that shares resources. On the Restore Object display, enter the following parameter values:
1. To restore from a tape device, enter the associated i5/OS device description in the **Device** field. For example, if your tape device is named TAP01, enter `/qsys.lib/tap01.devd`.
2. To restore from a save file in library QGPL, enter the associated file name. For example, `/qsys.lib/qgpl.lib/myfile.file`.
3. In the **Objects: Name** field, enter the integrated-file-system location of the network-server storage space. For example, `/qfpnwsstg/test1`.

Backing up the network server description and virtual disk drives associated with a Linux partition:

Learn about how to back up the data for a Linux logical partition that uses i5/OS resources.

Backing up the data for a Linux logical partition that uses i5/OS resources is different from backing up the data for a Linux logical partition that uses its own resources. When you install the logical partitions with virtual disk, the i5/OS logical partition that shares resources creates a network server description and creates disk drives for your Linux logical partition that you need to back up. Some of the disk drives are server-related (the installation and server drives), while others are user-related. Because your Linux logical partition might consider the disk drives to be a unified server, you must save all the disk drives and the network server description so they restore correctly.

The implementation of a logical partition for IBM System i servers allows you to save and restore virtual disks as i5/OS network-server storage space objects. These objects are saved as part of the i5/OS server when you perform a full i5/OS server backup. You can also specifically save the network server description and storage spaces that are associated with a logical partition on an IBM System i server. Daily backup of the server drive is a good practice.
Building a rescue image on a network storage space:

You can build a rescue image on a network storage space (NWSSTG) to assist you in checking and repairing a faulty Linux installation.

A rescue image is a disk image that contains the Linux kernel, a shell, and the diagnostic tools, drivers, and other utilities that would be useful for checking and repairing a faulty Linux installation. Many Linux distributors include a rescue image on their installation disks. One rescue solution for a logical partition is to create a small NWSSTG that can remain on the integrated file system solely for the purpose of rescuing logical partitions. You can install a rescue image to the NWSSTG when you create your logical partition.

Before creating a rescue image on network storage, it is important to document the configuration information for each of your logical partitions.

1. Document the drive configuration information, which is located in the /etc/fstab file.
2. Capture the networking information that is reported when you run the `ifconfig` command.
3. Create a list of the modules that are needed by each logical partition. You can see which modules are in use by using the `lsmod` command from within Linux. Use the information obtained from the commands and files listed above to determine which files to store on your rescue network storage space.

To build a rescue image on an NWSSTG, follow these steps:

1. Determine how much network storage space you need to build the rescue image. Consult your Linux documentation to see how much space is required for a minimum installation of your distribution, and add enough space to create a swap partition (a PowerPC Reference Platform (PReP) start partition) and to install any extra software that you would like to have available in your rescue image. For example, if the documentation states that a minimum server installation is 291 MB, create a storage space of 425 MB.
2. Create a network storage space (CRTNWSSTG) of the size you determined for the rescue image. You might want to make a note in the storage space description field that indicates which distribution was used to make the rescue image and warns that it should be saved.
3. Link this storage space to a network server description (NWSD). You do not need to create a new NWSD for this step. You could unlink an existing storage space and temporarily link your rescue storage space to any of your existing NWSDs.
4. Start the installation server for your distribution as described in the documentation and follow the prompts. To partition your installation manually, ensure that you create a PReP start partition. At the point where you select the packages to install, select the minimum number of packages supported. The name for the package group varies by distribution.
5. Allow the installer to complete its package installation and configuration. After installation has finished, the installer starts the rescue image for you.
6. Verify that the rescue image has all the utilities that you need. For a logical partition, at a Linux command prompt, type `rpm -qa | grep ibmsis` to make sure that the utilities that work with the integrated disk are available.
7. Ensure that the device drivers that your logical partitions require are installed. For example, verify that `pcnet32` is installed for Ethernet devices, or that `olympic` is installed for token-ring devices. The kernel modules that have been compiled can be found in the `/lib/modules/kernel version/kernel/drivers` directory or in directories under that directory.
8. Install any other special drivers or software packages that your logical partitions require.
9. Use File Transfer Protocol (FTP) to send the files with the configuration information for your other logical partitions to the rescue server network storage space.

10. Install the kernel manually (if you are required to do so by your Linux distribution). For details regarding installing the kernel, consult the appropriate installation documentation for your distribution.

11. Make note of the path to the root partition on the rescue-storage space. You must use this information to start the rescue network storage space from the network. To determine the root partition, type the command `cat /etc/fstab`. The partition that has a forward slash (/) in the second column is your root partition. For further assistance in determining the root partition, see the documentation for your distribution.

You can shut down your logical partition by typing `shutdown -h now` and varying off the partition after the shutdown has completed. After the partition has varied off, you can unlink the rescue storage space and relink the normal storage space for the NWSD.

**Using a rescue image from a network-server storage space:**

You can use a Linux rescue image on a network-server storage space (NWSSTG) to repair a Linux logical partition that uses i5/OS resources. A rescue image is a disk image that contains the Linux kernel, a shell, and the diagnostic tools, drivers, and other utilities that would be useful for checking and repairing a faulty Linux installation.

To use the rescue image that you built on the NWSSTG, use the following steps:

1. Disconnect the virtual storage space for the failed logical partition (if applicable) by using the Work with NWS Storage Spaces (WRKNWSSTG) command.

2. Connect your rescue storage space as the first drive to the network server description (NWSD), and reconnect the original storage space (where applicable) as the second drive.

3. Edit the NWSD for the failed partition so that it starts from IPL source *NWSSTG. Also, edit the IPL Parameters field to reflect the root partition on the rescue storage space. For most distributions, this is a parameter such as `root=/dev/sda3` or `root=/dev/vda1`. For assistance, see the documentation for your Linux distribution.

4. Restart the partition.

5. If the existing root partition is on a dedicated disk, you might need to insert the `ibmsis` driver using the `insmod ibmsis` command.

6. Create a mount point to which you will mount the root partition of the network storage space that you are trying to rescue. You can use a command such as `mkdir /mnt/rescue`.

7. Mount the root partition of the network storage space that you are trying to rescue. Mount a drive using the command `mount -t partition-type partition-location mount-point`, where the partition type is the format of the partition such as ext2 or reiserfs, the partition location is similar to `/dev/sdb3` (for non-devfs disk partitions), `/dev/sd/disc1/part3` (for devfs disk partitions), or `/dev/sda2` (for a partition on a dedicated disk).

8. The drive that you are trying to rescue, when using virtual disk, will be the second drive rather than the first drive. (That is, if the drive was `/dev/sda3` when the partition was running normally, it will be `/dev/sdb3` in the rescue server.)

9. Use the documentation or the configuration files you created when you created the rescue NWSSTG to help you determine the device for the root of the partition you are trying to rescue. Your mount point will be similar to `/mnt/rescue` if you use the previous example.

You can either use the rescue tools provided in your rescue storage space against the mount point you have created or you can work on the partition that you are rescuing from within its own storage space. If rescuing the image from its own storage space, change the root directory for that partition using the `chroot mount-point` command.
Backing up network server descriptions for a Linux partition:

When you save the storage space objects that are associated with a logical partition that uses virtual disks, you must also save the network server description (NWSD). Otherwise, a logical partition might not be able to re-establish items such as the file-system permissions for the partition.

Use the Save Configuration (SAVCFG) command to save the network server description:
1. On the i5/OS command line, type SAVCFG.
2. Press Enter to save the NWSD configuration.

The Save Configuration command (SAVCFG) saves the objects associated with an NWSD and the current static network-server storage spaces. This command does not save the links associated with the dynamically added storage spaces. You must add these links manually after the configuration and the dynamically linked storage spaces have been restored.

Restoring network-server descriptions for a Linux partition:

In a disaster-recovery situation, you would restore all the configuration objects, which include the network-server description (NWSD) for your logical partition. In some situations, you must specifically restore the NWSD. For example, you must restore the NWSD when you migrate to new hardware.

To have i5/OS automatically relink disk drives within the integrated file system to the restored NWSD, restore those disk drives first.

To restore the NWSD, use the Restore Configuration (RSTCFG) command:
1. On an i5/OS command line, type RSTCFG and press F4 (Prompt).
2. In the Objects field, specify the name of the NWSD.
3. In the Device field, specify which device you are using to restore the NWSD. If you are restoring from media, specify the device name. If you are restoring from a save file, specify *SAVF and identify the name and library for the save file in the appropriate fields.
4. Press Enter to restore the NWSD.
5. When you have restored the NWSD and all of its associated storage spaces, start (vary on) the logical partition.

Performance impacts to i5/OS
Managing i5/OS performance ensures that your managed system is efficiently using resources and that your managed system provides the best possible services to you and to your business. Moreover, effective performance management can help you quickly respond to changes in your managed system and can save you money by postponing costly upgrades and service fees.

For more information about managing i5/OS performance, see the i5/OS Performance topic collection.

Related information

Troubleshooting i5/OS logical partitions
If you have problems with a partitioned system, determine if the problem is specific to logical partitions or is a system problem. If your problem is specific to logical partitions, you can use the reference codes to resolve the error. However, specific recovery actions and tasks might require the assistance of your next level of support.

Refer to Troubleshooting to determine whether or not your problem is a general system problem.
Related information

Troubleshooting

Reference codes for logical partitions:

Logical partition reference codes are diagnostic aids that help you determine the source of a hardware or operating system problem. Using reference codes enables you to find the correct solution to fix the problem. To use reference codes effectively, you must use them in conjunction with other service and support procedures.

For additional information about reference codes, including how to use reference code information, refer to the following topics:

Table 21. Information about reference codes for logical partitions

<table>
<thead>
<tr>
<th>Topic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference codes overview</td>
<td>This topic contains information about the four categories of status indicators that can appear in the control panel or console of the system or operating system.</td>
</tr>
<tr>
<td>Using system reference codes</td>
<td>This topic shows you how you can use reference code information to identify a list of possible failing items. The information in this topic is intended for authorized service providers.</td>
</tr>
<tr>
<td>Logical partition reference codes</td>
<td>This topic contains a list of common system reference codes. The information in this topic is intended for authorized service providers.</td>
</tr>
<tr>
<td>Partition firmware reference codes</td>
<td>This topic contains a list of common partition firmware reference codes. The information in this topic is intended for authorized service providers.</td>
</tr>
<tr>
<td>Hardware Management Console error messages</td>
<td>This topic contains a list of common HMC error messages.</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>This topic collection contains information to help you understand, isolate, and resolve problems that you are having with your server.</td>
</tr>
</tbody>
</table>

Related information

Reference codes overview
Using system reference codes
Logical partition reference codes
Partition firmware reference codes
Hardware Management Console error messages
Troubleshooting

Debugging network server description error messages for AIX logical partitions:

This topic provides a list of network server description (NWSD) error codes and explanations to help you debug NWSD error messages for AIX logical partitions.

You could encounter error messages when you try to vary on an AIX logical partition. These error messages will appear if you provide information that does not apply to a logical partition running on the server when you create your network server description (NWSD). All error messages related to the NWSD should appear in QSYSOPR and should indicate a description of the problem and a resolution to the problem.
<table>
<thead>
<tr>
<th>Reason codes</th>
<th>Code explanations</th>
</tr>
</thead>
<tbody>
<tr>
<td>00000001</td>
<td>*NWSSTG was specified as the IPL source, but no storage space was found.</td>
</tr>
<tr>
<td>00000002</td>
<td>The partition specified in the PARTITION parameter was not found.</td>
</tr>
<tr>
<td>00000003</td>
<td>The partition specified in the PARTITION parameter is not a GUEST partition (that is, the TYPE parameter for the partition specified in the PARTITION parameter does not have a value of *GUEST).</td>
</tr>
<tr>
<td>00000004</td>
<td>There is already an NWSD in the i5/OS partition that is active and using the partition specified in the PARTITION parameter of the NWSD.</td>
</tr>
<tr>
<td>00000005</td>
<td>The partition specified in the PARTITION parameter of the NWSD is powered on (perhaps through the LPAR configuration interface or from another i5/OS partition.)</td>
</tr>
<tr>
<td>00000006</td>
<td>The partition is set to start from a stream file (stmf) and that did not work. You should note that the user performing the vary on operation needs read access to the IPL STMF parameter.</td>
</tr>
<tr>
<td>00000007</td>
<td>The NWSD is set to start from a network-storage space (NWSSTG), but the kernel could not find the NWSSTG. Some common reasons are that the storage space does not have a disk partition that is formatted as type 0x41 or is marked as startable.</td>
</tr>
<tr>
<td>00000008</td>
<td>The partition would not start. There are a variety of reasons why the partition will not start. You should look at the information for this partition and start reviewing the SRCs.</td>
</tr>
<tr>
<td>00000009</td>
<td>The partition identified as the logical partition is not configured. You should specify who has power controlling access to the partition.</td>
</tr>
<tr>
<td>00000010</td>
<td>A network server storage space linked to this network server is damaged. Contact your next level of support.</td>
</tr>
<tr>
<td>00000011</td>
<td>Contact your next level of support to find a proper solution to the problem.</td>
</tr>
<tr>
<td>00000012</td>
<td>The resource name you selected in the RSRCNAME parameter is not valid. Use the Work with Hardware Resources (WRKHDWRSC) command with the TYPE(*CMN) parameter to help determine the resource name.</td>
</tr>
<tr>
<td>00000013</td>
<td>The resource you selected in the RSRCNAME command exists, but is not in the partition you specified. Use the WRKHDWRSC command with the TYPE(*CMN) parameter to help determine a resource name in the partition you specified.</td>
</tr>
<tr>
<td>00000014</td>
<td>Unable to determine partition for resource name. Either specify a partition directly or update the resource definition at the HMC to indicate the client partition.</td>
</tr>
<tr>
<td>00000015</td>
<td>Unknown error occurred. Contact your next level of support.</td>
</tr>
</tbody>
</table>

**Troubleshooting errors for Linux partitions using i5/OS virtual I/O resources:**

In many cases, you can troubleshoot and resolve errors specific to Linux logical partitions using i5/OS virtual I/O resources without having to call service and support.

**Debugging network server description error messages:**

This topic provides a list of network server description (NWSD) error codes and explanations to help you debug NWSD error messages for Linux logical partitions.

You could encounter error messages when you try to vary on a Linux logical partition. These error messages will appear if you provide information when you create your network server description (NWSD) that does not apply to a logical partition running on the server. All error messages related to the NWSD should appear in QSYSOPR indicating a description of the problem and a resolution to the...
### Table 23. NWSD error messages

<table>
<thead>
<tr>
<th>Reason codes</th>
<th>Code explanations</th>
</tr>
</thead>
<tbody>
<tr>
<td>00000001</td>
<td>*NWSSTG was specified as the IPL source, but no storage space was found.</td>
</tr>
<tr>
<td>00000002</td>
<td>The partition specified in the PARTITION parameter was not found. Use the CHGNWSD i5/OS Control Language (CL) command to compare the partition name in the NWSD with the partition name created on the Hardware Management Console (HMC), and change the partition name as necessary.</td>
</tr>
<tr>
<td>00000003</td>
<td>The partition specified in the PARTITION parameter is not a GUEST partition (that is, the TYPE parameter for the partition specified in the PARTITION parameter does not have a value of *GUEST).</td>
</tr>
<tr>
<td>00000004</td>
<td>There is already an NWSD in the i5/OS partition that is active and using the partition specified in the PARTITION parameter of the NWSD.</td>
</tr>
<tr>
<td>00000005</td>
<td>The partition specified in the PARTITION parameter of the NWSD is powered on (perhaps through the LPAR configuration interface or from another i5/OS partition.)</td>
</tr>
<tr>
<td>00000006</td>
<td>The partition is set to start from a stream file (stmf) and that did not work. You should note that the user performing the vary on operation needs read access to the IPL STMF parameter.</td>
</tr>
<tr>
<td>00000007</td>
<td>The NWSD is set to start from a network-storage space (NWSSTG), but the kernel could not found the NWSSTG. Some common reasons are that the storage space does not have a disk partition that is formatted as type 0x41 or is marked as startable.</td>
</tr>
<tr>
<td>00000008</td>
<td>The partition would not start. There are a variety of reasons why the partition will not start. You should look at the information for this partition and start reviewing the SRCs.</td>
</tr>
<tr>
<td>00000009</td>
<td>The partition identified as the logical partition is not configured. You should specify who has power controlling access to the partition.</td>
</tr>
<tr>
<td>00000010</td>
<td>A network server storage space linked to this network server is damaged. Contact your next level of support.</td>
</tr>
<tr>
<td>00000011</td>
<td>Contact your next level of support to find a proper solution to the problem.</td>
</tr>
<tr>
<td>00000012</td>
<td>The resource name you selected in the RSRCNAME parameter is not valid. Use the Work with Hardware Resources (WRKHDWRSC) command with the TYPE(*CMN) parameter to help determine the resource name.</td>
</tr>
<tr>
<td>00000013</td>
<td>The resource you selected in the RSRCNAME command exists, but is not in the partition you specified. Use the WRKHDWRSC command with the TYPE(*CMN) parameter to help determine a resource name in the partition you specified.</td>
</tr>
<tr>
<td>00000014</td>
<td>Unable to determine partition for resource name. Either specify a partition directly or update the resource definition at the HMC to indicate the client partition.</td>
</tr>
<tr>
<td>00000015</td>
<td>Unknown error occurred. Contact your next level of support.</td>
</tr>
</tbody>
</table>

**Troubleshooting Linux virtual tape errors:**

You can troubleshoot and recover from many common Linux virtual tape errors without having to call service and support.

If errors occur while you access Linux virtual tape, examine the file `/proc/iSeries/viotape`. It describes the mapping between i5/OS device names and Linux device names and records the last error for each tape device.
Table 24. Common errors and recovery scenarios for troubleshooting Linux virtual tape

<table>
<thead>
<tr>
<th>Error</th>
<th>Recovery scenario</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device unavailable</td>
<td>Make sure the device is varied off in the i5/OS logical partition.</td>
</tr>
<tr>
<td>Not ready</td>
<td>Retry the operation. If the operation still fails with the same description in /proc/iSeries/viotape, verify that the correct medium is in the tape drive.</td>
</tr>
<tr>
<td>Load failure or cleaning cartridge found</td>
<td>Verify that the correct medium is in the tape drive.</td>
</tr>
<tr>
<td>Data check or Equipment check</td>
<td>Verify that you are using a supported block size to read or write the tape. All known IBM-supported tape devices can use a block size of 20 KB (supplied by the -b 40 argument to tar).</td>
</tr>
<tr>
<td>Internal error</td>
<td>Contact your service representative.</td>
</tr>
</tbody>
</table>

Situations requiring the assistance of an authorized service provider:

Some i5/OS troubleshooting tasks on the server require the assistance of an authorized service provider. These tasks are not common and are only performed if the authorized service provider deems it necessary.

If you need to perform any of these tasks on your server, consult the Support for iSeries Web site for information on iSeries support.

Related information

Support for iSeries Web site

Main storage dumps on i5/OS logical partitions:

When the system has a failure, it might create a main storage dump. A main storage dump copies the contents of the server’s memory to disk. It is an important tool for problem analysis.

When your system performs a main storage dump, contact service and support.

On a system with logical partitions, there are two types of failures that can cause main storage dumps: server failure and partition failure.

Failures caused by server processing hardware or server firmware might cause the entire server to fail. Software failures in a logical partition cause only that logical partition to fail. A server failure may cause a platform system dump. A logical partition failure may cause a main storage dump only on that logical partition.

You can also force a main storage dump on a partition or managed system when you are directed to do so by an authorized service provider.

For more information about main storage dumps and how to collect system data for analysis, see Performing dumps.

Related information

Performing dumps

Using remote service with logical partitions:
You can use the Hardware Management Console (HMC) to enable remote services with logical partitions. Remote service is a method that an authorized service provider can use to access your managed system through a modem.

**Attention:** Use this procedure only when directed to do so by service and support, and ensure that remote service is deactivated when you authorized service provider is finished with it. It is a security risk to leave remote service enabled when not in use. Someone could access your server without your knowledge.

The logical partition that is using remote service must have an electronic customer support communications IOP with a modem. The IOP needs to be tagged as the electronic customer support resource for the partition. If the communications IOP is on a shared bus and is used by another partition, switch the IOP to the partition that needs to use the modem. If this IOP is also attached to Operations Console, the console may be unavailable until the IOP is switched back to the original partition.

1. Create user ID.
2. Service Applications > Remote Support > Customize Inbound Connectivity Settings

**Shutting down a power domain with logical partitions:**

You can use the Hardware Management Console (HMC) to power off, repair, and power on the appropriate power domain when a disk unit I/O processor (IOP) or disk unit I/O adapter (IOA) fails. This allows you to replace the IOP or IOA without restarting the logical partition or managed system.

**Attention:** Use this procedure only when directed to do so by service and support. Incorrect use of this function can cause loss of data. It can also cause failures that may be incorrectly diagnosed as expensive hardware failures.

When a disk unit IOP or IOA fails, communication with the disk units (which is controlled by the) IOP or IOA is lost resulting in a disk unit attention SRC and possibly partial or complete loss of system responsiveness.

**Resetting a disk unit IOP with i5/OS logical partitions:**

You can use the Hardware Management Console (HMC) to reset a disk unit I/O processor (IOP). This function should only be used to start an IOP dump to reset the IOP or to reload IOP. This function becomes enabled when certain disk unit reference codes appear and the associated IOP supports a reset or reload function.

**Attention:** Use this procedure only when directed to do so by service and support. Incorrect use of this function can cause loss of data. It can also cause failures that may be incorrectly diagnosed as expensive hardware failures.

**Scenarios: Logical partitions**

One of the best ways to learn about logical partitions is to see examples illustrating how many of the applications and functions can be used in a sample business environment. Use these scenarios to learn about how you can use logical partitions in your business.

**Scenario: Creating a logical partition using version 7 or later of the HMC**

You can create a logical partition that acts as a virtual server on your managed system using version 7 or later of the HMC. When you create the logical partition, you specify the resources that the logical partition uses in a partition profile.
Situation

As the system administrator of a medium-sized technology company, you are responsible for configuring and managing the server that your company just purchased. Your server has arrived and you are ready to start partitioning your model.

Objectives

The objective of this scenario is to create a logical partition and partition profile on a new server.

Prerequisites and assumptions

This scenario assumes that the following prerequisite steps have been completed and are operational prior to beginning the configuration steps:

1. The Hardware Management Console (HMC) was set up and version 7 or later of the HMC software was installed.
   - The HMC was cabled. For more information about cabling the HMC, see Cabling the HMC.
   - You completed the planning process and you understood how you wanted to configure your HMC. For more information about configuring your HMC, see Gathering required configuration settings.
   - You used the Guided Setup wizard or the HMC configuration checklist to set up the HMC. For more information about the Guided Setup wizard, see Configuring the HMC using the Guided Setup wizard. For more information about the HMC configuration checklist, see Configuring the HMC using the HMC configuration checklist.
2. You read and understand the HMC concepts. For more information about HMC concepts, see Concepts for partitioning the server.
3. You completed the tasks recommended for logical partition planning. For more information about logical partition planning, see Planning for logical partitions.
4. You removed the system from the manufacturing default configuration and moved the physical hardware to support a partitioned configuration. For more information about how to prepare your system for partitioning, see Partitioning a new or nonpartitioned managed system using version 7 or later of the HMC.
5. You logged into the HMC with one of the following user roles:
   - Super administrator
   - Operator
   For more information about user roles, see Tasks and roles in the Operations Guide for the Hardware Management Console and its Managed Systems.

Configuration steps

Ensure that all the prerequisites for this scenario have been completed prior to completing these tasks.

To create a new logical partition on your server using the HMC, follow these steps:

1. In the navigation pane, open Systems Management and click Servers.
2. In the contents pane, select the managed system, click the Tasks button, and choose Configuration → Create Logical Partitions.
3. Follow the steps in the Create Logical Partition wizard to create a logical partition and a partition profile.

Scenario: Using partition profiles with version 7 or later of the HMC

As you will see, partition profiles allow you to change the hardware configuration of a logical partition.
Situation

You are the system administrator for a business recovery service center. You use your server primarily to test disaster-recovery strategies for your clients. Each of your clients has a different system configuration. This means that, each time a client comes into the office, you must change the system configuration of your managed system.

On each logical partition on your server, you create one profile for each client that uses the logical partition. When a client returns to the business recovery service center, you can reconfigure the managed system for that client simply by activating the partition profiles for that client.

You have just finished testing for Client 1. You must now reconfigure the server for Client 2, who comes into the office tomorrow.

Note: This is one example of how to change your system configuration. Depending on your operating system, business needs, and resource allocation, you could resolve this situation by dynamically moving resources.

Objectives

The objective of this scenario is to change the configuration of your managed system by using partition profiles.

Details

Your managed system has three logical partitions. The managed system has eight processors and 12 GB of memory. Each logical partition has one or two partition profiles. The following table illustrates how the logical partitions and partition profiles are set up.

<table>
<thead>
<tr>
<th>Logical partition ID</th>
<th>Name of logical partition</th>
<th>Name of partition profile</th>
<th>Processor resources</th>
<th>Memory resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partition 1</td>
<td>Test 1</td>
<td>Profile 1: Client 1</td>
<td>5 dedicated processors</td>
<td>8 GB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Profile 2: Client 2</td>
<td>7 dedicated processors</td>
<td>10 GB</td>
</tr>
<tr>
<td>Partition 2</td>
<td>Test 2</td>
<td>Profile 1: Client 1</td>
<td>2 dedicated processors</td>
<td>3 GB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Profile 2: Client 2</td>
<td>1 dedicated processor</td>
<td>2 GB</td>
</tr>
<tr>
<td>Partition 3</td>
<td>Test 3</td>
<td>Profile 1: Client 1</td>
<td>1 dedicated processor</td>
<td>1 GB</td>
</tr>
</tbody>
</table>

Prerequisites and assumptions

This scenario assumes that the following prerequisite steps have been completed prior to beginning the configuration steps:
1. The Hardware Management Console (HMC) was set up and version 7 or later of the HMC software was installed.
   • The HMC was cabled. For more information about cabling the HMC, see Cabling the HMC.
   • You completed the planning process and you understood how you wanted to configure your HMC. For more information about configuring your HMC, see Gathering required configuration settings.
   • You used the Guided Setup wizard or the HMC configuration checklist to set up the HMC. For more information about the Guided Setup wizard, see Configuring the HMC using the Guided Setup wizard. For more information about the HMC configuration checklist, see Configuring the HMC using the HMC configuration checklist.
2. You read and understand the HMC concepts. For more information about HMC concepts, see Concepts for partitioning the server.
3. You completed the tasks recommended for logical partition planning.
4. You moved and assigned the physical hardware according to the System Planning Tool (SPT) output. For more information about the SPT, see System Planning Tool.
5. You logged in to the HMC with one of the following user roles:
   - Super administrator
   - Service representative
   - Product engineer
6. You created the logical partitions and partition profiles.
7. You activated the partition profiles for Client 1.

The following table lists the partition profiles that are currently active for each logical partition on the managed system.

<table>
<thead>
<tr>
<th>Logical partition ID</th>
<th>Name of logical partition</th>
<th>Name of partition profile</th>
<th>Processor resources</th>
<th>Memory resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partition 1</td>
<td>Test 1</td>
<td>Profile 1: Client 1</td>
<td>5 dedicated processors</td>
<td>8 GB</td>
</tr>
<tr>
<td>Partition 2</td>
<td>Test 2</td>
<td>Profile 1: Client 1</td>
<td>2 dedicated processors</td>
<td>3 GB</td>
</tr>
<tr>
<td>Partition 3</td>
<td>Test 3</td>
<td>Profile 1: Client 1</td>
<td>1 dedicated processor</td>
<td>1 GB</td>
</tr>
</tbody>
</table>

**Configuration steps**

To change the configuration of your managed system so that it is ready for Client 2, you must first shut down the logical partitions by using usual operating system procedures.

After shutting down the logical partitions, you can activate the partition profiles for Client 2. To do this, complete the following steps on your HMC:
1. In the navigation pane, open **Systems Management**, open **Servers**, and click the system on which the Test 1 logical partition is located.
2. In the contents pane, select the Test 1 logical partition, click the **Tasks** button, and choose **Operations → Activate**.
3. Select the Profile 2 partition profile and click **OK**.
4. In the contents pane, select the Test 2 logical partition, click the **Tasks** button, and choose **Operations → Activate**.
5. Select the Profile 2 partition profile and click **OK**.

After activating the partition profile, the managed system is configured according to the needs of Client 2. The following table lists the partition profiles that are currently active for each logical partition on the managed system.

<table>
<thead>
<tr>
<th>Logical partition ID</th>
<th>Name of logical partition</th>
<th>Name of partition profile</th>
<th>Processor resources</th>
<th>Memory resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partition 1</td>
<td>Test 1</td>
<td>Profile 2: Client 2</td>
<td>7 dedicated processors</td>
<td>10 GB</td>
</tr>
<tr>
<td>Partition 2</td>
<td>Test 2</td>
<td>Profile 2: Client 2</td>
<td>1 dedicated processor</td>
<td>2 GB</td>
</tr>
</tbody>
</table>
Scenario: Using system profiles with version 7 or later of the HMC

As you will see, system profiles allow you to change the hardware configuration of an entire managed system quickly and easily.

Situation

You are the system administrator for a business recovery service center. You use your server primarily to test disaster-recovery strategies for your clients. Each of your clients has a different system configuration. This means that, each time a client comes in, you must change the system configuration of your managed system.

You decide to create and use system profiles to change the system configuration of your managed system. First, on each logical partition on your server, you create a partition profile for each client that uses the logical partition. Then, you create a system profile for each client. Each system profile contains the partition profiles that you want to activate for the client. When a client returns to the business recovery service center, you can reconfigure the managed system for that client simply by activating the system profile for that client.

You have just finished testing for Client 1. You must now reconfigure the managed system for Client 2, who comes in tomorrow.

Note: This is one example of how to change your system configuration. Depending on your operating system, business needs, and resource allocation, you could resolve this situation by dynamically moving resources.

Objectives

The objective of this scenario is to change the configuration of your managed system by using system profiles.

Details

Your managed system has eight processors and 12 GB of memory. You have created two system profiles on this managed system. Each system profile divides the resources of the managed system between two or three logical partitions.

The following table shows how the system profiles are set up:

<table>
<thead>
<tr>
<th>System Profile ID</th>
<th>Logical partition ID</th>
<th>Name of logical partition</th>
<th>Name of partition profile</th>
<th>Processor resources</th>
<th>Memory resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client 1</td>
<td>Partition 1</td>
<td>Test 1</td>
<td>Profile 1: Client 1</td>
<td>5 dedicated processors</td>
<td>8 GB</td>
</tr>
<tr>
<td></td>
<td>Partition 2</td>
<td>Test 2</td>
<td>Profile 1: Client 1</td>
<td>2 dedicated processors</td>
<td>3 GB</td>
</tr>
<tr>
<td></td>
<td>Partition 3</td>
<td>Test 3</td>
<td>Profile 1: Client 1</td>
<td>1 dedicated processor</td>
<td>1 GB</td>
</tr>
<tr>
<td>Client 2</td>
<td>Partition 1</td>
<td>Test 1</td>
<td>Profile 2: Client 2</td>
<td>7 dedicated processors</td>
<td>10 GB</td>
</tr>
<tr>
<td></td>
<td>Partition 2</td>
<td>Test 2</td>
<td>Profile 2: Client 2</td>
<td>1 dedicated processor</td>
<td>2 GB</td>
</tr>
</tbody>
</table>
Prerequisites and assumptions

This scenario assumes that the following prerequisite steps have been completed prior to beginning the configuration steps:

1. The Hardware Management Console (HMC) was set up.
   - The HMC was cabled.
   - You completed the planning process and you understand how you want to configure your HMC.
   - You used the Guided Setup wizard or the HMC configuration checklist to set up the HMC.
2. You understand the concepts for partitioning the server.
3. You completed the tasks recommended for logical partition planning.
4. You moved and assigned the physical hardware according to the System Planning Tool (SPT) output. For more information about the SPT, see System Planning Tool.
5. You logged in to the HMC with one of the following user roles:
   - Super administrator
   - Service representative
   - Product engineer
6. You created the logical partitions, partition profiles, and system profiles described.
7. You activated the system profile for Client 1.

The following table lists the system profile that is currently active on the managed system.

<table>
<thead>
<tr>
<th>System Profile</th>
<th>Logical partition ID</th>
<th>Name of logical partition</th>
<th>Name of partition profile</th>
<th>Processor resources</th>
<th>Memory resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client 1</td>
<td>Partition 1</td>
<td>Test 1</td>
<td>Profile 1: Client 1</td>
<td>5 dedicated processors</td>
<td>8 GB</td>
</tr>
<tr>
<td></td>
<td>Partition 2</td>
<td>Test 2</td>
<td>Profile 1: Client 1</td>
<td>2 dedicated processors</td>
<td>3 GB</td>
</tr>
<tr>
<td></td>
<td>Partition 3</td>
<td>Test 3</td>
<td>Profile 1: Client 1</td>
<td>1 dedicated processor</td>
<td>1 GB</td>
</tr>
</tbody>
</table>

Configuration steps

To change the configuration of your managed system so that it is ready for Client 2, you must first shut down the logical partitions by using usual operating system procedures.

After shutting down the logical partitions, you can activate the system profile for Client 2. To do this, complete the following steps on your HMC:

1. In the navigation pane, open Systems Management and click Servers.
2. In the contents pane, select the managed system, click the Tasks button, and choose Configuration → Manage System Profiles.
3. Select the Client 2 system profile and click Activate.
4. Select the desired activation settings for the system profile and click Continue.

After activating the system profile, the managed system is configured according to the needs of Client 2. The following table lists the system profile that is currently active on the managed system.
### System Profile

<table>
<thead>
<tr>
<th>Logical partition ID</th>
<th>Name logical partition</th>
<th>Name of partition profile</th>
<th>Processor resources</th>
<th>Memory resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client 1</td>
<td>Partition 1</td>
<td>Test 1</td>
<td>Profile 2: Client 2</td>
<td>7 dedicated processors</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Partition 2</td>
<td>Test 2</td>
<td>Profile 2: Client 2</td>
<td>1 dedicated processor</td>
</tr>
</tbody>
</table>

### Scenario: Dynamically moving processors and memory resources using version 7 or later of the HMC

You can use dynamic logical partitioning to move processor and memory resources between logical partitions. This allows you to maximize resource utilization on your managed system by moving resources to wherever the resources are needed.

### Situation

You are the system administrator for a business recovery service center with IBM Systems hardware. You use IBM Systems hardware primarily to test disaster recovery strategies for your clients. Each of your clients has a different system configuration. This means that, each time a client comes in, you must change the system configuration of your managed system.

To change the system configuration of your managed system, you decide to use dynamic logical partitioning. Whenever you need to move resources from one logical partition to another, you move the resources directly between the logical partitions without shutting down the logical partitions.

You have just finished testing for Client 1. You must now reconfigure the logical partitions for Client 2, who comes in tomorrow.

**Note:** This is one example of how to change your system configuration. Depending on your operating system, business needs, and resource allocation, you could resolve this situation using partition profiles or system profiles.

### Objectives

The objective of this scenario is to change the configuration of the logical partitions by dynamically moving resources.

### Details

Your managed system has two logical partitions. It has eight processors and 12 GB of memory. The following table shows the system configuration required for client 1.

<table>
<thead>
<tr>
<th>Client</th>
<th>Logical partition ID</th>
<th>Name of logical partition</th>
<th>Processor resources</th>
<th>Memory resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client 1</td>
<td>Partition 1</td>
<td>Test 1</td>
<td>5 dedicated processors</td>
<td>8 GB</td>
</tr>
<tr>
<td></td>
<td>Partition 2</td>
<td>Test 2</td>
<td>3 dedicated processors</td>
<td>4 GB</td>
</tr>
</tbody>
</table>

The following table shows the system configuration required for client 2.
### Prerequisites and assumptions

This scenario assumes that the following prerequisite steps have been completed and are operational prior to beginning the configuration steps:

1. The Hardware Management Console (HMC) was set up.
   - The HMC was cabled. For more information about cabling the HMC, see [Cabling the HMC](#).
   - You completed the planning process and you understood how you wanted to configure your HMC. For more information about configuring your HMC, see [Gathering required configuration settings](#).
   - You used the Guided Setup wizard or the HMC configuration checklist to set up the HMC. For more information about the Guided Setup wizard, see [Configuring the HMC using the Guided Setup wizard](#). For more information about the HMC configuration checklist, see [Configuring the HMC using the HMC configuration checklist](#).

2. You read and understand the HMC concepts. For more information about HMC concepts, see [Concepts for partitioning the server](#).

3. You completed the tasks recommended for logical partition planning.

4. You removed the system from the manufacturing default configuration and moved the physical hardware to support a partitioned configuration. For more information about how to prepare your system for partitioning, see [Partitioning a new or nonpartitioned managed system using the HMC](#).

5. You logged in to the HMC with one of the following user roles:
   - Super administrator
   - Service representative
   - Product engineer
   
   For more information about user roles, see [Tasks and roles in the Operations Guide for the Hardware Management Console and its Managed Systems](#).

6. You created the logical partitions and partition profiles.

7. The managed system is configured for Client 1.

The following table displays the current configuration of each logical partition on the managed system.

<table>
<thead>
<tr>
<th>Logical partition ID</th>
<th>Name of logical partition</th>
<th>Name of partition profile</th>
<th>Processor resources</th>
<th>Memory resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partition 1</td>
<td>Test 1</td>
<td>Profile 1</td>
<td>5 dedicated processors</td>
<td>8 GB</td>
</tr>
<tr>
<td>Partition 2</td>
<td>Test 2</td>
<td>Profile 1</td>
<td>2 dedicated processors</td>
<td>4 GB</td>
</tr>
</tbody>
</table>

### Configuration steps

To change the configuration of your managed system so that it is ready for Client 2, you must complete the following:

- Move two dedicated processors from the logical partition Test 2 to the logical partition Test 1.
- Move 2 GB of memory from the logical partition Test 2 to the logical partition Test 1.
To move two dedicated processors from one logical partition to another, complete the following steps on
your HMC.

1. In the navigation pane of the HMC, open **Systems Management**, open **Servers**, and click the
   managed system on which the Test2 logical partition is located.
2. In the contents pane, select the Test2 logical partition, click the **Tasks** button, and select **Dynamic
   Logical Partitioning → Processor → Move**.
3. Specify two processors in the **To move** column, select the Test 1 logical partition in **Select Destination
   Partition**, and click **OK**.

To move two memory units from one logical partition to another, complete the following steps on your
HMC:

1. In the contents pane, select the Test2 logical partition, click the **Tasks** button, and select **Dynamic
   Logical Partitioning → Memory → Move**.
2. Specify 2 GB in the **Memory To Move** row, select the Test 1 logical partition in **Select Destination
   Partition**, and click **OK**.

When this is completed, the managed system is configured according to the needs of Client 2. The
following table displays the current configuration of each logical partition on the managed system.

<table>
<thead>
<tr>
<th>Logical partition ID</th>
<th>Name of logical partition</th>
<th>Name of partition profile</th>
<th>Processor resources</th>
<th>Memory resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partition 1</td>
<td>Test 1</td>
<td>Profile 1</td>
<td>7 dedicated processors</td>
<td>10 GB</td>
</tr>
<tr>
<td>Partition 2</td>
<td>Test 2</td>
<td>Profile 1</td>
<td>1 dedicated processor</td>
<td>2 GB</td>
</tr>
</tbody>
</table>

**Scenario: Dynamically moving desired I/O devices using version 7 or later of the HMC**

You can move infrequently used I/O devices such as optical disc drives dynamically from one logical
partition to another using version 7 or later of the HMC. This allows you to share the single I/O device
among many logical partitions.

**Situation**

You are the system administrator for a business recovery service center. You use your managed system to
test disaster recovery strategies for your clients. The managed system has only one CD drive and one
tape drive, which are to be shared among all the logical partitions in the managed system.

The CD drive and tape drive can be used by only one logical partition at a time. When you are
recovering a managed system with two logical partitions, you must move the CD drive and tape drive
between the two logical partitions.

You have just finished using the CD drive and tape drive to recover logical partition Test 1. You now
need to move the CD drive and tape drive to logical partition Test 2 so that you can begin recovery
procedures for that logical partition.

**Note:** This is one example of how to change your system configuration. Depending on your operating
system, business needs, and resource allocation, you could resolve this situation using partition profiles.

**Objectives**

The objective of this scenario is to move I/O devices from one logical partition to another by dynamically
moving desired I/O devices.
Prerequisites and assumptions

This scenario assumes that the following prerequisite steps have been completed and are operational prior to beginning the configuration steps:

1. The Hardware Management Console (HMC) was set up.
   - The HMC was cabled. For more information about cabling the HMC, see Cabling the HMC.
   - You completed the planning process and you understood how you wanted to configure your HMC. For more information about configuring your HMC, see Gathering required configuration settings.
   - You used the Guided Setup wizard or the HMC configuration checklist to set up the HMC. For more information about the Guided Setup wizard, see Configuring the HMC using the Guided Setup wizard. For more information about the HMC configuration checklist, see Configuring the HMC using the HMC configuration checklist.
2. You read and understand the HMC concepts. For more information about HMC concepts, see Concepts for partitioning the server.
3. You completed the tasks recommended for logical partition planning. For more information about logical partition planning, see Planning for logical partitions.
4. You removed the system from the manufacturing default configuration and moved the physical hardware to support a partitioned configuration. For more information about how to prepare your system for partitioning, see Partitioning a new or nonpartitioned managed system using the HMC.
5. You logged in to the HMC with one of the following user roles:
   - Super administrator
   - Service representative
   - Product engineer
   For more information about user roles, see Tasks and roles in the Operations Guide for the Hardware Management Console and its Managed Systems.
6. You created the logical partitions and partition profiles.
7. The CD drive and tape drive are currently selected as desired I/O resources for both logical partition Test 1 and logical partition Test 2.
8. The CD drive and tape drive are varied off.

Configuration steps

To move the CD drive and tape drive from one logical partition to another, complete the following steps on your HMC.

1. In the navigation pane of the HMC, open Systems Management, open Servers, and click the managed system on which the Test 1 logical partition is located.
2. In the contents pane, select the Test 1 logical partition, click the Tasks button, and select Dynamic Logical Partitioning → Physical Adapter → Move.
3. Select the CD drive and the tape drive, select the Test 2 logical partition in the Move To area, and click OK.

When this is completed, the CD drive and tape drive belong to the Test 2 logical partition. You can now begin recovery procedures for the Test 2 logical partition using the CD drive and tape drive.

Scenario: Capacity on Demand for Linux

Learn the steps of planning, ordering, and using Capacity on Demand for Linux logical partitions on IBM Systems and eServer hardware.

Note: Capacity on Demand is not available on all hardware models.
Capacity on Demand allows customers to activate inactive processors as their workload requires. The following scenario walks through the steps of planning for, ordering, and using this feature.

**Situation**

A server is operating with eight active processors and four inactive processors. As the server workload grows, the available processor resource utilization consistently approaches or exceeds 70% of the available capacity. Anticipating the need for additional resources, the system administrator decides to consider activating some of the inactive processors.

**Objectives**

The objectives of this scenario are as follows:
- To test the effectiveness of increasing the number of available processors
- To increase the number of processors (if that change will improve performance)

**Capacity on Demand preparation and activation**

The system administrator completes the following steps to prepare and configure the server for Capacity on Demand:

1. Before activating any processors, the system administrator prepares the server for Capacity on Demand. This task involves performing a trend analysis to learn how many additional processors will be required, preparing the server to activate additional processors, and preparing to order the new capacity.

2. To investigate the benefits of activating the additional processors, the system administrator decides to activate the processors for a trial period. The trial period lasts 14 days.

3. After deciding that the performance improvement gained by activating the additional processors warrants purchasing the processors permanently, the system administrator contacts the IBM marketing representative or IBM Business Partner, or visits http://www.ibm.com to place an order for four processor activation features.

4. The IBM marketing representative places the order in the IBM configurator and receives a reminder to send the vital product data (VPD) from the server with the order. The VPD can be faxed to IBM or sent electronically with the Electronic Service Agent™. (The Electronic Service Agent is located on your HMC and is designed to monitor events and to transmit server inventory information to IBM on a periodic, customer-definable timetable.)

5. The system administrator retrieves the activation codes from the Web and activates the permanent capacity. This task involves entering the activation code on the target server and assigning the processors to a logical partition.

The server now has all eight processors available for use.

For more information, refer to Working with Capacity on Demand.

**Partitioning with version 6 or earlier of the HMC**

The *Hardware Management Console (HMC)* is a system that controls managed systems, including the management of logical partitions and use of Capacity Upgrade on Demand. Using service applications, the HMC communicates with managed systems to detect, consolidate, and send information to IBM for analysis.
In this figure, you can see the logical partitions and the server firmware on the IBM Systems and eServer hardware. The server firmware is code that is stored in flash memory on the server. The server firmware directly controls the resource allocations on the server and the communications between logical partitions on the server. The HMC connects with the server firmware and specifies how the server firmware allocates resources on the server.

If you use a single HMC to manage a server, and the HMC malfunctions or becomes disconnected from the server firmware, then the server continues to run, but you will not be able to change the logical partition configuration of the server. If desired, you can attach an additional HMC to act as a backup and to provide a redundant path between the server and IBM service and support.

When you configure logical partitions using the HMC, you must create at least one partition profile for each logical partition. A partition profile is a record on the HMC that specifies a resource configuration and activation state for a logical partition. Each logical partition has a default partition profile. If desired, you can create additional partition profiles with different resource configurations. When you activate a logical partition using the HMC, you choose a partition profile, and the server firmware starts the logical partition according to the specifications contained in the selected partition profile. For more information on partition profiles, see Partition profiles.

To simplify the process of starting an entire system configuration, you can create system profiles. A system profile is a record on the HMC that contains an ordered list of partition profiles. When you activate a system profile from the HMC, the server firmware activates the partition profiles in the system profile in the order in which the partition profiles are listed. For more information on system profiles, see System profiles.

The HMC also provides terminal and 5250 console emulation for the logical partitions on your managed system. You can connect to logical partitions from the HMC itself, or you can set up the HMC so that you can connect to logical partitions remotely through the HMC. HMC terminal and 5250 console emulation provides a dependable connection that you can use if no other terminal or console device is connected or operational. HMC terminal and 5250 console emulation is particularly useful during initial system setup, before you have configured your terminal or console of choice.

Partitioning using the HMC is supported on all IBM System i5 and eServer i5 and IBM System p5 and eServer p5 server models, although some models require you to enter an Advanced POWER Virtualization Technologies enablement code before partitioning the server.

**System plan overview for the HMC**

Learn about system plan concepts and operations, as well as understand the high-level tasks that you can perform with system plans when using the Hardware Management Console (HMC).
A system plan is a specification of the hardware and the logical partitions contained in one or more systems. A system plan is stored in a system-plan file, which has a file suffix of .sysplan. A system-plan file can contain more than one system plan, although multiple plans in a single file are not common. After you create a system plan, you also can also view, delete, and export the system plan.

System plans have a number of valuable uses. For example, you can use system plans to accomplish the following goals:

- You can create a system plan as a means of capturing up-to-date system documentation. The system plan provides a record of the hardware and partition configuration of the managed system at a given time.
- You can use a system plan that you create for system documentation as part of your disaster recovery planning. You can export the system-plan file to an offsite location or to removable media for offsite storage so that you have the system documentation that you need available to you if you must recover a managed system.
- You can use system plans as audit records to track system resources for accounting and accountability purposes by exporting them to a spreadsheet.
- You can use system plans to help you plan new workloads that require additional system and hardware resources. You can use a system plan, along with appropriate capacity planning information, to make decisions about whether your current system can handle a new workload.
- You can deploy this system plan to other systems that this HMC manages that have hardware that is identical to the hardware in the system plan. In this way, you can rapidly configure and use other, similar systems in your business.
- You can export the system plan to another HMC and use it to deploy the system plan to other systems that the target HMC manages that have hardware that is identical to the hardware in the system plan. In this case and the previous case, you can use the system plan to create logical partitions on new managed systems that do not already have logical partitions created on them.

To create logical partitions from a system plan, you must first complete the following tasks:

1. Create the system plan.
2. Import the system plan (when necessary).
3. Deploy the system plan.

After you create a system plan, you also can also view, delete, and export the system plan. The following table provides a complete overview of system plan tasks.
### Table 25. Overview of the tasks for system plans

<table>
<thead>
<tr>
<th>Task</th>
<th>Overview</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a system plan</td>
<td>You can create system plans by using any of the following methods:</td>
</tr>
<tr>
<td></td>
<td>• System Planning Tool (SPT)</td>
</tr>
<tr>
<td></td>
<td>SPT helps you design a system to fit your needs, whether you want to design a logically partitioned system or to design an unpartitioned system. SPT incorporates the function from Workload Estimator (WLE) to help you create an overall system plan. The SPT opens the WLE to help you gather and integrate workload data, and provides advanced users with the option of creating a system plan without the help of additional tools. To help you get started, SPT provides the following options:</td>
</tr>
<tr>
<td></td>
<td>– You can use the sample system plans that SPT provides as a starting point for planning your system</td>
</tr>
<tr>
<td></td>
<td>– You can create a system plan based on existing performance data</td>
</tr>
<tr>
<td></td>
<td>– You can create a system plan based on new or anticipated workloads</td>
</tr>
<tr>
<td></td>
<td>– You can export a system plan as a .cfr file and import it into the marketing configurator (eConfig) tool to use for ordering a system. When you import the .cfr file into the eConfig tool, the tool populates your order with the information from the .cfr file. However, the .cfr file does not contain all the information that the eConfig tool requires and you will need to enter all required information before you can submit your order.</td>
</tr>
<tr>
<td></td>
<td>• Hardware Management Console (HMC) Web user interface</td>
</tr>
<tr>
<td></td>
<td>You can use the HMC to create a system plan based on the configuration of one managed system and can use the HMC to deploy that plan to another managed system. Based on the logical partition configuration in the system plan, the HMC creates logical partitions on the managed system to which it deploys the system plan. Depending on the contents of the system plan, the HMC can install operating environments on the partitions in the plan and, if the plan contains Virtual I/O Server provisioning information for a partition, such as storage assignments, the HMC can make these resource assignments for the partition.</td>
</tr>
<tr>
<td></td>
<td>• HMC command-line interface</td>
</tr>
<tr>
<td></td>
<td>You also can use the <code>mksysplan</code> command to create a system plan. After the system plan is created, you can also use the command-line interface to deploy that plan to a managed system. Based on the logical partition configuration in the system plan, the HMC creates logical partitions on the managed system to which it deploys the system plan.</td>
</tr>
<tr>
<td>Import the system plan</td>
<td>Before you can use a system plan to create logical partitions, the system-plan file must exist on the HMC that manages the managed system to which you want to deploy the system plan. If the system-plan file does not already exist on the HMC, you must import the file into the HMC. You can use the HMC Web user interface to import the file into the HMC from one of the following sources:</td>
</tr>
<tr>
<td></td>
<td>• Upload the system-plan file from the remote console (the computer from which you remotely access the HMC)</td>
</tr>
<tr>
<td></td>
<td>• Copy the system-plan file to media (optical disc or USB drive), insert the media into the HMC, and import the file from the media.</td>
</tr>
<tr>
<td></td>
<td>• Download the system-plan file from a remote FTP site.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can also use the HMC command-line interface to import a system plan.</td>
</tr>
<tr>
<td></td>
<td>After you import the system-plan file into an HMC, you can deploy the system plan within that file to other systems that the HMC manages.</td>
</tr>
<tr>
<td>Task</td>
<td>Overview</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Deploy the system plan</td>
<td>You can choose to deploy a system plan in stages, with some logical partitions being created in one stage, and other logical partitions being created in later stages. You cannot, however, deploy a system plan to a managed system if the managed system already has logical partitions. The managed system must be in the manufacturing default configuration. Also, if you want to deploy a system plan in stages, you need to create a new system plan if you change the resource allocations on the logical partitions on the managed system between stages to avoid validation problems in later stages. When you deploy a system plan by using the HMC Web user interface, the HMC validates the system plan. The managed system on which you deploy a system plan must have hardware that is identical to the hardware in the system plan. The HMC deploys a system plan to a managed system only if the system plan level is supported by the HMC, the format of the system plan is valid, and the hardware and each existing logical partition on the managed system passes validation. If the system plan contains installation information about the Virtual I/O Server, you can use the Deploy System Plan wizard to install the Virtual I/O Server and assign virtual networking and storage resources for the client logical partitions.</td>
</tr>
<tr>
<td>Export the system plan</td>
<td>You can use the HMC Web user interface to export a system-plan file from the HMC to one of the following locations: • Save the system-plan file to the remote console (the computer from which you remotely access the HMC). • Export the system-plan file to media that is mounted to the HMC (such as optical discs or USB drives). • Download the system-plan file to a remote FTP site. <strong>Note:</strong> You can also use the HMC command-line interface to export a system plan.</td>
</tr>
<tr>
<td>View the system plan</td>
<td>You can look at the contents of a system-plan file in the HMC by using the System Plan Viewer that is integrated with the HMC. The System Plan Viewer uses a navigation tree and tables to display the information in the system-plan file. It includes features such as dynamic table-column sorting and displaying EADS boundary lines. You can open a system plan in the System Plan Viewer, either by using the View System Plan task or by clicking the name of a system plan. When you start the System Plan Viewer, you must enter your HMC user ID and password before you can view the system plan.</td>
</tr>
<tr>
<td>Print the system plan</td>
<td>You can use the System Plan Viewer to print a system plan that you have open in the Viewer. You can print all of the system plan or a portion of the system plan, depending on the current view of the system plan. To print the current view of the system plan, click <strong>Print</strong> in the Actions pane of the System Plan Viewer.</td>
</tr>
<tr>
<td>Delete the system plan</td>
<td>You can delete unnecessary system plans from your HMC.</td>
</tr>
</tbody>
</table>

**Optimizing system plan hardware information**

The amount of hardware information that the HMC can capture in a new system plan varies based on the method that the HMC uses to gather the hardware information. Setting up your environment to maximize inventory gathering allows the HMC to capture more complete information about the hardware allocated to the partitions on the managed system. For example, the HMC can capture disk drive and tape drive configuration information for an active partition in the new system plan. However, doing so can cause system plan creation to take several more minutes to complete.

There are two methods that the HMC potentially can use:
- Inventory gathering, which is available for HMC Version 7 Release 3.1.0 and later
- Hardware discovery, which is available for some systems with HMC Version 7 Release 3.2.0 and later
### System plan inventory gathering

The HMC always performs inventory gathering to capture detailed information for hardware that has an assignment to an active partition.

**Note:** Beginning with HMC Version 7.3.2, you can use the hardware discovery process to gather information about hardware assignments for an inactive partition or hardware on a managed system that does not have a partition assignment.

To optimize the amount of and type of hardware information that the inventory-gathering process is able to capture, ensure that you meet the following prerequisites and conditions:

- You must set up Resource Monitoring and Control (RMC) prior to creating a system plan. Using RMC ensures that the inventory-gathering process can capture more detailed hardware information. Without RMC, the inventory-gathering process is not able to detect the types of disk drives installed on a managed system.

**Note:** i5/OS partitions respond to RMC requests from the HMC by means of the Management Server.

- To ensure that Linux systems and partitions can perform inventory gathering, you must load the IBM Installation Toolkit for Linux on POWER, which is available at the [IBM Service and productivity tools](http://www14.software.ibm.com/webapp/set2/sas/f/lopdiags/installtools/home.html) Web site.
- You must have the managed system in the 'Standby' state or you must power on the managed system and activate the logical partitions on the managed system before creating the system plan.

**Note:** It is possible for a partition to have more than one HMC set up to manage it. In this situation, if the partition is an i5/OS partition and you want to use RMC to create a new system plan, ensure that you create the system plan from the primary HMC for the partition because redundant HMCs cannot use RMC.

### System plan hardware discovery

In some cases, the HMC Version 7.3.2 can use hardware discovery, in addition to the inventory-gathering process, to capture hardware information for a new system plan. Using hardware discovery, you can capture information about hardware that does not have a partition assignment, as well as hardware with assignments to inactive partitions.

On a system that can use hardware discovery, the hardware discovery process runs whenever the system is powered on in *hardware discovery* mode. The hardware discovery process writes hardware inventory information to a cache on the system. The hardware inventory cache ensures that a certain amount of hardware information is available on the system when you create a system plan. The HMC can capture the information in the cache for a system plan when partitions are active and the HMC cannot perform fresh hardware discovery on the partition.

**Note:** It is recommended that you power on the system in hardware discovery mode whenever you add or change hardware on the system.

If the managed system is capable of hardware discovery, the Create System Plan page provides an additional option that you can select to capture a broader range of hardware information for the new system plan. This option, called **Retrieve inactive and unallocated hardware resources**, allows you to capture hardware configuration information for the managed system, regardless of the state of the hardware.

When you create a system plan and do not select the **Retrieve inactive and unallocated hardware resources** option, the HMC does not perform hardware discovery. The HMC still performs inventory gathering and retrieves hardware information for any active partitions on the managed server. The
resulting new system plan contains hardware information from the inventory-gathering process, as well as hardware information from the hardware inventory cache on the system.

To use the hardware discovery process, ensure that you meet the following prerequisites and conditions:

**Available processing capability:**
The hardware discovery process requires a minimum .5 processor be available for it to use.

**Memory capability:**
The hardware discovery process requires a minimum of 256 MB of free memory for it to use.

**Partition state:**
To maximize the information that the hardware discovery process can capture, partitions on the managed server must be inactive. If a partition is active, the hardware discovery process cannot capture fresh information from the partition and instead retrieves information about the hardware assigned to the inactive partition from the hardware inventory cache on the managed system.

By setting up your system to optimize the hardware information that you capture in a system plan that you create by using the HMC, you ensure that your system plan provides you with the most valuable information possible. It also ensures that you have the most usable configuration information possible when you convert the system plan for use in the System Planning Tool (SPT). The following table describes the type of hardware information that you can expect to see in a system plan that you convert, based on the system management product that you use to create the plan.

<table>
<thead>
<tr>
<th>Table 26. Type of hardware information available in a system plan that you create in the HMC and convert to use in the SPT</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Partition</strong></td>
</tr>
<tr>
<td>All other operating systems</td>
</tr>
</tbody>
</table>

**System plan validation**

When validating the hardware on the managed system, the HMC compares the following information from the system plan with the hardware available on the managed system:

- Processor and memory amounts, including 5250 commercial processing workload (5250 CPW) where applicable
- Physical I/O adapter placement

The hardware described in the system plan passes validation if it matches the hardware specified by the managed system. The hardware on the managed system can contain resources in addition to those specified in the system plan and still pass validation, but the hardware on the managed system must at least match the hardware specified in the system plan.

For example, a system plan specifies a server with two processors, 8 GB of memory, and a specific placement of physical I/O adapters within the system unit. A server that contains two processors, 16 GB of memory, a matching placement of physical I/O adapters within the system unit, and an expansion unit with additional physical I/O adapters would allow the system to pass validation. A server that contains 4 GB of memory can cause the system to fail validation. A system plan can also fail validation if the system plan specifies one type of physical I/O adapter in a slot but the actual system unit has a different type of physical I/O adapter in that slot. However, if the system plan specifies an empty slot, validation allows any type of physical I/O adapter to be in that slot on the actual system.
The HMC does not validate the disk drives that are attached to physical I/O adapters against the disk drives specified in the system plan. You must ensure that the disk drives installed in the managed system support your desired logical partition configuration. Embedded devices automatically pass hardware validation because they are embedded into the system and cannot be removed.

If any step fails, validation fails for the existing logical partition. Any existing partition found on the managed system must appear in the system plan and must match the system plan as it appears in the managed system. For example, hardware on the managed system must at least match the hardware specified in the system plan. When validating an existing logical partition, the HMC validates the following items for that logical partition:

1. Is there a logical partition in the system plan that has the same partition ID as the existing logical partition specified in the machine default configuration?
2. Does the existing logical partition have partition profiles that match each partition profile specified for the logical partition in the system plan?
3. Do the partition profiles for the existing logical partitions contain the resources specified in the corresponding partition profiles in the system plan?

For example, if the server has an existing logical partition with a partition ID of 1, the HMC examines the logical partition in the system plan that has a partition ID of 1. If this logical partition exists and has a partition profile that is named SUPPORT, the HMC looks at the existing logical partition to see if it also has a partition profile that is named SUPPORT. If so, the HMC verifies that the resources specified in the SUPPORT partition profile in the system plan are contained in the SUPPORT partition profile in the existing logical partition.

When the HMC validates partition profiles, it compares the following resources in the partition profiles:

- Processor and memory amounts, including 5250 commercial processing workload (5250 CPW) where applicable
- Physical I/O slot assignments

The following examples illustrate how the HMC compares resources in the partition profiles during the validation process to determine whether the system plan is valid for a managed system:

- If the SUPPORT partition profile in the system plan specifies 2 GB of memory and the SUPPORT partition profile for the existing logical partition specifies 3 GB of memory, the amount of memory is valid.
- If the SUPPORT partition profile in the system plan specifies 4 GB of memory and the SUPPORT partition profile for the existing logical partition specifies 3 GB of memory, the amount of memory is not valid.
- If physical I/O slot P1 is assigned to the SUPPORT partition profile in the system plan but not to the SUPPORT partition profile for the existing logical partition, the physical slot assignment is not valid.
- If physical I/O slot P2 is not assigned to the SUPPORT partition profile in the system plan, it does not matter whether slot P2 is assigned to the SUPPORT partition profile for the existing logical partition.

If the system plan contains installation information for the Virtual I/O Server, you can use the Deploy System Plan wizard to install the Virtual I/O Server and to set up virtual networking and storage resources for the client logical partitions of the Virtual I/O Server.

**Note:** The HMC cannot install AIX or Linux or i5/OS operating environments on logical partitions.
Related tasks

“Creating logical partitions using version 6 or earlier of the HMC” on page 222
You can use the Create Logical Partition wizard on the Hardware Management Console (HMC) to create a new logical partition. When you create a logical partition, you also create a partition profile that contains the resource allocations and settings for the new logical partition.

“Creating logical partitions using version 7 or later of the HMC” on page 91
You can use the Create Logical Partition wizard on the Hardware Management Console (HMC) to create a new logical partition. When you create a logical partition, you also create a partition profile that contains the resource allocations and settings for the logical partition.

“Partitioning a new or nonpartitioned IBM System i5 or eServer i5 managed system using version 6 or earlier of the HMC” on page 211
Use this procedure to partition a new or nonpartitioned IBM System i5 or eServer i5 managed system using version 6 or earlier of the Hardware Management Console (HMC). In this procedure, you will validate the hardware on the managed system, create the logical partitions on the managed system, and designate the service partition for the managed system.

“Partitioning a new or nonpartitioned IBM System i5 or eServer i5 managed system using version 7 or later of the HMC” on page 69
Use this procedure to partition a new or nonpartitioned IBM System i5 or eServer i5 managed system using version 7 or later of the Hardware Management Console (HMC). In this procedure, you will validate the hardware on the managed system, create the logical partitions on the managed system, and designate the service partition for the managed system.

“Partitioning a new or nonpartitioned IBM System p5, eServer p5, or IntelliStation POWER 285 managed system using version 6 or earlier of the HMC” on page 217
Use this procedure to partition a new or nonpartitioned IBM System p5, eServer p5, or IntelliStation POWER 285 managed system using the Hardware Management Console (HMC). In this procedure, you will validate the hardware on the managed system and create the logical partitions on the managed system.

“Partitioning a new or nonpartitioned IBM System p5, eServer p5 or IntelliStation POWER 285 managed system using version 7 or later of the HMC” on page 75
Use this procedure to partition a new or nonpartitioned IBM System p5, eServer p5 or IntelliStation POWER 285 managed system using version 7 or later of the Hardware Management Console (HMC). In this procedure, you will validate the hardware on the managed system and create the logical partitions on the managed system.

“Creating a system plan by using the HMC Version 6” on page 208
You can use the Hardware Management Console (HMC) to create a new system plan based on an existing system configuration, and then deploy that system plan to other managed systems.

“Deleting a system plan by using the HMC Version 6” on page 210
You can remove a system plan from your Hardware Management Console (HMC).

“Deploying a system plan by using the HMC Version 6” on page 204
You can use the Hardware Management Console (HMC) to deploy all or part of a system plan to a managed system.

“Exporting a system-plan file by using the HMC Version 6” on page 206
You can export a system-plan file from an Hardware Management Console (HMC) to various types of media or to a remote site for use on another HMC.

“Importing a system-plan file by using the HMC Version 6”
You can import a system-plan file into a Hardware Management Console (HMC) from various types of media, a remote FTP site, or the computer from which you remotely access the HMC. You can then deploy the imported system plan to a system that the HMC manages.

“Viewing a system plan by using the HMC Version 6” on page 209
You can view a system plan from the System Plan Viewer on the Hardware Management Console (HMC).

Importing a system-plan file by using the HMC Version 6
You can import a system-plan file into a Hardware Management Console (HMC) from various types of
media, a remote FTP site, or the computer from which you remotely access the HMC. You can then deploy the imported system plan to a system that the HMC manages.

You can import a system-plan file into the HMC from any of the following locations:
• From various media, such as optical discs or USB drivers, that is mounted on the HMC.
• From a system-plan file from a remote site by using FTP. To use this option, you must fulfill the following requirements:
  – The HMC must have a network connection to the remote site.
  – An FTP server must be active on the remote site.
  – Port 21 must be open on the remote site.

**Note:** You cannot import a system plan that has an identical name to any system plan that is available on the HMC.

To import a system-plan file, you must be a super administrator. For more information about user roles, refer to Tasks and roles.

To import a system-plan file into Version 6 or earlier of the HMC, complete the following steps:
1. If you are importing the system-plan file from media, complete these steps to mount the media on the HMC:
   a. Insert the media into the HMC or connect the media to the HMC.
   b. On your HMC desktop (outside of any of the open windows), right-click **Terminal → rshterm**. The Restricted shell command line interface opens.
   c. Enter the `mount mountpoint` command, where `mountpoint` is the location of the media. You can typically use `mount /mnt/cdrom` to mount an optical drive or `mount /media/sda1` to mount a USB drive.
   d. Enter the `lsmediadev` command to list the mounted drives on the HMC and verify that the media is mounted and ready to use.
2. In the navigation area of the HMC, select **System Plans**.
3. In the tasks area, select **Import System Plan**. The Import System Plan window opens.
4. Enter the name of the system-plan file into the **System plan file name** field. The name of the system-plan file must end with the `.sysplan` file name suffix and can use alphanumeric characters only.
5. Specify whether you are importing the system-plan file from locally mounted media or from a remote FTP site. Use the following table to complete the appropriate steps for importing the system plan from the selected source location of the file:

<table>
<thead>
<tr>
<th>Source of the system-plan file to import</th>
<th>Complete the following steps:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locally mounted media</td>
<td>1. Select <strong>Import from media</strong>.</td>
</tr>
<tr>
<td></td>
<td>2. Enter the path of the system-plan file location into the <strong>Directory</strong> field.</td>
</tr>
</tbody>
</table>
Source of the system-plan file to import | Complete the following steps:
--- | ---
Remote FTP site | 1. Select *Import from a remote site*.
2. Enter the host name or IP address of the remote FTP site into the *Remote site hostname* field.
3. Enter the user ID to use to access the remote FTP site into the *User id* field.
4. Enter the password to use to access the remote FTP site into the *Password* field.
5. Enter the path of the system-plan file location on the remote FTP site into the *Remote directory* field. If you do not enter a path, the HMC uses the default path specified on the remote FTP site.

6. Click **Import**. If the HMC returns an error, return to step 4 on page 203 and verify that the information you entered on this window is correct.

When you complete the process of importing the system-plan file, you can deploy the system plan in the system-plan file to a system that HMC manages. For more information about how to deploy the system plan, see Deploying a system plan. If you imported the system-plan file from media, you can unmount the media by using the `umount` command in the HMC command line interface.

**Note:** As an alternative to the HMC Web user interface, you can use the `cpysysplan` command from the HMC command line interface to import a system plan.

**Related concepts**

“System plan overview for the HMC” on page 195
Learn about system plan concepts and operations, as well as understand the high-level tasks that you can perform with system plans when using the Hardware Management Console (HMC).

**Related tasks**

“Creating a system plan by using the HMC Version 6” on page 208
You can use the Hardware Management Console (HMC) to create a new system plan based on an existing system configuration, and then deploy that system plan to other managed systems.

“Deleting a system plan by using the HMC Version 6” on page 210
You can remove a system plan from your Hardware Management Console (HMC).

“Deploying a system plan by using the HMC Version 6”
You can use the Hardware Management Console (HMC) to deploy all or part of a system plan to a managed system.

“Exporting a system-plan file by using the HMC Version 6” on page 206
You can export a system-plan file from an Hardware Management Console (HMC) to various types of media or to a remote site for use on another HMC.

“Viewing a system plan by using the HMC Version 6” on page 209
You can view a system plan from the System Plan Viewer on the Hardware Management Console (HMC).

**Related information**

Tasks and roles

**Deploying a system plan by using the HMC Version 6**
You can use the Hardware Management Console (HMC) to deploy all or part of a system plan to a managed system.

When you deploy a system plan, the HMC creates logical partitions on the managed system according to the specifications in the system plan.

Before you deploy a system plan, complete the following tasks:
• Ensure that the system-plan file exists on the HMC. If the system-plan file does not exist on the HMC, you must import the system-plan file into the HMC. For more information about importing a system-plan file, see Importing a system-plan file.

• Verify that the physical hardware is connected and reporting to the server. Every server comes with one logical partition with one partition profile. All of the physical hardware resources on the system are automatically assigned to this logical partition so that you can power on the server and verify that the physical hardware is connected and reporting to the server.

• Delete the logical partition that was provided with your server, and delete any other logical partition that is not in the system plan. For instructions, see Deleting a logical partition. The name of the logical partition that was provided with the server is the serial number of the managed system, and the name of the partition profile is default.

• Shut down any logical partitions that you have already deployed to the managed system from the system plan.

• Ensure that you are not performing any other operations on the managed system using this HMC or any other HMC that is attached to the managed system.

• Ensure that you are a super administrator. For more information about user roles, refer to Tasks and roles.

To use the HMC to deploy a system plan on a managed system, complete the following steps:

1. In the navigation area of your HMC, select System Plans.

2. In the contents area, select Manage System Plans.

3. Select the system-plan file that contains the system plan that you want to deploy and click Deploy to start the Deploy System Plan wizard. If you are not certain which system-plan file to choose, you can select a system-plan file and click View to list the contents of a system-plan file in a browser window.

4. Verify that the system-plan file that you want to deploy is displayed and click Next.

5. Optional: If there are multiple system plans within the system-plan file, the wizard prompts you to select the system plan that you want to deploy from that system-plan file. Select the system plan that you want to deploy in the System plan to deploy field and click Next.

6. Select the managed system to which you want to deploy the system plan in Managed system field and click Next. If the system plan does not match the managed system to which you want to deploy the plan, the wizard displays a window that informs you of this. Click OK to continue or Cancel to select a different system plan.

7. Wait for the wizard to validate the managed system and its hardware against the system plan. The validation process can take several minutes.

8. If the validation process completes successfully, click Next. If the validation process does not complete successfully, correct the issues that the error messages describe, click Cancel to exit the wizard, and restart this procedure from the beginning. To help you to correct validation issues, you might want to create a system plan that is based on the current configuration of the managed system. Such a system plan would allow you to compare the system plan that you want to deploy with the current configuration of the managed system. For more information about creating a system plan, see Creating a system plan.

9. Optional: If you do not want to create all of the logical partitions, partition profiles, virtual adapter types, or virtual adapters in the system plan, clear the boxes in the Deploy column beside the logical partitions, partition profiles, virtual adapter types, or virtual adapters that you do not want to create. Virtual serial adapters are required in virtual slots 0 and 1 for each logical partition. You cannot create the logical partition unless you create these virtual serial adapters.

10. Click Next to continue.

11. Review the system deployment step order and click Finish. The HMC creates the specified logical partitions. This process can take several minutes.

After you finish the deployment of the system plan, complete the following tasks:
• Locate the physical disk I/O adapters that belong to each logical partition and verify that the disk drives that are attached to these physical I/O adapters will support your desired configuration for each logical partition.

• Install operating systems and software on the logical partitions. For installation procedures for AIX, i5/OS, and Linux, refer to Installing operating systems. For installation procedures for the Virtual I/O Server, refer to Installing the Virtual I/O Server manually using the HMC version 6.

• Configure the virtual I/O adapters that are assigned to each logical partition within the operating systems so that virtual storage resources can be shared among logical partitions.

Related concepts
“System plan overview for the HMC” on page 195
Learn about system plan concepts and operations, as well as understand the high-level tasks that you can perform with system plans when using the Hardware Management Console (HMC).

Related tasks
“Creating a system plan by using the HMC Version 6” on page 208
You can use the Hardware Management Console (HMC) to create a new system plan based on an existing system configuration, and then deploy that system plan to other managed systems.

“Deleting a system plan by using the HMC Version 6” on page 210
You can remove a system plan from your Hardware Management Console (HMC).

“Deleting a logical partition using version 6 or earlier of the HMC” on page 237
You can use the Hardware Management Console to delete a logical partition and all of the partition profiles associated with the logical partition.

“Exporting a system-plan file by using the HMC Version 6”
You can export a system-plan file from an Hardware Management Console (HMC) to various types of media or to a remote site for use on another HMC.

“Importing a system-plan file by using the HMC Version 6” on page 202
You can import a system-plan file into a Hardware Management Console (HMC) from various types of media, a remote FTP site, or the computer from which you remotely access the HMC. You can then deploy the imported system plan to a system that the HMC manages.

“Viewing a system plan by using the HMC Version 6” on page 209
You can view a system plan from the System Plan Viewer on the Hardware Management Console (HMC).

Related information
Installing operating systems
Installing the Virtual I/O Server
Tasks and roles

Exporting a system-plan file by using the HMC Version 6
You can export a system-plan file from an Hardware Management Console (HMC) to various types of media or to a remote site for use on another HMC.

You can export a system-plan file from the HMC to any of the following locations:
• To media that is mounted on the HMC (such as optical discs or USB drives).
• To a remote site by using FTP. This allows you to import the system-plan file into a different HMC and deploy the system plan to a managed system with identical hardware. To use this option, you must fulfill the following requirements:
  – The HMC must have a network connection to the remote site.
  – An FTP server must be active on the remote site.
  – Port 21 must be open on the remote site.

To export a system-plan file, you must be a super administrator. For more information about user roles, refer to Tasks and roles.
To export a system-plan file that is stored on an HMC, complete the following steps:

1. If you are exporting the system-plan file to media, complete these steps to mount the media on the HMC:
   a. Insert the media into the HMC or connect the media to the HMC.
   b. On your HMC desktop (outside of any of the open windows), right-click **Terminal → rshterm**. The Restricted shell command-line interface opens.
   c. Enter the `mount mountpoint` command, where `mountpoint` is the location at which the media is located. You can typically use `mount /mnt/cdrom` to mount an optical drive or `mount /media/sda1` to mount a USB drive.
   d. Enter the `1smediadev` command to list the mounted drives on the HMC and verify that the media is mounted and ready to use.

2. In the navigation area of the HMC, select **System Plans**.
3. In the contents area, select **Manage System Plans**.
4. Select the system-plan file that you want to export and click **Export**.
5. Select the export destination for the system plan. Use the following table to complete the appropriate steps for exporting the system plan to the selected destination location of the file:

<table>
<thead>
<tr>
<th>Export destination for the system plan</th>
<th>Complete the following steps:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locally mounted media</td>
<td>1. Select Export to media.</td>
</tr>
<tr>
<td></td>
<td>2. Enter the path to which you want to export the system-plan file into the Directory field.</td>
</tr>
<tr>
<td>Remote FTP site</td>
<td>1. Select Export to a remote site.</td>
</tr>
<tr>
<td></td>
<td>2. Enter the host name or IP address of the remote FTP site into the Remote site hostname field.</td>
</tr>
<tr>
<td></td>
<td>3. Enter the user ID to use to access the remote FTP site into the User id field.</td>
</tr>
<tr>
<td></td>
<td>4. Enter the password to use to access the remote FTP site into the Password field.</td>
</tr>
<tr>
<td></td>
<td>5. Enter the path to which you want to export the system-plan file into the Remote directory field. If you do not enter a path, the HMC exports the system-plan file to the default path specified on the remote FTP site.</td>
</tr>
</tbody>
</table>

6. Click **Export**. If the HMC returns an error, verify that the information you entered on this window is correct. If necessary, click **Cancel**, return to step 4, and redo the procedure, ensuring that the information you specify at each step is correct.

If you exported the system-plan file to media, you can unmount the media by using the `umount` command in the HMC command-line interface. You can then import the system-plan file into a different HMC so that you can deploy the system plan to systems that the other HMC manages. For more information about importing the system-plan file into a different HMC, see Importing a system-plan file.

**Note**: As an alternative to the HMC Web user interface, you can use the `cpysysplan` command from the HMC command line interface to export a system plan.
Related concepts
“System plan overview for the HMC” on page 195
Learn about system plan concepts and operations, as well as understand the high-level tasks that you can perform with system plans when using the Hardware Management Console (HMC).

Related tasks
“Creating a system plan by using the HMC Version 6”
You can use the Hardware Management Console (HMC) to create a new system plan based on an existing system configuration, and then deploy that system plan to other managed systems.
“Deleting a system plan by using the HMC Version 6” on page 210
You can remove a system plan from your Hardware Management Console (HMC).
“Deploying a system plan by using the HMC Version 6” on page 204
You can use the Hardware Management Console (HMC) to deploy all or part of a system plan to a managed system.
“Importing a system-plan file by using the HMC Version 6” on page 202
You can import a system-plan file into a Hardware Management Console (HMC) from various types of media, a remote FTP site, or the computer from which you remotely access the HMC. You can then deploy the imported system plan to a system that the HMC manages.
“Viewing a system plan by using the HMC Version 6” on page 209
You can view a system plan from the System Plan Viewer on the Hardware Management Console (HMC).

Related information
Tasks and roles

Creating a system plan by using the HMC Version 6
You can use the Hardware Management Console (HMC) to create a new system plan based on an existing system configuration, and then deploy that system plan to other managed systems.

The HMC can deploy that plan to the managed system. The HMC creates logical partitions based on the logical partition configuration information in the system plan.

To maximize the amount of data that the HMC is able to collect from the system, ensure that you complete the following tasks:
• Ensure that the managed system from which you plan to base the new system plan is powered on.

  Note: You cannot create a system plan if the managed server is in either the power off state or the recovery state.
• Ensure that all the logical partitions on the managed system from which you plan to base the new system plan are activated.

To create a system plan based on an existing system configuration by using the HMC, complete the following steps:
1. From the navigation area, select System Plans.
2. In the contents area, select Manage System Plans. The Manage System Plans window opens.
3. Select the system plan you want to create, and click Create. The Create System Plan window opens.
4. Select the managed system on which you want to base the new system plan.
5. Enter a name and description for the new system plan.
6. Click Create.

Now that you have a new system plan, you can export the system plan, import it onto another managed system, and deploy the system plan to the managed system.

When you deploy the system plan, the HMC creates logical partitions on the target managed system based on the logical partition configuration information in the system plan.
Note: As an alternative to the HMC Web user interface, you can use the mksysplan command on the HMC to create a system plan based upon the configuration of an existing managed system.

Related concepts

“System plan overview for the HMC” on page 195
Learn about system plan concepts and operations, as well as understand the high-level tasks that you can perform with system plans when using the Hardware Management Console (HMC).

Related tasks

“Deleting a system plan by using the HMC Version 6” on page 210
You can remove a system plan from your Hardware Management Console (HMC).

“Deploying a system plan by using the HMC Version 6” on page 204
You can use the Hardware Management Console (HMC) to deploy all or part of a system plan to a managed system.

“Exporting a system-plan file by using the HMC Version 6” on page 206
You can export a system-plan file from an Hardware Management Console (HMC) to various types of media or to a remote site for use on another HMC.

“Importing a system-plan file by using the HMC Version 6” on page 202
You can import a system-plan file into a Hardware Management Console (HMC) from various types of media, a remote FTP site, or the computer from which you remotely access the HMC. You can then deploy the imported system plan to a system that the HMC manages.

“Viewing a system plan by using the HMC Version 6”
You can view a system plan from the System Plan Viewer on the Hardware Management Console (HMC).

Related information

mksysplan Command

Viewing a system plan by using the HMC Version 6
You can view a system plan from the System Plan Viewer on the Hardware Management Console (HMC).

The System Plan Viewer uses a navigation tree and tables to display the information in the system-plan file. The System Plan Viewer is included with the HMC so that it can be accessed from the HMC. However, to access the System Plan Viewer, you must re-enter your user ID and password before you can view the system plan.

To view a system plan from the HMC, complete the following steps:

1. From the navigation area, select System Plans.
2. In the contents area, select Manage System Plans. The Manage System Plans window is displayed.
3. Select the system plan you want to view, and click View. The System Plan Viewer opens in a separate browser window.

Note: You can also open the system plan in the System Plan Viewer by clicking on the name of the system plan.
4. Enter your HMC Username and Password to log in to the System Plan Viewer.
Related concepts

“System plan overview for the HMC” on page 195
Learn about system plan concepts and operations, as well as understand the high-level tasks that you can perform with system plans when using the Hardware Management Console (HMC).

Related tasks

“Creating a system plan by using the HMC Version 6” on page 208
You can use the Hardware Management Console (HMC) to create a new system plan based on an existing system configuration, and then deploy that system plan to other managed systems.

“Deleting a system plan by using the HMC Version 6”
You can remove a system plan from your Hardware Management Console (HMC).

“Deploying a system plan by using the HMC Version 6” on page 204
You can use the Hardware Management Console (HMC) to deploy all or part of a system plan to a managed system.

“Exporting a system-plan file by using the HMC Version 6” on page 206
You can export a system-plan file from an Hardware Management Console (HMC) to various types of media or to a remote site for use on another HMC.

“Importing a system-plan file by using the HMC Version 6” on page 202
You can import a system-plan file into a Hardware Management Console (HMC) from various types of media, a remote FTP site, or the computer from which you remotely access the HMC. You can then deploy the imported system plan to a system that the HMC manages.

Related information

System Planning Tool Web site

Deleting a system plan by using the HMC Version 6
You can remove a system plan from your Hardware Management Console (HMC).

Removing a system plan from the HMC does not undo any partition or hardware configuration changes that occurred if the specified system plan was deployed on a managed system.

To remove a system plan from the HMC, complete the following steps:

1. From the navigation area, select System Plans.
2. In the contents area, select Manage System Plans. The Manage System Plans window opens.
3. Select the system plan that you want to delete, and click Remove.
4. Confirm that the system plan is the one that you want to remove and click Remove System Plan to delete the system plan.
Related concepts

“System plan overview for the HMC” on page 195
Learn about system plan concepts and operations, as well as understand the high-level tasks that you can perform with system plans when using the Hardware Management Console (HMC).

Related tasks

“Creating a system plan by using the HMC Version 6” on page 208
You can use the Hardware Management Console (HMC) to create a new system plan based on an existing system configuration, and then deploy that system plan to other managed systems.

“Deploying a system plan by using the HMC Version 6” on page 204
You can use the Hardware Management Console (HMC) to deploy all or part of a system plan to a managed system.

“Exporting a system-plan file by using the HMC Version 6” on page 206
You can export a system-plan file from an Hardware Management Console (HMC) to various types of media or to a remote site for use on another HMC.

“Importing a system-plan file by using the HMC Version 6” on page 202
You can import a system-plan file into a Hardware Management Console (HMC) from various types of media, a remote FTP site, or the computer from which you remotely access the HMC. You can then deploy the imported system plan to a system that the HMC manages.

“Viewing a system plan by using the HMC Version 6” on page 209
You can view a system plan from the System Plan Viewer on the Hardware Management Console (HMC).

Configuring i5/OS logical partitions using version 6 or earlier of the HMC

The Create Logical Partition wizard on the Hardware Management Console (HMC) guides you through the process of creating logical partitions and partition profiles on your server.

Before you start creating logical partitions, it is essential that you understand the concepts behind this type of system configuration. For more information on the concepts behind logical partitioning, see Concepts for partitioning the server.

Partitioning a new or nonpartitioned server

Use these procedures to partition your new or nonpartitioned server using the Hardware Management Console (HMC).

When you receive your server, the server is in what is known as the manufacturing default configuration. You can install an operating system on the server and use the server in a nonpartitioned configuration. However, if you want to create logical partitions on the managed system, you must develop a partition plan for the server, add hardware to the server or move the hardware within the server according to your partition plan, and validate the hardware on the server. When the server is ready, you can then create the logical partitions using the HMC.

The procedure used to partition a new or nonpartitioned server varies by server type.

Partitioning a new or nonpartitioned IBM System i5 or eServer i5 managed system using version 6 or earlier of the HMC:

Use this procedure to partition a new or nonpartitioned IBM System i5 or eServer i5 managed system using version 6 or earlier of the Hardware Management Console (HMC). In this procedure, you will validate the hardware on the managed system, create the logical partitions on the managed system, and designate the service partition for the managed system.

Use this procedure in the following cases:
• You have just received your managed system and want to partition the managed system immediately.
You have used the managed system as a nonpartitioned server, and now want to partition the managed system.

If you want to create a new logical partition on a managed system that has already been partitioned, then you do not need to perform all of the steps in this procedure. For more information on creating a new logical partition on a managed system that has already been partitioned, see Creating logical partitions using version 6 or earlier of the HMC.

Before you begin, complete the following tasks:
- Use the System Planning Tool (SPT) to ensure that your hardware configuration supports your desired logical partition configuration.
- If necessary, install additional hardware resources on your managed system to support the partition plan specified by the SPT.
- Set up the HMC to manage your logical partition and the managed system. For information on how to set up the HMC, see Setting up the HMC.
- If you have used the managed system prior to partitioning, back up all data on the managed system.

To partition a new or nonpartitioned IBM System i5 or eServer i5 managed system using version 6 or earlier of the HMC, you must be a super administrator or operator on the HMC. For more information about user roles, refer to Tasks and roles.

To partition a new or nonpartitioned IBM System i5 or eServer i5 managed system using version 6 or earlier of the HMC, complete the following steps:

1. Ensure that the managed system is in a state of **Standby** or **Operating**. Complete the following:
   a. In the navigation area of the HMC, open the object with the same name as your HMC, open **Server and Partition**, and select **Server Management**.
   b. Find the state of the managed system as displayed in the contents area under the **State** heading.
   c. If the managed system is in a **Power off** state, right-click the managed system, choose **Power On**, select the power-on mode of **Partition Standby**, click **OK**, and wait until the contents area displays a **Standby** state for the managed system.

   If the managed system does not display in the contents area, or if the managed system is in any state other than Standby or Operating, you must fix the problem before continuing. For more information on correcting the operating state of the managed system, see Correcting the managed system operating state.

2. Verify that a single logical partition exists on the managed system. When you connect a new or nonpartitioned managed system to an HMC, a single logical partition displays in the HMC user interface. All system resources belong to this logical partition. In this procedure, you will use this logical partition to validate the hardware on the managed system. After you validate the hardware on the managed system, you will delete this logical partition and create the logical partitions according to your logical partition plan.
   a. In the contents area of the HMC, open the managed system.
   b. Open **Partitions**. The logical partition displays as an object under **Partitions**. The name of this logical partition will be the serial number of the managed system, and the logical partition will have one partition profile called **default**.

   If the logical partition that is described in this step exists, continue to step 4 on page 213. Otherwise, continue to step 3 to reset the managed system.

3. Reset the managed system so that a single logical partition exists on the managed system. Complete the following **at your HMC** (not using a remote client such as Web-based System Manager) to create this logical partition on your managed system:
   a. Ensure that the hardware placement in the managed system supports the manufacturing default configuration. If the hardware placement in the managed system does not support the manufacturing default configuration, you must move the hardware so that the hardware
placement supports the manufacturing default configuration. For more information on placing the hardware in your managed system to support the manufacturing default configuration, contact your marketing representative or business partner.

b. If necessary, move the hardware in the managed system to support the manufacturing default configuration, according to instructions from service and support.

c. In the contents area, right-click the managed system.

d. From the menu, click Profile Data → Initialize and click Yes.

e. Right-click your HMC desktop (outside of any of the displayed windows) and click Terminal → rshterm. The Restricted shell command-line interface displays.

f. Type: lpcfgop -m managed_system_name -o clear. managed_system_name is the name of managed system as it displays in the content area.

g. Enter 1 to confirm. This step will take several seconds to complete.

4. Ensure that the contents area displays a state of Not Activated for the logical partition. If the logical partition is in a Running state, shut down the logical partition by completing the following:

ea. Right-click the managed system in the contents area.

b. Click Properties.

c. Ensure that Power off the system after all the logical partitions are powered off is cleared.

d. Click OK.

e. Shut down the logical partition using operating system procedures. For more information on shutting down logical partitions using operating system procedures, see Shutting down i5/OS logical partitions.

If the logical partition is in an Error state, complete the following:

a. Right-click the logical partition and choose Properties.

b. Click the Reference Code tab and use the reference codes displayed on the Reference Code tab to diagnose and fix the problem. For more information on using reference codes to diagnose and fix problems, see Reference codes list for customers.

5. Identify (or tag) the load source device, alternate restart device, and console device to use for system setup. Identify the HMC as the console device for system setup, regardless of the types of console device that you ultimately plan to use for the logical partitions on your system. The HMC provides the easiest, most reliable method to access a console session during system setup. When you create your logical partitions, you can specify the console of your choice for each logical partition. Also, when you select the load source device and alternate restart device, select the devices that will be used by the first i5/OS logical partition in your SPT plan. To identify the devices to use for system setup, complete the following:

a. Open the logical partition, right-click on the default partition profile, and choose Properties.

b. Click the Tagged I/O tab.

c. Under Load source, click Select.

d. Open the unit and bus in which the load source I/O Adapter (IOA) or the load source I/O Processor (IOP) is installed, select the slot in which the load source IOA or IOP is installed, and click Select.

e. Click OK.

f. Under Alternate restart device, click Select.

g. Open the unit and bus in which the alternate restart device IOA or IOP is installed, select the slot in which the alternate restart device IOA or IOP is installed, and click Select.

h. Click OK.

i. Select Use HMC console and click OK.

6. If Licensed Internal Code was not preinstalled on the server, or if you want to install Licensed Internal Code yourself, then install Licensed Internal Code at this time. For more information on
installing Licensed Internal code, see Installing Licensed Internal Code on the new logical partition. When the Licensed Internal Code installation is complete, continue to step 8.

7. Activate the logical partition:
   a. Right-click the logical partition and click **Activate**.
   b. Click **Advanced**.
   c. Select Manual in the **Keylock position** field, select B: IPL from the second side of the load source in the **IPL type** field, and click **OK**.
   d. If you are performing this procedure from the HMC, select **Open a terminal window or console session** and click **OK**. If you are performing this procedure remotely, click **OK** and then open an HMC 5250 console session remotely on the logical partition. For more information about opening an HMC 5250 console session remotely, see Connecting to a 5250 console remotely.
   e. Type 1 and press Enter to start a dedicated HMC 5250 console session.

8. Verify that the physical adapters are connected and reporting to the managed system using the Failed and non-reporting hardware resources option in the Hardware Service Manager. Use the Failed and non-reporting hardware resource option to display a list of the logical hardware resources that either failed or did not report to the system at the last IPL.
   **Attention**: Incorrect use of the Failed and non-reporting hardware resource option can cause damage to data in your system.
   a. In the HMC 5250 console session, type 3 and press Enter to select option 3 [Use Dedicated Service Tools (DST)].
   b. Sign onto DST with a valid user ID and password.
   c. Type 7 and press Enter to select option 7 [Start a service tool].
   d. Type 4 and press Enter to select option 4 [Hardware service manager].
   e. Type 4 and press Enter to select option 4 [Failed and non-reporting hardware resources].
   f. Verify that there are no failed or non-reporting resources. If no failed resources or non-reporting resources exist, the informational message No failed or non-reporting logical hardware resources were found will appear. If there are failed resources, contact your service provider.
   g. Press F3 until the Use Dedicated Service Tools (DST) display appears.
   h. Type 7 and press Enter to select option 7 [Start a service tool].
   i. Type 7 and press Enter to select option 7 [Operator panel functions].
   j. Press F10 to power off, press Enter to confirm, close the 5250 console session window, and wait until the logical partition shuts down.

9. If the hardware in the managed system is already in the configuration specified in your SPT configuration plan, then continue to step 15 on page 215.

10. Power off the managed system using your HMC.
    a. In the navigation area of your HMC, open **Server and Partition**.
    b. Select **Server Management**.
    c. In the contents area, right-click the managed system that you are partitioning and choose **Power Off**.
    d. Select the **Normal power off** option and click **OK**.

11. Move the hardware in the managed system according to your SPT configuration plan.

12. Power on the managed system to the **Standby** state using your HMC.
    a. In the navigation area of your HMC, open **Server and Partition**.
    b. Select **Server Management**.
    c. In the contents area, right-click the managed system that you are partitioning and choose **Power On**.
d. Select Partition standby as the power-on mode and click OK.

13. Activate the logical partition:
   a. Right-click the logical partition and click Activate.
   b. Click Advanced.
   c. Select Manual in the Keylock position field, select B: IPL from the second side of the load source in the IPL type field, and click OK.
   d. If you are performing this procedure from the HMC, select Open a terminal window or console session and click OK. If you are performing this procedure remotely, click OK and then open an HMC 5250 console session remotely on the logical partition. For more information on opening an HMC 5250 console session remotely, see Connecting to a 5250 console remotely.
   e. Type 1 and press Enter to start a dedicated HMC 5250 console session.

14. Verify that the physical adapters are connected and reporting to the managed system using the Failed and non-reporting hardware resources option in the Hardware Service Manager.
   Attention: Incorrect use of the Failed and non-reporting hardware resource option can cause damage to data in your system.
   a. Type 3 and press Enter to select option 3 [Use Dedicated Service Tools (DST)].
   b. Sign onto DST with a valid user ID and password.
   c. Type 7 and press Enter to select option 7 [Start a service tool].
   d. Type 4 and press Enter to select option 4 [Hardware service manager].
   e. Type 4 and press Enter to select option 4 [Failed and non-reporting hardware resources].
   f. Verify that there are no failed or non-reporting hardware resources. If no failed or non-reporting hardware resources exist, the informational message No failed or non-reporting logical hardware resources were found will appear. If there are failed resources, contact your service provider.

   Note: You can verify only the adapters that are supported by i5/OS. Any adapter that is not supported by i5/OS might have an error of unknown or failed hardware.
   g. Press F3 until the Use Dedicated Service Tools (DST) display appears.
   h. Type 7 and press Enter to select option 7 [Start a service tool].
   i. Type 7 and press Enter to select option 7 [Operator panel functions].
   j. Press F10 to power off, press Enter to confirm, close the 5250 console session window, and wait until the logical partition shuts down.

15. Delete the logical partition that owns all of the system resources.
   Attention: This procedure erases the logical partition and the logical partition configuration data stored on the partition profiles. This procedure does not affect any of the data stored on the managed system.
   a. In the navigation area of your HMC, open Server and Partition.
   b. Select Server Management.
   c. In the contents area, open the managed system that you are partitioning.
   d. Open Partitions.
   e. Ensure that the logical partition is powered off.
   f. Right-click the logical partition and choose Delete.
   g. Click Yes to confirm.

16. Create each logical partition on your managed system according to your logical partition plan. You can do this by importing a system plan file into your HMC and deploying the system plan to the managed system. For more information on creating logical partitions using a system plan, see Working with system plans using version 6 or earlier of the HMC. You can alternately create the logical partitions by performing the following procedure for each logical partition that you want to create.
a. In the navigation area of your HMC, open **Server and Partition**.
b. Select **Server Management**.
c. In the contents area, right-click **Partitions** under the managed system that you are partitioning, and choose **Create → Logical Partition**.
d. Follow the steps in the Create Logical Partition wizard to create a logical partition and a partition profile.

17. Designate one of the i5/OS logical partitions on your managed system as the service partition for the managed system.
   a. In the navigation area of your HMC, open **Server and Partition**.
   b. Select **Server Management**.
   c. In the contents area, right-click the managed system that you are partitioning and choose **Properties**.
   d. In the **Service partition** field, select the logical partition that you want to designate as the service partition.
   e. Click **OK**.

18. Ensure that there is at least one LAN adapter on the HMC that is configured to connect with the logical partitions on your managed system.
   a. In the navigation area of your HMC, open **HMC Management**.
   b. Select **HMC Configuration**.
   c. In the contents pane, click **Customize Network Settings**.
   d. Click the **LAN Adapters** tab.
   e. Select any LAN adapter other than the eth0 adapter that connects the HMC with the service processor and click **Details**.
   f. On the **LAN Adapter** tab, under **Local area network information**, select **Open**, and select **Partition communication**.
   g. Click the **Firewall Settings** tab.
   h. Ensure that the RMC application is one of the applications displayed in **Allowed Hosts**. If it is not displayed in **Allowed Hosts**, select the RMC application under **Available Applications** and click **Allow Incoming**. The RMC application displays in **Allowed Hosts** to signify that it has been selected.
   i. Click **OK**.

After you have created the logical partitions on your managed system, you must then complete the following tasks:

1. Install operating systems on the logical partitions. For installation procedures for the AIX, i5/OS, and Linux operating systems, refer to Installing operating systems.
2. Change the console device on each i5/OS logical partition to the console device of your choice. For procedures to change the console i5/OS logical partitions, see Changing the i5/OS console from the HMC to Operations Console or twinaxial console.
3. Connect the logical partitions on your managed system to the LAN adapter that you have just configured on the HMC. You can create a virtual LAN to connect the logical partitions on your managed system with each other, bridge the virtual LAN to a physical Ethernet adapter on an external network, and connect the LAN adapter on the HMC to the same external network. Alternately, you can configure a physical Ethernet adapter on each logical partition, connect the physical Ethernet adapters on the logical partitions to an external network, and connect the LAN adapter on the HMC to the same external network. For information on how to create and configure virtual Ethernet adapters for your AIX logical partitions, see Configuring a virtual Ethernet adapter for AIX. For information on how to create and configure virtual Ethernet adapters for your logical partitions, see Configuring a virtual Ethernet adapter using version 6 or earlier of the HMC.
Related concepts

“Shutting down i5/OS logical partitions” on page 163
The correct way to shut down an i5/OS logical partition safely is from an i5/OS command line.

“System plan overview for the HMC” on page 195
Learn about system plan concepts and operations, as well as understand the high-level tasks that you can perform with system plans when using the Hardware Management Console (HMC).

Related tasks

“Creating logical partitions using version 6 or earlier of the HMC” on page 222
You can use the Create Logical Partition wizard on the Hardware Management Console (HMC) to create a new logical partition. When you create a logical partition, you also create a partition profile that contains the resource allocations and settings for the new logical partition.

“Configuring a virtual Ethernet adapter using version 6 or earlier of the HMC” on page 224
You can configure a virtual Ethernet adapter dynamically for a running logical partition. Doing so will connect the logical partition to a virtual LAN.

Related information

Tasks and roles
Setting up the HMC
Correcting the managed system operating state
Connecting to a 5250 console remotely
Shutting down AIX using the HMC
Shutting down Linux using the HMC
Reference codes list for customers
Installing operating systems
Changing consoles, interfaces, and terminals

Partitioning for i5/OS with an HMC

Partitioning a new or nonpartitioned IBM System p5, eServer p5, or IntelliStation POWER 285 managed system using version 6 or earlier of the HMC:

Use this procedure to partition a new or nonpartitioned IBM System p5, eServer p5, or IntelliStation POWER 285 managed system using the Hardware Management Console (HMC). In this procedure, you will validate the hardware on the managed system and create the logical partitions on the managed system.

Use this procedure in the following cases:
• You have just received your managed system and want to partition the managed system immediately.
• You have used the managed system as a nonpartitioned server, and now want to partition the managed system.

If you want to create a new logical partition on a managed system that has already been partitioned, then you do not need to perform all of the steps in this procedure. For more information on creating a new logical partition on a managed system that has already been partitioned, see Creating logical partitions using version 6 or earlier of the HMC.

Before you begin, complete the following:
• Use the System Planning Tool (SPT) to ensure that your hardware configuration supports your desired logical partition configuration.
• If necessary, install additional hardware resources on your managed system to support the partition plan specified by the SPT.
• Set up the HMC to manage your logical partition and the managed system. For information on how to set up the HMC, see Setting up the HMC.
• If you have used the managed system prior to partitioning, back up all data on the managed system.
To partition a new or nonpartitioned IBM System p5, eServer p5, or IntelliStation POWER 285 managed system using version 6 or earlier of the HMC, you must be a super administrator or operator on the HMC. For more information about user roles, refer to Tasks and roles.

To partition a new or nonpartitioned IBM System p5, eServer p5, or IntelliStation POWER 285 managed system using version 6 or earlier of the HMC, complete the following steps:

1. Ensure that the managed system is in a state of **Standby** or **Operating**. Complete the following:
   a. In the navigation area of the HMC, open the object with the same name as your HMC, open **Server and Partition**, and choose **Server Management**.
   b. Find the state of the managed system as displayed in the contents area under the **State** heading.
   c. If the managed system is in a **Power off** state, right-click the managed system, choose **Power On**, select the power-on mode of **Partition Standby**, click **OK**, and wait until the contents area displays a **Standby** state for the managed system.

   If the managed system does not display in the contents area, or if the managed system is in any state other than **Standby** or **Operating**, you must fix the problem before continuing. For more information on correcting the operating state of the managed system, see Correcting the managed system operating state.

2. Verify that a single logical partition exists on the managed system. When you connect a new or nonpartitioned managed system to an HMC, a single logical partition displays in the HMC user interface. All system resources belong to this logical partition. In this procedure, you will use this logical partition to validate the hardware on the managed system. After you validate the hardware on the managed system, you will delete this logical partition and create the logical partitions according to your logical partition plan.
   a. In the contents area of the HMC, open the managed system.
   b. Open **Partitions**. The logical partition displays as an object under **Partitions**. The name of this logical partition will be the serial number of the managed system, and the logical partition will have one partition profile called **default**.

   If the logical partition that is described in this step exists, continue to step 4. Otherwise, continue to step 3 to reset the managed system.

3. Reset the managed system so that a single logical partition exists on the managed system. Complete the following at your HMC (not using a remote client such as Web-based System Manager) to create this logical partition on your managed system:
   a. Ensure that the hardware placement in the managed system supports the manufacturing default configuration. If the hardware placement in the managed system does not support the manufacturing default configuration, you must move the hardware so that the hardware placement supports the manufacturing default configuration. For more information on placing the hardware in your managed system to support the manufacturing default configuration, contact your marketing representative or business partner.
   b. In the contents area, right-click the managed system.
   c. From the menu, click **Profile Data** → **Initialize** and click **Yes**.
   d. Right-click your HMC desktop (outside of any of the displayed windows) and click **Terminal** → **rshterm**. The Restricted shell command-line interface displays.
   e. Type: `lpcfgop -m managed_system_name -o clear`. `managed_system_name` is the name of managed system as it displays in the content area.
   f. Enter 1 to confirm. This step will take several seconds to complete.

4. Ensure that the contents area displays a state of **Not Activated** for the logical partition. If the logical partition is in a **Running** state, shut down the logical partition by completing the following:
   a. Right-click the managed system in the contents area.
   b. Click **Properties**.
   c. Ensure that **Power off the system after all the logical partitions are powered off** is cleared.
d. Click OK.

e. Shut down the logical partition using operating system procedures. For more information on shutting down logical partitions using operating system procedures, see the following information:
   • For managed systems running AIX, see Shutting down AIX in a logical partition.
   • For managed systems running Linux, see Using the Hardware Management Console to shut down Linux logical partitions.

If the logical partition is in an Error state, complete the following:

a. Right-click the logical partition and choose Properties.

b. Click the Reference Code tab and use the reference codes displayed on the Reference Code tab to diagnose and fix the problem. For more information on using reference codes to diagnose and fix problems, see Reference codes list for customers.

5. Activate the logical partition and verify that the physical adapters on the managed system are connected and reporting to the managed system using the configuration manager. If AIX is not installed on your managed system, continue with step 6. You can use the configuration manager in AIX to view all of the available devices. When AIX boots and the configuration manager runs, the configuration manager displays all the working adapters. The recognized adapters will be in the Available state if they are configured correctly.

a. In the contents area, right-click the partition and click Activate.

b. Click Advanced.

c. In the Boot mode field, select Normal and click OK.

d. Select Open a terminal window or console session and click OK. A virtual terminal (vterm) window opens for the logical partition.

e. Ensure that all the resources are attached and powered on.

f. Log in to AIX using a valid user name and password.

g. Enter the following command at the command prompt to list all of the adapters on AIX: 
   ```
   # lsdev -Cc adapter
   ```
   If there are any adapters that do not display as Available, contact service and support.

   Note: You can verify only the adapters that are recognized by AIX. Any adapter that is not recognized by AIX might have an error of unknown or failed hardware.

h. When you are done, shut down the logical partition using operating system procedures and close the terminal session window. For information on how to shut down AIX, see Restarting and shutting down AIX in a logical partition.

6. Activate the logical partition and verify that the physical adapters on the managed system are connected and reporting to the managed system using the System Management Services (SMS) interface. If Linux is installed on the managed system, or if there is no operating system on the managed system, you can use the SMS interface to view the available devices. When the logical partition is activated, the bus is scanned to determine what device adapters are attached. The recognized adapters are listed.

a. In the contents area, right-click the partition and click Activate.

b. Click Advanced.

c. In the Boot mode field, select SMS and click OK.

d. Select Open a terminal window or console session and click OK. A virtual terminal (vterm) window opens for the logical partition.

e. When the SMS interface is displayed, type 5 and press Enter to select option 5 [Select Boot Options].

f. Type 1 and press Enter to select option 1 [Select Install or Boot a Device]

g. Type 7 and press Enter to select option 7 [List all Devices]. All of the recognized devices in the partition are listed. If there are any devices that do not display, contact service and support.
7. If the hardware in the managed system is already in the configuration specified in your SPT configuration plan, then continue to step 13 on page 221.

8. Power off the managed system using your HMC.
   a. In the navigation area of your HMC, open Server and Partition.
   b. Select Server Management.
   c. In the contents area, right-click the managed system that you are partitioning and choose Power Off.
   d. Select the Normal power off option and click OK.

9. Move the hardware in the managed system according to your SPT configuration plan.

10. Power on the managed system to the Standby state using your HMC.
    a. In the navigation area of your HMC, open Server and Partition.
    b. Select Server Management.
    c. In the contents area, right-click the managed system that you are partitioning and choose Power On.
    d. Select Partition standby as the power-on mode and click OK.

11. Activate the logical partition and verify that the physical adapters on the managed system are connected and reporting to the managed system using the configuration manager. If AIX is not installed on the managed system, continue with step 12. You can use the configuration manager in AIX to view all of the available devices. When AIX boots and the configuration manager runs, the configuration manager displays all the working adapters. The recognized adapters will be in the Available state if they are configured correctly.
    a. In the contents area, right-click the partition and click Activate.
    b. Click Advanced.
    c. In the Boot mode field, select Normal and click OK.
    d. Select Open a terminal window or console session and click OK. A virtual terminal (vterm) window opens for the logical partition.
    e. Ensure that all the resources are attached and powered on.
    f. Log in to AIX using a valid user name and password.
    g. Enter the following command at the command prompt to list all of the adapters on AIX: 
       ```
       # lsdev -Cc adapter
       ```
       If there are any adapters that do not display as Available, contact service and support.

       Note: You can verify only the adapters that are recognized by AIX. Any adapter that is not recognized by AIX might have an error of unknown or failed hardware.

    h. When you are done, shut down the logical partition using operating system procedures and close the terminal session window. For information on how to shut down AIX, see Restarting and shutting down AIX in a logical partition.

12. Activate the logical partition and verify that the physical adapters on the managed system are connected and reporting to the managed system using the System Management Services (SMS) interface. If Linux is installed on the managed system, or if there is no operating system on the managed system, you can use the SMS interface to view the available devices. When the logical partition is activated, the bus is scanned to determine what device adapters are attached. The recognized adapters are listed.
    a. In the contents area, right-click the partition and choose Activate.
    b. Click Advanced.
c. In the **Boot mode** field, select **SMS** and click **OK**.

d. Select **Open a terminal window or console session** and click **OK**. A virtual terminal (vterm) window opens for the logical partition.

e. When the SMS interface is displayed, type 5 and press Enter to select option 5 [Select Boot Options].

f. Type 1 and press Enter to select option 1 [Select Install or Boot a Device]

g. Type 7 and press Enter to select option 7 [List all Devices]. All of the recognized devices in the partition are listed. If there are any devices that do not display, contact service and support.

   **Note**: You can verify only the adapters that are recognized by SMS. Any adapter that is not recognized by SMS might have an error of unknown or failed hardware.

h. When you are done, close the terminal session window, right-click the partition in the contents area, click **Shut down partition**, and click **OK**.

13. Delete the logical partition that owns all of the system resources.

   **Attention**: This procedure erases the logical partition and the logical partition configuration data stored on the partition profiles. This procedure does not affect any of the data stored on the managed system.

   a. In the navigation area of your HMC, open **Server and Partition**.

   b. Select **Server Management**.

   c. In the contents area, open the managed system that you are partitioning.

   d. Open **Partitions**.

   e. Ensure that the logical partition is powered off.

   f. Right-click the logical partition and choose **Delete**.

   g. Click **Yes** to confirm.

14. Create each logical partition on your managed system according to your logical partition plan. You can do this by importing a system plan file into your HMC and deploying the system plan to the managed system. For more information on creating logical partitions using a system plan, see Working with system plans using version 6 or earlier of the HMC. You can alternately create the logical partitions by performing the following procedure for each logical partition that you want to create.

   a. In the navigation area of your HMC, open **Server and Partition**.

   b. Select **Server Management**.

   c. In the contents area, right-click **Partitions** under the managed system that you are partitioning, and choose **Create → Logical Partition**.

   d. Follow the steps in the Create Logical Partition wizard to create a logical partition and a partition profile.

15. Ensure that there is at least one LAN adapter on the HMC that is configured to connect with the logical partitions on your managed system.

   a. In the navigation area of your HMC, open **HMC Management**.

   b. Select **HMC Configuration**.

   c. In the contents pane, click **Customize Network Settings**.

   d. Click the **LAN Adapters** tab.

   e. Select any LAN adapter other than the eth0 adapter that connects the HMC with the service processor and click **Details**.

   f. On the **LAN Adapter** tab, under **Local area network information**, select **Open**, and select **Partition communication**.

   g. Click the **Firewall Settings** tab.
h. Ensure that the RMC application is one of the applications displayed in **Allowed Hosts**. If it is not displayed in **Allowed Hosts**, select the RMC application under **Available Applications** and click **Allow Incoming**. The RMC application displays in **Allowed Hosts** to signify that it has been selected.

i. **Click OK.**

After you have created the logical partitions on your managed system, you must then complete the following tasks:

1. **Install operating systems on the logical partitions.** For installation procedures for the AIX, i5/OS, and Linux operating systems, refer to Installing operating systems.

2. **Connect the logical partitions on your managed system to the LAN adapter that you have just configured on the HMC.** You can create a virtual LAN to connect the logical partitions on your managed system with each other, bridge the virtual LAN to a physical Ethernet adapter on an external network, and connect the LAN adapter on the HMC to the same external network. Alternately, you can configure a physical Ethernet adapter on each logical partition, connect the physical Ethernet adapters on the logical partitions to an external network, and connect the LAN adapter on the HMC to the same external network. For information on how to create and configure virtual Ethernet adapters for your logical partitions, see Configuring a virtual Ethernet adapter using version 6 or earlier of the HMC.

**Related concepts**

- “System plan overview for the HMC” on page 195

Learn about system plan concepts and operations, as well as understand the high-level tasks that you can perform with system plans when using the Hardware Management Console (HMC).

**Related tasks**

- “Creating logical partitions using version 6 or earlier of the HMC” on page 224

You can use the Create Logical Partition wizard on the Hardware Management Console (HMC) to create a new logical partition. When you create a logical partition, you also create a partition profile that contains the resource allocations and settings for the new logical partition.

- “Configuring a virtual Ethernet adapter using version 6 or earlier of the HMC” on page 224

You can configure a virtual Ethernet adapter dynamically for a running logical partition. Doing so will connect the logical partition to a virtual LAN.

**Related information**

- Tasks and roles
- Setting up the HMC
- Correcting the managed system operating state
- Shutting down AIX using the HMC
- Shutting down Linux using the HMC
- Reference codes list for customers
- Installing operating systems

**Creating logical partitions using version 6 or earlier of the HMC**

You can use the Create Logical Partition wizard on the Hardware Management Console (HMC) to create a new logical partition. When you create a logical partition, you also create a partition profile that contains the resource allocations and settings for the new logical partition.

Use this procedure only if you are creating logical partitions on a managed system that has already been partitioned. If you are creating logical partitions on a new or nonpartitioned managed system, you must test the hardware on your managed system to ensure that the hardware is in working order. Testing the hardware helps you detect potential problems with your managed system and makes such problems easier to correct. After you test the hardware, you can create logical partitions on a new or nonpartitioned
managed system by deploying a system plan to the managed system. For more information on how to create logical partitions on new and nonpartitioned managed systems, see the Partitioning a new or nonpartitioned server topics.

You can also create logical partitions on a managed system by deploying a system plan to the managed system. A system plan automates the process of creating logical partitions and ensures that each logical partition gets the resources that are specified within the system plan. For more information on system plans, see System plan overview.

Before you create a logical partition, have the System Planning Tool (SPT) output available. Use the output from this tool as a guide as you start to create partition profiles on your server.

To create a logical partition using version 6 or earlier of the HMC, you must be a super administrator or an operator. For more information about the role of a super administrator and operator, refer to Tasks and roles.

To create a logical partition on your server using version 6 or earlier of the HMC, follow these steps:
1. In the navigation area, open Server and Partition.
2. Select Server Management.
3. In the contents area, open the managed system on which you want to create the partition profile.
4. Right-click Partitions, and select Create → Logical Partition.
5. Follow the steps in the Create Logical Partition wizard to create a logical partition and a partition profile.

After creating your logical partition and partition profile, you must install an operating system. For installation procedures for the AIX, i5/OS, and Linux operating systems, refer to Installing operating systems.

Related concepts
“System plan overview for the HMC” on page 195
Learn about system plan concepts and operations, as well as understand the high-level tasks that you can perform with system plans when using the Hardware Management Console (HMC).

Related tasks
“Partitioning a new or nonpartitioned IBM System i5 or eServer i5 managed system using version 6 or earlier of the HMC” on page 211
Use this procedure to partition a new or nonpartitioned IBM System i5 or eServer i5 managed system using version 6 or earlier of the Hardware Management Console (HMC). In this procedure, you will validate the hardware on the managed system, create the logical partitions on the managed system, and designate the service partition for the managed system.

“Partitioning a new or nonpartitioned IBM System p5, eServer p5, or IntelliStation POWER 285 managed system using version 6 or earlier of the HMC” on page 217
Use this procedure to partition a new or nonpartitioned IBM System p5, eServer p5, or IntelliStation POWER 285 managed system using the Hardware Management Console (HMC). In this procedure, you will validate the hardware on the managed system and create the logical partitions on the managed system.

Related information
Tasks and roles
Installing operating systems

Creating additional partition profiles using version 6 or earlier of the HMC
You can create more than one partition profile for a logical partition using the Hardware Management Console (HMC). Each partition profile can specify a different amount of system resources and different partition startup attributes. You can change the attributes used by a logical partition by shutting down the logical partition and restarting the logical partition using a different partition profile.
Before you create a partition profile using version 6 or earlier of the HMC, it is recommended that you have the System Planning Tool (SPT) output available. You should use the output from this tool as a guide as you start to create partition profiles on your server. For more information on the SPT, see System Planning Tool.

To create a partition profile, you must be a super administrator or an operator. For more information about the role of a super administrator and operator, refer to Tasks and roles.

To create a partition profile using version 6 or earlier of the HMC, follow these steps:

1. In the navigation area, open **Server and Partition**.
2. Select **Server Management**.
3. In the contents area, open the managed system on which you want to create the partition profile.
4. Open **Partitions**.
5. Right-click the logical partition for which you want to create the partition profile and select **Create → Profile**.
6. Follow the steps in the Create Partition Profile wizard to create the partition profile.

**Related concepts**

“System Planning Tool” on page 62

The System Planning Tool (SPT) helps you design a managed system that can support a specified set of workloads. You can design a managed system based upon workload data from your current systems, based upon new workloads that you want the managed system to support, based upon sample systems that are provided with the utility, or based upon your own custom specifications.

**Related information**

Tasks and roles

**Configuring a virtual Ethernet adapter using version 6 or earlier of the HMC**

You can configure a virtual Ethernet adapter dynamically for a running logical partition. Doing so will connect the logical partition to a virtual LAN.

You can dynamically configure a virtual Ethernet adapter for a Linux logical partition only if the following conditions are met:

- A Linux distribution that supports dynamic logical partitioning is installed on the Linux logical partition. Distributions that support dynamic logical partitioning include Red Hat Enterprise Linux version 4, SUSE Linux Enterprise Server 9, and later versions of these distributions.
- The DynamicRM tool package is installed on the Linux logical partition. For more information on the DynamicRM tool package, see the Service and productivity tools Web site.

To configure a virtual Ethernet adapter dynamically on a running logical partition using version 6 or earlier of the HMC, follow these steps:

1. In the navigation area, open **Server and Partition**.
2. Select **Server Management**.
3. In the contents area, expand the managed system on which the logical partition that will use the Ethernet adapter resides.
4. Expand **Partitions**.
5. Right-click the logical partition that will use the virtual Ethernet adapter and select **Dynamic Logical Partitioning → Virtual Adapter Resources → Add/Remove**.
6. Select the **Virtual I/O** tab.
7. In the **Create Adapters** area, select **Ethernet** and click **Create**. The Virtual Ethernet Adapter Properties window appears.
8. Enter the slot number for the virtual Ethernet adapter.
9. Enter the Port Virtual LAN ID (PVID) for the virtual Ethernet adapter. The PVID allows the virtual Ethernet adapter to communicate other virtual Ethernet adapters that have the same PVID.

10. If the logical partition is an AIX, Linux, or Virtual I/O Server logical partition, select the IEEE 802.1Q-compatible adapter check box if you want to configure the virtual Ethernet adapter to communicate over multiple virtual LANs. If you leave this option unchecked and you want this partition to connect to multiple virtual networks, then you need to create multiple virtual adapters by creating additional virtual LAN IDs.

11. Click OK.

After you have finished, access any existing partition profiles for the logical partition and add the virtual Ethernet adapters to those partition profiles. The virtual Ethernet adapter will be lost if you shut down the logical partition and activate the logical partition using a partition profile that does not have the virtual Ethernet adapter in it.

Related concepts
“Virtual Ethernet for i5/OS logical partitions” on page 56

Related tasks
“Changing partition profile properties using version 6 or earlier of the HMC” on page 240
You can change the properties of a partition profile using the Hardware Management Console (HMC). Changing the properties of a partition profile will change the resource amounts that are assigned to a logical partition when you shut down and restart the logical partition using the changed partition profile.

“Saving the partition configuration to a partition profile” on page 256
Use this procedure to save the current configuration of a logical partition to a new partition profile using a Hardware Management Console (HMC). Use this procedure if you change the configuration of a logical partition using dynamic logical partitioning and you do not want to lose the changes when you reactivate the logical partition. This procedure allows you to save the changed configuration to a new partition profile instead of having to enter the changed resource allocations manually.

“Partitioning a new or nonpartitioned IBM System i5 or eServer i5 managed system using version 6 or earlier of the HMC” on page 211
Use this procedure to partition a new or nonpartitioned IBM System i5 or eServer i5 managed system using version 6 or earlier of the Hardware Management Console (HMC). In this procedure, you will validate the hardware on the managed system, create the logical partitions on the managed system, and designate the service partition for the managed system.

“Partitioning a new or nonpartitioned IBM System p5, eServer p5, or IntelliStation POWER 285 managed system using version 6 or earlier of the HMC” on page 217
Use this procedure to partition a new or nonpartitioned IBM System p5, eServer p5, or IntelliStation POWER 285 managed system using the Hardware Management Console (HMC). In this procedure, you will validate the hardware on the managed system and create the logical partitions on the managed system.

Related information
Tasks and roles
“Service and productivity tools Web site

Designating the service partition for your managed system using version 6 or earlier of the HMC
The service partition is the i5/OS logical partition on an IBM System i5 or eServer i5 server that you can configure to apply server firmware updates to the service processor or to the hypervisor and to communicate server common hardware errors to IBM. These abilities are useful if the Hardware Management Console (HMC) is undergoing maintenance or is otherwise unable to perform these functions.

The preferred method for applying server firmware updates and communicating server common hardware errors to IBM is by using the HMC.
IBM System p5, eServer p5, and OpenPower servers do not have a service partition. If an IBM System p5, eServer p5, or OpenPower server is managed by an HMC, then you must use the HMC to update the server firmware, and the server can contact service and support only through the HMC. If you use an HMC to manage IBM System p5, eServer p5, and OpenPower servers, then use a backup HMC to ensure that the servers have redundant methods for contacting service and support and for applying fixes.

You can designate only one logical partition at a time as the service partition for your managed system. The service partition for your IBM System i5 or eServer i5 server must be an i5/OS logical partition.

Before you can designate a logical partition as the service partition for your managed system, you must shut down the logical partition. You must also shut down the logical partition before you remove the service partition designation from the logical partition. If you want to change the service partition from one logical partition to another logical partition, you must shut down both logical partitions before using this procedure. Refer to the operating system shutdown procedures for information on shutting down your logical partitions normally.

**Note:** You must designate a service partition on a server only after you use the HMC to create, change, delete, copy, or activate any logical partitions on the managed system. You can set up the operating system on an unpartitioned server to contact service and support, and you can use the operating system on an unpartitioned server to apply server firmware updates.

To designate a service partition for your managed system using version 6 or earlier of the HMC, you must be a member of the super administrator role. For more information about user roles, refer to Tasks and roles.

To designate one of your logical partitions as the service partition for your managed system using version 6 or earlier of the HMC, follow these steps:

1. In the navigation area, open **Server and Partition**.
2. Select **Server Management**.
3. In the contents area, right-click the managed system and select **Properties**.
4. In the **Service partition** field, select the logical partition that you want to designate as the service partition. If you do not want to designate another logical partition as the service partition, select **None**.
5. Click **OK**.

**Related concepts**

“Service partition” on page 18

If you are using the Hardware Management Console (HMC) to manage systems and the HMC becomes unavailable, then you can use the service partition to perform service-related tasks on systems.

**Related tasks**

“Deleting a logical partition using version 6 or earlier of the HMC” on page 237

You can use the Hardware Management Console to delete a logical partition and all of the partition profiles associated with the logical partition.

“Deleting a logical partition using version 7 or later of the HMC” on page 146

You can use the Hardware Management Console (HMC) to delete a logical partition and all of the partition profiles associated with the logical partition.

**Migrating existing i5/OS logical partitions to your new server**

You can migrate your existing i5/OS logical partition configuration from an iSeries 8xx server to an IBM System i5 or eServer i5 server using the LPAR Migration Tool.

To learn more about the migration tool and the prerequisite tasks you will need to perform on your existing logical partitions before using the tool, see Upgrade the partitioned server.
Related information

Upgrade the partitioned server

Copying a partition profile using version 6 or earlier of the HMC
You can create a copy of an existing partition profile using the Hardware Management Console (HMC). After you create a copy of the existing partition profile, you can change the resource allocations within the new partition profile. This allows you to create multiple, nearly identical partition profiles easily.

To copy a partition profile using version 6 or earlier of the HMC, you must be a super administrator, operator, or product engineer. For more information about user roles, refer to Tasks and roles.

To copy a partition profile using version 6 or earlier of the HMC, follow these steps:
1. In the navigation area, open Server and Partition.
2. Select Server Management.
3. In the contents area, open the managed system on which the partition profile that you want to copy is located.
4. Open Partitions.
5. Open the logical partition for the partition profile that you want to copy.
6. Right-click the partition profile that you want to copy and select Copy.
7. Enter the name of the new partition profile and click OK.

Related information

Tasks and roles

Creating a system profile using version 6 or earlier of the HMC
You can create a system profile using the Hardware Management Console (HMC). A system profile is an ordered list of partition profiles. When you activate a system profile, the managed system attempts to activate the partition profiles in the system profile in the order in which the partition profiles are listed.

System profiles are useful to validate your partition profile. If a partition profile has overcommitted resources, you will not be able to add that partition profile to the system profile.

To create a system profile using version 6 or earlier of the HMC, you must be a super administrator or an operator. For more information about the role of a super administrator and operator, refer to Tasks and roles.

To create a system profile using version 6 or earlier of the HMC, follow these steps:
1. In the navigation area, open Server and Partition.
2. Select Server Management.
3. In the contents area, right-click the managed system on which you want to create the system profile and select Create → System Profile.

Related information

Tasks and roles

Copying a system profile using version 6 or earlier of the HMC
You can use the Hardware Management Console (HMC) to create a copy of an existing system profile. After you create a copy of the existing system profile, you can change the partition profiles that are contained within the new system profile. This allows you to create multiple, nearly identical system profiles quickly and easily.

To copy a system profile using version 6 or earlier of the HMC, you must be a super administrator, operator, or product engineer. For more information about user roles, refer to Tasks and roles.
To copy a system profile using version 6 or earlier of the HMC, follow these steps:

1. In the navigation area, open **Server and Partition**.
2. Select **Server Management**.
3. In the contents area, open the managed system on which the system profile that you want to copy is located.
4. Open **System Profiles**.
5. Right-click the system profile that you want to copy and select **Copy**.
6. Enter the name of the new system profile and click **OK**.

**Related information**

**Tasks and roles**

**Creating an AIX logical partition using i5/OS virtual I/O resources**

You can create an AIX logical partition that uses i5/OS virtual I/O resources on IBM System i5 or eServer i5 models. This allows you to maximize utilization of the physical hardware and simplify the backup procedure for your managed system.

i5/OS can share virtual I/O resources to provide I/O function for AIX logical partitions. AIX running on IBM System i5 and eServer i5 servers supports several types of virtual I/O resources. Use the Create Logical Partition wizard on the Hardware Management Console (HMC) to create virtual SCSI adapters and virtual serial adapters for AIX logical partitions.

You cannot create a AIX logical partition that uses i5/OS virtual I/O resources on IBM System p5, eServer p5, and OpenPower servers. On IBM System p5, eServer p5, and OpenPower servers, you can create a Virtual I/O Server logical partition and configure the AIX logical partition to use the virtual SCSI and virtual Ethernet resources of the Virtual I/O Server logical partition. You might need to enter an Advanced POWER Virtualization activation code to create a Virtual I/O Server logical partition on your IBM System p5, eServer p5, or OpenPower server. For more information about the Virtual I/O Server, see Using the Virtual I/O Server.

To create an AIX logical partition using i5/OS virtual I/O resources, you must be a super administrator or operator. For more information about the role of a super administrator and an operator, refer to Tasks and roles.

To create an AIX logical partition using i5/OS virtual I/O resources, follow these steps on your HMC:

1. In the navigation area, open **Server and Partition**.
2. Select **Server Management**.
3. In the contents area, open the server on which you want to create the partition profile.
4. Right-click **Partitions** and select **Create → Logical Partitions**
5. Follow the steps in the Create Logical Partition wizard to create a logical partition and a partition profile.
6. Create a network server description (NWSD) and network server storage space. See Creating a network-server description and a network-server storage space for an AIX logical partition for details.
7. Set up the console for your AIX partition. See Connecting to the virtual console for an AIX logical partition.
8. Start the NWSD. See Staring the network-server description for an AIX logical partition.
9. Install the AIX operating system on your new logical partition. For installation procedures, see Installing operating systems.
Related tasks

"Creating a network-server description and a network-server storage space for an AIX logical partition" on page 100

A network-server description (NWSD) is an i5/OS object that describes the storage resources that are used by an integrated operating environment. An NWSD can be linked to one or more network-server storage spaces. Create an NWSD to assign storage to an AIX logical partition that uses i5/OS resources.

"Connecting to the virtual console for an AIX logical partition" on page 102

You can connect to the virtual console for an AIX logical partition so that you can install the operating system or access the command line interface for the AIX logical partition.

"Starting the network-server description for an AIX logical partition" on page 103

You can start the network-server description (NWSD) for a AIX logical partition that uses i5/OS resources to make the resources defined in the NWSD available to the AIX logical partition.

Related information

Using the Virtual I/O Server

Tasks and roles

Installing operating systems

Creating a network-server description and a network-server storage space for an AIX logical partition:

A network-server description (NWSD) is an i5/OS object that describes the storage resources that are used by an integrated operating environment. An NWSD can be linked to one or more network-server storage spaces. Create an NWSD to assign storage to an AIX logical partition that uses i5/OS resources.

To create an NWSD and a network-server storage space for an AIX logical partition that uses i5/OS resources, follow these steps:

1. Determine the correct SCSI server resource name.
   - If there is only one SCSI server adapter corresponding to a given client partition, and that adapter has its remote partition and remote slot configured correctly, you can specify *AUTO as the RSRCNAME in your NWSD.
   - Otherwise, you must determine the actual resource name. At an i5/OS command line, type WRKHDWRSC *CMN, and find a controller resource with type 290B and a converged location code that corresponds to the SCSI server adapter at the Hardware Management Console (HMC). This resource name will be used later to specify the SCSI server resource.

2. At an i5/OS command line on the partition that shares resources, type CRTNWSD and press F4 for prompts.

3. Specify the following information: The default or suggested parameter values are provided within the parentheses. These settings are relevant only to a logical partition. After the installation, if your root file system (/) is not installed on the first partition of the first disk, you must set a root parameter.
   - NWSD (Provide a name for the NWSD)
   - RSRCNAME (*AUTO or the resource name of the SCSI server resource
   - TYPE(*GUEST)
   - ONLINE (*NO or *YES)
   - PARTITION ('Provide the name of your AIX logical partition')
   - As an alternative to the Partition parameter, you can also specify a partition number by typing PTNBNR(integer) where integer is the number of the partition you are specifying.
   - CODEPAGE (437)
   - TCPPORTCFG (*NONE)
   - RSTODEVRSRC (for virtual CD and tape devices) (*NONE)
   - SYNCTIME (*TYPE)
   - IPLSRC (*NWSSTG)
– You can store a kernel in a disk partition of a virtual disk (a network-server storage space (NWSSTG)). By specifying the IPLSRC (*NWSSTG) parameter, you are specifying that the AIX logical partition will start from a disk partition on that virtual disk. The disk partition on the virtual disk must be formatted as type PReP Boot (type 0x41) and marked as a device that starts.
– To start an NWSD with a kernel from a stream file, set the IPLSRC parameter to *STMF and set the IPLSTMF parameter to point to the kernel. You must have read access to the file and the path leading to the file to use the vary on command. This value only loads the kernel. After the kernel is running, it must find a root file system. In an initial installation, the root file system might be a RAM disk that is physically attached to the kernel.

- IPLSTMF (*NONE)
- IPLPARM (*NONE)
- PWRCTL (*YES)

– If you specify PWRCTL (*YES), perform the following steps:
  a. Ensure that the server adapter in the i5/OS partition specifies the remote partition and remote slot in its configuration.
  b. Ensure that the client partition has the i5/OS partition as the power-controlling partition in the profile.
  c. Ensure before you activate the NWSD that the client partition’s profile has been saved to the server by activating the partition from the HMC, even if the client operating system does not activate correctly because of the absence of virtual devices.

– If you specify PWRCTL(*NO), virtual devices will be available to the partition. You must shut down and restart the partition using the HMC.

4. If you use iSeries Navigator, create the network-server storage space using iSeries Navigator.
   a. Expand My Connections → your server → Network → Windows Administration.
   b. Right-click the Disk Drives and select New Disk.
   c. In the Disk drive name field, specify the name that you want to give to the disk drive.
   d. In the Description field, specify a meaningful description for the disk drive.
   e. In the Capacity field, specify the size of the new disk drive in megabytes.
   f. Click OK.
   g. Continue with step 6 on page 102

5. If you use a character-based interface, create the network-server storage space using a character-based interface:
   a. At an i5/OS command line, type the command CRTNWSSTG and press F4. The Create NWS Storage Space (CRTNWSSTG) display appears.
   b. In the Network-server storage space field, specify the name you want to give to the storage space.
   c. In the Size field, specify the size in megabytes for the new storage space.
   d. In the Text description field, specify a meaningful description for the storage space.
   e. Press Enter.
   f. Continue with step 7 on page 102

6. If you use iSeries Navigator, link the network-server storage space using iSeries Navigator.
   a. Expand My Connections → your server → Network → Windows Administration.
   b. Click Disk Drives, right-click an available network-server storage space, and select Add Link.
   c. Select the server to which you want to link the network-server storage space.
   d. Select the link sequence position you want to use.
   e. Select one of the available data access types.
   f. Click OK.

   The procedure is complete. Do not complete step 7 on page 102.
7. If you use a character-based interface, link the network-server storage space using a character-based
interface:
   a. At an i5/OS command line, type the command ADDNWSSTGL and press F4. The Add
      Network-Server Storage Link (ADDNWSSTGL) display appears.
   b. In the Network server description field, specify the name of the network server description
      (NWSD).
   c. In the Dynamic storage link field, specify "YES to make the network-server storage space
dynamically available to the partition (that is, available without rebooting the AIX partition).
   d. In the Drive sequence number field, specify the link sequence position you want to use.
   e. Press Enter.

Related tasks
“Creating an AIX logical partition using i5/OS virtual I/O resources” on page 228
You can create an AIX logical partition that uses i5/OS virtual I/O resources on IBM System i5 or eServer
i5 models. This allows you to maximize utilization of the physical hardware and simplify the backup
procedure for your managed system.

Connecting to the virtual console for an AIX logical partition:

You can connect to the virtual console for an AIX logical partition so that you can install the operating
system or access the command line interface for the AIX logical partition.

You must have one of the following privileges to use the AIX virtual console:
   • Remote Panel
   • System Partitions - Administration

The virtual console provides the console function for an AIX server. It is used primarily during the initial
installation of the operating system. The virtual console can also be used to view server errors or to
restore communication to the LAN. This console connection is used prior to configuring TCP/IP.

Any Telnet client can be used as the AIX console. Multiple Telnet clients can share access to the same
virtual console. To connect to a console, use Telnet to connect to port 2301 of the partition that is sharing
its resources. TCP/IP must be configured and running on at least one i5/OS logical partition. Perform
one of the following procedures:
   • If you use IBM Personal Communications, connect to a virtual console using IBM Personal
     Communications.
     1. Click Start → IBM Personal Communications → Start or Configure Session.
     2. From the Customize Communication window, select ASCII as your type of host and select Link
        Parameters.
     3. From the Telnet ASCII window, enter the host name or the IP address of the partition that is
        sharing its resources, and enter port number 2301 of the partition sharing its resources. Click OK.
     4. If you are not using an Integrated xSeries Server, go to the next step. If you are using both AIX
        partitions and Integrated xSeries Server consoles, select i5/OS Guest Partition Consoles from the
        i5/OS Virtual Consoles window.
     5. From the i5/OS Guest Partition Consoles window, select the logical partition to which you want to
        connect as the console.
     6. Enter the i5/OS service tools ID and password to connect to the AIX logical partition.
   • If you use Telnet, connect to the virtual console using Telnet from an MS-DOS command prompt.
     1. From an MS-DOS command prompt, use the Telnet command to connect to your server and port
        2301 (telnet xxxxx 2301).
2. If you are not using an Integrated xSeries Server, go to the next step. If you are using both AIX partitions and Integrated xSeries Server consoles, select **i5/OS Guest Partition Consoles** from the i5/OS Virtual Consoles window.

3. From the i5/OS Guest Partition Consoles window, select the logical partition to which you want to connect as the console.

4. Enter the i5/OS service tools ID and password to connect to the AIX logical partition.

**Related tasks**

“Creating an AIX logical partition using i5/OS virtual I/O resources” on page 228

You can create an AIX logical partition that uses i5/OS virtual I/O resources on IBM System i5 or eServer i5 models. This allows you to maximize utilization of the physical hardware and simplify the backup procedure for your managed system.

**Starting the network-server description for an AIX logical partition:**

You can start the network-server description (NWSD) for a AIX logical partition that uses i5/OS resources to make the resources defined in the NWSD available to the AIX logical partition.

To start (vary on) the NWSD for an AIX logical partition, complete the following tasks:

1. If you use iSeries Navigator, start the NWSD using iSeries Navigator.
   a. Click **Network → Windows Administration → Integrated xSeries Servers**
   b. Right-click the name of the NWSD that you want to start.
   c. Click **Start**.

2. If you use the character-based interface, start the NWSD using the character-based interface:
   a. Type `WRKCFGSTS *NWS` and press Enter.
   b. Type `1` next to the NWSD that you want to start and press Enter.

**Related tasks**

“Creating an AIX logical partition using i5/OS virtual I/O resources” on page 228

You can create an AIX logical partition that uses i5/OS virtual I/O resources on IBM System i5 or eServer i5 models. This allows you to maximize utilization of the physical hardware and simplify the backup procedure for your managed system.

“Unlinking virtual disk drives from an AIX logical partition” on page 108

By unlinking virtual disk drives (network-server storage spaces) from an AIX logical partition that uses i5/OS resources, you disconnect the virtual disk drives from the logical partition, making the virtual disk drives inaccessible to users. If you delete a AIX logical partition that uses i5/OS resources, you must unlink all virtual disk drives from the logical partition before you delete the logical partition.

**Creating a Linux logical partition using i5/OS virtual I/O resources**

IBM System i5 and eServer i5 models allow you to create a Linux logical partition that uses i5/OS virtual I/O resources. This allows you to maximize utilization of the physical hardware and simplify the backup procedure for your managed system.

To set this up, you must create virtual SCSI adapters that connect the Linux logical partition with the i5/OS. You can then set up i5/OS to provide disk resources to the Linux logical partition through the virtual SCSI connection. You can also create a virtual serial connection between the i5/OS logical partition and the Linux logical partition. A virtual serial connection would allow the i5/OS logical partition to control the Linux logical partition.

You cannot create a Linux logical partition that uses i5/OS virtual I/O resources on IBM System p5, eServer p5, or OpenPower servers. On IBM System p5, eServer p5, and OpenPower servers, you can create a Virtual I/O Server logical partition and configure the Linux logical partition to use the virtual SCSI and virtual Ethernet resources of the Virtual I/O Server logical partition. You might need to enter an
Advanced POWER Virtualization activation code to create a Virtual I/O Server logical partition on your IBM System p5, eServer p5, or OpenPower server. For more information about the Virtual I/O Server, see Using the Virtual I/O Server.

To create a Linux logical partition using i5/OS virtual I/O resources, you must be a super administrator or operator. For more information about the role of a super administrator and an operator, refer to Tasks and roles.

To create a Linux logical partition using i5/OS virtual I/O resources, follow these steps on your HMC:
1. In the navigation area, open Server and Partition.
2. Select Server Management.
3. In the contents area, open the server on which you want to create the partition profile.
4. Right-click Partitions and select Create → Logical Partitions.
5. Follow the steps in the Create Logical Partition wizard to create a logical partition and a partition profile.
6. Create a network server description (NWSD) and network-server storage space. See Creating an NWSD and a network-server storage space for a Linux logical partition for details.
7. Set up the console for your Linux partition. See Connecting to the virtual console for a Linux logical partition.
8. Start the NWSD. See Starting the network-server description for a Linux logical partition.
9. Install the Linux operating system on your new logical partition. For installation procedures, see Installing operating systems.

Related tasks
"Creating an NWSD and a network-server storage space for a Linux logical partition" on page 110
A network-server description (NWSD) is an i5/OS object that describes the storage resources that are used by an integrated operating environment. An NWSD can be linked to one or more network-server storage spaces. Create an NWSD to assign storage to a Linux logical partition that uses i5/OS resources.

"Connecting to the virtual console for a Linux logical partition" on page 112
You can connect to the virtual console for a Linux logical partition so that you can install the operating system or access the command line interface for the Linux logical partition.

"Starting the network-server description for a Linux logical partition" on page 113
You can start the network-server description (NWSD) for a Linux logical partition that uses i5/OS resources to make the resources defined in the NWSD available to the Linux logical partition.

Related information
Using the Virtual I/O Server
Tasks and roles
Installing operating systems

Creating an NWSD and a network-server storage space for a Linux logical partition:

A network-server description (NWSD) is an i5/OS object that describes the storage resources that are used by an integrated operating environment. An NWSD can be linked to one or more network-server storage spaces. Create an NWSD to assign storage to a Linux logical partition that uses i5/OS resources.

To create an NWSD and a network-server storage space for a Linux logical partition that uses i5/OS resources, follow these steps:
1. Determine the correct SCSI server resource name.
   • If there is only one SCSI server adapter corresponding to a given client partition, and that adapter has its remote partition and remote slot configured correctly, you can specify *AUTO as the RSRCNAME in your NWSD.
Otherwise, you must determine the actual resource name. At an i5/OS command line, type WRKHDWRSC *CMN, and find a controller resource with type 290B and a converged location code that corresponds to the SCSI server adapter at the Hardware Management Console (HMC). This resource name will be used later to specify the SCSI server resource.

2. At an i5/OS command line on the partition that shares resources, type CRTNWSD and press F4 for prompts.

3. Specify the following information. The default or suggested parameter values are provided within the parentheses. These settings are relevant only to a logical partition. After the installation, if your root file system (/) is not installed on the first partition of the first disk, you must set a root parameter.

- NWSD (Provide a name for the NWSD)
- RSRCNAME (*AUTO or the resource name of the SCSI server resource
- TYPE(*GUEST)
- ONLINE (*NO or *YES)
- PARTITION (Provide the name of your Linux logical partition)

As an alternative to the Partition parameter, you can also specify a partition number by typing PTNBR(integer) where integer is the number of the partition you are specifying.

- CODEPAGE (437)
- TCPPORTCFG (*NONE)
- RSTDDEVRSC (for virtual CD and tape devices) (*NONE)
- SYNTIME (*TYPE)
- IPLSRC (*NWSSTG)

You can store a kernel in a disk partition of a virtual disk (a network-server storage space (NWSSTG)). By specifying the IPLSRC (*NWSSTG) parameter, you are specifying that the Linux logical partition will start from a disk partition on that virtual disk. The disk partition on the virtual disk must be formatted as type PreP Boot (type 0x41) and marked as a device that starts. You can format a disk partition as type PreP Boot by using the Linux fdisk command with the -t option. You can specify that the disk partition starts by using the fdisk command with the -a option.

- To start an NWSD with a kernel from a stream file, set the IPLSRC parameter to *STMF and set the IPLSTMF parameter to point to the kernel. You must have read access to the file and the path leading to the file to use the vary on command. This value only loads the kernel. After the kernel is running, it must find a root file system. In an initial installation, the root file system might be a RAM disk that is physically attached to the kernel.

- IPLSTMF (*NONE)
- IPLPARM (*NONE)
- PWRCTL (*YES)

- If you specify PWRCTL (*YES), perform the following steps:
  a. Ensure that the server adapter in the i5/OS partition specifies the remote partition and remote slot in its configuration.
  b. Ensure that the client partition has the i5/OS partition as the power-controlling partition in the profile.
  c. Ensure before you activate the NWSD that the client partition’s profile has been saved to the server by activating the partition from the HMC, even if the client operating system does not activate correctly because of the absence of virtual devices.

- If you specify PWRCTL(*NO), virtual devices will be available to the partition. You must shut down and restart the partition using the HMC.

4. If you use iSeries Navigator, create the network-server storage space using iSeries Navigator.
   a. Expand My Connections → your server → Network → Windows Administration.
   b. Right-click the Disk Drives and select New Disk.
c. In the **Disk drive name** field, specify the name that you want to give to the disk drive.
d. In the **Description** field, specify a meaningful description for the disk drive.
e. In the **Capacity** field, specify the size of the new disk drive in megabytes. Refer to your preferred Linux distributor installation documentation to determine the size you want to use.
f. Click **OK**.
g. Continue with step 6 on page 112

5. If you use a character-based interface, create the network-server storage space using the character-based interface:
   a. At an i5/OS command line, type the command CRTNWSSTG and press F4. The Create NWS Storage Space (CRTNWSSTG) display appears.
   b. In the Network-server storage space field, specify the name you want to give to the storage space.
   c. In the Size field, specify the size in megabytes for the new storage space. Refer to your preferred Linux distributor installation documentation to determine the size you want to use.
   d. In the Text description field, specify a meaningful description for the storage space.
   e. Press Enter.
   f. Continue with step 7 on page 112

6. If you use iSeries Navigator, link the network-server storage space using iSeries Navigator:
   a. Expand **My Connections → your server → Network → Windows Administration**.
   b. Click **Disk Drives**, right-click an available network-server storage space, and select **Add Link**.
   c. Select the server to which you want to link the network-server storage space.
   d. Select the link sequence position you want to use.
   e. Select one of the available data access types.
   f. Click **OK**.
   The procedure is complete. Do not complete step 7 on page 112

7. If you use a character-based interface, link the network-server storage space using the character-based interface:
   a. At an i5/OS command line, type the command ADDNWSSTGL and press F4. The Add Network-Server Storage Link (ADDNWSSTGL) display appears.
   b. In the Network server description field, specify the name of the network server description (NWSD).
   c. In the Dynamic storage link field, specify "YES to make the network-server storage space dynamically available to the partition (that is, available without rebooting the Linux partition).
   d. In the Drive sequence number field, specify the link sequence position you want to use. If you want the system to find the next available position for you, specify "CALC.
   e. Press Enter.

Related tasks

"Creating a Linux logical partition using i5/OS virtual I/O resources" on page 232

IBM System i5 and eServer i5 models allow you to create a Linux logical partition that uses i5/OS virtual I/O resources. This allows you to maximize utilization of the physical hardware and simplify the backup procedure for your managed system.

**Connecting to the virtual console for a Linux logical partition:**

You can connect to the virtual console for a Linux logical partition so that you can install the operating system or access the command line interface for the Linux logical partition.

You must have one of the following privileges to use the Linux virtual console.
- Remote Panel
- System Partitions - Administration
The virtual console provides the console function for a Linux server. It is used primarily during the initial installation of the operating system. The virtual console can also be used to view server errors or to restore communication to the LAN. This console connection is used prior to configuring TCP/IP.

Any Telnet client can be used as the Linux console. Multiple Telnet clients can share access to the same virtual console. To connect to a console, use Telnet to connect port 2301 of the partition that is sharing its resources. TCP/IP must be configured and running on at least one i5/OS logical partition. Perform one of the following procedures:

- If you use IBM Personal Communications, connect to a virtual console using IBM Personal Communications.
  1. Click Start → IBM Personal Communications → Start or Configure Session.
  2. From the Customize Communication window, select ASCII as your type of host and select Link Parameters.
  3. From the Telnet ASCII window, enter the host name or the IP address of the partition that is sharing its resources, and enter port number 2301 of the partition sharing its resources. Click OK.
  4. If you are not using an Integrated xSeries Server, go to the next step. If you are using both Linux partitions and Integrated xSeries Server consoles, select i5/OS Guest Partition Consoles from the i5/OS Virtual Consoles window.
  5. From the i5/OS Guest Partition Consoles window, select the logical partition to which you want to connect as the console.
  6. Enter the i5/OS service tools ID and password to connect to the Linux logical partition.
- If you use Telnet, connect to the virtual console using Telnet from an MS-DOS command prompt.
  1. From an MS-DOS command prompt, use the Telnet command to connect to your server and port 2301 (telnet $xx$xx 2301).
  2. If you are not using an Integrated xSeries Server, go to the next step. If you are using both Linux partitions and Integrated xSeries Server consoles, select i5/OS Guest Partition Consoles from the i5/OS Virtual Consoles window.
  3. From the i5/OS Guest Partition Consoles window, select the logical partition to which you want to connect as the console.
  4. Enter the i5/OS service tools ID and password to connect to the Linux logical partition.

Related tasks

"Creating a Linux logical partition using i5/OS virtual I/O resources" on page 233

IBM System i5 and eServer i5 models allow you to create a Linux logical partition that uses i5/OS virtual I/O resources. This allows you to maximize utilization of the physical hardware and simplify the backup procedure for your managed system.

Starting the network-server description for a Linux logical partition:

You can start the network-server description (NWSD) for a Linux logical partition that uses i5/OS resources to make the resources defined in the NWSD available to the Linux logical partition.

To start (vary on) the NWSD for a Linux logical partition, complete the following tasks:

1. If you use iSeries Navigator, start the NWSD using iSeries Navigator.
   a. Click Network → Windows Administration → Integrated xSeries Servers
   b. Right-click the name of the NWSD that you want to start.
   c. Click Start.
2. If you use the character-based interface, start the NWSD using a character-based interface:
   a. Type WRKCFSSTS *NWS and press Enter.
   b. Type 1 next to the NWSD that you want to start and press Enter.
Related tasks

“Creating a Linux logical partition using i5/OS virtual I/O resources” on page 232

IBM System i5 and eServer i5 models allow you to create a Linux logical partition that uses i5/OS virtual I/O resources. This allows you to maximize utilization of the physical hardware and simplify the backup procedure for your managed system.

“Unlinking virtual disk drives from a Linux logical partition” on page 119

By unlinking virtual disk drives (network-server storage spaces) from a Linux logical partition that uses i5/OS resources, you disconnect the virtual disk drives from the logical partition, making the virtual disk drives inaccessible to users. If you delete a Linux logical partition that uses i5/OS resources, you must unlink all virtual disk drives from the logical partition before you delete the logical partition.

Deleting a logical partition using version 6 or earlier of the HMC

You can use the Hardware Management Console to delete a logical partition and all of the partition profiles associated with the logical partition.

To delete a logical partition, you must be a super administrator or operator. For more information about user roles, refer to Tasks and roles.

You cannot delete a logical partition if it is the service partition of your managed system. Before you can delete such a logical partition, you must designate another logical partition as the service partition of your managed system or remove the service partition designation from the logical partition. For more information, see Designating the service partition for your managed system.

Attention: This procedure erases the logical partition and the logical partition configuration data stored on the partition profiles.

To delete a logical partition using version 6 or earlier of the HMC, follow these steps:

1. In the navigation area, open Server and Partition.
2. Select Server Management.
3. In the contents area, open the server on which the logical partition that you want to delete is located.
4. Open Partitions.
5. Ensure the logical partition you want to delete is powered off.
6. Right-click the logical partition and select Delete.
7. Click Yes to confirm.
Related tasks

“Designating the service partition for your managed system using version 6 or earlier of the HMC” on page 225

The service partition is the i5/OS logical partition on an IBM System i5 or eServer i5 server that you can configure to apply server firmware updates to the service processor or to the hypervisor and to communicate server common hardware errors to IBM. These abilities are useful if the Hardware Management Console (HMC) is undergoing maintenance or is otherwise unable to perform these functions.

“Deploying a system plan by using the HMC Version 6” on page 204

You can use the Hardware Management Console (HMC) to deploy all or part of a system plan to a managed system.

Related information

Tasks and roles

Reseting the managed system to a nonpartitioned configuration using version 6 or earlier of the HMC

You can erase all of your logical partitions and reset the managed system to a nonpartitioned configuration. When you reset the managed system, all of the physical hardware resources are assigned to a single logical partition. This allows you to use the managed system as if it were a single, nonpartitioned server.

Attention: By resetting a partitioned managed system to a nonpartitioned configuration, you will lose all of your logical partition configuration data. However, resetting the managed system does not erase the operating systems and data from disk units on that managed system.

Before you reset the managed system, ensure that the hardware placement in the managed system supports a nonpartitioned configuration. If the hardware placement in the managed system does not support a nonpartitioned configuration, you must move the hardware so that the hardware placement supports a nonpartitioned configuration. For more information about how to place the hardware in your managed system to support a nonpartitioned configuration, contact your marketing representative or business partner.

Also, if you plan to use an operating system that is already installed on one of the logical partitions on the managed system (instead of reinstalling the operating system after you reset the managed system), consider how the console used by that operating system will change when you reset the managed system.

• If the operating system that you want to use is AIX, log into AIX and enable the login prompt for the virtual serial port vty0 using either SMIT or the chdev command. You can then reset the managed system, use a physical serial console to log into AIX, and use SMIT or chcons to change the console device to the console device you want to use.

• If the operating system that you want to use is i5/OS, the device tagging that you set up on the HMC no longer applies after you disconnect the HMC. Before you reset the managed system, switch the console setting to the device that you want to use.

To reset a partitioned managed system to a nonpartitioned configuration using version 6 or earlier of the HMC, you must be a super administrator or operator. For more information about user roles, refer to Tasks and roles. You must also have an Advanced System Management Interface (ASMI) login profile with an administrator authority level.

To reset a partitioned managed system to a nonpartitioned configuration using version 6 or earlier of the HMC, follow these steps:

1. Shut down all logical partitions on your managed system using operating system procedures. For more information about shutting down logical partitions using operating system procedures, see the following information:
• For logical partitions running AIX, see Shutting down AIX in a logical partition.
• For logical partitions running i5/OS, see Shutting down i5/OS logical partitions.
• For logical partitions running Linux, see Using the Hardware Management Console to shut down Linux logical partitions.

2. If the managed system powered off automatically when you shut down the last logical partition, power on the managed system to the **Standby** state. Complete the following:
   a. In the contents area of your HMC, right-click the managed system and choose **Power On**.
   b. Select the power-on mode of **Partition Standby** and click **OK**.
   c. Wait until the contents area displays a **Standby** state for the managed system.

3. Initialize the profile data on the HMC. Complete the following:
   a. In the contents area, right-click on the managed system, choose **Profile Data → Initialize**.
   b. Click **Yes** to confirm.

4. Clear the partition configuration data on the managed system. Complete the following:
   a. On your HMC desktop (outside of any of the displayed windows), right-click **Terminal → rshterm**. The Restricted shell command line interface displays.
   b. Type the command: `lpcfgop -m managed_system_name -o clear`. In this command, `managed_system_name` is the name of the managed system as it displays in the content area.
   c. Enter 1 to confirm. This step will take several seconds to complete.

5. Optional: If you no longer intend to manage the system using the HMC, remove the connection between the HMC and the managed system. To remove the connection between the HMC and the managed system, complete the following:
   a. In the contents area, right-click on the managed system.
   b. From the menu, click **Reset or Remove Connection**.
   c. Select **Remove connection** and click **OK**.

6. Access the Advanced System Management Interface (ASMI) using a Web browser on a PC. If you do not already have a PC that is set up to access the ASMI on the managed system, you will need to set up the PC at this point. For more information on accessing ASMI, see Accessing the ASMI using a Web browser.

7. On the ASMI Welcome pane, log in using the admin user ID (enter `admin` into **User ID**, enter the admin password into **Password**, and click **Log In**).

8. In the navigation area, expand **Power/Restart Control** and click **Power On/Off System**.

9. Set **Boot to server firmware** to **Running**.

10. Click **Save settings and power off**.

11. Click **Power On/Off System** periodically to refresh the window. Repeat this step until **Current system power state: Off** is displayed in the navigation area.

12. Click **Save settings and power on**.

13. Wait for the managed system to restart. It can take several minutes for the managed system and operating system to restart completely.
Related concepts
“Manufacturing default configuration” on page 17
The manufacturing default configuration is the initial partition setup of the managed system as received from your service provider.

Related information
Tasks and roles
Accessing the ASMI using a Web browser
Shutting down AIX using the HMC
Shutting down Linux using the HMC

Managing i5/OS logical partitions
You can manage the configuration of your i5/OS logical partitions using the Hardware Management Console (HMC). The HMC allows you to adjust the hardware resources that are used by each logical partition.

Managing partition profiles for logical partitions
You can manage the partition profiles for your logical partitions using the Hardware Management Console (HMC). This allows you to change the resource specifications stored in your partition profiles as your needs change.

Activating a logical partition using the HMC:

You must activate a logical partition before you can use the logical partition. When you activate a logical partition, the system commits resources to the logical partition and starts the operating system or software that is installed on the logical partition.

To activate a logical partition, you must be a super administrator, operator, or product engineer. For more information about user roles, refer to Tasks and roles.

When you activate a logical partition, you must select a partition profile. A partition profile is a record on the HMC that specifies a possible configuration for a logical partition.

To activate a logical partition using the HMC, follow these steps:
1. In the navigation area, open Server and Partition.
2. Select Server Management.
3. In the contents area, open the system on which the logical partition is located.
4. Open Partitions.
5. Right-click the logical partition and select Activate.
6. Select the partition profile that you want to use when activating the logical partition.
7. If you want the HMC to open a terminal window or console session for the logical partition when the logical partition is activated, select Open a terminal window or console session.
8. If you want to use a keylock position or boot mode that is different from the keylock position or boot mode specified in the partition profile, click Advanced, select the desired keylock position and boot mode, and click OK.
9. Click OK.

Related information
Tasks and roles

Changing partition profile properties using version 6 or earlier of the HMC:
You can change the properties of a partition profile using the Hardware Management Console (HMC). Changing the properties of a partition profile will change the resource amounts that are assigned to a logical partition when you shut down and restart the logical partition using the changed partition profile.

To change partition profile properties using version 6 or earlier of the HMC, you must be a super administrator, service representative, operator, or product engineer. For more information about user roles, refer to Tasks and roles.

A partition profile stores the required number of processors, memory, and hardware resources assigned to that profile. Any partition profile property changes will not be applied to the logical partition until the partition profile has been activated.

To change partition profile properties using version 6 or earlier of the HMC, follow these steps:
1. In the navigation area, open Server and Partition.
2. Select Server Management.
3. In the contents area, open the managed system on which the partition profile is located.
4. Open Partitions.
5. Open the logical partition for the partition profile.
6. Right-click the partition profile and select Properties.
7. Make the appropriate changes and click OK.
Related concepts

“Dynamically managing 5250 CPW for i5/OS logical partitions using version 6 or earlier of the HMC” on page 244
Add, remove, and move 5250 commercial processing workload (5250 CPW) dynamically from one running logical partition to another using the Hardware Management Console (HMC).

“Managing physical I/O devices and slots dynamically using version 6 or earlier of the HMC” on page 246
You can add, remove, and move physical I/O devices and slots dynamically from one running logical partition to another using the Hardware Management Console (HMC). This allows logical partitions to share infrequently used I/O devices (such as optical disc drives).

“Managing memory dynamically using version 6 or earlier of the HMC” on page 249
You can add, remove, and move memory dynamically from one running logical partition to another using the Hardware Management Console (HMC). This allows you to adjust the memory allocated to each logical partition without having to shut down the logical partitions.

“Managing processor resources dynamically using version 6 or earlier of the HMC” on page 252
You can add, remove, and move processor resources dynamically from one running logical partition to another using the Hardware Management Console (HMC). This allows you to adjust the processor resources allocated to each logical partition without having to shut down the logical partitions.

“High-Speed link (HSL) OptiConnect for i5/OS logical partitions” on page 60
The High-Speed link (HSL) OptiConnect feature provides high-speed system-to-system communication between managed systems.

“Virtual OptiConnect for i5/OS logical partitions” on page 61
The virtual OptiConnect feature provides high-speed interpartition communication within a managed system. The Virtual OptiConnect feature emulates external OptiConnect hardware by providing a virtual bus between logical partitions.

Related tasks

“Configuring a virtual Ethernet adapter using version 6 or earlier of the HMC” on page 224
You can configure a virtual Ethernet adapter dynamically for a running logical partition. Doing so will connect the logical partition to a virtual LAN.

“Installing new hardware for i5/OS logical partitions” on page 123
You can install an I/O processor (IOP) or an I/O adapter (IOA) for an i5/OS logical partition.

“Saving the partition configuration to a partition profile” on page 256
Use this procedure to save the current configuration of a logical partition to a new partition profile using a Hardware Management Console (HMC). Use this procedure if you change the configuration of a logical partition using dynamic logical partitioning and you do not want to lose the changes when you reactivate the logical partition. This procedure allows you to save the changed configuration to a new partition profile instead of having to enter the changed resource allocations manually.

Related information

Tasks and roles

Deleting a partition profile using version 6 or earlier of the HMC:

You can delete a partition profile using the Hardware Management Console (HMC). This allows you to remove partition profiles that you no longer use.

To delete a partition profile using version 6 or earlier of the HMC, you must be a super administrator or an operator. For more information about the role of a super administrator and operator, refer to Tasks and roles.

Note: You cannot delete a partition profile that is the default partition profile for the logical partition. If the partition profile you want to delete is the default partition profile, you must first change the default profile to another partition profile.
To delete a partition profile using version 6 or earlier of the HMC, follow these steps:
1. In the navigation area, open Server and Partition.
2. Select Server Management.
3. In the contents area, open the managed system on which the partition profile is located.
4. Open Partitions.
5. Open the logical partition for the partition profile.
6. Right-click the partition profile and select Delete.
7. Click OK to confirm.

Related information
Tasks and roles

Managing system profiles
You can managed the system profiles on your managed system using the Hardware Management Console (HMC). This allows you to change the logical partitions and partition profiles specified within the system profiles as the logical partitions change on your managed system.

Activating a system profile using version 6 or earlier of the HMC:

You can activate many logical partitions at a time by activating a system profile using the HMC.

To activate a system profile using version 6 or earlier of the HMC, you must be a super administrator, operator, or product engineer. For more information about user roles, refer to Tasks and roles.

A system profile is an ordered list of partition profiles. When you activate a system profile, the managed system attempts to activate the partition profiles in order. A system profile helps you activate or change the managed system from one complete set of logical partition configurations to another.

To activate a system profile using version 6 or earlier of the HMC, follow these steps:
1. In the navigation area, open Server and Partition.
2. Select Server Management.
3. In the contents area, open the server on which the system profile is located.
4. Open System Profiles.
5. Right-click the system profile and select Activate. Optionally, you may set the activation settings for your system profile.
6. Click Continue.

Related information
Tasks and roles

Deleting a system profile using version 6 or earlier of the HMC:

You can delete a system profile using the Hardware Management Console (HMC). This allows you to remove system profiles that you no longer use.

To delete a system profile using version 6 or earlier of the HMC, you must be a super administrator or an operator. For more information about the role of a super administrator and operator, refer to Tasks and roles.

A system profile helps you activate or change the managed system from one complete set of logical partition configurations to another.

To delete a system profile using version 6 or earlier of the HMC, follow these steps:
1. In the navigation area, open Server and Partition.
2. Select Server Management.
3. In the contents area, open the managed system on which the system profile is located.
4. Right-click the system profile and select Delete.
5. Click Yes to confirm.

Related information

**Tasks and roles**

**Dynamically managing logical partition resources**

You can add, remove, or move processor, memory, and I/O resources between running logical partitions without restarting the logical partitions or the managed system.

Dynamic resource management is used only for running logical partitions. If a logical partition is not running, you cannot add resources to that logical partition dynamically or remove resources from that logical partition dynamically. Also, if you shut down a logical partition, you cannot move resources dynamically to or from that logical partition. (However, the resources that were used by that logical partition can be added dynamically to running logical partitions.) You can change the resource allocations for an idle logical partition by changing the properties of the partition profiles used by that logical partition. When you start the logical partition using one of the changed partition profiles, the managed system applies the changes to the logical partition.

**Dynamically managing 5250 CPW for i5/OS logical partitions using version 6 or earlier of the HMC:**

Add, remove, and move 5250 commercial processing workload (5250 CPW) dynamically from one running logical partition to another using the Hardware Management Console (HMC).

5250 CPW is the capacity to perform 5250 online transaction processing (5250 OLTP) tasks on i5/OS logical partitions. Certain IBM System i5 and eServer i5 models allow you to assign a percentage of the total 5250 CPW available on the managed system to each i5/OS logical partition. The ability to assign 5250 CPW to i5/OS logical partitions is available only for Express Configurations and Value Editions.

5250 CPW can be moved based on the desired, minimum, and maximum percentages you created for the partition profile. The desired 5250 CPW percentage you establish is the amount of 5250 CPW that you get if you do not overcommit the available 5250 CPW. The minimum and maximum values enable you to establish a range within which you can dynamically move the 5250 CPW.

**Attention:** If resources are moved dynamically, the configuration change is temporary and is not reflected in the partition profile. This means that all configuration changes will be lost the next time the partition profile is activated. If you want to save your new partition configuration, you should change the partition profile. For more information on changing the partition profile properties, see Changing partition profile properties using version 6 or earlier of the HMC.

**Related tasks**

- "Changing partition profile properties using version 6 or earlier of the HMC" on page 240
  You can change the properties of a partition profile using the Hardware Management Console (HMC). Changing the properties of a partition profile will change the resource amounts that are assigned to a logical partition when you shut down and restart the logical partition using the changed partition profile.
- "Saving the partition configuration to a partition profile" on page 256
  Use this procedure to save the current configuration of a logical partition to a new partition profile using a Hardware Management Console (HMC). Use this procedure if you change the configuration of a logical partition using dynamic logical partitioning and you do not want to lose the changes when you reactivate the logical partition. This procedure allows you to save the changed configuration to a new partition profile instead of having to enter the changed resource allocations manually.

Dynamically adding 5250 CPW for i5/OS logical partitions using version 6 or earlier of the HMC:
You can add 5250 commercial processing workload (5250 CPW) to a running i5/OS logical partition using the Hardware Management Console (HMC). This allows you to increase the ability of the i5/OS logical partition to run 5250 online transaction processing (5250 OLTP) tasks.

This procedure applies only to IBM System i5 and eServer i5 Express Configurations and Value Editions, which provide a fixed amount of processing capability for 5250 OLTP tasks.

To add 5250 CPW dynamically to a running logical partition using version 6 or earlier of the HMC, you must be a super administrator, service representative, product engineer, or operator. For more information about user roles, refer to Tasks and roles.

To add 5250 CPW to a running i5/OS logical partition using version 6 or earlier of the HMC, follow these steps:

1. In the navigation area, open Server and Partition.
2. Select Server Management.
3. In the contents area, open the managed system on which the logical partition resides.
4. Open Partitions.
5. Right-click the logical partition and select Dynamic Logical Partitioning → Processor Resources → Add.
6. Specify the 5250 CPW percentage that you want the logical partition to use.
7. Click Advanced and adjust the settings there. You might need to increase the value in the Timeout setting field to allow enough time for the HMC to complete the operation. (These settings relate to how the managed system adds the 5250 CPW dynamically. These settings are not retained after the change is completed.)
8. Click OK.

Related information

Tasks and roles

Dynamically removing 5250 CPW for i5/OS logical partitions using version 6 or earlier of the HMC:

You can remove 5250 commercial processing workload (5250 CPW) dynamically from a running i5/OS logical partition using the Hardware Management Console (HMC). This allows you to make 5250 CPW available for assignment to other i5/OS logical partitions on the managed system.

This procedure applies only to IBM System i5 and eServer i5 Express Configurations and Value Editions, which provide a fixed amount of processing capability for 5250 online transaction processing (5250 OLTP) tasks.

To remove 5250 CPW dynamically from a running logical partition using version 6 or earlier of the HMC, you must be a super administrator, service representative, product engineer, or operator. For more information about user roles, refer to Tasks and roles.

To remove 5250 CPW from a running i5/OS logical partition using version 6 or earlier of the HMC, follow these steps:

1. In the navigation area, open Server and Partition.
2. Select Server Management.
3. In the contents area, open the managed system on which the logical partition resides.
4. Open Partitions.
5. Right-click the logical partition and select Dynamic Logical Partitioning → Processor Resources → Remove.
6. Specify the 5250 CPW percentage that you want the logical partition to use.
7. Click Advanced and adjust the settings there. You might need to increase the value in the Timeout setting field to allow enough time for the HMC to complete the operation. (These settings relate to how the managed system removes the 5250 CPW dynamically. These settings are not retained after the change is completed.)

8. Click OK.

Related information

Tasks and roles

Dynamically moving 5250 CPW for i5/OS logical partitions using version 6 or earlier of the HMC:

You can move 5250 commercial processing workload (5250 CPW) from one running i5/OS logical partition to another using the Hardware Management Console (HMC). This allows you to use the limited amount of 5250 CPW that is available on your managed system efficiently.

This procedure applies only to IBM System i5 and eServer i5 Express Configurations and Value Editions, which provide a fixed amount of processing capability for 5250 online transaction processing (5250 OLTP) tasks.

To remove 5250 CPW dynamically from a running logical partition using version 6 or earlier of the HMC, you must be a super administrator, service representative, product engineer, or operator. For more information about user roles, refer to Tasks and roles.

To move 5250 CPW from one running i5/OS logical partition to another using version 6 or earlier of the HMC, follow these steps:

1. In the navigation area, open Server and Partition.
2. Select Server Management.
3. In the contents area, open the managed system on which the logical partition resides.
4. Open Partitions.
5. Right-click the logical partition and select Dynamic Logical Partitioning → Processor Resources → Move.
6. Specify the 5250 CPW percentage that you want the logical partition to use.
7. Click Advanced and adjust the settings there. You might need to increase the value in the Timeout setting field to allow enough time for the HMC to complete the operation. (These settings relate to how the managed system changes the 5250 CPW percentage dynamically. These settings are not retained after the change is completed.)
8. Click OK.

Related information

Tasks and roles

Managing physical I/O devices and slots dynamically using version 6 or earlier of the HMC:

You can add, remove, and move physical I/O devices and slots dynamically from one running logical partition to another using the Hardware Management Console (HMC). This allows logical partitions to share infrequently used I/O devices (such as optical disc drives).

Logical partitions can have desired or required I/O devices or slots. When you specify that an I/O device or slot is desired (or shared), this means either that the I/O device or slot is meant to be shared with other logical partitions, or that the I/O device or slot is optional. When you specify that an I/O device or slot is required (or dedicated), then you cannot activate the logical partition if the I/O device or slot is unavailable or in use by another logical partition.

Note: If resources are moved dynamically, the configuration change is temporary and is not reflected in the partition profile. This means that all configuration changes will be lost the next time the partition
If you want to save your new partition configuration, you should change the partition profile. For more information on changing the partition profile properties, see Changing partition profile properties using version 6 or earlier of the HMC.

Related tasks

Changing partition profile properties using version 6 or earlier of the HMC
You can change the properties of a partition profile using the Hardware Management Console (HMC). Changing the properties of a partition profile will change the resource amounts that are assigned to a logical partition when you shut down and restart the logical partition using the changed partition profile.

Saving the partition configuration to a partition profile
Use this procedure to save the current configuration of a logical partition to a new partition profile using a Hardware Management Console (HMC). Use this procedure if you change the configuration of a logical partition using dynamic logical partitioning and you do not want to lose the changes when you reactivate the logical partition. This procedure allows you to save the changed configuration to a new partition profile instead of having to enter the changed resource allocations manually.

Installing new hardware for i5/OS logical partitions
You can install an I/O processor (IOP) or an I/O adapter (IOA) for an i5/OS logical partition.

Adding physical I/O devices and slots dynamically using version 6 or earlier of the HMC:

You can add a physical I/O slot (and the adapter and devices that are connected to that slot) to a running logical partition using version 6 or earlier of the Hardware Management Console (HMC). This allows you to add I/O capabilities to a running logical partition without having to shut down the logical partition.

A Linux logical partition supports the dynamic addition of physical I/O slots only if the following conditions are met:

- A Linux distribution that supports dynamic logical partitioning is installed on the Linux logical partition. Distributions that support dynamic logical partitioning include Red Hat Enterprise Linux version 4, SUSE Linux Enterprise Server 9, and later versions of these distributions.
- The DynamicRM tool package is installed on the Linux logical partition. For more information on the DynamicRM tool package, see the Service and productivity tools Web site.

To add a physical I/O slot dynamically to a running logical partition using version 6 or earlier of the HMC, you must be a super administrator, service representative, product engineer, or operator. For more information about user roles, refer to Tasks and roles.

To add a physical I/O slot to a running logical partition using version 6 or earlier of the HMC, follow these steps:

1. In the navigation area, open Server and Partition.
2. Select Server Management.
3. In the contents area, open the managed system on which the logical partition resides.
4. Open Partitions.
5. Right-click the logical partition and select Dynamic Logical Partitioning → Adapter Resources → Add.
6. In the Current area, open the unit on which the physical I/O slot resides, open the planar on which the physical I/O slot resides, and select the line corresponding to the physical I/O slot.
7. Select the I/O pool for the physical I/O slot (if any).
8. Click Advanced and adjust the settings there. You might need to increase the value in the Timeout setting field to allow enough time for the HMC to complete the operation. (These settings relate to how the managed system adds the physical I/O device or slot dynamically. These settings are not retained after the change is completed.)
9. Click OK.
Removing physical I/O devices and slots dynamically using version 6 or earlier of the HMC:

You can remove a physical I/O slot and the adapter and devices that are connected to that slot dynamically from a running logical partition using version 6 or earlier of the Hardware Management Console (HMC). This allows you to reassign the physical I/O slot to other logical partitions.

Before you begin, vary off any devices that are attached to the managed system through the physical I/O slot that you want to remove. You can vary off devices using operating system commands.

Attention: The dynamic removal of a physical I/O slot that controls disk drives can cause unpredictable results, such as partition failure or loss of data.

A Linux logical partition supports the dynamic removal of physical I/O slots only if the following conditions are met:

- A Linux distribution that supports dynamic logical partitioning is installed on the Linux logical partition. Distributions that support dynamic logical partitioning include Red Hat Enterprise Linux version 4, SUSE Linux Enterprise Server 9, and later versions of these distributions.
- The DynamicRM tool package is installed on the Linux logical partition. For more information on the DynamicRM tool package, see the Service and productivity tools Web site.

To remove a physical I/O slot dynamically from a running logical partition using version 6 or earlier of the HMC, you must be a super administrator, service representative, product engineer, or operator. For more information about user roles, refer to Tasks and roles.

To remove a physical I/O slot dynamically from a running logical partition using version 6 or earlier of the HMC, follow these steps:

1. In the navigation area, open Server and Partition.
2. Select Server Management.
3. In the contents area, open the managed system on which the logical partition resides.
4. Open Partitions.
5. Right-click the logical partition and select Dynamic Logical Partitioning → Adapter Resources → Remove.
6. In the Current area, open the unit on which the physical I/O slot resides, open the planar on which the physical I/O slot resides, and select the line corresponding to the physical I/O slot.
7. Click Advanced and adjust the settings there. You might need to increase the value in the Timeout setting field to allow enough time for the HMC to complete the operation. (These settings relate to how the managed system removes the physical I/O slot dynamically. These settings are not retained after the removal is completed.)
8. Ensure that any devices that are attached to the managed system through the physical I/O slot that you want to remove are not busy. The devices should be varied off.
9. Click OK.

Related information

Tasks and roles
Service and productivity tools Web site

Moving physical I/O devices and slots dynamically using version 6 or earlier of the HMC:
You can move a physical I/O slot (and the adapter and devices that are connected to that slot) from one running logical partition to another using version 6 or earlier of the Hardware Management Console (HMC). This allows you to share a physical I/O device such as a DVD drive among many logical partitions.

Before you begin, vary off any devices that are attached to the managed system through the physical I/O slot that you want to move. You can vary off devices using operating system commands.

**Attention:** The dynamic movement of a physical I/O slot that controls disk drives can cause unpredictable results, such as partition failure or loss of data.

A Linux logical partition supports the dynamic movement of physical I/O slots only if the following conditions are met:

- A Linux distribution that supports dynamic logical partitioning is installed on the Linux logical partition. Distributions that support dynamic logical partitioning include Red Hat Enterprise Linux version 4, SUSE Linux Enterprise Server 9, and later versions of these distributions.
- The DynamicRM tool package is installed on the Linux logical partition. For more information on the DynamicRM tool package, see the Service and productivity tools Web site.

To move a physical I/O slot dynamically from one running logical partition to another using version 6 or earlier of the HMC, you must be a super administrator, service representative, product engineer, or operator. For more information about user roles, refer to Tasks and roles.

To move a physical I/O slot dynamically from one running logical partition to another using version 6 or earlier of the HMC, follow these steps:

1. In the navigation area, open **Server and Partition**.
2. Select **Server Management**.
3. In the contents area, open the managed system on which the logical partitions reside.
4. Open **Partitions**.
5. Right-click the logical partition from which you want to move the physical I/O slot and select **Dynamic Logical Partitioning -> Adapter Resources -> Move**.
6. In the **Current** area, open the unit on which the physical I/O slot resides, open the planar on which the physical I/O slot resides, and select the line corresponding to the physical I/O slot.
7. In **Logical Partition**, select the logical partition to which you want to move the physical I/O slot.
8. Click **Advanced** and adjust the settings there. You might need to increase the value in the **Timeout setting** field to allow enough time for the HMC to complete the operation. (These settings relate to how the managed system moves the physical I/O slot dynamically. These settings are not retained after the move is completed.)
9. Ensure that any devices that are attached to the managed system through the physical I/O slot that you want to move are not busy. The devices should be varied off.
10. Click **OK**.

**Related information**

- [Tasks and roles](http://www.ibm.com)
- [Service and productivity tools Web site](http://www.ibm.com)

**Managing memory dynamically using version 6 or earlier of the HMC:**

You can add, remove, and move memory dynamically from one running logical partition to another using the Hardware Management Console (HMC). This allows you to adjust the memory allocated to each logical partition without having to shut down the logical partitions.
Dynamic memory changes on i5/OS logical partitions affect the base memory pool of the logical partitions (*BASE pool). Private memory pools or shared memory pools are not affected. Dynamic memory changes cannot cause the amount of memory in the base pool to fall below the minimum amount of memory required in the base pool (as determined by the base storage minimum size (QBASPOOL) system value). If a dynamic memory change would cause the base pool to fall below this amount, the system releases excess memory pages only after keeping the minimum amount of memory required in the base pool.

To prevent any data loss during dynamic memory movement, the system first writes any data from memory pages to the disks before making the memory pages available to another partition. Depending on the amount of memory you have requested to move, this might take some time.

Memory in each logical partition operates within its assigned minimum and maximum values. The full amount of memory that you assign to a logical partition might not be available for the logical partition to use. Static memory overhead that is required to support the assigned maximum memory affects the reserved or hidden memory amount. This static memory overhead also influences the minimum memory size of a partition.

Note: If resources are moved dynamically, the configuration change is temporary and is not reflected in the partition profile. This means that all configuration changes will be lost the next time the partition profile is activated. If you want to save your new partition configuration, you should change the partition profile. For more information on changing the partition profile properties, see Changing partition profile properties using version 6 or earlier of the HMC.

Related tasks
“Changing partition profile properties using version 6 or earlier of the HMC” on page 240
You can change the properties of a partition profile using the Hardware Management Console (HMC). Changing the properties of a partition profile will change the resource amounts that are assigned to a logical partition when you shut down and restart the logical partition using the changed partition profile.

“Saving the partition configuration to a partition profile” on page 256
Use this procedure to save the current configuration of a logical partition to a new partition profile using a Hardware Management Console (HMC). Use this procedure if you change the configuration of a logical partition using dynamic logical partitioning and you do not want to lose the changes when you reactivate the logical partition. This procedure allows you to save the changed configuration to a new partition profile instead of having to enter the changed resource allocations manually.

Adding memory dynamically using version 6 or earlier of the HMC:

You can add memory dynamically to a running AIX, i5/OS, or Virtual I/O Server logical partition using the Hardware Management Console (HMC). This allows you to increase the memory available to a logical partition without having to shut down the logical partition.

You cannot add memory dynamically to a running Linux logical partition. To add memory to a Linux logical partition, you must shut down the logical partition and reactivate the logical partition using a partition profile that specifies a greater amount of memory.

To add memory dynamically to a running logical partition using version 6 or earlier of the HMC, you must be a super administrator, service representative, product engineer, or operator. For more information about user roles, refer to Tasks and roles.

To add memory dynamically to a running logical partition using version 6 or earlier of the HMC, follow these steps:
1. In the navigation area, open Server and Partition.
2. Select Server Management.
3. In the contents area, open the managed system on which the logical partitions are located.
4. Open Partitions.

5. Right-click the logical partition to which you want to add memory and select Dynamic Logical Partitioning → Memory Resources → Add.

6. Specify the amount of memory you want to add.

7. Click Advanced and adjust the settings there. You might need to increase the value in the Timeout setting (minutes) field to allow enough time for the HMC to complete the operation. (These settings relate to how the managed system adds the memory dynamically. These settings are not retained after the addition is completed.)

8. Click OK.

Related information
Tasks and roles

**Removing memory dynamically using version 6 or earlier of the HMC:**

You can remove memory dynamically from a running AIX, i5/OS, or Virtual I/O Server logical partition using the Hardware Management Console (HMC). This allows you to reassign the memory to other logical partitions.

You cannot remove memory dynamically from a running Linux logical partition. To remove memory from a Linux logical partition, you must shut down the logical partition and reactivate the logical partition using a partition profile that specifies a lesser amount of memory.

To remove memory dynamically from a running logical partition using version 6 or earlier of the HMC, you must be a super administrator, service representative, product engineer, or operator. For more information about user roles, refer to Tasks and roles.

To remove memory dynamically from a running logical partition using version 6 or earlier of the HMC, follow these steps:

1. In the navigation area, open Server and Partition.
2. Select Server Management.
3. In the contents area, open the managed system on which the logical partition resides.
4. Open Partitions.
5. Right-click the logical partition and select Dynamic Logical Partitioning → Memory Resources → Remove.
6. Specify the amount of memory you want to remove.
7. Click Advanced and adjust the settings there. You might need to increase the value in the Timeout setting field to allow enough time for the HMC to complete the operation. (These settings relate to how the managed system removes the memory dynamically. These settings are not retained after the removal is completed.)

8. Click OK.

Related information
Tasks and roles

**Moving memory dynamically using version 6 or earlier of the HMC:**

You can move memory dynamically from one running AIX, i5/OS, or Virtual I/O Server logical partition to another using the Hardware Management Console (HMC). This allows you to reassign memory directly to a logical partition that needs additional memory.

You cannot move memory dynamically to or from a running Linux logical partition. To add memory to a Linux logical partition, you must shut down the logical partition and reactivate the logical partition using...
a partition profile that specifies a greater amount of memory. To remove memory from a Linux logical partition, you must shut down the logical partition and reactivate the logical partition using a partition profile that specifies a lesser amount of memory.

To move memory dynamically from one running logical partition to another using version 6 or earlier of the HMC, you must be a super administrator, service representative, product engineer, or operator. For more information about user roles, refer to Tasks and roles.

To move memory from one running logical partition to another using version 6 or earlier of the HMC, follow these steps:
1. In the navigation area, open Server and Partition.
2. Select Server Management.
3. In the contents area, open the managed system on which the logical partitions are located.
4. Open Partitions.
5. Right-click the logical partition that is currently using the memory that you want to move, and select Dynamic Logical Partitioning → Memory Resources → Move.
6. Specify the amount of memory you want to move and the logical partition to which you want to move the memory.
7. Click Advanced and adjust the settings there. You might need to increase the value in the Timeout setting field to allow enough time for the HMC to complete the operation. (These settings relate to how the managed system moves the memory dynamically. These settings are not retained after the move is completed.)
8. Click OK.

Related information
Tasks and roles

Managing processor resources dynamically using version 6 or earlier of the HMC:

You can add, remove, and move processor resources dynamically from one running logical partition to another using the Hardware Management Console (HMC). This allows you to adjust the processor resources allocated to each logical partition without having to shut down the logical partitions.

The ability to move processor resources dynamically becomes important when you need to adjust to changing workloads. Processor resources can be moved based on the minimum and maximum values that you created for the partition profile. You can move processor resources as long as the processor resources for each logical partition remains within the range specified by the minimum and maximum values for the logical partition.

Note: If resources are moved dynamically, the configuration change is temporary and is not reflected in the partition profile. This means that all configuration changes will be lost the next time the partition profile is activated. If you want to save your new partition configuration, you should change the partition profile. For more information on changing the partition profile properties, see Changing partition profile properties using version 6 or earlier of the HMC.
Related tasks

- "Changing partition profile properties using version 6 or earlier of the HMC" on page 240
  You can change the properties of a partition profile using the Hardware Management Console (HMC). Changing the properties of a partition profile will change the resource amounts that are assigned to a logical partition when you shut down and restart the logical partition using the changed partition profile.

- "Saving the partition configuration to a partition profile" on page 256
  Use this procedure to save the current configuration of a logical partition to a new partition profile using a Hardware Management Console (HMC). Use this procedure if you change the configuration of a logical partition using dynamic logical partitioning and you do not want to lose the changes when you reactivate the logical partition. This procedure allows you to save the changed configuration to a new partition profile instead of having to enter the changed resource allocations manually.

Adding processor resources dynamically using version 6 or earlier of the HMC:

You can add processor resources dynamically to a running logical partition using version 6 or earlier of the Hardware Management Console (HMC). This allows you to increase the processing capacity of a running logical partition without having to shut down the logical partition.

A Linux logical partition supports the dynamic addition of processor resources only if the following conditions are met:

- A Linux distribution that supports dynamic logical partitioning is installed on the Linux logical partition. Distributions that support dynamic logical partitioning include Red Hat Enterprise Linux version 4, SUSE Linux Enterprise Server 9, and later versions of these distributions.
- The DynamicRM tool package is installed on the Linux logical partition. For more information on the DynamicRM tool package, see the Service and productivity tools Web site.

To add processor resources dynamically to a running logical partition using version 6 or earlier of the HMC, you must be a super administrator, service representative, product engineer, or operator. For more information about user roles, refer to Tasks and roles.

To add processor resources dynamically to a running logical partition using version 6 or earlier of the HMC, follow these steps:

1. In the navigation area, open Server and Partition.
2. Select Server Management.
3. In the contents area, open the managed system on which the logical partition is located.
4. Open Partitions.
5. Right-click the logical partition to which you want to add processor resources and select Dynamic Logical Partitioning → Processor Resources → Add.
6. Specify the amount of processor resources you want to add. If the logical partition uses processors from the shared processor pool, you can change the sharing mode, uncapped weight, and number of virtual processors for the logical partition.
7. Click Advanced and adjust the settings there. You might need to increase the value in the Timeout setting field to allow enough time for the HMC to complete the operation. (These settings relate to how the managed system adds the processor resources dynamically. These settings are not retained after the addition is completed.)
8. Click OK.

Related information

- Tasks and roles
- Service and productivity tools Web site

Removing processor resources dynamically using version 6 or earlier of the HMC:
You can remove processor resources dynamically from a running logical partition using the Hardware Management Console (HMC). This allows you to reassign the processor resources to other logical partitions.

A Linux logical partition supports the dynamic removal of processor resources only if the following conditions are met:

- A Linux distribution that supports dynamic logical partitioning is installed on the Linux logical partition. Distributions that support dynamic logical partitioning include Red Hat Enterprise Linux version 4, SUSE Linux Enterprise Server 9, and later versions of these distributions.
- The DynamicRM tool package is installed on the Linux logical partition. For more information on the DynamicRM tool package, see the Service and productivity tools Web site.

To remove processor resources dynamically from a running logical partition using version 6 or earlier of the HMC, you must be a super administrator, service representative, product engineer, or operator. For more information about user roles, refer to Tasks and roles.

To remove processor resources dynamically from a running logical partition using version 6 or earlier of the HMC, follow these steps:

1. In the navigation area, open Server and Partition.
2. Select Server Management.
3. In the contents area, open the managed system on which the logical partitions are located.
4. Open Partitions.
5. Right-click the logical partition that is currently using the processor resources that you want to remove, and select Dynamic Logical Partitioning → Processor Resources → Remove.
6. Specify the amount of processor resources you want to remove. If the logical partition uses processors from the shared processing pool, you can change the logical partition’s sharing mode, uncapped weight, and number of virtual processors.
7. Click Advanced and adjust the settings there. You might need to increase the value in the Timeout setting field to allow enough time for the HMC to complete the operation. (These settings relate to how the managed system removes the processor resources dynamically. These settings are not retained after the removal is completed.)
8. Click OK.

Related information

- Tasks and roles
- Service and productivity tools Web site

Moving processor resources dynamically using version 6 or earlier of the HMC:

You can move processor resources from one running logical partition to another using version 6 or earlier of the Hardware Management Console (HMC). This allows you to reassign processor resources directly to a logical partition that needs additional processor resources.

A Linux logical partition supports the dynamic movement of processor resources only if the following conditions are met:

- A Linux distribution that supports dynamic logical partitioning is installed on the Linux logical partition. Distributions that support dynamic logical partitioning include Red Hat Enterprise Linux version 4, SUSE Linux Enterprise Server 9, and later versions of these distributions.
- The DynamicRM tool package is installed on the Linux logical partition. For more information on the DynamicRM tool package, see the Service and productivity tools Web site.
To move processor resources dynamically from one running logical partition to another using version 6 or earlier of the HMC, you must be a super administrator, service representative, product engineer, or operator. For more information about user roles, refer to Tasks and roles.

To move processor resources from one running logical partition to another using version 6 or earlier of the HMC, follow these steps:
1. In the navigation area, open Server and Partition.
2. Select Server Management.
3. In the contents area, open the managed system on which the logical partitions are located.
4. Open Partitions.
5. Right-click the logical partition that is currently using the processor resources that you want to move, and select Dynamic Logical Partitioning → Processor Resources → Move.
6. Specify the amount of processor resources that you want to move and the logical partition to which you want to move the processor resources. If either logical partition uses processing resources from the shared processor pool, you can change the sharing mode, uncapped weight, and number of virtual processors for the logical partition.
7. Click Advanced and adjust the settings there. You might need to increase the value in the Timeout setting field to allow enough time for the HMC to complete the operation. (These settings relate to how the managed system moves the processor resources dynamically. These settings are not retained after the move is completed.)
8. Click OK.

Related information
Tasks and roles

Scheduling the movement of resources to and from logical partitions using version 6 or earlier of the HMC:

You can schedule the movement of memory, dedicated processors, shared processors, and I/O devices between running logical partitions on a managed system. This allows you to move resources between running logical partitions without user intervention.

To schedule the movement of resources to and from running logical partitions on your managed system using version 6 or earlier of the HMC, you must be a member of the super administrator role or the operator role. For more information about user roles, refer to Tasks and roles.

To schedule the movement of resources to or from a running logical partition using version 6 or earlier of the HMC, follow these steps:
1. In the navigation area, open HMC Management.
2. Select HMC Configuration.
3. In the contents area, select Schedule Operations.
4. Select the logical partition for which you want to schedule the movement of resources and click OK. (If you want to schedule the movement of resources from one logical partition to another, select the logical partition from which you are moving resources.)
5. Select Options → New from the menu bar.
6. Select the logical partition for which you want to schedule the movement of resources, select Dynamic Reconfiguration, and click OK.
7. Select the date and time on which you want the movement to occur.
8. Select the Options tab and select the type of movement (Add, Remove, or Move to), the destination logical partition (if you are moving resources to another logical partition), the resource type (CPU or memory), and the quantity (in processors or in megabytes).
9. If you want the operation to be repeated, select the Repeat tab and specify how you want the operation to be repeated.

10. Click Save.

11. When the message dialog displays, click OK to continue.

When this procedure is completed, the managed system is set to perform the dynamic logical partitioning task at the date and time that you specify.

Related information

Tasks and roles

Saving the partition configuration to a partition profile:

Use this procedure to save the current configuration of a logical partition to a new partition profile using a Hardware Management Console (HMC). Use this procedure if you change the configuration of a logical partition using dynamic logical partitioning and you do not want to lose the changes when you reactivate the logical partition. This procedure allows you to save the changed configuration to a new partition profile instead of having to enter the changed resource allocations manually.

You can perform this procedure at any time after you initially activate a logical partition.

To save the current configuration of a logical partition to a new partition profile, you must be a super administrator, service representative, operator, or product engineer. For more information about user roles, refer to Tasks and roles.

You can perform this procedure on active logical partitions and on logical partitions that are shut down. In either of these cases, the HMC reads the partition configuration that is stored for the logical partition in the server firmware and saves this partition configuration to the specified partition profile. For active logical partitions, the partition configuration that is stored in the server firmware is the current partition configuration of the logical partition. For logical partitions that are shut down, the partition configuration that is stored in the server firmware is the partition configuration at the time that you shut down the logical partition. Regardless of the state of the logical partition at the time that you perform this procedure, the procedure allows you to save the dynamic logical partitioning changes to a partition profile and use the partition profile to reactivate the logical partition without losing those changes.

After you shut down a logical partition, other logical partitions can use the resources that were used by that logical partition when the logical partition was active. Therefore, the resources available on the managed system might not support the logical partition configuration that is stored in the server firmware for the inactive logical partition. After you save the partition configuration of a logical partition that is shut down, verify that the resources available on the managed system can support the logical partition configuration that you saved to a partition profile.

When you save the partition configuration to a new partition profile, the desired amounts of memory, processors, processing units, and virtual processors in the new partition profile are set to the current amounts from the partition configuration. The minimum and maximum amounts of memory, processors, processing units, and virtual processors in the new partition profile are set to the minimum and maximum amounts from the partition configuration. For example, you start a logical partition using a partition profile that specifies a minimum of 512 MB of memory, a maximum of 2 GB of memory, and 1 GB as the desired amount of memory. The managed system has over 1 GB of memory available, so the logical partition has 1 GB of memory when it starts. You then add 1 GB of memory to the logical partition for a total of 2 GB of memory. If you shut down the logical partition, and then save the partition configuration, the resulting partition profile specifies a minimum of 512 MB of memory, a maximum of 2 GB of memory, and 2 GB as the desired amount of memory. Likewise, if the model and edition feature of the managed system allow you to assign percentages of the 5250 CPW capability of the managed system...
to i5/OS logical partitions, the minimum, desired, and maximum percentage of 5250 CPW in the new partition profile are the minimum, current, and maximum percentages of 5250 CPW from the partition configuration.

The physical and virtual I/O devices that are set as required in the active partition profile are saved as required devices in the new partition profile. The physical and virtual I/O devices that are set as desired in the active partition profile or that were added to the logical partition through dynamic logical partitioning are saved as desired devices in the new partition profile. The partition workload group on the logical partition (if any) is saved as the partition workload group on the new partition profile.

To save the current configuration of a logical partition to a new partition profile, complete the following:
1. In the navigation area of the HMC, open the object with the same name as your HMC, open Server and Partition, and select Server Management.
2. In the contents area of the HMC, open the managed system, open Partitions, and right-click the logical partition whose configuration you want to save and select Save.
3. Enter the name of the new partition profile into New profile and click OK.

After you save the partition configuration to a new partition profile, verify that the new partition profile is set the way that you want. In particular, verify that the required and desired settings are set correctly for your I/O devices. By default, physical and virtual I/O devices that are added to the logical partition using dynamic logical partitioning are saved as desired devices in the new partition profile. If you want any of these I/O devices to be required, you must change the partition profile so that the I/O device is required. For more information on changing partition profiles, see Changing partition profile properties using version 6 or earlier of the HMC.
Related concepts

“Dynamically managing 5250 CPW for i5/OS logical partitions using version 6 or earlier of the HMC” on page 244
Add, remove, and move 5250 commercial processing workload (5250 CPW) dynamically from one running logical partition to another using the Hardware Management Console (HMC).

“Managing physical I/O devices and slots dynamically using version 6 or earlier of the HMC” on page 246
You can add, remove, and move physical I/O devices and slots dynamically from one running logical partition to another using the Hardware Management Console (HMC). This allows logical partitions to share infrequently used I/O devices (such as optical disc drives).

“Managing memory dynamically using version 6 or earlier of the HMC” on page 249
You can add, remove, and move memory dynamically from one running logical partition to another using the Hardware Management Console (HMC). This allows you to adjust the memory allocated to each logical partition without having to shut down the logical partitions.

“Managing processor resources dynamically using version 6 or earlier of the HMC” on page 252
You can add, remove, and move processor resources dynamically from one running logical partition to another using the Hardware Management Console (HMC). This allows you to adjust the processor resources allocated to each logical partition without having to shut down the logical partitions.

Related tasks

“Configuring a virtual Ethernet adapter using version 6 or earlier of the HMC” on page 224
You can configure a virtual Ethernet adapter dynamically for a running logical partition. Doing so will connect the logical partition to a virtual LAN.

“Changing partition profile properties using version 6 or earlier of the HMC” on page 240
You can change the properties of a partition profile using the Hardware Management Console (HMC). Changing the properties of a partition profile will change the resource amounts that are assigned to a logical partition when you shut down and restart the logical partition using the changed partition profile.

Related information

Tasks and roles

Managing partitions remotely
You can access your Hardware Management Console (HMC) remotely by installing the remote client on your personal computer (PC).

For more information about the remote client and how to install it, refer to Installing and uninstalling the remote client.

Installing new hardware for i5/OS logical partitions
You can install an I/O processor (IOP) or an I/O adapter (IOA) for an i5/OS logical partition.

When you install new hardware in an i5/OS partitioned environment, you should be aware of the following things:

- Verify that your logical partition configuration is current.
- Empty positions might not be owned by a logical partition. They should be assigned to the desired logical partition before installing new adapters in them. After you install the new adapter, you must also add the adapter to the partition profile so that, when you shut down and activate the logical partition using the partition profile, the logical partition reactivates with the adapter that you added.
- A new IOP or IOA is owned by the logical partition that owns the slot, and a new device is owned by the logical partition that owns the IOA to which the device is attached.
- New processors and memory are available (unassigned) to be assigned to any partition.
New 5250 commercial processing workload (5250 CPW) is assigned across i5/OS logical partitions by the percentage specified in the Create Partition Profile wizard. After an upgrade, ensure partitions are not assigned more 5250 CPW than they can use.

To install an IOP or IOA for an i5/OS logical partition, perform the following steps:
1. Assign empty slots to the desired logical partition. For more information about assigning an empty slot to a logical partition, see Managing physical I/O devices and slots dynamically using the HMC. For more information about adding an adapter to a partition profile, see Changing partition profile properties using the HMC.
2. Install the new hardware into the empty slots using the Installing features and replacing parts information.

Related concepts
“Managing physical I/O devices and slots dynamically using version 6 or earlier of the HMC” on page 246
You can add, remove, and move physical I/O devices and slots dynamically from one running logical partition to another using the Hardware Management Console (HMC). This allows logical partitions to share infrequently used I/O devices (such as optical disc drives).

Related tasks
“Changing partition profile properties using version 6 or earlier of the HMC” on page 240
You can change the properties of a partition profile using the Hardware Management Console (HMC). Changing the properties of a partition profile will change the resource amounts that are assigned to a logical partition when you shut down and restart the logical partition using the changed partition profile.

Related information
Installing features and replacing parts

Managing AIX logical partitions using i5/OS virtual I/O resources
i5/OS can provide virtual I/O resources to an AIX logical partition. These AIX logical partitions receive their I/O resources from the i5/OS logical partition.

Adding virtual disk units to an AIX logical partition:
You can add virtual disk units dynamically to an AIX logical partition that uses i5/OS resources. This allows you to increase the storage capacity of your AIX logical partition when needed.

Virtual disks simplify hardware configuration on the server because they do not require you to add additional physical devices to the server in order to run AIX. You can allocate up to 64 virtual disks to an AIX logical partition. Each virtual disk supports up to 1000 GB of storage. Each virtual disk appears to AIX as one actual disk unit. However, the associated space in the i5/OS integrated file system is distributed across the disks that belong to the i5/OS logical partition. Distributing storage across the disks provides the benefits of device parity protection through i5/OS. Therefore, you do not have to use additional processing resources and memory resources by setting up device parity protection through AIX.

i5/OS provides the ability to dynamically add virtual disks to an AIX logical partition. You can allocate disk space in the integrated file system and make it available to AIX without restarting the server or logical partition. The AIX administrator can also configure the newly allocated disk space and make it available without restarting the server.

To add virtual disks dynamically to an AIX logical partition, do the following:
1. If you use iSeries Navigator, create a network-server storage space using iSeries Navigator.
   a. Expand My Connections > your server > Network > Windows Administration.
   b. Right-click the Disk Drives and select New Disk.
c. In the **Disk drive name** field, specify the name that you want to give to the network-server storage space.

d. In the **Description** field, specify a meaningful description for the network-server storage space.

e. In the **Capacity** field, specify the size of the new network-server storage space in megabytes. Refer to the AIX installation documentation to determine the size you want to use.

f. Click **OK**.

g. Continue with step 3 on page 105.

2. If you use a character-based interface, create a network-server storage space using the character-based interface:

   a. At an i5/OS command line, type the command CRTNWSSTG and press F4. The Create NWS Storage Space (CRTNWSSTG) display appears.

   b. In the **Network-server storage space** field, specify the name you want to give to the network-server storage space.

   c. In the **Size** field, specify the size in megabytes for the new network-server storage space. Refer to the AIX installation documentation to determine the size you want to use.

   d. In the **Text description** field, specify a meaningful description for the network-server storage space.

   e. Press Enter.

   f. Continue with step 4 on page 105.

3. If you use iSeries Navigator, link the network-server storage space using iSeries Navigator.

   a. Expand **My Connections** → **your server** → **Network** → **Windows Administration**.

   b. Click **Disk Drives**, right-click an available network-server storage space, and select **Add Link**.

   c. Select the server to which you want to link the network-server storage space.

   d. Select one of the available data access types.

   e. Click **OK**.

   f. Continue with step 5 on page 105.

4. If you use a character-based interface, link the network-server storage space using a character-based interface:

   a. At an i5/OS command line, type the command ADDNWSSTGL and press F4. The Add Network-Server Storage Link (ADDNWSSTGL) display appears.

   b. In the **Network server description** field, specify the name of the network server description (NWSD).

   c. In the **Dynamic storage link** field, specify *YES to make the network-server storage space dynamically available to the partition (that is, available without rebooting the AIX partition).

   d. In the **Drive sequence number** field, specify the link sequence position you want to use.

   e. Press Enter.

   f. Continue with step 5 on page 105.

5. Activate the AIX logical partition (if it is not already activated).

6. Log in to AIX using a user name with superuser (root) privileges.

7. Configure the new virtual disk on the AIX logical partition by running the AIX command **cfgmgr**.

8. Verify that your new disk has been added and can be configured by running the AIX command **lspv**. When you enter **lspv** at the command prompt, the system lists the disks that are currently available to AIX. An example of the output for this command is below:

   ```
   # lspv
   hdisk0 00cad6aceafe8fe4 rootvg active
   hdisk1 none None
   ```

   Note the name of the new disk as it displays in the left-hand column.

9. Configure the new disk using one of the following two methods.
• Add the new virtual disk to the root volume group by using the AIX command `extendvg rootvg diskname`, where `diskname` is the name of the new disk. If you use this method, you do not need to continue this procedure. You can use AIX methods to increase the file system size at a later time.

• Create a new volume group for the new virtual disk by using the AIX command `mkvg -y volgroup diskname`, where `volgroup` is the name that you want to use for the new volume group and `diskname` is the name of the new disk.

10. Make a logical volume on the new virtual disk using the AIX command `mklv -y logicvol volgroup 1 diskname` command. `logicvol` is the name that you want to use for the new logical volume, `volgroup` is the name of the new volume group, and `diskname` is the name of the new disk. (The numeral 1 indicates that the logical volume is to consist of one logical disk partition.)

11. Format the disk partition using the AIX `crfs` command. There are a number of optional parameters for the `crfs` command, but typically the defaults satisfy most disk uses. To format the disk partition created in the previous steps, type the following command at an AIX command prompt, where `logicvol` is the name of the logical volume and `/mnt/data` is the mount point directory at which you want to mount the new disk:
   ```
crfs -v jfs -d logicvol -m /mnt/data
   ```

   The `crfs` command displays the following diagnostic messages:
   ```
crfs -v jfs -d logicvol -m /mnt/data
   Based on the parameters chosen, the new /mnt/data JFS file system is limited to
   a maximum size of 134217728 (512 byte blocks)
   New File System size is 8192.
   ```

12. Verify that the mount point directory exists by using the `cd /mnt/data` command. `/mnt/data` is the mount point. The `crfs` command creates this directory so that you can access your new file system. If the mount point directory does not exist, then run the following command, where `/mnt/data` is the name of the mount point directory:
   ```
   mkdir /mnt/data
   ```

13. Verify that an entry for your new file system exists in the `/etc/filesystems` file. The `crfs` command automatically generates the appropriate `/etc/filesystems` entry for your new file system. To verify that the entry exists, use an AIX text editor, such as `vi`, to open the `/etc/filesystems` file, and look for the entry in the `/etc/filesystems` file. If the entry does not exist, use the text editor to add the entry to the `/etc/filesystems` file. An example of such an entry is below:
   ```
   /mnt/data:
   dev = /dev/logicvol
   vfs = jfs
   log = /dev/loglv01
   mount = true
   account = false
   ```

   This entry mounts the virtual disk every time you restart AIX.

14. Mount the virtual disk drive in the new directory by typing: `mount /dev/logicvol /mnt/data`. `logicvol` is the name of the logical volume and `/mnt/data` is the mount point directory.

**Managing network-server descriptions for an AIX logical partition that uses i5/OS resources:**

You can change the resource specifications within a network-server description (NWSD) for an AIX logical partition that uses i5/OS resources. For example, you can link a single network-server storage (NWSSTG) to many NWSDs.

**Linking a network-server storage space to a network-server description:**

You can link a network-server storage space (NWSSTG) to one or more network-server descriptions (NWSDs). This allows the NWSDs and their associated logical partitions to use the data stored on the NWSSTG.
You can link an NWSSTG to an unlimited number of NWSDs. This is beneficial when multiple logical partitions need access to a single application.

When you link an NWSSTG to an NWSD, you can set up the NWSD to have read-only access to the NWSSTG, or you can set up the NWSD to read or write to the NWSSTG.

**Attention:** If more than one NWSD can write to the NWSSTG, ensure that only one NWSD can update the data at a time. Otherwise, changes made by one NWSD can be overwritten by another NWSD.

To link an NWSSTG to an NWSD, follow these steps:
1. At an i5/OS command line, type the command ADDNWSSTGL and press F4.
2. From the Add Server Storage Link display, provide the following information:
   - NWSSTG (Name)
   - NWSD (Name)
   - DYNAMIC (*YES)
   - DRVSEQNBR (*CALC)
3. Press F10 (Additional Parameters).
4. Enter the type of access the storage space will have.

**Deleting network-server descriptions for an AIX logical partition:**

You can delete the i5/OS network-server description (NWSD) for an AIX logical partition that uses i5/OS resources. When you delete the NWSD, all the configuration information for the AIX logical partition is deleted from i5/OS.

To delete the network-server description (NWSD) for an AIX logical partition, follow these steps:
1. On an i5/OS control language (CL) command line, type the command WRKNWSD and press Enter.
2. Type 8 in the Opt field to the left of the Network Server and press Enter.
3. In the Work with Configuration Status display, if the status of the NWSD is not varied off, type 2 in the Opt field to the left of the Network Server and press Enter. Otherwise, go to the next step.
4. Press F3 to return to the previous display.
5. Enter a 4 in the Opt field to the left of the Network Server and press Enter.

**Deleting virtual disk drives for an AIX logical partition:**

You can delete a virtual disk drive from an AIX logical partition that uses i5/OS resources to make the space available to the i5/OS logical partition once more. When you delete a virtual disk drive, all of the information on the virtual disk drive is erased.

Before you can delete a virtual disk drive, you must unlink the virtual disk drive from the network-server description (NWSD). For more information on how to unlink a virtual disk drive from an NWSD, see Unlinking virtual disk drives from an AIX logical partition.

To delete a virtual disk drive, follow these steps:

Delete the disk drive using the interface that you prefer.

<table>
<thead>
<tr>
<th>Interface</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>iSeries Navigator</td>
<td>1. Click <strong>Network</strong> → <strong>Windows Administration</strong> → <strong>Disk Drives</strong>.</td>
</tr>
<tr>
<td></td>
<td>2. Right-click the disk drive that you want to delete.</td>
</tr>
<tr>
<td></td>
<td>3. Click <strong>Delete</strong> in the confirmation window.</td>
</tr>
</tbody>
</table>
At an i5/OS control language (CL) command line, type DLTNWSSTG and press F4.
2. Type the name of the disk drive in the Network-server storage space field and press Enter.

Related tasks

“Unlinking virtual disk drives from an AIX logical partition” on page 108

By unlinking virtual disk drives (network-server storage spaces) from an AIX logical partition that uses i5/OS resources, you disconnect the virtual disk drives from the logical partition, making the virtual disk drives inaccessible to users. If you delete a AIX logical partition that uses i5/OS resources, you must unlink all virtual disk drives from the logical partition before you delete the logical partition.

Using IPL types when running AIX:

The IPL source (IPLSRC) parameter on the network-server description (NWSD) determines the initial program that is loaded when the NWSD is varied on. For an AIX logical partition that uses i5/OS resources, the initial program is the kernel. Ensure that the IPLSRC parameter specifies the kernel location of the kernel for the AIX logical partition that uses i5/OS resources.

You can set the IPLSRC parameter when you use the Create Network Server Description (CRTNWSD) command, and you can change the IPLSRC parameter when you use the Change Network Server Description (CHGNWSD) command.

Note: IPLSRC parameter also has the values A, B, and D, which are not valid for IBM System i hardware.

The IPLSRC parameter has the following valid values.

<table>
<thead>
<tr>
<th>IPLSRC values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>*Panel</td>
<td>The partition is started from the source indicated on the control panel.</td>
</tr>
<tr>
<td>*NWSSTG (network-server storage space)</td>
<td>This IPL type is used to start a partition from a virtual disk. The open firmware will find the kernel in the virtual disk. The open firmware searches the first virtual disk connected to the server for a partition marked bootable, and of type 0x41 (PReP start). If a partition of this type does not exist, the partition IPL will fail.</td>
</tr>
<tr>
<td>*STMF (stream file)</td>
<td>This IPL type is used to start a partition from a kernel i5/OS loaded in the i5/OS integrated file system. Note that the integrated file system includes files on the optical (CD) drive on i5/OS.</td>
</tr>
</tbody>
</table>

Backing up and recovering AIX logical partitions that use i5/OS virtual I/O resources:

When you create an AIX logical partition that uses resources from an i5/OS logical partition, you can manage backup and recovery using i5/OS control language (CL) commands, AIX commands, or a combination of the two.

For more information on planning your backup strategy, see the i5/OS Backup and recovery topic.

To save AIX data in a logical partition that uses i5/OS resources to a shared tape drive and restore the data from the tape drive, you can use either the AIX tar command or the i5/OS Save (SAV) and Restore (RST) commands. You can also use the tar command to save your data to a file. If you use the tar command to save data, the only way you can restore that data is by using the tar command again. Similarly, if you use the SAV command to save data, the only way you can restore that data is by using the RST command. The two methods of backing up and restoring data are not compatible.
The following restrictions apply:

- To use the i5/OS SAV or RST command to save or restore the NWSD, AIX must be inactive (that is, the NWSD must be varied off).
- Saving the storage space is typically faster than saving by using the `tar` command, but it does not provide file-level backup and recovery.
- You cannot save i5/OS data and `tar` data on the same tape volume.

**Related information**

- **Backup and recovery**

**Backing up and recovering AIX files using the `tar` command:**

The most common data backup utility in AIX is the `tar` (tape archive) utility. Use the AIX `tar` command if you have AIX installed on a dedicated disk or if you cannot vary off an AIX partition while you are backing up data.

Backups using the AIX `tar` command are at the file level. They save only the files and directories that the `tar` command specifies. Therefore, you cannot use the `tar` command to save AIX data that is not in the file server. For example, you cannot save a kernel in the PowerPC Reference Platform (PReP) start partition by using the `tar` command.

**Saving to and restoring from a tape device:**

Use these procedures to save and restore AIX files between an AIX logical partition that uses i5/OS resources and a shared tape drive.

Ensure that your AIX data is in the file server.

To save and restore AIX files between a partition that uses i5/OS resources and a shared tape drive, follow these steps:

1. Type the following command: `tar -c -f /dev/rmt0 files` Use the following descriptions to help you understand the arguments of this command:
   - `tar` is the command name (the contraction of “tape archive”).
   - `-c` is the command action to create. This argument specifies that the `tar` command creates a new archive or overwrites an old one (as opposed to restoring files from an archive or adding individual files to an existing archive).
   - `-f /dev/rmt0` is the tape device and number. This argument specifies that the command uses virtual tape 0 on the IBM System i server. After the `tar` command runs, the tape device is closed and the tape is rewound. To save more than one archive on the tape, you must keep the tape from rewinding after each use, and you must position the tape to the next file marker. To do this, specify the `rmt0.1` (nonrewinding virtual tape) device instead of `rmt0`.
   - `files` are the names of the files and directories that you plan to save.

   You have now saved AIX data from a partition that uses i5/OS resources to the shared tape drive.

2. Type the following command: `tar -x -f /dev/rmt0 files` The `-x` (extract) argument replaces the `-c` (create) argument in the `tar` command used in step x. You have now restored AIX data from the shared tape drive to a partition that is sharing resources.

**Saving to and restoring from a file:**

You can save and restore AIX files between an AIX logical partition that uses i5/OS resources and a `tar` file.
Saving to a file

The following is an example of using the `tar` command to save to a file.

```
tar -cvf /tmp/etc.tar /etc
```

Use the following descriptions to help you understand the arguments of this command:

- **tar**: The command name.
- **c**: Create a tar file.
- **v**:Verbose. This argument shows the files that are being added to the tar file.
- **f**: The data immediately following `f` is the name of the tar file.

```
/tmp/etc.tar
```

The name of the tar file.

```
/etc
```

An object to be added to the tar file. Because `/etc` is a directory, the utility adds all the contents of the directory and its subdirectories to the tar file.

After you create the tar file, you can save it to an offline medium in several ways. For example, you can save the tar file to a virtual tape device or a directly attached tape device. You can also copy the tar file to the integrated file system and save it at a later time.

You can save the data on an AIX partition to a tar file during normal server usage. You can automate and start the `tar` utility by using the `cron` (chronology) daemon on the logical partition. The `cron` daemon is a scheduling mechanism for AIX. You can also use the `tar` utility to schedule a single backup request. For example, if you want to use the `tar` utility to back up the `/etc` directory at 10 p.m. on 19 September, you can type the following command: `at 10pm Sep 19 -f tar.command`.

Restoring from a file

The following is an example of using the `tar` command to restore from file:

```
tar -xvf /tmp/etc.tar /etc
```

The `-x` (extract) argument replaces the `-c` (create) argument in the tar command used to save the files.

**Backing up and recovering AIX logical partitions using i5/OS CL commands:**

If you have an AIX logical partition that uses i5/OS resources, tools are available in i5/OS for backup and recovery. You can use the Save (SAV) and Restore (RST) commands to save and restore entire virtual disks in their current state.

The SAV command saves the directory that has the same name as the virtual disk under the QFPNWSSTG directory in the integrated file system. This method of backup and recovery is most effective if the AIX kernel is saved in a PowerPC Reference Platform (PReP) start partition on the virtual disk. On AIX, this usually occurs as part of a default installation.

Backups using i5/OS control language (CL) command are at the drive level. This means that i5/OS backs up the entire contents of a virtual disk, or network storage space, rather than individual files. Thus, the correct SAV command backs up any information on the drive, including a kernel in the PReP start partition.

If you save the AIX kernel in a PReP partition, you can restore and start the partition after a total system reinstallation. You can also transport and restore saved virtual disks to other IBM System i servers using File Transfer Protocol (FTP) and tape.

**Save AIX data by using i5/OS SAV:**

You can save data for an AIX logical partition that uses i5/OS resources by using the Save (SAV) i5/OS CL command.

On i5/OS, your data is in a network-server storage space (NWSSTG).

To save data for an AIX logical partition that uses i5/OS resources by using the Save (SAV) i5/OS CL command, follow these steps:

1. At the i5/OS command line, enter the Save (SAV) command.
2. On the Save display, enter the following parameter values:
   a. In the Device field, enter the associated i5/OS device description. To save to a save file in a library like QGPL, enter /qsys.lib/qgpl.lib/myfile.file. For example, if your tape device is named TAP01, enter /qsys.lib/tap01.devd.
   b. In the Objects: Name field, enter the integrated-file-system location of the network-server storage space. For example, if your network-server storage space is named TEST1, enter /qfpnwsstg/test1.
3. At the i5/OS command line, enter the Display Save File (DSPSAVF) command to verify that the changed save file exists.
4. In the Option field by the new save file name, enter 5 (Display) to display a list of the stream files in the save file.

Restore AIX data by using i5/OS RST:

You can restore data for an AIX logical partition that uses i5/OS resources by using the Restore (RST) i5/OS CL command.

Restore (RST) is the i5/OS CL command to restore AIX files from the shared tape drive of the partition that shares resources.

To restore data for an AIX logical partition that uses i5/OS resources by using the Restore (RST) i5/OS CL command, follow these steps:

1. At the i5/OS command line, enter the Restore (RST) command.
2. On the Restore Object display, enter the following parameter values:
   a. To restore from a tape device, enter the associated i5/OS device description in the Device field. To save to a save file in a library like QGPL, enter /qsys.lib/qgpl.lib/myfile.file. For example, if your tape device is named TAP01, enter /qsys.lib/tap01.devd. To restore from a save file in library QGPL, enter, enter /qsys.lib/qgpl.lib/myfile.file.
   b. In the Objects: Name field, enter the integrated-file-system location of the network-server storage space. For example, if your network-server storage space is named TEST1, enter /qfpnwsstg/test1.

Backing up the network server description and virtual disk drives associated with an AIX logical partition:

Learn about how to back up the data for an AIX logical partition that uses i5/OS resources.

When you install the logical partitions with virtual disk, the i5/OS logical partition that shares resources creates a network server description and creates disk drives for your AIX logical partition that you need to back up. Some of the disk drives are server-related (the installation and server drives), while others are user-related. Because your AIX logical partition might consider the disk drives to be a unified server, you must save all the disk drives and the network server description so they restore correctly.

The implementation of a logical partition for IBM System i servers allows you to save and restore virtual disks as i5/OS network-server storage space objects. These objects are saved as part of the full i5/OS server backup. You can also specifically save the network server description and storage spaces that are associated with a logical partition on an IBM System i server. Daily backup of the server drive is a good practice.
Related information

Backup and recovery

Backing up network server descriptions for an AIX logical partition:

When you save the storage space objects that are associated with a logical partition that uses virtual disks, you must also save the network server description (NWSD). Otherwise, a logical partition might not be able to re-establish items such as the file-system permissions for the partition.

To save the network server description (NWSD), use the Save Configuration (SAVCFG) command as follows:

1. On an i5/OS command line, type SAVCFG.
2. Press Enter to save the NWSD configuration.

The Save Configuration command (SAVCFG) saves the objects associated with an NWSD and the current static network-server storage spaces. This command does not save the links associated with the dynamically added storage spaces. You must add these links manually after the configuration and the dynamically linked storage spaces have been restored.

Restoring network-server descriptions for an AIX partition:

In a disaster-recovery situation, you would restore all the configuration objects, which include the network-server description (NWSD) for your logical partition. In some situations, you must specifically restore the NWSD. For example, you must restore the NWSD when you migrate to new hardware.

To have i5/OS automatically relink disk drives within the integrated file system to the restored NWSD, restore those disk drives first.

To restore the NWSD, use the Restore Configuration (RSTCFG) command:

1. On an i5/OS command line, type RSTCFG and press F4 (Prompt).
2. In the Objects field, specify the name of the NWSD.
3. In the Device field, specify which device you are using to restore the NWSD. If you are restoring from media, specify the device name. If you are restoring from a save file, specify *SAVF and identify the name and library for the save file in the appropriate fields.
4. Press Enter to restore the NWSD.
5. When you have restored the NWSD and all of its associated storage spaces, start (vary on) the logical partition.

Unlinking virtual disk drives from an AIX logical partition:

By unlinking virtual disk drives (network-server storage spaces) from an AIX logical partition that uses i5/OS resources, you disconnect the virtual disk drives from the logical partition, making the virtual disk drives inaccessible to users. If you delete a AIX logical partition that uses i5/OS resources, you must unlink all virtual disk drives from the logical partition before you delete the logical partition.

To unlink a virtual disk drive from an AIX logical partition that uses i5/OS resources, follow these steps:

1. Unlink disk drives from a logical partition using iSeries Navigator. If you prefer to use a character-based interface, go to step 2 on page 108
   a. Vary off the NWSD for your logical partition. For more information, see Starting and stopping the network server description.
   b. Click Network → Windows Administration → Disk Drives.
   c. Right-click the name of the disk drive that you want to unlink.
   d. Click Remove Link.
e. Select a server from the list of linked servers.
f. If you are unlinking a disk drive that you plan to relink later, uncheck **Compress link sequence**. You must relink the disk drive as the same link sequence number before you vary on the server. By preventing compression of the link sequence values, you avoid having to unlink and relink all the disk drives to get them in the correct sequence.
g. Click **Remove**.
h. You have completed this procedure. Do not complete step 2 on page 108.

2. Unlink disk drives from a logical partition using a character-based interface:

   a. Vary off the NWSD for your logical partition. For more information, see Starting and stopping the network server description.
   
   b. Type `RMVNWSSTGL` and press F4.
   
   c. In the Network-server storage space field, type the name of the storage space that you want to unlink and press Enter.
   
   d. In the Network server description field, type the name of the server from which you want to unlink the storage space and press Enter.
   
   e. If you are unlinking a linked disk drive that you plan to relink later, specify *NO in the Renumber field.

   **Note:** You must relink the disk drive as the same sequence number before you vary on the server. By preventing automatic renumbering, you avoid having to unlink and relink all the disk drives to get them in the correct sequence.
   
   f. Press Enter.

   **Note:** If you are uninstalling a logical partition, your next step is to delete the disk drive. For more information on deleting disk drives, see Deleting virtual disk drives for an AIX logical partition. Otherwise, vary on the NWSD for your logical partition. For more information about starting the NWSD, see Starting and stopping the network server description.

For more information about saving i5/OS server objects, see **Saving server objects in i5/OS**

**Related tasks**

**“Deleting virtual disk drives for an AIX logical partition” on page 107**
You can delete a virtual disk drive from an AIX logical partition that uses i5/OS resources to make the space available to the i5/OS logical partition once more. When you delete a virtual disk drive, all of the information on the virtual disk drive is erased.

**“Starting the network-server description for an AIX logical partition” on page 103**
You can start the network-server description (NWSD) for a AIX logical partition that uses i5/OS resources to make the resources defined in the NWSD available to the AIX logical partition.

**Saving AIX server objects in i5/OS:**

When an AIX logical partition uses i5/OS resources, i5/OS stores AIX information in i5/OS objects. i5/OS can restore the objects correctly only if you save all objects for an AIX logical partition.

You can save these objects by using options of the i5/OS GO SAVE command in the server.

- Option 21 saves the entire server.
- Option 22 saves server data, which includes objects in the QUSRSYS library.
- Option 23 saves all user data, which includes objects in the QFPNWSSTG library.

If you want to save a particular object, use the following table to see the location of that object on i5/OS and the command to use. For more information about using the save commands, see the i5/OS Backup and recovery topic collection.
Table 27. Objects to save for logical partitions with virtual disk

<table>
<thead>
<tr>
<th>Object content</th>
<th>Object name</th>
<th>Object location</th>
<th>Object type</th>
<th>Save command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Guest partition and virtual disk drive</td>
<td>stgsph</td>
<td>/QFPNWSSTG</td>
<td>User-defined network-server storage spaces in system auxiliary storage pool (ASP)</td>
<td>GO SAV, option 21 or 23</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>SAVOBJ('/QFPNWSSTG/stgsph') DEV('/QSYS.LIB/TAP01.DEVD')</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>GO SAV OBJ('/QFPNWSSTG/stgsph') DEV('/QSYS.LIB/TAP01.DEVD')</td>
</tr>
</tbody>
</table>

Table 28. Objects to save for all logical partitions with a server

<table>
<thead>
<tr>
<th>Object content</th>
<th>Object name</th>
<th>Object location</th>
<th>Object type</th>
<th>Save command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Messages from the logical partition</td>
<td>Various</td>
<td>Various</td>
<td>Server message queue</td>
<td>GO SAVE, option 21 or 23</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>SAVOBJ OBJ(msg) LIB(library) DEV(TAP01) OBJTYPE(*MSGQ)</td>
</tr>
<tr>
<td>i5/OS configuration objects for logical partitions</td>
<td>Various</td>
<td>QSYS</td>
<td>Device configuration objects</td>
<td>GO SAVE, option 21, 22, or 23</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>SAVOBJ DEV (TAP01)</td>
</tr>
<tr>
<td>Various</td>
<td>Various</td>
<td>QUSRsys</td>
<td>Various</td>
<td>GO SAVE, option 21 or 23</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>SAVLIB LIB(*NONSYS) or LIB(*ALLUSR)</td>
</tr>
</tbody>
</table>

Related information

Backup and recovery

Managing Linux logical partitions using i5/OS virtual I/O resources
i5/OS can provide virtual I/O resources to a Linux logical partition. These Linux logical partitions receive their I/O resources from the i5/OS logical partition.

Adding virtual disk units to a Linux logical partition:

You can add virtual disk units dynamically to a Linux logical partition that uses i5/OS resources. This allows you to increase the storage capacity of your AIX logical partition when needed.

Virtual disks simplify hardware configuration on the server because they do not require you to add additional physical devices to the server in order to run Linux. You can allocate up to 64 virtual disks to a Linux logical partition. Each virtual disk supports up to 1000 GB of storage. Each virtual disk appears to Linux as one actual disk unit. However, the associated space in the i5/OS integrated file system is distributed across the disks that belong to the i5/OS logical partition. Distributing storage across the disks provides the benefits of device parity protection through i5/OS. Therefore, you do not have to use additional processing resources and memory resources by setting up device parity protection through Linux.

i5/OS provides the ability to dynamically add virtual disks to a Linux logical partition. You can allocate disk space in the integrated file system and make it available to Linux without restarting the server or logical partition. The Linux administrator can also configure the newly allocated disk space and make it available without restarting the server.

To add virtual disks dynamically to a Linux logical partition, do the following:
1. If you use iSeries Navigator, create a network-server storage space using iSeries Navigator.
   a. Expand My Connections → your server → Network → Windows Administration.
   b. Right-click the Disk Drives and select New Disk.
   c. In the Disk drive name field, specify the name that you want to give to the network-server storage space.
   d. In the Description field, specify a meaningful description for the network-server storage space.
   e. In the Capacity field, specify the size of the new network-server storage space in megabytes. Refer to the installation documentation of your preferred Linux distributor to determine the size you want to use.
   f. Click OK.
   g. Continue with step 4 on page 115.

2. If you use a character-based interface, create a network-server storage space using the character-based interface:
   a. At an i5/OS command line, type the command CRTNWSSTG and press F4. The Create NWS Storage Space (CRTNWSSTG) display appears.
   b. In the Network-server storage space field, specify the name you want to give to the network-server storage space.
   c. In the Size field, specify the size in megabytes for the new network-server storage space. Refer to the installation documentation of your preferred Linux distributor to determine the size you want to use.
   d. In the Text description field, specify a meaningful description for the network-server storage space.
   e. Press Enter.

3. If you use iSeries Navigator, link the network-server storage space using iSeries Navigator.
   a. Expand My Connections → your server → Network → Windows Administration.
   b. Click Disk Drives, right-click an available network-server storage space, and select Add Link.
   c. Select the server to which you want to link the network-server storage space.
   d. Select one of the available data access types.
   e. Click OK.
   f. Continue with step 5 on page 115.

4. If you use a character-based interface, link the network-server storage space using a character-based interface:
   a. At an i5/OS command line, type the command ADDNWSSTGL and press F4. The Add Network-Server Storage Link (ADDNWSSTGL) display appears.
   b. In the Network server description field, specify the name of the network server description (NWSD).
   c. In the Dynamic storage link field, specify *YES to make the network-server storage space dynamically available to the partition (that is, available without rebooting the Linux partition).
   d. In the Drive sequence number field, specify the link sequence position you want to use.
   e. Press Enter.

5. If the Linux logical partition is not running, activate the Linux logical partition. Do not continue until the partition is running.

6. Log in to Linux using a user name with superuser (root) privileges.

7. Determine the host ID, SCSI bus, and logical unit number (LUN) for your new virtual disk drive.
   You can list the existing devices by typing the following command at the Linux command prompt: cat /proc/scsi/scsi. The following example shows sample output of the command:
In this example, NETSPACE is the name of the network storage space for the displayed device. Look for the name of an existing network storage space on your Linux logical partition. Note the numeric part of the Host: value (host ID) and the Channel: (SCSI bus) and Lun: (logical unit number (LUN)) values for the existing network storage space. The new virtual disk drive will have the same host ID, SCSI bus, and LUN as the existing network storage space. For example, if the existing network storage space is as displayed in the preceding example output, then the new virtual disk drive will have a host ID of 0, a SCSI bus of 0, and a LUN of 0.

8. Determine the SCSI ID for your new virtual disk drive. You can list the existing devices in table form by typing the following commands at the Linux command prompt:
   
   cd /proc/scsi/sg
   cat device_hdr; cat devices

   The following example shows sample output of the commands:

<table>
<thead>
<tr>
<th>host</th>
<th>chan</th>
<th>id</th>
<th>lun</th>
<th>type</th>
<th>opens</th>
<th>qdepth</th>
<th>busy</th>
<th>online</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>2</td>
<td>30</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>30</td>
<td>0</td>
<td>1</td>
</tr>
</tbody>
</table>

   Note the host (host ID), chan (SCSI bus), id (SCSI ID), and lun (logical unit number (LUN)) values for the existing devices. Find the devices that have the same host ID, SCSI bus, and LUN as the new virtual disk drive (as you determined in the previous step). Of those devices, find the device with the greatest SCSI ID. The new virtual disk drive will have a SCSI ID that is one greater than the greatest existing SCSI ID. For example, if the new virtual disk drive has a host ID of 0, a SCSI bus of 0, and a LUN of 0, and the devices on your Linux logical partition are as listed in the example output above, then the new virtual disk drive will have a SCSI ID of 1.

9. Type the following command at the Linux command prompt to add the virtual disk drive manually:
   
   echo "scsi add-single-device host chan id lun" > /proc/scsi/scsi
   Use the following information to help you understand the arguments of the command:
   
   • host is the host ID.
   • chan is the SCSI bus.
   • id is the SCSI ID.
   • lun is the LUN.

   For example, if the new virtual disk drive is to have a host ID of 0, a SCSI bus of 0, a SCSI ID of 1, and a LUN of 0, you would type the command echo "scsi add-single-device 0 0 1 0" > /proc/scsi/scsi at the Linux command prompt.

10. At the Linux command prompt, type the following command to create a disk partition on the virtual disk drive: fdisk /dev/sdb. You must have superuser (root) privileges to run this command. The Command (m for help): prompt appears.

11. Type p at the prompt to see the current partition table for the virtual disk drive. By default, the new virtual disk drive shows a single disk partition on the virtual disk. For example,

   Disk /dev/sdb: 64 heads, 32 sectors, 200 cylinders
   Units = cylinders of 2048 * 512 bytes

   Device Boot Start   End   Blocks  Id  System
   /dev/sdb1   1    199    203760  6  FAT16

12. Type d at the command prompt to delete the current partition and then create a new one. The default format for the disk partition is FAT16. Do not use a disk partition that is formatted as FAT16 on your virtual disk drive. The Partition number (1-4): prompt appears.

13. Type the disk partition number you want to delete and press Enter. In this example, you type a 1. The fdisk command indicates that the deletion is successful by displaying the command prompt.
14. Type n to create a new disk partition. The Command action E extended P primary partition (1-4) prompt appears.

15. Type p to create a primary disk partition on the virtual disk and press Enter. The Partition number (1-4): prompt appears.

16. Type 1 because this is the first partition on the virtual disk, and press Enter. The First cylinder (1-200, default 1): prompt appears.

17. Press Enter to use the default of 1 for the first disk cylinder. This uses the entire disk for this disk partition. The Last cylinder or +size or +sizeM or +sizeK (1-200, default 200): prompt appears.

18. Press Enter to use the default of 200 for the last disk cylinder. This uses the entire virtual disk for this partition.

Note: The type of the partition defaults to Linux. If you need a different disk type (like Logical Volume Manager (LVM), or Linux Extended), type t to change the type of the partition. The fdisk command indicates that the partition creation is successful by returning the command prompt.

19. Type w to commit the changes to the disk structure and press Enter. The fdisk command writes the changes to the virtual disk drive. The fdisk command displays the following diagnostic message:

   The partition table has been altered!
   Calling ioctl() to re-read partition table.
   Syncing disks.

After the operation is completed, the fdisk command returns the command prompt.

20. Format the disk partition using the Linux mkfs command. There are a number of optional parameters for the mkfs command, but typically the defaults satisfy most disk uses. To format the disk partition created in the previous steps, ensure that you are logged in with superuser (root) privileges and type the following command at a Linux command prompt:

```
mkfs /dev/sdb1
```

Since a single disk partition exists on the second virtual disk, the name of the disk is /dev/sdb1 (the sdb indicates that it is the second disk, and the 1 indicates that it is partition 1). The mkfs command displays the following diagnostic messages:

```
mke2fs 1.28 (31-Aug-2002)
    Filesystem label=
    OS type: Linux Block size=1024 (log=0)
    Fragment size=1024 (log=0)
    51200 inodes, 204784 blocks
    10239 blocks (5.00%) reserved for the super user
    First data block=1
    25 block groups
    8192 blocks per group, 8192 fragments per group
    2048 inodes per group
    Superblock backups stored on blocks:
        8193, 24577, 40961, 57345, 73729

    Writing inode tables: done
    Writing superblocks and filesystem accounting information: done

This fileserver will be automatically checked every 29 mounts or
180 days, whichever comes first. Use tune2fs -c or -i to override.
```

21. Type the following command to create a directory that you can use to access the new file: mkdir /mnt/data

22. Type the following command to mount the virtual disk drive in the new directory: mount /dev/sdb1 /mnt/data

23. Add an entry to the /etc/fstab file using a Linux text editor, such as vi. For example, /dev/sdb1 /mnt/data ext2 defaults 1 1. This entry mounts the virtual disk every time you restart Linux.
Managing network-server descriptions for a Linux logical partition that uses i5/OS resources:

You can change the resource specifications within a network-server description (NWSD) for a Linux logical partition that uses i5/OS resources. For example, you can link a single network-server storage (NWSSTG) to many NWSDs.

Linking a network-server storage space to a network-server description:

You can link a network-server storage space (NWSSTG) to one or more network-server descriptions (NWSDs). This allows the NWSDs and their associated logical partitions to use the data stored on the NWSSTG.

You can link an NWSSTG to an unlimited number of NWSDs. This is beneficial when multiple logical partitions need access to a single application.

When you link an NWSSTG to an NWSD, you can set up the NWSD to have read-only access to the NWSSTG, or you can set up the NWSD to read or write to the NWSSTG.

Attention: If more than one NWSD can write to the NWSSTG, ensure that only one NWSD can update the data at a time. Otherwise, changes made by one NWSD can be overwritten by another NWSD.

To link an NWSSTG to an NWSD, follow these steps:
1. At an i5/OS command line, type the command ADDNWSSTG and press F4.
2. From the Add Server Storage Link display, provide the following information:
   - NWSSTG (Name)
   - NWSD (Name)
   - DYNAMIC (*YES)
   - DRVSEQNBR (*CALC)
3. Press F10 (Additional Parameters).
4. Enter the type of access the storage space will have.

Deleting network-server descriptions for a Linux logical partition:

You can delete the i5/OS network-server description (NWSD) for a Linux logical partition that uses i5/OS resources. When you delete the NWSD, all the configuration information for the Linux logical partition is deleted from i5/OS.

To delete the network-server description (NWSD) for a Linux logical partition, follow these steps:
1. On an i5/OS control language (CL) command line, type the command WRKNWSD and press Enter.
2. Type 8 in the Opt field to the left of the Network Server and press Enter.
3. In the Work with Configuration Status display, if the status of the NWSD is not varied off, type 2 in the Opt field to the left of the Network Server and press Enter. Otherwise, go to the next step.
4. Press F3 to return to the previous display.
5. Enter a 4 in the Opt field to the left of the Network Server and press Enter.

Deleting virtual disk drives for a Linux logical partition:

You can delete a virtual disk drive from a Linux logical partition that uses i5/OS resources to make the space available to the i5/OS logical partition once more. When you delete a virtual disk drive, all of the information on the virtual disk drive is erased.
Before you can delete a disk drive, you must unlink it from the network-server description. For more information on how to unlink a virtual disk drive from an NWSD, see Unlinking virtual disk drives from a Linux logical partition.

To delete a virtual disk drive, follow these steps:

Delete the disk drive using the interface that you prefer.

<table>
<thead>
<tr>
<th>Interface</th>
<th>Actions</th>
</tr>
</thead>
</table>
| iSeries Navigator                  | Complete the following steps:  
1. Click Network → Windows Administration → Disk Drives.  
2. Right-click the disk drive that you want to delete.  
3. Click Delete.  
4. Click Delete in the confirmation window. |
| i5/OS character-based interface    | Complete the following steps:  
1. At an i5/OS control language (CL) command line, type DLTNWSSTG and press F4.  
2. Type the name of the disk drive in the Network-server storage space field and press Enter. |

Related tasks

"Unlinking virtual disk drives from a Linux logical partition" on page 119

By unlinking virtual disk drives (network-server storage spaces) from a Linux logical partition that uses i5/OS resources, you disconnect the virtual disk drives from the logical partition, making the virtual disk drives inaccessible to users. If you delete a Linux logical partition that uses i5/OS resources, you must unlink all virtual disk drives from the logical partition before you delete the logical partition.

Using IPL types when running Linux:

The IPL source (IPLSRC) parameter on the network-server description (NWSD) determines the initial program that is loaded when the NWSD is varied on. For a Linux logical partition that uses i5/OS resources, the initial program is the kernel. Ensure that the IPLSRC parameter specifies the kernel location of the kernel for the Linux logical partition that uses i5/OS resources.

You can set the IPLSRC parameter when you use the Create Network Server Description (CRTNWSD) command, and you can change the IPLSRC parameter when you use the Change Network Server Description (CHGNWSD) command.

Note: IPLSRC parameter also has the values A, B, and D, which are not valid for IBM System i hardware.

The IPLSRC parameter has the following valid values.

<table>
<thead>
<tr>
<th>IPLSRC values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>*Panel</td>
<td>The partition is started from the source indicated on the control panel.</td>
</tr>
<tr>
<td>*NWSSTG (network-server storage space)</td>
<td>This IPL type is used to start a partition from a virtual disk. The open firmware will find the kernel in the virtual disk. The open firmware searches the first virtual disk connected to the server for a partition marked bootable, and of type 0x41 (PReP start). If a partition of this type does not exist, the partition IPL will fail.</td>
</tr>
<tr>
<td>*STMF (stream file)</td>
<td>This IPL type is used to start a partition from a kernel loaded in the i5/OS integrated file system. Note that the integrated file system includes files on the optical (CD) drive on i5/OS.</td>
</tr>
</tbody>
</table>
Backing up and recovering Linux logical partitions that use i5/OS virtual I/O resources:

When you create a Linux logical partition that uses resources from an i5/OS logical partition, you can manage backup and recovery using i5/OS control language (CL) commands, Linux commands, or a combination of the two.

For more information on planning your backup strategy, see the i5/OS Backup and recovery topic.

To save Linux data in a logical partition that uses i5/OS resources to a shared tape drive and restore the data from the tape drive, you can use either the Linux `tar` command or the i5/OS Save (SAV) and Restore (RST) commands. You can also use the `tar` command to save your data to a file. If you use the `tar` command to save data, the only way you can restore that data is by using the `tar` command again. Similarly, if you use the SAV command to save data, the only way you can restore that data is by using the RST command. The two methods of backing up and restoring data are not compatible.

The following restrictions apply:
- To use the tape device from Linux, you must vary the tape off under i5/OS.
- To use the i5/OS SAV or RST command to save or restore the NWSD, Linux must be inactive (that is, the NWSD must be varied off).
- Saving the storage space is typically faster than saving by using the `tar` command, but it does not provide file-level backup and recovery.
- Linux does not support switching tapes in a library device. You can only use the tape that is currently in the device.
- You cannot save i5/OS data and `tar` data on the same tape volume.

Related information

**Backup and recovery**

**Backing up and recovering Linux files using the `tar` command:**

The most common data backup utility in Linux is the `tar` (tape archive) utility. Use the Linux `tar` command if you have Linux installed on a dedicated disk or if you cannot vary off a Linux partition while you are backing up data.

Backups using the Linux `tar` command are at the file level. They save only the files and directories that the `tar` command specifies. Therefore, you cannot use the `tar` command to save Linux data that is not in the file server. For example, you cannot save a kernel in the PowerPC Reference Platform (PReP) start partition by using the `tar` command.

One advantage of the `tar` command is that it supports incremental backups and backup of special devices, which is not common for `tar` implementations. Also, the `tar` command backs up files without regard to the underlying file system type.

**Saving to and restoring from a tape device:**

Use these procedures to save and restore Linux files between a Linux logical partition that uses i5/OS resources and a shared tape drive.

Ensure that your Linux data is in the file server.
Linux typically treats tape as a *character device* that it can quickly read from or write to in long streams of data, but cannot quickly access to find specific data. By contrast, Linux treats a disk or CD as a *block device* that it can read from or write to quickly at any point on the device, making it suitable for the *mount* command.

Complete the following steps to save and restore Linux files between a partition that uses i5/OS resources and a shared tape drive:

1. Type the following command:
   ```
   tar -b 40 -c -f /dev/st0 files
   
   Use the following descriptions to help you understand the arguments of this command:
   - `tar` is the command name (the contraction of “tape archive”).
   - `-b 40` is the block size in sectors. This argument specifies that Linux is to write the archive stream in blocks of 40 sectors (20 KB). If you do not specify a value for this argument, the default value is 20 sectors (10 KB), which does not perform as well over virtual tape as does a value of 40.
   - `-c` is the command action to create. This argument specifies that the `tar` command creates a new archive or overwrites an old one (as opposed to restoring files from an archive or adding individual files to an existing archive).
   - `-f /dev/st0` is the virtual tape device and number. This argument specifies that the command uses virtual tape 0 on the IBM System i server. After the `tar` command runs, the tape device is closed and the tape is rewound. To save more than one archive on the tape, you must keep the tape from rewinding after each use, and you must position the tape to the next file marker. To do this, specify the `nst0` (nonrewinding virtual tape) device instead of `st0`.
   - `files` are the names of the files and directories that you plan to save.

   You have now saved Linux data from a partition that uses i5/OS resources to the shared tape drive.

2. Type the following command:
   ```
   tar -b 40 -x -f /dev/st0 files
   
   The `-x` (extract) argument replaces the `-c` (create) argument in the `tar` command used in step 1 on page 174. You have now restored Linux data from the shared tape drive to a partition that is sharing resources.

*Saving to and restoring from a file:*

You can save and restore Linux files between a Linux logical partition that uses i5/OS resources and a tar file.

### Saving to a file

The following is an example of using the `tar` command to save to a file.

```bash

tar -cvf /tmp/etc.tar /etc
```

Use the following descriptions to help you understand the arguments of this command:

- `tar` The command name.
- `c` Create a tar file.
- `v` Verbose. This argument shows the files that are being added to the tar file.
- `f` The data immediately following `f` is the name of the tar file.
- `/tmp/etc.tar` The name of the tar file.
- `/etc` An object to be added to the tar file. Because `/etc` is a directory, the utility adds all the contents of the directory and its subdirectories to the tar file.

After you create the tar file, you can save it to an offline medium in several ways. For example, you can save the tar file to a virtual tape device or a directly attached tape device. You can also copy the tar file to the integrated file system and save it at a later time.
You can save the data on a Linux partition to a tar file during normal server usage. You can automate and start the tar utility by using the cron (chronology) daemon on the logical partition. The cron daemon is a scheduling mechanism for Linux. You can also use the tar utility to schedule a single backup request. For example, if you want to use the tar utility to back up the /etc directory at 10 p.m. on 19 September, you can type the following command: at 10pm Sep 19 -f tar.command.

**Restoring from a file**

The following is an example of using the tar command to restore from file: tar -xvf /tmp/etc.tar /etc. The -x (extract) argument replaces the -c (create) argument in the tar command used to save the files.

**Backing up and recovering Linux partitions using i5/OS commands:**

If you have a Linux logical partition that uses i5/OS resources, tools are available in i5/OS for backup and recovery. You can use the Save (SAV) and Restore (RST) control language (CL) commands to save and restore entire virtual disks in their current state.

The SAV command saves the directory that has the same name as the virtual disk under the QFPNWSSTG directory in the integrated file system. This method of backup and recovery is most effective if the Linux kernel is saved in a PowerPC Reference Platform (PReP) start partition on the virtual disk. On most Linux distributions, this usually occurs as part of a default installation.

Backups using i5/OS commands are at drive level. This means that i5/OS backs up the entire contents of a virtual disk, or network storage space, rather than individual files. Thus, the correct SAV command backs up any information on the drive, including a kernel in the PReP start partition.

If you save the Linux kernel in a PReP partition, you can restore and start the partition after a total system reinstallation. You can also transport and restore saved virtual disks to other IBM System i servers using File Transfer Protocol (FTP) and tape.

**Save Linux data by using i5/OS SAV:**

You can save data for a Linux logical partition that uses i5/OS resources by using the Save (SAV) i5/OS CL command.

On i5/OS, your data is in a network-server storage space.

To save data for a Linux logical partition that uses i5/OS resources by using the Save (SAV) i5/OS CL command, follow these steps:

1. At the i5/OS command line, enter the Save (SAV) command.
2. On the Save display, enter the following parameter values:
   a. In the **Device** field, enter the associated i5/OS device description. To save to a save file in a library like QGPL, enter /qsys.lib/qGPL.lib/myfile.file. For example, if your tape device is named TAP01, enter /qsys.lib/tap01.devd.
   b. In the **Objects: Name** field, enter the integrated-file-system location of the network-server storage space. For example, if your network-server storage space is named TEST1, enter /qfpnwsstg/test1.
3. At the i5/OS command line, enter the Display Save File (DSPSAVF) command to verify that the changed save file exists.
4. In the **Option** field by the new save file name, enter 5 (Display) to display a list of the stream files in the save file.

**Restore Linux data using i5/OS RST:**

You can restore data for a Linux logical partition that uses i5/OS resources by using the Restore (RST) i5/OS CL command.
Restore (RST) is the i5/OS command to restore Linux files from the shared tape drive of the partition that shares resources. On the Restore Object display, enter the following parameter values:

1. To restore from a tape device, enter the associated i5/OS device description in the **Device** field. For example, if your tape device is named TAP01, enter `/qsys.lib/tap01.devd`.
2. To restore from a save file in library QGPL, enter the associated file name. For example, `/qsys.lib/qgpl.lib/myfile.file`.
3. In the **Objects: Name** field, enter the integrated-file-system location of the network-server storage space. For example, `/qfpnwsstg/test1`.

**Backing up the network server description and virtual disk drives associated with a Linux partition:**

Learn about how to back up the data for a Linux logical partition that uses i5/OS resources.

Backing up the data for a Linux logical partition that uses i5/OS resources is different from backing up the data for a Linux logical partition that uses its own resources. When you install the logical partitions with virtual disk, the i5/OS logical partition that shares resources creates a network server description and creates disk drives for your Linux logical partition that you need to back up. Some of the disk drives are server-related (the installation and server drives), while others are user-related. Because your Linux logical partition might consider the disk drives to be a unified server, you must save all the disk drives and the network server description so they restore correctly.

The implementation of a logical partition for IBM System i servers allows you to save and restore virtual disks as i5/OS network-server storage space objects. These objects are saved as part of the i5/OS server when you perform a full i5/OS server backup. You can also specifically save the network server description and storage spaces that are associated with a logical partition on an IBM System i server. Daily backup of the server drive is a good practice.

**Related information**

[Backup and recovery](#)

**Building a rescue image on a network storage space:**

You can build a rescue image on a network storage space (NWSSTG) to assist you in checking and repairing a faulty Linux installation.

A rescue image is a disk image that contains the Linux kernel, a shell, and the diagnostic tools, drivers, and other utilities that would be useful for checking and repairing a faulty Linux installation. Many Linux distributors include a rescue image on their installation disks. One rescue solution for a logical partition is to create a small NWSSTG that can remain on the integrated file system solely for the purpose of rescuing logical partitions. You can install a rescue image to the NWSSTG when you create your logical partition.

Before creating a rescue image on network storage, it is important to document the configuration information for each of your logical partitions.

1. Document the drive configuration information, which is located in the `/etc/fstab` file.
2. Capture the networking information that is reported when you run the `ifconfig` command.
3. Create a list of the modules that are needed by each logical partition. You can see which modules are in use by using the `lsmod` command from within Linux. Use the information obtained from the commands and files listed above to determine which files to store on your rescue network storage space.

To build a rescue image on an NWSSTG, follow these steps:

1. Determine how much network storage space you need to build the rescue image. Consult your Linux documentation to see how much space is required for a minimum installation of your distribution, and add enough space to create a swap partition (a PowerPC Reference Platform (PReP)
start partition) and to install any extra software that you would like to have available in your rescue image. For example, if the documentation states that a minimum server installation is 291 MB, create a storage space of 425 MB.

2. Create a network storage space (CRTNWSSTG) of the size you determined for the rescue image. You might want to make a note in the storage space description field that indicates which distribution was used to make the rescue image and warns that it should be saved.

3. Link this storage space to a network server description (NWSD). You do not need to create a new NWSD for this step. You could unlink an existing storage space and temporarily link your rescue storage space to any of your existing NWSDs.

4. Start the installation server for your distribution as described in the documentation and follow the prompts. To partition your installation manually, ensure that you create a PReP start partition. At the point where you select the packages to install, select the minimum number of packages supported. The name for the package group varies by distribution.

5. Allow the installer to complete its package installation and configuration. After installation has finished, the installer starts the rescue image for you.

6. Verify that the rescue image has all the utilities that you need. For a logical partition, at a Linux command prompt, type `rpm -qa | grep ibmsis` to make sure that the utilities that work with the integrated disk are available.

7. Ensure that the device drivers that your logical partitions require are installed. For example, verify that pcnet32 is installed for Ethernet devices, or that olympic is installed for token-ring devices. The kernel modules that have been compiled can be found in the `/lib/modules/kernel version/kernel/drivers` directory or in directories under that directory.

8. Install any other special drivers or software packages that your logical partitions require.

9. Use File Transfer Protocol (FTP) to send the files with the configuration information for your other logical partitions to the rescue server network storage space.

10. Install the kernel manually (if you are required to do so by your Linux distribution). For details regarding installing the kernel, consult the appropriate installation documentation for your distribution.

11. Make note of the path to the root partition on the rescue-storage space. You must use this information to start the rescue network storage space from the network. To determine the root partition, type the command `cat /etc/fstab`. The partition that has a forward slash (/) in the second column is your root partition. For further assistance in determining the root partition, see the documentation for your distribution.

You can shut down your logical partition by typing `shutdown -h now` and varying off the partition after the shutdown has completed. After the partition has varied off, you can unlink the rescue storage space and relink the normal storage space for the NWSD.

Using a rescue image from a network-server storage space:

You can use a Linux rescue image on a network-server storage space (NWSSTG) to repair a Linux logical partition that uses i5/OS resources. A rescue image is a disk image that contains the Linux kernel, a shell, and the diagnostic tools, drivers, and other utilities that would be useful for checking and repairing a faulty Linux installation.

To use the rescue image that you built on the NWSSTG, use the following steps:

1. Disconnect the virtual storage space for the failed logical partition (if applicable) by using the Work with NWS Storage Spaces (WRKNWSSTG) command.

2. Connect your rescue storage space as the first drive to the network server description (NWSD), and reconnect the original storage space (where applicable) as the second drive.
3. Edit the NWSD for the failed partition so that it starts from IPL source *NWSSTG. Also, edit the IPL Parameters field to reflect the root partition on the rescue storage space. For most distributions, this is a parameter such as root=/dev/sda3 or root=/dev/vda1. For assistance, see the documentation for your Linux distribution.

4. Restart the partition.

5. If the existing root partition is on a dedicated disk, you might need to insert the ibmsis driver using the insmod ibmsis command.

6. Create a mount point to which you will mount the root partition of the network storage space that you are trying to rescue. You can use a command such as mkdir /mnt/rescue.

7. Mount the root partition of the network storage space that you are trying to rescue. Mount a drive using the command mount -t partition-type partition-location mount-point, where the partition type is the format of the partition such as ext2 or reiserfs, the partition location is similar to /dev/sdb3 (for non-devfs disk partitions), /dev/sd/disc1/part3 (for devfs disk partitions), or /dev/sda2 (for a partition on a dedicated disk).

8. The drive that you are trying to rescue, when using virtual disk, will be the second drive rather than the first drive. (That is, if the drive was /dev/sda3 when the partition was running normally, it will be /dev/sdb3 in the rescue server.)

9. Use the documentation or the configuration files you created when you created the rescue NWSSTG to help you determine the device for the root of the partition you are trying to rescue. Your mount point will be similar to /mnt/rescue if you use the previous example.

You can either use the rescue tools provided in your rescue storage space against the mount point you have created or you can work on the partition that you are rescuing from within its own storage space. If rescuing the image from its own storage space, change the root directory for that partition using the chroot mount-point command.

**Backing up network server descriptions for a Linux partition:**

When you save the storage space objects that are associated with a logical partition that uses virtual disks, you must also save the network server description (NWSD). Otherwise, a logical partition might not be able to re-establish items such as the file-system permissions for the partition.

Use the Save Configuration (SAVCFG) command to save the network server description:

1. On the i5/OS command line, type SAVCFG.
2. Press Enter to save the NWSD configuration.

The Save Configuration command (SAVCFG) saves the objects associated with an NWSD and the current static network-server storage spaces. This command does not save the links associated with the dynamically added storage spaces. You must add these links manually after the configuration and the dynamically linked storage spaces have been restored.

**Restoring network-server descriptions for a Linux partition:**

In a disaster-recovery situation, you would restore all the configuration objects, which include the network-server description (NWSD) for your logical partition. In some situations, you must specifically restore the NWSD. For example, you must restore the NWSD when you migrate to new hardware.

To have i5/OS automatically relink disk drives within the integrated file system to the restored NWSD, restore those disk drives first.

To restore the NWSD, use the Restore Configuration (RSTCFG) command:

1. On an i5/OS command line, type RSTCFG and press F4 (Prompt).
2. In the Objects field, specify the name of the NWSD.
3. In the **Device** field, specify which device you are using to restore the NWSD. If you are restoring from media, specify the device name. If you are restoring from a save file, specify *SAVF and identify the name and library for the save file in the appropriate fields.

4. Press Enter to restore the NWSD.

5. When you have restored the NWSD and all of its associated storage spaces, start (vary on) the logical partition.

**Unlinking virtual disk drives from a Linux logical partition:**

By unlinking virtual disk drives (network-server storage spaces) from a Linux logical partition that uses i5/OS resources, you disconnect the virtual disk drives from the logical partition, making the virtual disk drives inaccessible to users. If you delete a Linux logical partition that uses i5/OS resources, you must unlink all virtual disk drives from the logical partition before you delete the logical partition.

To unlink a virtual disk drive from a Linux logical partition that uses i5/OS resources, follow these steps:

1. Unlink disk drives from a logical partition using iSeries Navigator. If you prefer to use a character-based interface, go to step 2 on page 120.
   a. Vary off the NWSD for your logical partition. For more information, see Starting and stopping the NWSD.
   b. Click **Network → Windows Administration → Disk Drives**.
   c. Right-click the name of the disk drive that you want to unlink.
   d. Click **Remove Link**.
   e. Select a server from the list of linked servers.
   f. If you are unlinking a disk drive that you plan to relink later, uncheck **Compress link sequence**. You must relink the disk drive as the same link sequence number before you vary on the server. By preventing compression of the link sequence values, you avoid having to unlink and relink all the disk drives to get them in the correct sequence.
   g. Click **Remove**.
   h. You have completed this procedure. Do not complete step 2 on page 120

2. Unlink disk drives from a logical partition using a character-based interface:
   a. Vary off the NWSD for your logical partition. For more information, see Starting and stopping the NWSD.
   b. Type `RMVNWSSTGL` and press F4.
   c. In the Network-server storage space field, type the name of the storage space that you want to unlink and press Enter.
   d. In the Network server description field, type the name of the server from which you want to unlink the storage space and press Enter.
   e. If you are unlinking a linked disk drive that you plan to relink later, specify *NO in the Renumber field.

   **Note**: You must relink the disk drive as the same sequence number before you vary on the server. By preventing automatic renumbering, you avoid having to unlink and relink all the disk drives to get them in the correct sequence.
   f. Press Enter.

   **Note**: If you are uninstalling a logical partition, your next step is to delete the disk drive. For more information on deleting disk drives, see Deleting virtual disk drives for a logical partition. Otherwise, vary on the NWSD for your logical partition. For more information about starting the NWSD, see Starting and stopping the NWSD.

For more information about saving i5/OS server objects, see Saving server objects in i5/OS.
Related concepts

“Saving Linux server objects in i5/OS” on page 120
When a Linux logical partition uses i5/OS resources, i5/OS stores Linux information in i5/OS objects. i5/OS can restore the objects correctly only if you save all objects for a Linux logical partition.

Related tasks

“Deleting virtual disk drives for a Linux logical partition” on page 118
You can delete a virtual disk drive from a Linux logical partition that uses i5/OS resources to make the space available to the i5/OS logical partition once more. When you delete a virtual disk drive, all of the information on the virtual disk drive is erased.

“Starting the network-server description for a Linux logical partition” on page 113
You can start the network-server description (NWSD) for a Linux logical partition that uses i5/OS resources to make the resources defined in the NWSD available to the Linux logical partition.

Saving Linux server objects in i5/OS:

When a Linux logical partition uses i5/OS resources, i5/OS stores Linux information in i5/OS objects. i5/OS can restore the objects correctly only if you save all objects for a Linux logical partition.

You can save these objects by using options of the i5/OS GO SAVE command in the server.

- Option 21 saves the entire server.
- Option 22 saves server data, which includes objects in the QUSRSYS library.
- Option 23 saves all user data, which includes objects in the QFPNWSSTG library.

If you want to save a particular object, use the following table to see the location of that object on i5/OS and the command to use. For more information about using the save commands, see the i5/OS Backup and recovery topic collection.

Table 29. Objects to save for logical partitions with virtual disk

<table>
<thead>
<tr>
<th>Object content</th>
<th>Object name</th>
<th>Object location</th>
<th>Object type</th>
<th>Save command</th>
</tr>
</thead>
</table>
| Guest partition and virtual disk drive              | stgspc      | /QFPNWSSTG          | User-defined network-server storage spaces in system auxiliary storage pool (ASP) | GO SAVE, option 21 or 23
|                                                     |             |                     |                                                                             | SAV OBJ(’/QFPNWSSTG/stgspc’) DEV(’/QSYS.LIB/TAP01.DEVD’)                     |
|                                                     |             |                     |                                                                             |                                                                             |
|                                                     |             |                     | User-defined network-server storage spaces in user ASP                      |                                                                             |
|                                                     |             |                     |                                                                             |                                                                             |

Table 30. Objects to save for all logical partitions with a server

<table>
<thead>
<tr>
<th>Object content</th>
<th>Object name</th>
<th>Object location</th>
<th>Object type</th>
<th>Save command</th>
</tr>
</thead>
</table>
| Messages from the logical partition                 | Various     | Various         | Server message queue         | GO SAVE, option 21 or 23
|                                                     |             |                 |                                                                             | SAVOBJ OBJ(msg) LIB(library) DEV(TAP01) OBJTYPE(’MSGQ’)                      |
| i5/OS configuration objects for logical partitions  | Various     | QSYS            | Device configuration objects | GO SAVE, option 21, 22, or 23
|                                                     |             |                 |                                                                             | SAVOBJ DEV (TAPO1)                                                           |
Table 30. Objects to save for all logical partitions with a server (continued)

<table>
<thead>
<tr>
<th>Object content</th>
<th>Object name</th>
<th>Object location</th>
<th>Object type</th>
<th>Save command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Various</td>
<td>Various</td>
<td>QUSR_SYS</td>
<td>Various</td>
<td>GO SAVE, option 21 or 23 SAVLIB LIB(*NONSYS) or LIB(*ALLUSR)</td>
</tr>
</tbody>
</table>

Related tasks

"Unlinking virtual disk drives from a Linux logical partition" on page 119

By unlinking virtual disk drives (network-server storage spaces) from a Linux logical partition that uses i5/OS resources, you disconnect the virtual disk drives from the logical partition, making the virtual disk drives inaccessible to users. If you delete a Linux logical partition that uses i5/OS resources, you must unlink all virtual disk drives from the logical partition before you delete the logical partition.

Related information

Backup and recovery

Getting fixes for logical partitions and server firmware

Fixes play an important part in the maintenance strategy for your managed system. They give you a chance to reduce system downtime, add functionality, or provide optimal availability.

It is important that you develop a fix management strategy to help you keep track of fixes that are available for the software you have, and to ensure that you can keep these programs running smoothly.

For more information about installing fixes on your server firmware, Hardware Management Console, and i5/OS logical partitions, see the Getting fixes topic.

Related information

Getting fixes

Using i5/OS installed on a logical partition

There are some differences between using i5/OS on a logical partition and using i5/OS on a nonpartitioned server. In most cases, you will find these two environments to be similar, if not identical.

Restarting and shutting down i5/OS in a logical partition

At times you will need to perform an initial program load (IPL) or shut down an i5/OS logical partition. For example, if you want to apply a delayed fix to i5/OS, you must perform an IPL before i5/OS can apply the fix.

The preferred method for restarting and shutting down i5/OS logical partitions is through the i5/OS command line. The Hardware Management Console (HMC) does not shut down the i5/OS operating system before it shuts down the logical partition. Using the HMC to restart or shut down an i5/OS logical partition can result in an abnormal IPL and the loss of data. However, you might need to use the HMC to change the operating mode or IPL type of the i5/OS logical partition before you restart or shut down the i5/OS logical partition using the i5/OS command line.

It is important to remember that, when you perform an IPL of an i5/OS logical partition, you are powering off only the logical partition and not the entire managed system. Other logical partitions on your managed system continue to run when you perform an IPL on the i5/OS logical partition. However, when you shut down the last logical partition that is running on a managed system, then the managed system is set to power off automatically by default. If you want, you can set the managed system properties on the HMC so that the managed system remains powered on when you shut down the last running logical partition.

For more information about abnormal IPLs, see the i5/OS Basic system operations topic collection.
Related information

- Basic system operations

Shutting down i5/OS logical partitions:

The correct way to shut down an i5/OS logical partition safely is from an i5/OS command line.

If you cannot shut down the i5/OS logical partition from an i5/OS command line, you can shut down the i5/OS logical partition from the Shut Down Partition window on your HMC or from the remote control panel on the Operations Console. Using these methods can cause an abnormal shutdown and can result in loss of data.

Before you shut down an i5/OS logical partition, you must perform all of the basic i5/OS shutdown tasks. For example, all other users must be signed off of the i5/OS logical partition before you can shut it down. If you shut down the i5/OS logical partition without completing all of the required tasks, you can cause damage to data or cause the system to behave in unpredictable ways. For more information on what you must do before shutting down the i5/OS logical partition, see the i5/OS Basic system operations topic collection.

Related tasks

- "Partitioning a new or nonpartitioned IBM System i5 or eServer i5 managed system using version 6 or earlier of the HMC" on page 211
  Use this procedure to partition a new or nonpartitioned IBM System i5 or eServer i5 managed system using version 6 or earlier of the Hardware Management Console (HMC). In this procedure, you will validate the hardware on the managed system, create the logical partitions on the managed system, and designate the service partition for the managed system.

- "Partitioning a new or nonpartitioned IBM System i5 or eServer i5 managed system using version 7 or later of the HMC" on page 69
  Use this procedure to partition a new or nonpartitioned IBM System i5 or eServer i5 managed system using version 7 or later of the Hardware Management Console (HMC). In this procedure, you will validate the hardware on the managed system, create the logical partitions on the managed system, and designate the service partition for the managed system.

Related information

- Basic system operations

Shutting down i5/OS logical partitions using version 6 or earlier of the HMC:

You can shut down i5/OS logical partitions using the Hardware Management Console (HMC).

Before you shut down the i5/OS logical partition, complete the following:
1. If an Integrated xSeries Adapter (IXA) is present on the system, shut down the IXA using i5/OS options.
2. Ensure that all jobs are completed and all applications are ended.
3. Ensure that your partition profiles are updated with any dynamic logical partitioning resource changes that you want to keep when you restart the logical partition.

The correct way to shut down an i5/OS logical partition from the HMC is to open an HMC 5250 emulator session and run the Power Down System (PWRDWN SYS) command.

To shut down an i5/OS logical partition version 6 or earlier of the HMC, follow these steps:
1. Open an HMC 5250 emulator session for an i5/OS logical partition. See Connecting to a 5250 console for instructions.
2. From the i5/OS command line in the emulator session, type PWRDWN SYS OPTION (*CNTRLD) DELAY (600) and press Enter. The system will only shut down the i5/OS logical partition you
selected. The PWRDWNSYS command does not affect other i5/OS logical partitions on your system. If you enter the PWRDWNSYS command with the RESTART(*YES) option, the operating system restarts, and the resource specifications of the logical partition remain the same. If you do not use the RESTART(*YES) option, then the logical partition shuts down completely, and other logical partitions will be able to take and use the resources that were used by the logical partition. Also, when you reactivate the logical partition using a partition profile, the partition profile overlays the resource specifications of the logical partition with the resource specifications in the partition profile. Any resource changes that you made to the logical partition using dynamic logical partitioning are lost when you reactivate the logical partition using a partition profile. If the logical partition is set to start automatically when the managed system starts, you can preserve the resource specifications on that logical partition by restarting the entire managed system using the Partition autostart power-on mode. When the logical partitions start automatically, the logical partitions have the resource specifications that the logical partitions had when you shut down the managed system.

3. If the PWRDWNSYS command does not work, you can use either of the following methods to shut down the i5/OS logical partition.

   **Attention:** Using these methods can cause an abnormal shutdown and can result in loss of data.
   - Delayed shutdown. See Performing a delayed shutdown of an i5/OS logical partition using version 6 or earlier of the HMC for instructions.
   - Immediate shutdown. See Performing an immediate shutdown of an i5/OS logical partition using version 6 or earlier of the HMC for instructions.

**Related tasks**

- [Performing a delayed shutdown of an i5/OS logical partition using version 6 or earlier of the HMC](#)
- [Performing an immediate shutdown of an i5/OS logical partition using version 6 or earlier of the HMC on page 286](#)

**Related information**

- Connecting to a 5250 console

*Performing a delayed shutdown of an i5/OS logical partition using version 6 or earlier of the HMC:*

You can perform a delayed shutdown of a logical partition using the Hardware Management Console (HMC). Using delayed shutdown is equivalent to using the power button on the remote control panel. Use delayed shutdown only when you must shut down a logical partition, and the PWRDWNSYS command does not work.

*Performing an immediate shutdown of an i5/OS logical partition using version 6 or earlier of the HMC:*

You can perform a delayed shutdown of a logical partition using the Hardware Management Console (HMC). Using delayed shutdown is equivalent to using the power button on the remote control panel. Use delayed shutdown only when you must shut down a logical partition, and the PWRDWNSYS command does not work.

When you use the delayed shutdown option, the logical partition waits a predetermined amount of time to shut down. This allows the logical partition time to end jobs and write data to disks. If the logical partition is unable to shut down within the predetermined amount of time, it will end abnormally and the next restart might take a long time.

To perform a delayed shutdown of an i5/OS logical partition using version 6 or earlier of the HMC, complete the following:

1. In the navigation area, open **Server and Partition**.
2. Select **Server Management**.
3. In the contents area, open the managed system on which the logical partition resides.
4. Open **Partitions**.
5. Right-click the logical partition that you want to shut down and select **Shut Down Partition**.
6. Select **Delayed** and click **OK**.

**Related tasks**

“Shutting down i5/OS logical partitions using version 6 or earlier of the HMC” on page 284

You can shut down i5/OS logical partitions using the Hardware Management Console (HMC).

**Performing an immediate shutdown of an i5/OS logical partition using version 6 or earlier of the HMC:**

Use this procedure to perform an immediate shutdown of a logical partition using the Hardware Management Console (HMC).

**Attention:** Using immediate shutdown can cause an abnormal IPL of the i5/OS logical partition and possibly cause loss of data. Use immediate shutdown only when an i5/OS logical partition cannot shut down using PWRDWNSYS or delayed shutdown.

When you use the immediate shutdown option, the system shuts down without any preset delay. Using immediate shutdown is equivalent to using function 8 on the remote control panel.

To perform an immediate shutdown of an i5/OS logical partition using version 6 or earlier of the HMC, complete the following:

1. In the navigation area, open **Server and Partition**.
2. Select **Server Management**.
3. In the contents area, open the server on which the logical partition resides.
4. Open **Partitions**.
5. Right-click the logical partition that you want to shut down and select **Shut Down Partition**.
6. Select **Immediate** and click **OK**.

**Related tasks**

“Shutting down i5/OS logical partitions using version 6 or earlier of the HMC” on page 284

You can shut down i5/OS logical partitions using the Hardware Management Console (HMC).

**Shutting down i5/OS logical partitions using Operations Console:**

You can shut down i5/OS logical partitions using Operations Console.

Before you shut down the i5/OS logical partition, complete the following:

1. If an Integrated xSeries Adapter (IXA) is present on the system, shut down the IXA using i5/OS options.
2. Ensure that all jobs are completed and all applications are ended.
3. Ensure that your partition profiles are updated with any dynamic logical partitioning resource changes that you want to keep when you restart the logical partition.

The correct way to shut down a logical partition is by using the i5/OS power down system (PWRDWNSYS) command.

From an i5/OS command line, type PWRDWNSYS OPTION (*CNTRLD) DELAY (600) and press Enter. The system will only shut down the i5/OS logical partition you selected. The PWRDWNSYS command does not affect other i5/OS logical partitions on your system.

If you enter the PWRDWNSYS command with the RESTART(*YES) option, the operating system restarts, and the resource specifications of the logical partition remain the same. If you do not use the RESTART(*YES) option, then the logical partition shuts down completely, and other logical partitions will be able to take and use the resources that were used by the logical partition. Also, when you reactivate the logical partition using a partition profile, the partition profile overlays the resource specifications of the logical partition with the resource specifications in the partition profile. Any resource changes that
you made to the logical partition using dynamic logical partitioning are lost when you reactivate the logical partition using a partition profile. If the logical partition is set to start automatically when the managed system starts, you can preserve the resource specifications on that logical partition by restarting the entire managed system using the Partition autostart power-on mode. When the logical partitions start automatically, the logical partitions have the resource specifications that the logical partitions had when you shut down the managed system.

If the PWRDWN command does not work, you can use the remote control panel through Operations Console to use control panel functions through a PC. The graphical user interface of the remote control panel looks similar to the physical control panel. The remote control panel installs through Operations Console. For more information on the remote control panel, see the i5/OS Remote control panel topic collection. Using the remote control panel to shut down the i5/OS logical partition can result in an abnormal IPL and loss of data.

**Delayed shutdown**

Use delayed shutdown only when you must shut down a logical partition, and the PWRDWN command does not work.

When you use the delayed shutdown option, the partition waits a predetermined amount of time to shut down. This allows the partition time to end jobs and write data to disks. If the partition is unable to shut down within the predetermined amount of time, it will end abnormally and the next restart might take a long time.

**Immediate shutdown**

Use immediate shutdown only when an i5/OS logical partition cannot shut down using PWRDWN or delayed shutdown.

When you use the immediate shutdown option, the system powers down without any preset delay.

**Attention:** This might cause an abnormal IPL of the i5/OS logical partition and possibly cause loss of data.

Use the remote control panel to perform a delayed shutdown or an immediate shutdown. The power button will start a delayed shutdown and function 8 will start an immediate shutdown of a system.

**Related information**

[Remote control panel]

**Changing the operating mode for an i5/OS logical partition using version 6 or earlier of the HMC:**

You can change the operating mode for an i5/OS logical partition using the Hardware Management Console (HMC). The operating mode for an i5/OS logical partition determines the number of options that are presented to the operator for consideration during and after the initial program load (IPL). It can also secure (lock) the control panel to prevent an unauthorized or inadvertent IPL from the control panel.

To change the i5/OS operating mode of a logical partition using version 6 or earlier of the HMC, follow these steps:

1. In the navigation area, open **Server and Partition**.
2. Select **Server Management**.
3. In the contents area, open the managed system on which the logical partition resides.
4. Open **Partitions**.
5. Right-click the logical partition and select **Properties**.
6. Click **Power-On Parameters**, set i5/OS IPL source and Keylock position to your preference, and click **OK**.

For more information about operating modes for an i5/OS logical partition, see the Operating mode of an IPL.

**Related information**

[Operating mode of an IPL](#)

### Changing the IPL type for an i5/OS logical partition using version 6 or earlier of the HMC:

You can change the initial program load (IPL) type for an i5/OS logical partition using the Hardware Management Console (HMC). When you change the IPL type, the managed system loads the Licensed Internal Code and i5/OS from the location specified by the IPL type.

You can choose a separate IPL type for each i5/OS logical partition.

**Attention:** Only use IPL type C under the direction of your service representative. Severe data loss can occur with incorrect use of this function.

To change the i5/OS IPL type of a logical partition using version 6 or earlier of the HMC, follow these steps:

1. In the navigation area, open **Server and Partition**.
2. Select **Server Management**.
3. In the contents area, open the managed system on which the logical partition resides.
4. Open **Partitions**.
5. Right-click the logical partition and select **Properties**.
6. Click **Power-On Parameters**, set i5/OS IPL source and Keylock position to your preference, and click **OK**.

For information about how each IPL source works and why you might need to change IPL types, see the IPL type topic.

**Related information**

[IPL type](#)

### Managing logical-partition and operating-system security

When all logical partitions are managed by the Hardware Management Console, you can control who has access to the HMC and the system. You can also use the IBM eServer Security Planner to help you plan a basic security policy for each of the operating systems on your system.

When all logical partitions are managed by the Hardware Management Console (HMC), the system administrator for the HMC can control who has access to the HMC and the managed systems by creating HMC user roles. The user roles control who can access different parts of the HMC and what tasks they can perform on the managed system.

For more information about securing the HMC and protecting your server, refer to Working with users, roles, and passwords, System Manager Security, or Tasks and roles.

You can use the IBM eServer Security Planner to help you plan a basic security policy for each of the operating systems on your IBM Systems or eServer hardware. The planner provides you with a list of recommendations for setting password rules, resource-access rules, logging and auditing rules, and other security settings that are specific to the operating system.

For more information about protecting your operating system, refer to the IBM eServer Security Planner.
**Related information**

- Working with users, roles, and passwords
- System Manager Security
- Tasks and roles
- IBM eServer Security Planner

**Backing up and recovering data**

It is crucial that you back up your data because you never know when you might need to do a server recovery. Save everything in your system as often as possible. You might not be prepared to recover from a site loss or certain types of disk failures if you do not regularly save everything.

For more information about planning a backup and recovery strategy for the Hardware Management Console (HMC) and i5/OS data, refer to the following topics:

*Table 31. Backup and recovery information for the HMC and i5/OS*

<table>
<thead>
<tr>
<th>Topic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backing up critical HMC data</td>
<td>This procedure explains how to save critical HMC data (such as user information and platform-configuration files) to a backup file. This information is in the Managing the HMC topic.</td>
</tr>
<tr>
<td>Backing up partition profile data</td>
<td>This procedure explains how to back up the partitioning data on your HMC to a backup file on the HMC. This information is in the Managing the HMC topic.</td>
</tr>
<tr>
<td>Reinstalling the HMC machine code</td>
<td>This procedure explains how to reinstall the HMC interface from the recovery CD-ROM. This information is in the Managing the HMC topic.</td>
</tr>
<tr>
<td>Restoring profile data</td>
<td>This procedure explains how to restore the partitioning data from the backup file to the HMC. This information is in the Managing the HMC topic.</td>
</tr>
<tr>
<td>Back up your server</td>
<td>This information can help you develop the backup strategy for your i5/OS logical partition. This information is in the Backup and recovery topic in the iSeries Information Center.</td>
</tr>
<tr>
<td>Recover your server</td>
<td>This information can help you reload your operating system and data. This information is in the Backup and recovery topic in the iSeries Information Center.</td>
</tr>
</tbody>
</table>

**Performance impacts to i5/OS**

Managing i5/OS performance ensures that your managed system is efficiently using resources and that your managed system provides the best possible services to you and to your business. Moreover, effective performance management can help you quickly respond to changes in your managed system and can save you money by postponing costly upgrades and service fees.

For more information about managing i5/OS performance, see the i5/OS Performance topic collection.
Troubleshooting i5/OS logical partitions

If you have problems with a partitioned system, determine if the problem is specific to logical partitions or is a system problem. If your problem is specific to logical partitions, you can use the reference codes to resolve the error. However, specific recovery actions and tasks might require the assistance of your next level of support.

Refer to Troubleshooting to determine whether or not your problem is a general system problem.

Reference codes for logical partitions

Logical partition reference codes are diagnostic aids that help you determine the source of a hardware or operating system problem. Using reference codes enables you to find the correct solution to fix the problem. To use reference codes effectively, you must use them in conjunction with other service and support procedures.

For additional information about reference codes, including how to use reference code information, refer to the following topics:

Table 32. Information about reference codes for logical partitions

<table>
<thead>
<tr>
<th>Topic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference codes overview</td>
<td>This topic contains information about the four categories of status indicators that can appear in the control panel or console of the system or operating system.</td>
</tr>
<tr>
<td>Using system reference codes</td>
<td>This topic shows you how you can use reference code information to identify a list of possible failing items. The information in this topic is intended for authorized service providers.</td>
</tr>
<tr>
<td>Logical partition reference codes</td>
<td>This topic contains a list of common system reference codes. The information in this topic is intended for authorized service providers.</td>
</tr>
<tr>
<td>Partition firmware reference codes</td>
<td>This topic contains a list of common partition firmware reference codes. The information in this topic is intended for authorized service providers.</td>
</tr>
<tr>
<td>Hardware Management Console error messages</td>
<td>This topic contains a list of common HMC error messages.</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>This topic collection contains information to help you understand, isolate, and resolve problems that you are having with your server.</td>
</tr>
</tbody>
</table>
Debugging network server description error messages for AIX logical partitions

This topic provides a list of network server description (NWSD) error codes and explanations to help you debug NWSD error messages for AIX logical partitions.

You could encounter error messages when you try to vary on an AIX logical partition. These error messages will appear if you provide information that does not apply to a logical partition running on the server when you create your network server description (NWSD). All error messages related to the NWSD should appear in QSYSOPR and should indicate a description of the problem and a resolution to the problem.

Table 33. NWSD error messages

<table>
<thead>
<tr>
<th>Reason codes</th>
<th>Code explanations</th>
</tr>
</thead>
<tbody>
<tr>
<td>00000001</td>
<td>&quot;NWSSTG was specified as the IPL source, but no storage space was found.</td>
</tr>
<tr>
<td>00000002</td>
<td>The partition specified in the PARTITION parameter was not found.</td>
</tr>
<tr>
<td>00000003</td>
<td>The partition specified in the PARTITION parameter is not a GUEST partition (that is, the TYPE parameter for the partition specified in the PARTITION parameter does not have a value of &quot;GUEST&quot;).</td>
</tr>
<tr>
<td>00000004</td>
<td>There is already an NWSD in the i5/OS partition that is active and using the partition specified in the PARTITION parameter of the NWSD.</td>
</tr>
<tr>
<td>00000005</td>
<td>The partition specified in the PARTITION parameter of the NWSD is powered on (perhaps through the LPAR configuration interface or from another i5/OS partition.)</td>
</tr>
<tr>
<td>00000006</td>
<td>The partition is set to start from a stream file (stmf) and that did not work. You should note that the user performing the vary on operation needs read access to the IPL STMF parameter.</td>
</tr>
<tr>
<td>00000007</td>
<td>The NWSD is set to start from a network-storage space (NWSSTG), but the kernel could not found the NWSSTG. Some common reasons are that the storage space does not have a disk partition that is formatted as type 0x41 or is marked as startable.</td>
</tr>
<tr>
<td>00000008</td>
<td>The partition would not start. There are a variety of reasons why the partition will not start. You should look at the information for this partition and start reviewing the SRCs.</td>
</tr>
<tr>
<td>00000009</td>
<td>The partition identified as the logical partition is not configured. You should specify who has power controlling access to the partition.</td>
</tr>
<tr>
<td>00000010</td>
<td>A network server storage space linked to this network server is damaged. Contact your next level of support.</td>
</tr>
<tr>
<td>00000011</td>
<td>Contact your next level of support to find a proper solution to the problem.</td>
</tr>
<tr>
<td>00000012</td>
<td>The resource name you selected in the RSRCNAME parameter is not valid. Use the Work with Hardware Resources (WRKHDWRSC) command with the TYPE(*CMN) parameter to help determine the resource name.</td>
</tr>
<tr>
<td>00000013</td>
<td>The resource you selected in the RSRCNAME command exists, but is not in the partition you specified. Use the WRKHDWRSC command with the TYPE(*CMN) parameter to help determine a resource name in the partition you specified.</td>
</tr>
</tbody>
</table>
Troubleshooting errors for Linux partitions using i5/OS virtual I/O resources

In many cases, you can troubleshoot and resolve errors specific to Linux logical partitions using i5/OS virtual I/O resources without having to call service and support.

Debugging network server description error messages:

This topic provides a list of network server description (NWSD) error codes and explanations to help you debug NWSD error messages for Linux logical partitions.

You could encounter error messages when you try to vary on a Linux logical partition. These error messages will appear if you provide information when you create your network server description (NWSD) that does not apply to a logical partition running on the server. All error messages related to the NWSD should appear in QSYSOPR indicating a description of the problem and a resolution to the problem.

### Table 34. NWSD error messages

<table>
<thead>
<tr>
<th>Reason codes</th>
<th>Code explanations</th>
</tr>
</thead>
<tbody>
<tr>
<td>00000001</td>
<td>*NWSSTG was specified as the IPL source, but no storage space was found.</td>
</tr>
<tr>
<td>00000002</td>
<td>The partition specified in the PARTITION parameter was not found. Use the CHGNWSD i5/OS Control Language (CL) command to compare the partition name in the NWSD with the partition name created on the Hardware Management Console (HMC), and change the partition name as necessary.</td>
</tr>
<tr>
<td>00000003</td>
<td>The partition specified in the PARTITION parameter is not a GUEST partition (that is, the TYPE parameter for the partition specified in the PARTITION parameter does not have a value of &quot;*GUEST&quot;).</td>
</tr>
<tr>
<td>00000004</td>
<td>There is already an NWSD in the i5/OS partition that is active and using the partition specified in the PARTITION parameter of the NWSD.</td>
</tr>
<tr>
<td>00000005</td>
<td>The partition specified in the PARTITION parameter of the NWSD is powered on (perhaps through the LPAR configuration interface or from another i5/OS partition.)</td>
</tr>
<tr>
<td>00000006</td>
<td>The partition is set to start from a stream file (stmf) and that did not work. You should note that the user performing the vary on operation needs read access to the IPL STMF parameter.</td>
</tr>
<tr>
<td>00000007</td>
<td>The NWSD is set to start from a network-storage space (NWSSTG), but the kernel could not find the NWSSTG. Some common reasons are that the storage space does not have a disk partition that is formatted as type 0x41 or is marked as startable.</td>
</tr>
<tr>
<td>00000008</td>
<td>The partition would not start. There are a variety of reasons why the partition will not start. You should look at the information for this partition and start reviewing the SRCs.</td>
</tr>
<tr>
<td>00000009</td>
<td>The partition identified as the logical partition is not configured. You should specify who has power controlling access to the partition.</td>
</tr>
<tr>
<td>00000010</td>
<td>A network server storage space linked to this network server is damaged. Contact your next level of support.</td>
</tr>
<tr>
<td>00000011</td>
<td>Contact your next level of support to find a proper solution to the problem.</td>
</tr>
</tbody>
</table>
Table 34. NWSD error messages (continued)

<table>
<thead>
<tr>
<th>Reason codes</th>
<th>Code explanations</th>
</tr>
</thead>
<tbody>
<tr>
<td>00000012</td>
<td>The resource name you selected in the RSRCNAME parameter is not valid. Use the Work with Hardware Resources (WRKHDWRSC) command with the TYPE(*CMN) parameter to help determine the resource name.</td>
</tr>
<tr>
<td>00000013</td>
<td>The resource you selected in the RSRCNAME command exists, but is not in the partition you specified. Use the WRKHDWRSC command with the TYPE(*CMN) parameter to help determine a resource name in the partition you specified.</td>
</tr>
<tr>
<td>00000014</td>
<td>Unable to determine partition for resource name. Either specify a partition directly or update the resource definition at the HMC to indicate the client partition.</td>
</tr>
<tr>
<td>00000015</td>
<td>Unknown error occurred. Contact your next level of support.</td>
</tr>
</tbody>
</table>

Troubleshooting Linux virtual tape errors:

You can troubleshoot and recover from many common Linux virtual tape errors without having to call service and support.

If errors occur while you access Linux virtual tape, examine the file /proc/iSeries/viotape. It describes the mapping between i5/OS device names and Linux device names and records the last error for each tape device.

Table 35. Common errors and recovery scenarios for troubleshooting Linux virtual tape

<table>
<thead>
<tr>
<th>Error</th>
<th>Recovery scenario</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device unavailable</td>
<td>Make sure the device is varied off in the i5/OS logical partition.</td>
</tr>
<tr>
<td>Not ready</td>
<td>Retry the operation. If the operation still fails with the same description in /proc/iSeries/viotape, verify that the correct medium is in the tape drive.</td>
</tr>
<tr>
<td>Load failure or cleaning cartridge found</td>
<td>Verify that the correct medium is in the tape drive.</td>
</tr>
<tr>
<td>Data check or Equipment check</td>
<td>Verify that you are using a supported block size to read or write the tape. All known IBM -supported tape devices can use a block size of 20 KB (supplied by the -b 40 argument to tar).</td>
</tr>
<tr>
<td>Internal error</td>
<td>Contact your service representative.</td>
</tr>
</tbody>
</table>

Situations requiring the assistance of an authorized service provider

Some i5/OS troubleshooting tasks on the server require the assistance of an authorized service provider. These tasks are not common and are only performed if the authorized service provider deems it necessary.

If you need to perform any of these tasks on your server, consult the Support for iSeries Web site for information on iSeries support.

Related information

Support for iSeries Web site

Main storage dumps on i5/OS logical partitions:

When the system has a failure, it might create a main storage dump. A main storage dump copies the contents of the server’s memory to disk. It is an important tool for problem analysis.

When your system performs a main storage dump, contact service and support.
On a system with logical partitions, there are two types of failures that can cause main storage dumps: server failure and partition failure.

Failures caused by server processing hardware or server firmware might cause the entire server to fail. Software failures in a logical partition cause only that logical partition to fail. A server failure may cause a platform system dump. A logical partition failure may cause a main storage dump only on that logical partition.

You can also force a main storage dump on a partition or managed system when you are directed to do so by an authorized service provider.

For more information about main storage dumps and how to collect system data for analysis, see Performing dumps.

**Related information**

Performing dumps

**Using remote service with logical partitions:**

You can use the Hardware Management Console (HMC) to enable remote services with logical partitions. Remote service is a method that an authorized service provider can use to access your managed system through a modem.

**Attention:** Use this procedure only when directed to do so by service and support, and ensure that remote service is deactivated when you authorized service provider is finished with it. It is a security risk to leave remote service enabled when not in use. Someone could access your server without your knowledge.

The logical partition that is using remote service must have an electronic customer support communications IOP with a modem. The IOP needs to be tagged as the electronic customer support resource for the partition. If the communications IOP is on a shared bus and is used by another partition, switch the IOP to the partition that needs to use the modem. If this IOP is also attached to Operations Console, the console may be unavailable until the IOP is switched back to the original partition.

1. Create user ID.
2. Service Applications > Remote Support > Customize Inbound Connectivity Settings

**Shutting down a power domain with logical partitions:**

You can use the Hardware Management Console (HMC) to power off, repair, and power on the appropriate power domain when a disk unit I/O processor (IOP) or disk unit I/O adapter (IOA) fails. This allows you to replace the IOP or IOA without restarting the logical partition or managed system.

**Attention:** Use this procedure only when directed to do so by service and support. Incorrect use of this function can cause loss of data. It can also cause failures that may be incorrectly diagnosed as expensive hardware failures.

When a disk unit IOP or IOA fails, communication with the disk units (which is controlled by the) IOP or IOA is lost resulting in a disk unit attention SRC and possibly partial or complete loss of system responsiveness.

**Resetting a disk unit IOP with i5/OS logical partitions:**

You can use the Hardware Management Console (HMC) to reset a disk unit I/O processor (IOP). This function should only be used to start an IOP dump to reset the IOP or to reload IOP. This function becomes enabled when certain disk unit reference codes appear and the associated IOP supports a reset or reload function.
Attention: Use this procedure only when directed to do so by service and support. Incorrect use of this function can cause loss of data. It can also cause failures that may be incorrectly diagnosed as expensive hardware failures.

Scenarios: Logical partitions
One of the best ways to learn about logical partitions is to see examples illustrating how many of the applications and functions can be used in a sample business environment. Use these scenarios to learn about how you can use logical partitions in your business.

Scenario: Creating an i5/OS logical partition and partition profile using version 6 or earlier of the HMC:
You can create an i5/OS logical partition that acts as a virtual server on your managed system. When you create the i5/OS logical partition, you specify the resources that the logical partition uses in a partition profile.

Situation
As the system administrator of a medium-sized technology company, you are responsible for configuring and managing the IBM System i5 server that your company just purchased. Your server has arrived and you are ready to start partitioning your model.

Objectives
The objective of this scenario is to create an i5/OS logical partition and partition profile on a new IBM System i5 server.

Prerequisites and assumptions
This scenario assumes that the following prerequisite steps have been completed and are operational prior to beginning the configuration steps:
1. The Hardware Management Console (HMC) was set up.
   • The HMC was cabled. For more information about cabling the HMC, see Cabling the HMC.
   • You completed the planning process and you understood how you wanted to configure your HMC. For more information about configuring your HMC, see Gathering required configuration settings.
   • You used the Guided Setup wizard or the HMC configuration checklist to set up the HMC. For more information about the Guided Setup wizard, see Configuring the HMC using the Guided Setup wizard. For more information about the HMC configuration checklist, see Configuring the HMC using the HMC configuration checklist.
2. You read and understand the HMC concepts. For more information about HMC concepts, see Concepts for partitioning the server.
3. You completed the tasks recommended for logical partition planning. For more information about logical partition planning, see Planning for logical partitions.
4. You removed the system from the manufacturing default configuration and moved the physical hardware to support a partitioned configuration. For more information about how to prepare your system for partitioning, see Partitioning a new or nonpartitioned managed system using the HMC.
5. You logged in to the HMC with one of the following user roles:
   • Super administrator
   • Operator
   For more information about user roles, see Tasks and roles.
Configuration steps

Ensure that all the prerequisites for this scenario have been completed prior to completing these tasks.

To create a new logical partition on your server using the HMC, follow these steps:
1. In the Navigation Area, open Server and Partition.
2. Select Server Management.
3. In the contents area, open the server on which you want to create the partition profile.
4. Right-click Partitions and select Create → Logical Partitions.
5. Follow the steps in the Create Logical Partitions wizard to create a logical partition and a partition profile.

Related concepts
“Planning for logical partitions” on page 65
IBM hardware architectures allow you to create logical partitions to distribute resources within a single server and make it function as if it were two or more independent servers. Before creating logical partitions (LPARs), you need to plan for several variables that are specific to your solution. You need to understand how you can reconfigure partitions to respond to future needs.

Related information
Cabling the HMC
Preparing for HMC configuration
Configuring the HMC using the Guided Setup wizard
Configuring the HMC using the HMC configuration checklist
System Planning Tool Web site
Tasks and roles

Scenario: Using partition profiles:

As you will see, partition profiles allow you to change the hardware configuration of a logical partition quickly and easily.

Situation

You are the system administrator for a business recovery service center running IBM eServer hardware. You use IBM eServer hardware primarily to test disaster recovery strategies for your clients. Each of your clients has a different system configuration. This means that, each time a client comes into the office, you must change the system configuration of your managed system.

On each logical partition on your server, you create one profile for each client that uses the logical partition. When a client returns to the business recovery service center, you can reconfigure the managed system for that client simply by activating the partition profiles for that client.

You have just finished testing for Client 1. You must now reconfigure the server for Client 2, who comes into the office tomorrow.

Note: This is one example of how to change your system configuration. Depending on your operating system, business needs, and resource allocation, you could resolve this situation by dynamically moving resources.

Objectives

The objective of this scenario is to change the configuration of your managed system by using partition profiles.
Details

Your managed system has three logical partitions. The managed system has eight processors and 12 GB of memory. Each logical partition has one or two partition profiles. The following table illustrates how the logical partitions and partition profiles are set up.

<table>
<thead>
<tr>
<th>Logical partition ID</th>
<th>Name of logical partition</th>
<th>Name of partition profile</th>
<th>Processor resources</th>
<th>Memory resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partition 1</td>
<td>Test 1</td>
<td>Profile 1: Client 1</td>
<td>5 dedicated processors</td>
<td>8 GB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Profile 2: Client 2</td>
<td>7 dedicated processors</td>
<td>10 GB</td>
</tr>
<tr>
<td>Partition 2</td>
<td>Test 2</td>
<td>Profile 1: Client 1</td>
<td>2 dedicated processors</td>
<td>3 GB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Profile 2: Client 2</td>
<td>1 dedicated processor</td>
<td>2 GB</td>
</tr>
<tr>
<td>Partition 3</td>
<td>Test 3</td>
<td>Profile 1: Client 1</td>
<td>1 dedicated processor</td>
<td>1 GB</td>
</tr>
</tbody>
</table>

Prerequisites and assumptions

This scenario assumes that the following prerequisite steps have been completed prior to beginning the configuration steps:

1. The Hardware Management Console (HMC) was set up.
   • The HMC was cabled.
   • You completed the planning process and you understand how you want to configure your HMC.
   • You used the Guided Setup wizard or the HMC configuration checklist to set up the HMC.
2. You understand the concepts for partitioning the server.
3. You completed the tasks recommended for logical partition planning.
4. You moved and assigned the physical hardware according to the LPAR Validation Tool (LVT) output.
5. You logged in to the HMC with one of the following user roles:
   • Super administrator
   • Service representative
   • Product engineer
6. You created the logical partitions and partition profiles.
7. You activated the partition profiles for Client 1.

The following table lists the partition profiles that are currently active for each logical partition on the managed system.

<table>
<thead>
<tr>
<th>Logical partition ID</th>
<th>Name of logical partition</th>
<th>Name of partition profile</th>
<th>Processor resources</th>
<th>Memory resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partition 1</td>
<td>Test 1</td>
<td>Profile 1: Client 1</td>
<td>5 dedicated processors</td>
<td>8 GB</td>
</tr>
<tr>
<td>Partition 2</td>
<td>Test 2</td>
<td>Profile 1: Client 1</td>
<td>2 dedicated processors</td>
<td>3 GB</td>
</tr>
<tr>
<td>Partition 3</td>
<td>Test 3</td>
<td>Profile 1: Client 1</td>
<td>1 dedicated processor</td>
<td>1 GB</td>
</tr>
</tbody>
</table>
Configuration steps

To change the configuration of your managed system so that it is ready for Client 2, you must first shut down the logical partitions by using usual operating system procedures.

After shutting down the logical partitions, you can activate the partition profiles for Client 2. To do this, complete the following steps on your HMC:

1. In the navigation area, open Server and Partition.
2. Select Server Management.
3. In the contents area, open the server.
4. Open Partitions.
5. In the contents area, right-click the Test 1 logical partition and select Activate.
6. Select the Profile 2 partition profile and click OK.
7. Right-click the Test 2 logical partition and select Activate.
8. Select the Profile 2 partition profile and click OK.

After activating the partition profile, the managed system is configured according to the needs of Client 2. The following table lists the partition profiles that are currently active for each logical partition on the managed system.

<table>
<thead>
<tr>
<th>Logical partition ID</th>
<th>Name of logical partition</th>
<th>Name of partition profile</th>
<th>Processor resources</th>
<th>Memory resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partition 1</td>
<td>Test 1</td>
<td>Profile 2: Client 2</td>
<td>7 dedicated processors</td>
<td>10 GB</td>
</tr>
<tr>
<td>Partition 2</td>
<td>Test 2</td>
<td>Profile 2: Client 2</td>
<td>1 dedicated processor</td>
<td>2 GB</td>
</tr>
</tbody>
</table>

Related information

- Cabling the HMC
- Preparing for HMC configuration
- Configuring the HMC using the Guided Setup wizard
- Configuring the HMC using the HMC configuration checklist
- Planning for logical partitioning
- System Planning Tool Web site
- Tasks and roles

Scenario: Using system profiles:

As you will see, system profiles allow you to change the hardware configuration of an entire managed system quickly and easily.

Situation

You are the system administrator for a business recovery service center with IBM eServer hardware. You use IBM eServer hardware primarily to test disaster-recovery strategies for your clients. Each of your clients has a different system configuration. This means that, each time a client comes in, you must change the system configuration of your managed system.

You decide to create and use system profiles to change the system configuration of your managed system. First, on each logical partition on your server, you create a partition profile for each client that uses the logical partition. Then, you create a system profile for each client. Each system profile contains the
partition profiles that you want to activate for the client. When a client returns to the business recovery service center, you can reconfigure the managed system for that client simply by activating the system profile for that client.

You have just finished testing for Client 1. You must now reconfigure the managed system for Client 2, who comes in tomorrow.

Note: This is one example of how to change your system configuration. Depending on your operating system, business needs, and resource allocation, you could resolve this situation by dynamically moving resources.

Objectives

The objective of this scenario is to change the configuration of your managed system by using system profiles.

Details

Your managed system has eight processors and 12 GB of memory. You have created two system profiles on this managed system. Each system profile divides the resources of the managed system between two or three logical partitions.

The following table shows how the system profiles are set up:

<table>
<thead>
<tr>
<th>System Profile</th>
<th>Logical partition ID</th>
<th>Name of logical partition</th>
<th>Name of partition profile</th>
<th>Processor resources</th>
<th>Memory resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client 1</td>
<td>Partition 1</td>
<td>Test 1</td>
<td>Profile 1: Client 1</td>
<td>5 dedicated processors</td>
<td>8 GB</td>
</tr>
<tr>
<td></td>
<td>Partition 2</td>
<td>Test 2</td>
<td>Profile 1: Client 1</td>
<td>2 dedicated processors</td>
<td>3 GB</td>
</tr>
<tr>
<td></td>
<td>Partition 3</td>
<td>Test 3</td>
<td>Profile 1: Client 1</td>
<td>1 dedicated processor</td>
<td>1 GB</td>
</tr>
<tr>
<td>Client 2</td>
<td>Partition 1</td>
<td>Test 1</td>
<td>Profile 2: Client 2</td>
<td>7 dedicated processors</td>
<td>10 GB</td>
</tr>
<tr>
<td></td>
<td>Partition 2</td>
<td>Test 2</td>
<td>Profile 2: Client 2</td>
<td>1 dedicated processor</td>
<td>2 GB</td>
</tr>
</tbody>
</table>

Prerequisites and assumptions

This scenario assumes that the following prerequisite steps have been completed prior to beginning the configuration steps:

1. The Hardware Management Console (HMC) was set up.
   - The HMC was cabled.
   - You completed the planning process and you understand how you want to configure your HMC.
   - You used the Guided Setup wizard or the HMC configuration checklist to set up the HMC.
2. You understand the concepts for partitioning the server.
3. You completed the tasks recommended for logical partition planning.
4. You moved and assigned the physical hardware according to the LPAR Validation Tool (LVT) output.
5. You logged in to the HMC with one of the following user roles:
   - Super administrator
   - Service representative
6. You created the logical partitions, partition profiles, and system profiles described.
7. You activated the system profile for Client 1.

The following table lists the system profile that is currently active on the managed system.

<table>
<thead>
<tr>
<th>System Profile ID</th>
<th>Logical partition</th>
<th>Name of logical partition</th>
<th>Name of partition profile</th>
<th>Processor resources</th>
<th>Memory resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client 1</td>
<td>Partition 1</td>
<td>Test 1</td>
<td>Profile 1: Client 1</td>
<td>5 dedicated processors</td>
<td>8 GB</td>
</tr>
<tr>
<td></td>
<td>Partition 2</td>
<td>Test 2</td>
<td>Profile 1: Client 1</td>
<td>2 dedicated processors</td>
<td>3 GB</td>
</tr>
<tr>
<td></td>
<td>Partition 3</td>
<td>Test 3</td>
<td>Profile 1: Client 1</td>
<td>1 dedicated processor</td>
<td>1 GB</td>
</tr>
</tbody>
</table>

Configuration steps

To change the configuration of your managed system so that it is ready for Client 2, you must first shut down the logical partitions by using usual operating system procedures.

After shutting down the logical partitions, you can activate the system profile for Client 2. To do this, complete the following steps on your HMC:
1. In the navigation area, open **Server and Partition**.
2. Select **Server Management**.
3. In the contents area, open the server.
4. Open **System Profiles**.
5. Right-click the Client 2 system profile and select **Activate**.
6. Select the activation settings you want to use and click **Continue**.

After activating the system profile, the managed system is configured according to the needs of Client 2. The following table lists the system profile that is currently active on the managed system.

<table>
<thead>
<tr>
<th>System Profile ID</th>
<th>Logical partition</th>
<th>Name of logical partition</th>
<th>Name of partition profile</th>
<th>Processor resources</th>
<th>Memory resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client 2</td>
<td>Partition 1</td>
<td>Test 1</td>
<td>Profile 2: Client 2</td>
<td>7 dedicated processors</td>
<td>10 GB</td>
</tr>
<tr>
<td></td>
<td>Partition 2</td>
<td>Test 2</td>
<td>Profile 2: Client 2</td>
<td>1 dedicated processor</td>
<td>2 GB</td>
</tr>
</tbody>
</table>

Related information

Cabling the HMC
Preparing for HMC configuration
Configuring the HMC using the Guided Setup wizard
Configuring the HMC using the HMC configuration checklist
Planning for logical partitioning
System Planning Tool Web site
Tasks and roles

Scenario: Dynamically moving processors and memory resources using version 6 or earlier of the HMC:
You can use dynamic logical partition to move processor and memory resources between logical partitions using version 6 or earlier of the HMC. This allows you to maximize resource utilization on your managed system by moving resources to wherever the resources are needed.

**Situation**

You are the system administrator for a business recovery service center with IBM Systems hardware. You use IBM Systems hardware primarily to test disaster recovery strategies for your clients. Each of your clients has a different system configuration. This means that, each time a client comes in, you must change the system configuration of your managed system.

To change the system configuration of your managed system, you decide to use dynamic logical partitioning. Whenever you need to move resources from one logical partition to another, you move the resources directly between the logical partitions without shutting down the logical partitions.

You have just finished testing for Client 1. You must now reconfigure the logical partitions for Client 2, who comes in tomorrow.

*Note:* This is one example of how to change your system configuration. Depending on your operating system, business needs, and resource allocation, you could resolve this situation using partition profiles or system profiles.

**Objectives**

The objective of this scenario is to change the configuration of the logical partitions by dynamically moving resources.

**Details**

Your managed system has two logical partitions. It has eight processors and 12 GB of memory. The following table shows the system configuration required for client 1.

<table>
<thead>
<tr>
<th>Client</th>
<th>Logical partition ID</th>
<th>Name of logical partition</th>
<th>Processor resources</th>
<th>Memory resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client 1</td>
<td>Partition 1</td>
<td>Test 1</td>
<td>5 dedicated processors</td>
<td>8 GB</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Partition 2</td>
<td>Test 2</td>
<td>3 dedicated processors</td>
<td>4 GB</td>
</tr>
</tbody>
</table>

The following table shows the system configuration required for client 2.

<table>
<thead>
<tr>
<th>Client</th>
<th>Logical partition ID</th>
<th>Name of logical partition</th>
<th>Processor resources</th>
<th>Memory resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client 2</td>
<td>Partition 1</td>
<td>Test 1</td>
<td>7 dedicated processors</td>
<td>10 GB</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Partition 2</td>
<td>Test 2</td>
<td>1 dedicated processor</td>
<td>2 GB</td>
</tr>
</tbody>
</table>

**Prerequisites and assumptions**

This scenario assumes that the following prerequisite steps have been completed and are operational prior to beginning the configuration steps:

1. The Hardware Management Console (HMC) was set up.
   - The HMC was cabled. For more information about cabling the HMC, see Cabling the HMC.
• You completed the planning process and you understood how you wanted to configure your HMC. For more information about configuring your HMC, see Gathering required configuration settings.
• You used the Guided Setup wizard or the HMC configuration checklist to set up the HMC. For more information about the Guided Setup wizard, see Configuring the HMC using the Guided Setup wizard. For more information about the HMC configuration checklist, see Configuring the HMC using the HMC configuration checklist.

2. You read and understand the HMC concepts. For more information about HMC concepts, see Concepts for partitioning the server.
3. You completed the tasks recommended for logical partition planning.
4. You removed the system from the manufacturing default configuration and moved the physical hardware to support a partitioned configuration. For more information about how to prepare your system for partitioning, see Partitioning a new or nonpartitioned managed system using the HMC.
5. You logged in to the HMC with one of the following user roles:
   • Super administrator
   • Service representative
   • Product engineer

   For more information about user roles, see Tasks and roles.
6. You created the logical partitions and partition profiles.
7. The managed system is configured for Client 1.

The following table displays the current configuration of each logical partition on the managed system.

<table>
<thead>
<tr>
<th>Logical partition ID</th>
<th>Name of logical partition</th>
<th>Name of partition profile</th>
<th>Processor resources</th>
<th>Memory resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partition 1</td>
<td>Test 1</td>
<td>Profile 1</td>
<td>5 dedicated processors</td>
<td>8 GB</td>
</tr>
<tr>
<td>Partition 2</td>
<td>Test 2</td>
<td>Profile 1</td>
<td>2 dedicated processors</td>
<td>4 GB</td>
</tr>
</tbody>
</table>

**Configuration steps**

To change the configuration of your managed system so that it is ready for Client 2, you must complete the following:

• Move two dedicated processors from the logical partition Test 2 to the logical partition Test 1.
• Move 2 GB of memory from the logical partition Test 2 to the logical partition Test 1.

To move two dedicated processors from one logical partition to another, complete the following steps on your HMC.
1. In the navigation area, open **Server and Partition**.
2. Select **Server Management**.
3. In the contents area, open the server.
4. Open **Partitions**.
5. Right-click the Test 2 logical partition and select **Dynamic Logical Partitioning → Processor Resources → Move**.
6. Specify two processors in the **Move Processors From** area, select the Test 1 logical partition in the **Move Processors To** area, and click **OK**.

To move two memory units from one logical partition to another, complete the following steps on your HMC:
1. In the contents area, right-click the Test 2 logical partition and select Dynamic Logical Partitioning → Memory Resources → Move.
2. Specify 2 GB in the Move Memory From area, select the Test 1 logical partition in the Move Memory To area, and click OK.

When this is completed, the managed system is configured according to the needs of Client 2. The following table displays the current configuration of each logical partition on the managed system.

<table>
<thead>
<tr>
<th>Logical partition ID</th>
<th>Name of logical partition</th>
<th>Name of partition profile</th>
<th>Processor resources</th>
<th>Memory resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partition 1</td>
<td>Test 1</td>
<td>Profile 1</td>
<td>7 dedicated processors</td>
<td>10 GB</td>
</tr>
<tr>
<td>Partition 2</td>
<td>Test 2</td>
<td>Profile 1</td>
<td>1 dedicated processor</td>
<td>2 GB</td>
</tr>
</tbody>
</table>

Related concepts

“Planning for logical partitions” on page 65

IBM hardware architectures allow you to create logical partitions to distribute resources within a single server and make it function as if it were two or more independent servers. Before creating logical partitions (LPARs), you need to plan for several variables that are specific to your solution. You need to understand how you can reconfigure partitions to respond to future needs.

Related information

Cabling the HMC
Preparing for HMC configuration
Configuring the HMC using the Guided Setup wizard
Configuring the HMC using the HMC configuration checklist
System Planning Tool Web site

Tasks and roles

Scenario: Dynamically moving desired I/O devices using version 6 or earlier of the HMC:

You can move infrequently used I/O devices such as optical disc drives dynamically from one logical partition to another using version 6 or earlier of the HMC. This allows you to share the single I/O device among many logical partitions.

Situation

You are the system administrator for a business recovery service center with IBM Systems hardware. You use IBM Systems hardware primarily to test disaster recovery strategies for your clients. The managed system has only one CD drive and one tape drive, which are to be shared among all the logical partitions in the server.

The CD drive and tape drive can be used by only one logical partition at a time. When you are recovering a managed system with two logical partitions, you must move the CD drive and tape drive between the two logical partitions.

You have just finished using the CD drive and tape drive to recover logical partition Test 1. You now need to move the CD drive and tape drive to logical partition Test 2 so that you can begin recovery procedures for that logical partition.

Note: This is one example of how to change your system configuration. Depending on your operating system, business needs, and resource allocation, you could resolve this situation using partition profiles.
Objectives

The objective of this scenario is to move I/O devices from one logical partition to another by dynamically moving desired I/O devices.

Prerequisites and assumptions

This scenario assumes that the following prerequisite steps have been completed and are operational prior to beginning the configuration steps:

1. The Hardware Management Console (HMC) was set up.
   - The HMC was cabled. For more information about cabling the HMC, see Cabling the HMC.
   - You completed the planning process and you understood how you wanted to configure your HMC. For more information about configuring your HMC, see Gathering required configuration settings.
   - You used the Guided Setup wizard or the HMC configuration checklist to set up the HMC. For more information about the Guided Setup wizard, see Configuring the HMC using the Guided Setup wizard. For more information about the HMC configuration checklist, see Configuring the HMC using the HMC configuration checklist.

2. You read and understand the HMC concepts. For more information about HMC concepts, see Concepts for partitioning the server.

3. You read and understand the HMC concepts. For more information about HMC concepts, see Concepts for partitioning the server.

4. You removed the system from the manufacturing default configuration and moved the physical hardware to support a partitioned configuration. For more information about how to prepare your system for partitioning, see Partitioning a new or nonpartitioned managed system using the HMC.

5. You logged in to the HMC with one of the following user roles:
   - Super administrator
   - Service representative
   - Product engineer
   For more information about user roles, see Tasks and roles.

6. You created the logical partitions and partition profiles.

7. The CD drive and tape drive are currently selected as desired I/O resources for both logical partition Test 1 and logical partition Test 2.

8. The CD drive and tape drive are varied off.

Configuration steps

To move the CD drive and tape drive from one logical partition to another, complete the following steps on your HMC.

1. In the navigation area, open Server and Partition.

2. Select Server Management.

3. In the contents area, open the server.

4. Open Partitions.

5. Right-click the Test 1 logical partition and select Dynamic Logical Partitioning ➔ Physical Adapter Resources ➔ Move.

6. Select the CD drive in the Current area, select the Test 2 logical partition in the Move To area, and click OK.

7. Right-click the Test 1 logical partition and select Dynamic Logical Partitioning ➔ Physical Adapter Resources ➔ Move.

8. Select the tape drive in the Current area, select the Test 2 logical partition in the Move To area, and click OK.
When this is completed, the CD drive and tape drive belong to the Test 2 logical partition. You can now begin recovery procedures for the Test 2 logical partition using the CD drive and tape drive.

Related concepts

“Planning for logical partitions” on page 65
IBM hardware architectures allow you to create logical partitions to distribute resources within a single server and make it function as if it were two or more independent servers. Before creating logical partitions (LPARs), you need to plan for several variables that are specific to your solution. You need to understand how you can reconfigure partitions to respond to future needs.

Related information

Cabling the HMC
Preparing for HMC configuration
Configuring the HMC using the Guided Setup wizard
Configuring the HMC using the HMC configuration checklist
System Planning Tool Web site

Tasks and roles

Scenario: Using the HMC and Operations Console with i5/OS logical partitions using version 6 or earlier of the HMC:

Even if you use a Hardware Management Console (HMC) as your platform management tool, you can still use Operations Console as the operating system console for your i5/OS logical partitions.

Situation

Your company has a partitioned System i 8xx server with Operations Console LAN connectivity. You have access and control the logical partitions on the server from your office using a personal computer (PC) with iSeries Navigator and a 5250 session provided by Operations Console. Your company has just purchased an IBM System i5 with a HMC. You would like to continue managing the System i 8xx and the IBM System i5 server from one PC. What can you do?

Objectives

The objectives of this scenario are as follows:

• To manage the System i 8xx server and IBM System i5 using one PC.
• To install and use the remote HMC client.

Prerequisites and assumptions

This scenario assumes that the following prerequisite steps have been completed and are operational prior to beginning the configuration steps:

1. The Hardware Management Console (HMC) was set up.
   • The HMC was cabled. For more information about cabling the HMC, see Cabling the HMC.
   • You completed the planning process and you understood how you wanted to configure your HMC. For more information about configuring your HMC, see Gathering required configuration settings.
   • You used the Guided Setup wizard or the HMC configuration checklist to set up the HMC. For more information about the Guided Setup wizard, see Configuring the HMC using the Guided Setup wizard. For more information about the HMC configuration checklist, see Configuring the HMC using the HMC configuration checklist.

2. You read and understand the HMC concepts. For more information about HMC concepts, see Concepts for partitioning the server.
3. You completed the tasks recommended for logical partition planning. For more information about logical partition planning, see Planning for logical partitions.

4. You removed the system from the manufacturing default configuration and moved the physical hardware to support a partitioned configuration. For more information about how to prepare your system for partitioning, see Partitioning a new or nonpartitioned managed system using the HMC.

5. Your PC met the hardware and software requirements needed for the Web-based Systems Manager remote client installation. For more information about these requirements, see Installation requirements for the remote client.

Solution

Complete the following tasks to access the HMC remotely:

1. Install the Web-based System Manager remote client for Java™ Web Start or Install the Web-based System Manager remote client.

2. Configure System Manager security.

After you have installed the remote HMC client on your PC, you can access and control the logical partitions on your IBM System i5 using the same PC you use to control the System i 8xx server.

Related concepts

“Planning for logical partitions” on page 65
IBM hardware architectures allow you to create logical partitions to distribute resources within a single server and make it function as if it were two or more independent servers. Before creating logical partitions (LPARs), you need to plan for several variables that are specific to your solution. You need to understand how you can reconfigure partitions to respond to future needs.

Related information

Cabling the HMC
Preparation for HMC configuration
Configuring the HMC using the Guided Setup wizard
Configuring the HMC using the HMC configuration checklist
System Planning Tool Web site
Tasks and roles
Install the Web-based System Manager Remote Client for Java Web Start
Install the Web-based System Manager remote client
Configure system manager security

Related information for Partitioning for i5/OS with an HMC

Product manuals, IBM Redbooks® (in PDF format), Web sites, and information center topics contain information related to partitioning for i5/OS with an HMC. You can view or print any of the PDF files.

Manuals

- Partitioning for AIX with an HMC
- Partitioning for Linux with an HMC
- Partitioning with the Integrated Virtualization Manager
- Partitioning using the Virtual I/O Server

Redbooks

- Logical Partitions on IBM PowerPC®, A Guide to Working with LPAR on POWER5 for IBM eServer i5 Servers
• LPAR Configuration and Management: Working with System i Logical Partitions
• Virtual Partition Manager: A Guide to Planning and Implementation

Web sites
• iSeries Logical partitioning Web site (www.ibm.com/eserver/iseries/lpar)
• IBM eServer iSeries Information Center Web site (www.ibm.com/eserver/iseries/infocenter)
• Linux servers Web site (www.ibm.com/eserver/linux)

Other information
• Partitioning for AIX
• Partitioning for Linux
• Partitioning with the Integrated Virtualization Manager
• Partitioning using the Virtual I/O Server
• Installing operating systems
• Managing your server
• Working with Capacity on Demand
• i5/OS Performance
• TCP/IP setup
• Migrating or updating your iSeries system
• Customer service and support
• Consolidating i5/OS, AIX, and Linux partitions on your IBM eServer i5 system

Saving PDF files
To save a PDF on your workstation for viewing or printing:
1. Right-click the PDF link.
2. Click the option that saves the PDF locally.
3. Navigate to the directory in which you would like to save the PDF.
4. Click Save.

Downloading Adobe Reader
You need Adobe Reader installed on your system to view or print these PDFs. You can download a free copy from the Adobe Web site.
Appendix. Accessibility features

Accessibility features help users who have a physical disability, such as restricted mobility or limited vision, to use information technology products successfully.

The following list includes the major accessibility features:
- Keyboard-only operation
- Interfaces that are commonly used by screen readers
- Keys that are tactiley discernible and do not activate just by touching them
- Industry-standard devices for ports and connectors
- The attachment of alternative input and output devices

IBM and accessibility

See the IBM Accessibility Center at http://www.ibm.com/able/ for more information about the commitment that IBM has to accessibility.
Notices

This information was developed for products and services offered in the U.S.A.

The manufacturer may not offer the products, services, or features discussed in this document in other countries. Consult the manufacturer’s representative for information on the products and services currently available in your area. Any reference to the manufacturer’s product, program, or service is not intended to state or imply that only that product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any intellectual property right of the manufacturer may be used instead. However, it is the user’s responsibility to evaluate and verify the operation of any product, program, or service.

The manufacturer may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not give you any license to these patents. You can send license inquiries, in writing, to the manufacturer.

For license inquiries regarding double-byte (DBCS) information, contact the Intellectual Property Department in your country or send inquiries, in writing, to the manufacturer.

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law: THIS INFORMATION IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. The manufacturer may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to Web sites not owned by the manufacturer are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this product and use of those Web sites is at your own risk.

The manufacturer may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact the manufacturer.

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this information and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement, IBM License Agreement for Machine Code, or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurements may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.

Information concerning products not produced by this manufacturer was obtained from the suppliers of those products, their published announcements or other publicly available sources. This manufacturer has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to products not produced by this manufacturer. Questions on the capabilities of products not produced by this manufacturer should be addressed to the suppliers of those products.

All statements regarding the manufacturer’s future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

The manufacturer’s prices shown are the manufacturer’s suggested retail prices, are current and are subject to change without notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to change before the products described become available.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to the manufacturer, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly tested under all conditions. The manufacturer, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs.

CODE LICENSE AND DISCLAIMER INFORMATION:

The manufacturer grants you a nonexclusive copyright license to use all programming code examples from which you can generate similar function tailored to your own specific needs.

SUBJECT TO ANY STATUTORY WARRANTIES WHICH CANNOT BE EXCLUDED, THE MANUFACTURER, ITS PROGRAM DEVELOPERS AND SUPPLIERS, MAKE NO WARRANTIES OR CONDITIONS EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND NON-INFRINGEMENT, REGARDING THE PROGRAM OR TECHNICAL SUPPORT, IF ANY.

UNDER NO CIRCUMSTANCES IS THE MANUFACTURER, ITS PROGRAM DEVELOPERS OR SUPPLIERS LIABLE FOR ANY OF THE FOLLOWING, EVEN IF INFORMED OF THEIR POSSIBILITY:
1. LOSS OF, OR DAMAGE TO, DATA;
2. SPECIAL, INCIDENTAL, OR INDIRECT DAMAGES, OR FOR ANY ECONOMIC CONSEQUENTIAL DAMAGES; OR
3. LOST PROFITS, BUSINESS, REVENUE, GOODWILL, OR ANTICIPATED SAVINGS.
SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF DIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, SO SOME OR ALL OF THE ABOVE LIMITATIONS OR EXCLUSIONS MAY NOT APPLY TO YOU.

Each copy or any portion of these sample programs or any derivative work, must include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp. Sample Programs. © Copyright IBM Corp. _enter the year or years_. All rights reserved.

If you are viewing this information in softcopy, the photographs and color illustrations may not appear.

**Trademarks**

The following terms are trademarks of International Business Machines Corporation in the United States, other countries, or both:

AIX
eServer
i5/OS
IBM
iSeries
OS/400
POWER
POWER Hypervisor
POWER5
pSeries
PowerPC
PowerPC Reference Platform
Redbooks
System i5
System p5
Virtualization Engine
xSeries

Microsoft®, Windows, Windows NT®, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Red Hat, the Red Hat “Shadow Man” logo, and all Red Hat-based trademarks and logos are trademarks or registered trademarks of Red Hat, Inc., in the United States and other countries.

Other company, product or service names may be trademarks or service marks of others.

**Terms and conditions**

Permissions for the use of these publications is granted subject to the following terms and conditions.

**Personal Use:** You may reproduce these publications for your personal, noncommercial use provided that all proprietary notices are preserved. You may not distribute, display or make derivative works of these publications, or any portion thereof, without the express consent of the manufacturer.
Commercial Use: You may reproduce, distribute and display these publications solely within your enterprise provided that all proprietary notices are preserved. You may not make derivative works of these publications, or reproduce, distribute or display these publications or any portion thereof outside your enterprise, without the express consent of the manufacturer.

Except as expressly granted in this permission, no other permissions, licenses or rights are granted, either express or implied, to the publications or any data, software or other intellectual property contained therein.

The manufacturer reserves the right to withdraw the permissions granted herein whenever, in its discretion, the use of the publications is detrimental to its interest or, as determined by the manufacturer, the above instructions are not being properly followed.

You may not download, export or re-export this information except in full compliance with all applicable laws and regulations, including all United States export laws and regulations.

THE MANUFACTURER MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE PUBLICATIONS. THESE PUBLICATIONS ARE PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE.